
Name Allocation
76TH WAREHOUSE PLAZA CONDO $28.36
A T O M $47.16
AAA MOVING AND STORAGE $25.61
AABERG,ILLEAH A $38.16
AABERG,SHELBY $13.49
AAFEDT,BRENT JOEL $27.25
AANRUD,WILLIAM R $23.89
AARON PLUMBING AND HEATING CO $24.69
AARON,GARY G $70.34
AASE,ANNA C $0.57
ABAINZA,FEDERICO A $18.86
ABASTA,CARLO $40.27
ABBEY,MATHEW $12.92
ABBOTT,ANDREW $41.28
ABBOTT,JAMILA AISHA $2.44
ABBOTT,JOHN W $4.61
ABBOTT,JOSEPH $35.00
ABBOTT,SARA M $20.49
ABDIU,SANDRA J $33.17
ABDULHAQQ,TAHA $3.55
ABDULLAHI,ESHREF $14.63
ABEL,DAVID M $31.68
ABEL,SUSIE $76.84
ABELLERA,BERNON JOHN $10.87
ABER,BRYAN GENE $19.26
ABERNATHY,CARY $22.02
ABITZ,BRENDA $3.92
ABNEY,MARCUS $24.21
ABOLD,LAURIE K $16.05
ABOLOS,CONNIE MARIE $15.06
ABOOD,VIVEEN $2.51
ABOUEID,WAYEL A $7.32
ABRAHAMSON,ANNA $3.34
ABRAMS,SAMANDA C $20.55
ABRELL,LARRY T $33.50
ABREU,DEREK ISIDORO $14.58
ABSHIRE,SHANE $9.54
ABSOLUTE ENVIRONMENTAL SVC INC $10.59

Chugach recently mailed 2010 Capital Credit Allocation letters to its former members.  The letter stated an incorrect allocation 
amount on the letter.  If you received one of these letters, you may confirm the correct amount of your allocation by searching* 
for your name in the list below.  

*There are three ways to search for your name:                                                                                                                            

1. Press CTRL plus F on your keyboard.  A FIND dialog box will appear on the PDF reader.

2. Click on the Edit menu, and locate-click the Find command.

3. Locate the Find tool button on the toolbar of the PDF reader (most commonly under the File menu bar). The Find tool button 
has the icon image of a pair of binoculars. Pressing the binocular icon will also result to the display of the Find dialog box.
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ABTS,DAN P $10.50
ABURTO,CARLOS M $24.24
ACEVEDO,MARIA T $258.07
ACEVES CASTELLANOS,MARIA $10.79
ACEVES,JASMINE $28.20
ACHAYOK,PERRY DAVID $14.69
ACHEE,VENA A KORUNA $59.34
ACHERMANN-KELLER,JUDITH $48.97
ACHU,MACMILLAN $14.49
ACKERMAN,MEGAN A $6.46
ACOBA,MICHELLE B $19.67
ACOSTA,KARLA VALERIA $27.12
ACOSTA,MARCUS $2.79
ACOSTA,NICK JAMIRE $14.99
ACOSTA,ROLLAND $30.75
ADAIR,DEREK $20.86
ADAMCZYK,JESSICA M $6.96
ADAMECK,MARIA $2.98
ADAMI,JOSEPH A $37.75
ADAMS JR,CHARLES M $66.69
ADAMS,ANDREA L $40.47
ADAMS,CHABLIS $10.63
ADAMS,DANA $334.88
ADAMS,ERIC E $8.82
ADAMS,JOHN T $12.84
ADAMS,LAWRENCE T $9.87
ADAMS,MICHELLE D $7.96
ADAMS,RENIKA L $18.11
ADAMS,RONALD JOE $14.79
ADAMS,SANDRA $116.07
ADAMS,WILLIAM L $15.49
ADAMSON,JOHN E $45.50
ADATIA,KARIM $12.01
ADCOCK,RUSSELL E $3.75
ADCOX,JOHN A $62.93
ADDISON,ERIC $25.33
ADELSBERGER,MARLO M $5.18
ADGERSON,SHAWN $2.13
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ADKINS,CHRISTOPHER WAYNE $23.23
ADKINS,ELIZABETH A $9.73
ADKINS,KIMBERLY Y $11.12
ADNEY,VANESSA $35.05
ADOLFAE,KELLIE $28.25
ADVANI,ASHISH $26.67
AERO RECIP ALASKA $242.90
AFATIA JR,SEU $6.34
AFUSIA,MICHELLE H $10.76
AGANS,STACIE DANETTE $12.79
AGAYAR,ERICA $14.71
AGCAOILI,MOISES A $13.47
AGEE,MICAH L $23.85
AGEN,PAT $11.05
AGIBINIK,JOSEPH $26.25
AGNEW,FAYE $23.23
AGUCHAK,BRANDON $1.11
AGUIAR,MARCOS $15.60
AGUILA TODD,YASSER L $1.49
AGUILA TODD,YASSER U $1.08
AGUILAR,LUIS $34.64
AGUIRER-CASTILLO,RUBEN $16.07
AHGUPUK,AL $20.17
AHLERS,JUSTIN $25.42
AHMAD,MUHAMMAD $6.08
AHMAOGAK JR,GEORGE $22.05
AHMASUK,AUSTIN G $13.72
AHMED,SEAN $30.08
AHNUPKANA,WENDY L $36.22
AHTNA INC $13.47
AHTUANGARUAK,ALICE $7.29
AHWINONA,ELIZABETH $38.59
AIKEN,BETH M $4.05
AIKEN,CLAUDIA $7.20
AIKEN,JORDAN $27.58
AILEY,LONNIE J $17.56
AIM ALASKA INC $320.72
AK CLASSIC MOTION LLC $5.02



Name Allocation

Chugach recently mailed 2010 Capital Credit Allocation letters to its former members.  The letter stated an incorrect allocation 
amount on the letter.  If you received one of these letters, you may confirm the correct amount of your allocation by searching* 
for your name in the list below.  

*There are three ways to search for your name:                                                                                                                            

1. Press CTRL plus F on your keyboard.  A FIND dialog box will appear on the PDF reader.

2. Click on the Edit menu, and locate-click the Find command.

3. Locate the Find tool button on the toolbar of the PDF reader (most commonly under the File menu bar). The Find tool button 
has the icon image of a pair of binoculars. Pressing the binocular icon will also result to the display of the Find dialog box.

AK COUN ON PREV A/D A $474.59
AK CYCLES $92.50
AK LAWN & LANDSCAPE MNTNC INC $73.89
AK SUNBEAN ESPRESSO LLC $39.26
AKERS,BOBBIE $9.16
AKERSON,TERRY $7.85
AKOLA,ERIC H $17.99
AKULAW,ANDREW Z $51.79
ALADAN SMALL ENGINE $3.12
ALAMO,BECKY L $12.84
ALASKA CANINE SERVICES LLC $47.13
ALASKA CLEANERS $169.63
ALASKA DIESEL SERVICE $102.49
ALASKA SLEEP CLINIC,INC $15.19
ALASKA SUPPLY CHAIN INTEGRATOR $621.12
ALASKAN ACE HARDWARE INC $300.61
ALATALO,JENNA L $1.58
ALATERVO,REGINA A $10.24
ALBERT,BRYAN W $32.66
ALBERT,CHRISTOPHER $27.49
ALBERTSON,DENISE $17.92
ALBERTSON,JOEL C $16.96
ALBERTSON,MELANIE L $16.81
ALBORG,SARAH $10.54
ALBRANT,CATHERINE $5.81
ALBRECHT,DIANA P $35.12
ALBRECHT,HOPE $2.83
ALBRECHT,RONALD $6.76
ALBRIGHT,JON $55.76
ALBRIGHT,MATTHEW D $24.32
ALBRITE,RATHYA $31.59
ALDERIN,TANYA $16.03
ALDERMAN,ELISSA $28.78
ALDERMAN,KATHERINE $13.18
ALDERSON,MERCEDES $2.90
ALDOUS,WES $49.59
ALDRICH,CHARLES $17.94
ALDRIDGE,JESSIKA $5.91
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ALEMAN,DIANA E $26.73
ALEMANY,RACHEL $14.56
ALENEPI,VATAU D $67.99
ALEWINE,D L $22.74
ALEX,NATHANIEL $22.47
ALEXAKIS,PETE $39.94
ALEXAN,MISTY R $31.65
ALEXANDER,ANGELA $8.59
ALEXANDER,CHRISTOPHER $22.10
ALEXANDER,GERALD $15.79
ALEXANDER,KAIRA C $10.37
ALEXANDER,KAITLIN C $20.08
ALEXANDER,LIONEL $36.53
ALEXANDER,SARAH $14.82
ALEXANDER,WILLIAM A $6.81
ALEXIE,GORDON $17.71
ALEXIE,MARY $15.49
ALFARO R,OSCAR $23.49
ALFARO,ABIGAEL $2.86
ALFARO,ARACELI $0.57
ALFARO,EDUARDO $37.15
ALFORD,AMY J $3.63
ALFORD,CHRISTOPHER J $9.30
ALFORD,EDWARD B $46.76
ALGER,JENNIFER $18.17
ALGER,JUDITH $31.81
ALI,AMEER $6.41
ALI,HAZEM F $24.48
ALICE SLEEPER FAMILY TRUST $21.34
ALIOTH JR,JOHN T $49.37
ALIP,GARILYN $5.96
ALKER,DENNIS FRANCIS $60.67
ALL AUTOMOTIVE SERVICES $119.96
ALL NATIONS CHURCH OF ANCH $13.58
ALLABAUGH,WILLIAM $0.74
ALLAIN,LENA MICHELLE $23.96
ALLAIN,ROBERT A $31.91
ALLAIN,ROBERT C $73.52
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ALLAN,WILLIAM RYAN $31.63
ALLEN JR,GRADY T $18.58
ALLEN JR,TIMOTHY J $14.53
ALLEN,ANDREA N $31.22
ALLEN,BRITTNIE M $4.09
ALLEN,CANDY L $18.58
ALLEN,CARL R $36.09
ALLEN,CLARISSA $9.76
ALLEN,DANIEL W $3.43
ALLEN,DAVID L $52.03
ALLEN,DEAN W $12.43
ALLEN,GRAY L $13.95
ALLEN,HOWARD JW $2.03
ALLEN,ILENE M $10.25
ALLEN,JACQUE $37.23
ALLEN,JEANNETTE RAGLUND $6.96
ALLEN,JENNIFER R $14.89
ALLEN,JERRY L $9.50
ALLEN,JOYCE $4.09
ALLEN,JUDITH $20.52
ALLEN,JUSTIN B $0.99
ALLEN,KIRSTIN RENEE $19.54
ALLEN,MARI-ANN $21.81
ALLEN,MELANIE $11.20
ALLEN,MELODY S $10.23
ALLEN,MICHELE S $20.52
ALLEN,NASHARA $15.36
ALLEN,RICKY $40.57
ALLEN,STEPHEN T $11.72
ALLEN,THOMAS $26.60
ALLESSANDRINI,LEIA D $16.88
ALLESSIO,CYNTHIA A $20.95
ALLEVA,RON P. $5.89
ALLISON,RANSOM $12.34
ALLISON,RITA $5.20
ALLMAN,TREVOR $5.92
ALLRED,CYNTHIA E $0.19
ALLRED,JOHN D $34.39
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ALMANZA,STEPHANIE $28.59
ALMON,JAMIE $18.72
ALMON,LUKE B $26.61
ALMONTE,TOMAS DOEING $2.37
ALMRYDE,CHRIS $30.25
ALPHA,KAUAI M $8.10
ALPINE ALTERNATIVES INC $42.52
ALSOBROOK,MICHAEL A $9.10
ALSTON,DERIK $28.25
ALSTON,NOVA J $13.38
ALSTROM II,WILLIAM $0.98
ALSTROM,JACQUELINE $12.57
ALSTROM,JOAN M $12.31
ALTERS,STEPHEN $15.21
ALTIERI,MICHELE $2.66
ALTMAN III,RAY E $56.46
ALTO,NIKKI $20.25
ALVAREZ,ADOLPH ANTHONY $33.80
ALVAREZ,SARAH MARIE $17.61
ALVEY,ANTHONY WILLIAM $6.44
ALVEY,BRYAN $15.26
ALWARD,WENDY $1.63
AMADOR,ERIKA G $0.15
AMAKTOOLIK,DIANNA J $49.69
AMAND,KATHLEEN DENISE $29.64
AMBACHER,KYLE J $31.45
AMBERG,PAUL R $5.97
AMBRIZ,XOCHITL $41.05
AMBROSE,PHILIP $18.40
AMBRUS,JOHN $29.81
AMELINE,WILLIAM T $9.89
AMERICAN METER OF ALASKA $10.51
AMERICAN MOBILE NURSES INC $19.63
AMIK,ALICE $6.82
AMITRANO,JOHN $30.81
AMLING,ANTHONY $65.13
AMMENTORP,JENNIFER L $1.38
AMMERMAN,STEVEN $39.79



Name Allocation

Chugach recently mailed 2010 Capital Credit Allocation letters to its former members.  The letter stated an incorrect allocation 
amount on the letter.  If you received one of these letters, you may confirm the correct amount of your allocation by searching* 
for your name in the list below.  

*There are three ways to search for your name:                                                                                                                            

1. Press CTRL plus F on your keyboard.  A FIND dialog box will appear on the PDF reader.

2. Click on the Edit menu, and locate-click the Find command.

3. Locate the Find tool button on the toolbar of the PDF reader (most commonly under the File menu bar). The Find tool button 
has the icon image of a pair of binoculars. Pressing the binocular icon will also result to the display of the Find dialog box.

AMO IV,WILLIAM $16.50
AMORE,JOHN $45.92
AMOS,CHRISTOPHER L $6.90
AMOTAI,LOSI $20.34
AMSDEN,MATTHEW A $2.67
AMSTUTZ,DANIEL $25.13
AN,JAE HYUN $26.84
ANARUK,TRISHA C $28.63
ANASTASIO,BRANDEN $1.00
ANCHOR TOWN SPORTS ASSOCIATION $5.01
ANDERS,RAGAIL $42.45
ANDERSON,AIKO K $1.92
ANDERSON,ASHLEY $3.81
ANDERSON,BETTY JO $14.86
ANDERSON,CALVERT L $27.76
ANDERSON,CHAD $30.12
ANDERSON,CHELSEY $28.08
ANDERSON,CHRISTOPHER A $25.24
ANDERSON,DAMON G $24.45
ANDERSON,DANIELLE N $13.04
ANDERSON,DAWN $20.93
ANDERSON,DESREE ROCHELLE $20.59
ANDERSON,E TED $20.46
ANDERSON,ELEANOR $74.31
ANDERSON,ERIC T $19.09
ANDERSON,GERALD W $92.95
ANDERSON,HADLEY $11.70
ANDERSON,HEIDI $19.09
ANDERSON,J HARLAND TRUST $18.75
ANDERSON,JACK W $16.88
ANDERSON,JAMES R $27.89
ANDERSON,JERE P $8.43
ANDERSON,JESSICA J $12.59
ANDERSON,JOEL $15.04
ANDERSON,JOHN A $29.08
ANDERSON,JOHN MATTHEW $12.23
ANDERSON,JOSEPH M $17.92
ANDERSON,KATELIN N $3.95
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ANDERSON,KEITH M $14.47
ANDERSON,KETRA R $65.06
ANDERSON,LAURA LEE $19.68
ANDERSON,LISA J $23.72
ANDERSON,LYLA M $21.20
ANDERSON,MATTHEW $18.10
ANDERSON,MELODEE $19.33
ANDERSON,MICHAEL C $2.63
ANDERSON,MICHAEL J $69.26
ANDERSON,NOAH $5.98
ANDERSON,NORMAN $4.12
ANDERSON,RAYMOND C $8.16
ANDERSON,REBECCA L $3.03
ANDERSON,RICK D $17.94
ANDERSON,ROSEMARIE $36.65
ANDERSON,ROSEMARY $7.80
ANDERSON,RUSSELL G $2.38
ANDERSON,SCOTT C $49.44
ANDERSON,SHARA $6.75
ANDERSON,SHARON $5.65
ANDERSON,SHERMAN L $29.28
ANDERSON,STEVEN $17.25
ANDERSON,THOMASINA  A $18.30
ANDERSON,TINA $3.19
ANDERSON,VILMA M $66.96
ANDERSON,WALTER L $35.56
ANDERSSON,MARCUS M $14.57
ANDRADE,REY T $8.11
ANDRASCHKO,ANDREA $16.66
ANDRASCHKO,ANDREA $8.53
ANDRESEN,MATTHEW J $63.95
ANDREW,VALERIE ANN $9.25
ANDREWS,BENJERMIN $15.28
ANDREWS,GERALD A $46.44
ANDREWS,JARETH $2.00
ANDREWS,JENEVA M $3.31
ANDREWS,KATHIE $19.92
ANDREWS,PAMELA F $36.32
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ANDREYCHUK,YANA $32.88
ANDRIC,DRAGANA $1.68
ANDRICH,NANCY L $2.54
ANDRUS,RAYMOND $13.06
ANDRUS,ROBERT L $10.26
ANDRUSS,KAYLA M $12.62
ANGASAN,CHRISTOPHER L $3.36
ANGELES,CHELIN C $13.16
ANGELL,MADA M $37.62
ANGOVE,MICHAEL T $1.03
ANIMAL FOOD WAREHOUSE $683.31
ANKNER,JOSHUA E $11.51
ANKROM,STEPHEN C $7.59
ANNYYEV,SAPARMURAT $19.24
ANSELM,LINDA F $66.61
ANTHONY,ANNAMAE $2.26
ANTHONY,CHARLES $33.79
ANTHONY,HEATHER M $1.03
ANTON,NICOLE M $34.32
ANTONIO,ALAIAGITAFA M $45.78
ANTONOWICZ,ANTHONY $17.83
ANTRIM,DEREK M $7.12
ANUSCHAT,ALEXANDER $3.81
ANZILOTTI,WENDY $5.95
APATIKI,AMBER $29.19
APILADO,EMILLIANO $7.45
APOLLO MEDI-TRANS LLC $97.39
APONE,DANIEL C $25.81
APPELO,REID A $27.83
APPENZELLER,BENJAMIN G $13.14
APPLEBEE,AMY L $10.53
APPLETON,KELSEY R $13.15
APPLEWHITE,KENNY $7.76
APPLEWHITE,THELMA D $20.57
APRIL,TOYA RASHAWN $14.63
APSA LLC $829.77
ARAFILES,NICK ALLEN $7.59
ARANDA,ANGELA A $8.85
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ARANETA,ELISA E $12.54
ARAUJO,JOSE $5.74
ARBUCCI,NERESSA $42.53
ARBUCKLE,PAUL $14.32
ARBUCKLE,SHERRIE $2.22
ARCHER,TERRI $40.81
ARCIGA,ROCIO $3.78
ARCTIC INVESTMENT MANANGE INC $13.27
ARCTIC STRUCTURES LLC $83.98
ARD,JOSEPH C $13.32
ARECHE,EMELY $37.71
AREHART,KATHY E $20.45
ARENS,DEBORAH $10.67
ARIANS,BEN $11.69
ARITA,KRISTINE $1.32
ARLEDGE,KATHLEEN $4.95
ARMENT,JESSE $17.21
ARMISTEAD,LINDA M $28.46
ARMS,JOSHUA M $18.05
ARMSTEAD,THOMAS M $17.43
ARMSTEAD,WAYNE L $50.41
ARMSTRONG,BRANDON $19.10
ARMSTRONG,CHERISE $6.66
ARMSTRONG,ERIC $24.66
ARMSTRONG,JEFFREY PAUL $12.57
ARMSTRONG,JOANNA V $28.57
ARMSTRONG,KRISTY $21.13
ARMSTRONG,MELBA $3.44
ARMSTRONG,SUZAN LYNN $6.78
ARMSTRONG,TRAVIS J $30.69
ARNESS,JACOB $53.98
ARNESS,REBECCA $13.71
ARNOLD,DOUGLAS $9.44
ARNOLD,JASON BRENT $3.81
ARNOLD,JEFF J $4.37
ARNOLD,KATHERINE E $12.66
ARNOLD,LINDA D $1.66
ARNOLD,RONALD L $35.38
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ARNOLD,SANDRA L $5.50
ARNOLD,SETH J $1.34
ARONSON JR,ANDREW A $11.41
ARREDONDO,ALEXA $11.68
ARRIETA,OLIVIA $9.15
ARRIGO,JESSICA MAY $9.60
ARRINGTON,JACOB $3.55
ARRIOLA,MARGARET $10.91
ARROYO,EVELYN I $3.22
ARSENAULT,BETHANY $13.95
ARTHUR,PAUL $28.77
ARTZ,WESLEY $22.77
ARVITES,HELEN E $19.36
ASH,PATRICK J $56.99
ASHCRAFT,DUSTIN $20.26
ASHE,ASHLEY $42.07
ASHER,SAGE $3.88
ASHLEY,KENNETH $15.68
ASHLEY,MEREDITH S $10.43
ASHMORE,SCOTT H $14.24
ASHRAFI,FARIS $13.31
ASHTON,JACOB $7.17
ASHTON,MARY $5.59
ASICKSIK,EUGENE F $21.46
ASPERY,WILLIAM F $35.06
ASPIRAS,DAN $4.07
ASPIRAS,LILIA $8.86
ASTRELLA,ALLISON E $9.27
ASWANTO,ASWANTO $8.67
ATAY,LAURAL $11.34
ATCHAK JR,ALLEN $0.92
ATCHISON,THOMAS $13.40
ATEMBA,JAMES A $43.62
ATKINSON JR,THOMAS $23.16
ATKINSON,BABBARA $11.84
ATKINSON,DEANN $17.80
ATKINSON,RACHEL R $6.13
ATKINSON,TIMOTHY F $42.86
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amount on the letter.  If you received one of these letters, you may confirm the correct amount of your allocation by searching* 
for your name in the list below.  

*There are three ways to search for your name:                                                                                                                            

1. Press CTRL plus F on your keyboard.  A FIND dialog box will appear on the PDF reader.

2. Click on the Edit menu, and locate-click the Find command.

3. Locate the Find tool button on the toolbar of the PDF reader (most commonly under the File menu bar). The Find tool button 
has the icon image of a pair of binoculars. Pressing the binocular icon will also result to the display of the Find dialog box.

ATLAS AIR INCORPORATED $555.90
ATOL,JR GERALD RAYMOND $56.36
ATTANASIO,CHRISTOPHER $2.12
ATTERHOLT,DUSTIN $12.05
ATTID,JUMA K $0.68
ATTILA,FESUS $12.54
ATWOOD,RICHARD W $12.45
ATWOOD,ROBERT $33.98
AUELUA,GENEVIEVE $10.65
AUELUA,MICHAEL $9.02
AUFENKAMP,KASSIOPA D $0.64
AUGUSTINE,ADRIAN DARRYL $37.49
AUGUSTINE,WINIFRED $20.01
AUKONGAK,CATHRYN $32.47
AUKUSO,FIAPAI $33.17
AUMAVAE,IVA $10.27
AURHOMES LLC $13.62
AURORA FOODS LLC $767.60
AURORA REFRIGERATION INC $14.47
AUSTERMUHL,SHERRY SUE $5.40
AUSTIN,DALE J $43.31
AUSTIN,DANNY G $62.44
AUSTIN,ERIN A $23.12
AUSTIN,JAMAILLE $3.75
AUTENRIETH,RYAN $2.53
AUTREY,MARY ELIZABETH $15.00
AVENDANO,FARDI $24.36
AVERY,JACQUELINE $16.90
AVICHAYIL,VINCEN $5.57
AXT,ERIN $69.68
AYALA,MIGUEL $1.69
AYALA-ARREOLA,ARIADNA $17.02
AYERS,COLLINSWORTH $21.34
AYERS,DONALD $1.08
AYGUN,ERSIN $5.13
AYTCH,MICHAEL $35.47
AZELTINE,RILEY G $19.69
AZIMI-TABRIZI,DAPHNE $54.95



Name Allocation

Chugach recently mailed 2010 Capital Credit Allocation letters to its former members.  The letter stated an incorrect allocation 
amount on the letter.  If you received one of these letters, you may confirm the correct amount of your allocation by searching* 
for your name in the list below.  

*There are three ways to search for your name:                                                                                                                            

1. Press CTRL plus F on your keyboard.  A FIND dialog box will appear on the PDF reader.

2. Click on the Edit menu, and locate-click the Find command.

3. Locate the Find tool button on the toolbar of the PDF reader (most commonly under the File menu bar). The Find tool button 
has the icon image of a pair of binoculars. Pressing the binocular icon will also result to the display of the Find dialog box.

AZUMANO TRAVEL SERVICES INC $48.36
BAACK-HILL,ROBIN J $28.30
BABAIAN-KIBALA,ELIZABETH $67.20
BABCOCK,COREY $15.15
BABCOCK,JENNIFER $27.74
BABCOCK,SETH J $18.37
BABCOOK,ASHLEY $16.86
BABIAK,LISA J $12.69
BABLINSKAS,KRYSTIN $6.07
BAC FIELD SERVICES $235.32
BACA,MATTHEW AARON $27.23
BACHER,JACK R $20.70
BACHICHA,LUIS $3.94
BACHMAN,JAMIE $1.25
BACHNER,DANA K $6.01
BACINO,SUSAN K $19.90
BACIU,DENIS $6.08
BACK ROADS UTAH LLC $12.73
BACKES,BARBARA ANN $1.33
BACKES,BENJAMIN $20.98
BACKUS,ROBIN LEAN $1.76
BACOD,ROBERT $12.80
BACON,JOHN $10.79
BACON,KRISTIN M $20.74
BACON,VANCE $25.23
BADA,MARY $16.14
BADDLEY,ROBERT R $12.43
BADER,TRACY A $12.20
BADGLEY,JESSICA $45.59
BADILLO,BRITTANY TARA $51.64
BADOR,BRITANYMARIE $12.42
BADTEN,SARAH $32.50
BAER,ZACHARY L $14.35
BAEZ,ALFRED A $46.71
BAEZ,ALFRED A $18.74
BAGCHI,ABHISEK $41.69
BAGCHI,SUPRIYA $17.58
BAGLEY,ROBERT E $11.11



Name Allocation

Chugach recently mailed 2010 Capital Credit Allocation letters to its former members.  The letter stated an incorrect allocation 
amount on the letter.  If you received one of these letters, you may confirm the correct amount of your allocation by searching* 
for your name in the list below.  

*There are three ways to search for your name:                                                                                                                            

1. Press CTRL plus F on your keyboard.  A FIND dialog box will appear on the PDF reader.

2. Click on the Edit menu, and locate-click the Find command.

3. Locate the Find tool button on the toolbar of the PDF reader (most commonly under the File menu bar). The Find tool button 
has the icon image of a pair of binoculars. Pressing the binocular icon will also result to the display of the Find dialog box.

BAHR,CHRYSTENA L $4.87
BAHR,MARIA L $3.16
BAILEY,AARON $54.98
BAILEY,CARIE $28.99
BAILEY,CHERYL MARIE $14.78
BAILEY,JULIE A $8.51
BAILEY,KATHERINE J $16.05
BAILEY,MARSHA A $11.05
BAILEY,MICHAEL R $6.80
BAILEY,NICKOLE $18.28
BAILEY,WAYNE $40.15
BAILLEAUX,NICOLE $10.95
BAIN,AUTUMN J $11.30
BAINES,FRANK E $16.80
BAIRD,DIAMOND $45.22
BAIZE,ROSE MARY $20.30
BAKER JR,JAMES R $27.40
BAKER,ANGELA M $30.54
BAKER,BRETT M $39.81
BAKER,CARMEN E $13.45
BAKER,CHARLES C $15.79
BAKER,CINDY J $12.64
BAKER,CODY J $2.36
BAKER,COLIN A $9.83
BAKER,CRUZ $10.00
BAKER,DIANNE $8.84
BAKER,GEORGE A $3.51
BAKER,GEORGE L $39.49
BAKER,JEFFERY L $38.69
BAKER,JEWEL $13.57
BAKER,KURT $10.49
BAKER,LORI M $15.23
BAKER,MICHAEL $17.13
BAKER,RAYMOND WAYNE $10.33
BAKER,ROBERT T $23.74
BAKER,SUSAN M $14.57
BAKER,TIMOTHY A $12.69
BAKER,VIRGINIA $15.84



Name Allocation

Chugach recently mailed 2010 Capital Credit Allocation letters to its former members.  The letter stated an incorrect allocation 
amount on the letter.  If you received one of these letters, you may confirm the correct amount of your allocation by searching* 
for your name in the list below.  

*There are three ways to search for your name:                                                                                                                            

1. Press CTRL plus F on your keyboard.  A FIND dialog box will appear on the PDF reader.

2. Click on the Edit menu, and locate-click the Find command.

3. Locate the Find tool button on the toolbar of the PDF reader (most commonly under the File menu bar). The Find tool button 
has the icon image of a pair of binoculars. Pressing the binocular icon will also result to the display of the Find dialog box.

BAKKES,FRANCOIS $15.51
BALANGUE,BERT $10.65
BALANGUE,HOA L $24.93
BALAPPA,DOMINIC $7.24
BALATBAT,MARY ANN G $2.53
BALCHEN,AL P $2.53
BALCHEN,ARTHUR $0.76
BALCOURT,JOYCELYNN C $35.12
BALDUGO,RONA LYNNE $19.04
BALDWIN JR,CLYDE $14.24
BALDWIN,ADAM P $3.46
BALDWIN,KEITH A $40.74
BALDWIN,LISA $30.53
BALDWIN,LORRI A $13.73
BALDWIN,MICHAEL H $49.17
BALDWIN,NANCY L $11.72
BALDWIN,RANDALL O $5.39
BALDWIN-SCHAEFFER,MABEL A $38.67
BALES,PHYLLIS A $18.70
BALES,RODNEY $39.29
BALFE,JANET L $38.24
BALL,DONALD S $55.46
BALL,ERIN $23.90
BALL,RODGER D $58.52
BALL,SARAH $8.39
BALLA,CINDI R $29.96
BALLANTYNE,JEAN E $30.28
BALLAO,TONI $56.99
BALLESTEROS,ROBERT $6.49
BALL-HOUSER,TAMARA $40.94
BALLOT,JASON P $27.83
BALLUTA,ANDREA M $23.30
BALMFORTH,PAUL D $35.91
BALTS,WALLACE C $11.64
BALZOTTI,CHARLES $15.44
BAMBA,BRYANT R $41.10
BAMFORD,BERT $2.78
BANERJEE,SUTAPA $7.97



Name Allocation

Chugach recently mailed 2010 Capital Credit Allocation letters to its former members.  The letter stated an incorrect allocation 
amount on the letter.  If you received one of these letters, you may confirm the correct amount of your allocation by searching* 
for your name in the list below.  

*There are three ways to search for your name:                                                                                                                            

1. Press CTRL plus F on your keyboard.  A FIND dialog box will appear on the PDF reader.

2. Click on the Edit menu, and locate-click the Find command.

3. Locate the Find tool button on the toolbar of the PDF reader (most commonly under the File menu bar). The Find tool button 
has the icon image of a pair of binoculars. Pressing the binocular icon will also result to the display of the Find dialog box.

BANFIELD,THOMAS U $23.86
BANGHART,CHANELLE $5.37
BANISTER,KIM D $11.31
BANK OF AMERICA $6.06
BANKS,JASON $7.75
BANKS,LOVELL $4.39
BANKS,THOMAS $22.70
BANKS,THOMAS A $18.70
BANKSTON,JASON $7.96
BANNON,BONNIE $22.47
BANNON,WILLIAM A $6.79
BANOWETZ,STACY $19.13
BARAAN,VIOLETA $38.81
BARAHONA,GLADYS $16.08
BARAJAS,TOMAS $46.12
BARAKIS,TERRY $42.29
BARANOWSKI,CYNDI $40.65
BARBA,FELIPE STUART $21.08
BARBANO,AUNDRYA $55.31
BARBASH,AMANDA $8.01
BARBEE,SARAH M $7.22
BARBER,BARBARA A $18.54
BARBER,MICHAEL $6.29
BARBER,NANCY $27.77
BARBER,WILLIAM F $76.55
BARBO,VICTOR A $41.86
BARBOUR,JUDY $21.34
BARBOZA,JESSICA ANN R $4.54
BARCE,EMILY $27.91
BARCK,DAVID $12.25
BARCLAY,DUSTIN B $5.80
BARCO,JUAN MEJIA $8.98
BARE DISTILLERY INC $18.68
BARES,JASON $2.60
BARIOS,APRIL C $34.49
BARKAUSKAS,WILLIAM $9.30
BARKEL,NEIL J $16.99
BARKER,BENJAMIN S $4.67



Name Allocation

Chugach recently mailed 2010 Capital Credit Allocation letters to its former members.  The letter stated an incorrect allocation 
amount on the letter.  If you received one of these letters, you may confirm the correct amount of your allocation by searching* 
for your name in the list below.  

*There are three ways to search for your name:                                                                                                                            

1. Press CTRL plus F on your keyboard.  A FIND dialog box will appear on the PDF reader.

2. Click on the Edit menu, and locate-click the Find command.

3. Locate the Find tool button on the toolbar of the PDF reader (most commonly under the File menu bar). The Find tool button 
has the icon image of a pair of binoculars. Pressing the binocular icon will also result to the display of the Find dialog box.

BARKER,CHANTEE $2.81
BARKER,JOCELYN M $4.87
BARKER,JOHN B $10.54
BARKER,KRISTA $21.22
BARKER,MONIQUE $15.50
BARKER,S R $39.50
BARKLEY,DALE $63.84
BARKLEY,JOSEPH $10.51
BARKOWSKI,LYNNETTE $12.86
BARKSHIRE,BRITTANY $9.41
BARLOW,JON $3.33
BARLOW,KELLY $15.99
BARNES,ADAM LEE R $32.30
BARNES,BARBARA ANN $32.69
BARNES,BELINDA E $13.62
BARNES,BRIENNE $5.12
BARNES,DAISY $9.07
BARNES,ERIKA M $6.99
BARNES,JONATHAN DAVID $26.67
BARNES,KRISTINA $4.28
BARNES,SEANA $11.12
BARNES,SHAWNA NICOLE $13.68
BARNETT,BARBARA J $4.73
BARNETT,CHRISTINE $47.47
BARNETT,CHRISTOPHER $6.56
BARNETT,FENG C $0.78
BARNHARDT,MICHAEL $20.97
BAROTT,SUSAN L $16.28
BARR,JOSHUA $29.17
BARRAGAN,JOSE JAVIER $10.29
BARRAS III,PAUL $6.95
BARRAS,URSULA $19.62
BARREDA,BRIAN $26.49
BARRETO,ANA CAROLINE $5.22
BARRETO,RAFAEL $21.42
BARRETT,CILLIAN $12.38
BARRETT,KATHRINE $17.52
BARRETT,LOUIS P $2.13



Name Allocation

Chugach recently mailed 2010 Capital Credit Allocation letters to its former members.  The letter stated an incorrect allocation 
amount on the letter.  If you received one of these letters, you may confirm the correct amount of your allocation by searching* 
for your name in the list below.  

*There are three ways to search for your name:                                                                                                                            

1. Press CTRL plus F on your keyboard.  A FIND dialog box will appear on the PDF reader.

2. Click on the Edit menu, and locate-click the Find command.

3. Locate the Find tool button on the toolbar of the PDF reader (most commonly under the File menu bar). The Find tool button 
has the icon image of a pair of binoculars. Pressing the binocular icon will also result to the display of the Find dialog box.

BARRICKMAN,EVAN $12.88
BARRIE,CHERYL K $39.24
BARRINGTON,SHARENE $8.33
BARRIOS,EDWIN W $8.66
BARRITT,JOSHUA $37.41
BARRON,ALBERT $56.91
BARROW,ERIKA L $37.83
BARR-STONEBURNER,DEVON $7.32
BARRUS,TERRI A $44.43
BARRY,ARTHUR $6.45
BARRY,DUNCAN AMADEUS $43.58
BARTELS JR,JOHANN EVON $14.70
BARTELS,GARRETT S $18.16
BARTELS,HARRY T $28.47
BARTELS,MARY R $30.38
BARTELS-LEYDON,LINDSEY $5.98
BARTH,AMANDA $26.39
BARTH,MATTHEW DANIEL $25.76
BARTHOLOMEW,CHAD J $1.74
BARTLETT,KARSON $10.69
BARTLEY,KEVIN $1.83
BARTLEY,MELISSA $3.69
BARTON,CHRIS $28.07
BARTON,DUSTIN $9.91
BARTOW,KEITH $142.34
BARTZ,JACKLYN $6.78
BARTZ,JESSICA $46.33
BARZYK,TINA $22.47
BASALYGA,ANNABELLE $3.02
BASALYGA,CHRIS A $10.54
BASARAB,VLAD CONSTANTIN $9.25
BASARGIN,SAVVA I $21.42
BASCONCILLO,JULIE $9.87
BASHORE,RANDY M $30.44
BASILE,MARCO $7.64
BASKETTE,BRIAN M $2.93
BASS,JIMMY DALE $16.04
BASS,SHERALL L $28.17



Name Allocation

Chugach recently mailed 2010 Capital Credit Allocation letters to its former members.  The letter stated an incorrect allocation 
amount on the letter.  If you received one of these letters, you may confirm the correct amount of your allocation by searching* 
for your name in the list below.  

*There are three ways to search for your name:                                                                                                                            

1. Press CTRL plus F on your keyboard.  A FIND dialog box will appear on the PDF reader.

2. Click on the Edit menu, and locate-click the Find command.

3. Locate the Find tool button on the toolbar of the PDF reader (most commonly under the File menu bar). The Find tool button 
has the icon image of a pair of binoculars. Pressing the binocular icon will also result to the display of the Find dialog box.

BASS,WILLIAM $11.99
BATE,MATTHEW J $4.72
BATEMAN,JEFFREY $40.96
BATES,ANITA $18.93
BATES,DORTHY D $48.36
BATES,IVONNE M $11.95
BATES,JEANNE L $26.17
BATISTA,JOAO F $6.16
BATISTE,LORI DIANNA $26.68
BATT,BEULAH J $32.31
BAUER,GABRIELLE Y $14.91
BAUER,SAMUEL $34.25
BAUER,WAYNE J $46.66
BAUGH,DEANNA LEE $8.01
BAUGHER,KIMBERLY $30.72
BAUGHMAN,TIMOTHY J $9.42
BAUMAN,JUDY $14.58
BAUMANN,JOHN $16.63
BAUMANN,NICHOLAS KURT $30.59
BAUMEL,EVERETT $1.46
BAUMGARTNER,MATHEW K $26.65
BAUMSTARCK,HILARY $1.26
BAUN,KYNDE MARIE $17.68
BAUTISTA,ORLANDO $27.89
BAVILLA,DIANA $12.46
BAXLEY,LOUISE $2.60
BAXTER,DAVID $54.35
BAXTER,SHANNON $21.11
BAXTER,TOMMY $32.14
BAY,KELLY $28.88
BAYE,EZEKIEL J $2.01
BAYLINSON,ANTHONY $1.98
BAYS,JASON $28.88
BAZALDUA,MIRANDA MARIE $4.11
BEACH,DAVID R $21.85
BEACHY,MELVIN J $30.29
BEAL,TASHA $10.57
BEALER,PAUL J $19.11



Name Allocation

Chugach recently mailed 2010 Capital Credit Allocation letters to its former members.  The letter stated an incorrect allocation 
amount on the letter.  If you received one of these letters, you may confirm the correct amount of your allocation by searching* 
for your name in the list below.  

*There are three ways to search for your name:                                                                                                                            

1. Press CTRL plus F on your keyboard.  A FIND dialog box will appear on the PDF reader.

2. Click on the Edit menu, and locate-click the Find command.

3. Locate the Find tool button on the toolbar of the PDF reader (most commonly under the File menu bar). The Find tool button 
has the icon image of a pair of binoculars. Pressing the binocular icon will also result to the display of the Find dialog box.

BEALL,DAVID C $18.59
BEALS,SHELLENA $79.54
BEAN,AMBER B $67.48
BEAN,SAYDRA L $6.71
BEANE,ARIC J $40.71
BEANER,JOANN $20.20
BEARD,JOHN $8.58
BEARD,TOM $7.18
BEARDEN,LINDA $7.82
BEARDEN,LISA MARIE $26.24
BEARDSLEY,BRIAN $18.65
BEARDSLY,ZACHARY SCOTT $37.96
BEASLEY,AMALFI $9.14
BEASLEY,AMBER RENEE $29.73
BEASLEY,CHARLES C $1.86
BEASLEY,DAVID JOSEPH $7.38
BEASLEY,JANEY $14.78
BEASLEY,RICHARD $16.25
BEATON,SARAH MARIE $15.03
BEATTIE,J PATRICK $34.66
BEATTIE,MOLLY D $4.18
BEATTIE,SEAN M $6.74
BEATTY,CASSIE L $23.74
BEATTY,SAMUEL $34.92
BEATTY,SHYANNE $10.04
BEATY,KENNETH $17.60
BEAUDOIN,AMELIA $3.21
BEAUDRY,LOUIS $14.60
BEAULIEU,SARAH R $26.65
BEAVER,RAYMOND E $15.74
BEAVERSON,KATHERINE $13.38
BEBEY,ANN MARIE $10.36
BEBEY,FRANCIS $10.48
BECERRA,BRUCE D $29.30
BECK,BRUCE W $0.95
BECK,CATHLEEN $0.06
BECK,KELSEY $18.96
BECK,MARC D $22.31



Name Allocation

Chugach recently mailed 2010 Capital Credit Allocation letters to its former members.  The letter stated an incorrect allocation 
amount on the letter.  If you received one of these letters, you may confirm the correct amount of your allocation by searching* 
for your name in the list below.  

*There are three ways to search for your name:                                                                                                                            

1. Press CTRL plus F on your keyboard.  A FIND dialog box will appear on the PDF reader.

2. Click on the Edit menu, and locate-click the Find command.

3. Locate the Find tool button on the toolbar of the PDF reader (most commonly under the File menu bar). The Find tool button 
has the icon image of a pair of binoculars. Pressing the binocular icon will also result to the display of the Find dialog box.

BECK,MICHAEL F $45.41
BECKER,BARBARA L $13.09
BECKER,ERIC $18.52
BECKETT,JEREMY $2.44
BECKETT,JIM R $41.16
BECKETT,NICOLE $19.46
BECKHAM,JOSHUA L $6.69
BECKMAN,JESSICA $19.15
BECKNER,LINDA $5.46
BECKNER,MICHAEL T $29.68
BECKWITH,ANTONIO D $15.08
BECNEL,TIMOTHY J $24.29
BECS INC $39.66
BEDMINISTER,JOSEPHINE $40.31
BEEBE,GREGORY T $19.94
BEEDLE,JILL R $15.22
BEEDLE,STEPHEN $33.67
BEERS,TRACIE M $42.51
BEESLEY,ANNE T $10.39
BEESON,JASON $4.80
BEGEN,MYRTLE $38.63
BEGICH III,NICHOLAS J $44.37
BEHLA,CARL $15.88
BEHM,MICHAEL $68.10
BEHRENS,LISA A $5.09
BEISEMEIER,CRAIG R $39.37
BELAND,JOSEPH $1.57
BELANGER,LEAH G $41.93
BELANGER,NICK W $29.19
BELANGER,TONYA L $36.06
BELANGER,TROY E $41.72
BELDEN,DANETTE R $0.43
BELIC,DUSAN D $7.16
BELIC,VERA $9.85
BELILE,JOSH $12.08
BELL,BRITTANY M $8.68
BELL,JASON R $2.33
BELL,JERROLD W $43.97



Name Allocation

Chugach recently mailed 2010 Capital Credit Allocation letters to its former members.  The letter stated an incorrect allocation 
amount on the letter.  If you received one of these letters, you may confirm the correct amount of your allocation by searching* 
for your name in the list below.  

*There are three ways to search for your name:                                                                                                                            

1. Press CTRL plus F on your keyboard.  A FIND dialog box will appear on the PDF reader.

2. Click on the Edit menu, and locate-click the Find command.

3. Locate the Find tool button on the toolbar of the PDF reader (most commonly under the File menu bar). The Find tool button 
has the icon image of a pair of binoculars. Pressing the binocular icon will also result to the display of the Find dialog box.

BELL,JOEY D $10.01
BELL,KASH FREDRIC $21.44
BELL,KEITH B $30.10
BELL,KENNIS $26.78
BELL,LINDSEY L $9.70
BELL,LORETTA $9.81
BELL,PAULA $37.32
BELL,SOPHIE $12.43
BELL,TERESA Y $30.97
BELL,VIRGIE H $11.80
BELLAMY,HOWARD $77.54
BELLAND,VANCE $1.02
BELLEQUE,SCOTT A $19.31
BELLEW,BRIAN W $47.01
BELNAP,RYAN $17.83
BELTON,GREG A $25.79
BELTRAN,ANGELO $7.25
BELTZER,RICHARD $18.95
BEN,RUSSELL $3.86
BENAVIDES,ANGELA E $4.83
BENBOW,ERIN $3.94
BENDER,GRANT $14.44
BENEDICT,DAINE G $8.00
BENEDICT,MARILYN A $25.68
BENEDICT,RICK $0.93
BENEDICT,ROBERT $24.31
BENEFIEL,CRISTEENA $77.63
BENESCH,DUDLEY $32.99
BENJAMIN,SEAN $31.19
BENNARD,APRIL $46.32
BENNER,CHARLES $29.97
BENNER,KIMBERLY S $28.84
BENNETT,ANNDREA $38.40
BENNETT,ANTHONY $39.78
BENNETT,BONNIE $16.35
BENNETT,DARYL $19.88
BENNETT,DAVID A $43.09
BENNETT,DESIRAE S $7.52
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Chugach recently mailed 2010 Capital Credit Allocation letters to its former members.  The letter stated an incorrect allocation 
amount on the letter.  If you received one of these letters, you may confirm the correct amount of your allocation by searching* 
for your name in the list below.  

*There are three ways to search for your name:                                                                                                                            

1. Press CTRL plus F on your keyboard.  A FIND dialog box will appear on the PDF reader.

2. Click on the Edit menu, and locate-click the Find command.

3. Locate the Find tool button on the toolbar of the PDF reader (most commonly under the File menu bar). The Find tool button 
has the icon image of a pair of binoculars. Pressing the binocular icon will also result to the display of the Find dialog box.

BENNETT,JOHN G $28.65
BENNETT,JONI $11.79
BENNETT,JULIA M $23.07
BENNETT,MARISA D $6.08
BENNETT,MARTHA K $50.54
BENNETT,PATRICIA L $27.25
BENNETT,QUINN $9.15
BENNETT,RICHARD O $30.28
BENNETT,RILEY E $7.26
BENNETT,TANYA MARIA $16.88
BENNETT,THOMAS REID $3.40
BENNETT,WESLEY A $11.95
BENNIE,BLAKE $28.79
BENOIT,BROOKE $11.92
BENOIT,MICHAEL EDWARD $14.60
BENSON,BRIAN D $37.35
BENSON,JOHN L $70.33
BENSON,KATHRYN K $29.04
BENSON,KIATCHA $4.68
BENSON-CARLOUGH,JASON $22.74
BENTE,JUSTIN M $11.67
BENTLEY,TRINA M $16.01
BENZION,SETH J $12.69
BERESKIN,NELDA C $30.43
BERESTOFF,ERIK $30.79
BEREZYUK,ILYA $3.37
BERG,AARON $33.56
BERG,DYLAN $33.89
BERG,ELIZABETH A $12.64
BERG,LAURA $41.62
BERGA,PETER K $7.09
BERGEN,ZACHARY $56.11
BERGER SR,ROBERT HARRISON $52.91
BERGERSON,DUSTIN M $33.71
BERGMAN,KRISTINA M $27.00
BERGSTROM,BILLIE $8.42
BERGSTROM,JUSTIN $7.48
BERKHAHN,BRIAN $34.63
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BERKSHIRE,DAN A $36.46
BERLETICH,NANCY R $9.11
BERNARD,ALLAN H $19.85
BERNARD,CHRISTOPHER D $26.84
BERNARD,WHEELER III $17.64
BERNARDS,LAURA E $13.21
BERNER,TOM $10.28
BERRA,MARIA $5.18
BERRIER,ZACHARY $12.67
BERRY,ROBERT T $10.48
BERTHIAUME,EVA $24.78
BERTUCIO,CLARE S $19.63
BERUBE,BRANDEN $29.71
BERUBE,MARC $39.12
BESINAIZ,BREANA $10.38
BESKOW,KIMBERLY $20.79
BESSER,ANNE $24.31
BEST,MICHAEL R $1.49
BETHAM,CHELSEA $14.47
BETHAM,CHRISTINE $73.69
BETHUNE,SHANE $41.41
BETTIN,CINDI $18.78
BETTRIDGE,DANI J $33.76
BETTS,KATRENA $11.70
BETTYANN C JACKSON LIVING TRUS $46.92
BEUCH,ELIZABETH R $79.88
BEVANS,KATHLEEN $52.33
BEVERIDGE,HEATHER G $18.57
BEVERLIN,MOLLY $1.96
BEVERLY,JAMES C $26.63
BEVIL,BRIAN $6.78
BEVIS,CYNTHIA L $4.62
BEYER,ALEXIS $16.00
BEYER,CORY $14.15
BEYER,JAMES D $17.55
BEYER,JAMES L $10.93
BEZOLD,RANDALL $71.43
BHATTARAI,INDRA B $2.69
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BIAGIONI,DONNA $31.35
BICE,JESSICA $10.90
BICH JR,DAVID $14.16
BICHICK,NYEKAN B $25.84
BICKFORD,DEBRA V $13.24
BICKLE,BRIAN E $11.21
BICKLEY,LELAND $60.29
BIDDISCOMBE,RYAN $12.08
BIEDERMAN,KEVIN $5.92
BIERCE,ANNA $17.92
BIERLEIN,JEAN A $20.59
BIG APPLE INVESTMENTS LLC $13.81
BIGELOW,BROOKE E $20.84
BIGGERSTAFF,KEVIN T $39.69
BIGLEY,MARK $49.53
BIHAG,TSI-YAA $5.90
BIJAK,CRYSTAL $9.69
BIKSEN,TONI $18.84
BILET,TORIL $4.14
BILIRAN,MACARIO D $26.47
BINERO,MAISHA A $13.82
BINGHAM,DORENA E $30.98
BINGHAM,PATRICIA L $0.85
BINGHAM,SAMUEL R $12.03
BINGMAN,JILL $5.38
BIRCH RUN HOMEOWNERS ASSC INC $13.57
BIRCH,DERIC $12.43
BIRCH,PAUL $0.91
BIRCHFIELD,KEEGAN $3.28
BIRD,MICHELE N $36.56
BIRD,RION J $25.45
BIRD,RUSSELL P $17.84
BIRD,TRISTAN E $35.72
BIRKLAND,RABIA $17.17
BIRKY,DANIEL $2.75
BIRUCHENKO,SENA $23.94
BISBY,DONALD L $47.30
BISCHOFF,RICHARD S $10.42
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BISHOP,AARON A $20.11
BISHOP,ANDREW F $15.90
BISHOP,CANDIS D $25.14
BISHOP,CHAD B $8.35
BISHOP,DEIDRA D $16.00
BISHOP,GREGORY $16.12
BISHOP,JOYCE D $17.55
BISHOP,PORTIA F $7.84
BISHOP,WILLIAM H $6.57
BISSELL,ERIC A $23.14
BITHOW,BOTH K $24.09
BITTON,JANETTA $34.79
BITTON,JOSHUA $1.86
BIVINS,GARY J $29.53
BIZAILLON,SHELBY R $26.37
BJELLAND,SHEEN $10.80
BJERKE,JOHN $22.04
BLACK,KYLE $6.72
BLACK,LYNN D $7.75
BLACK,SANDRA $6.72
BLACKADAR,LEONA $52.08
BLACKBURN,DENNIS $51.53
BLACKBURN,DWIGHT R $26.50
BLACKBURN,KATIE M $15.62
BLACKCLOUD,RANDY $36.19
BLACKERBY,KAREN $30.61
BLACKFEATHER,LATONIA A $8.09
BLACKFORD,MARK $29.10
BLACKLEDGE,SIOUX F $87.52
BLACKMORE,JUSTIN U $14.55
BLACKSHEAR,TONYA $5.45
BLACKWELL,RICHARD E $39.55
BLACKWELL,TAJA $7.98
BLACKWELL,TORREJON L $12.79
BLAGMON,JASMINE U $5.36
BLAINE,JOHN G $14.67
BLAIR,PAUL J $0.59
BLAIR,ROBERT $9.33
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BLAIR,THOMAS K $16.95
BLAIR-WASSON,MICHAEL $18.50
BLAKE,JEFFERY CHRISTOPHER $7.66
BLAKE,NATHELYN $10.61
BLAKNEY,TAMARA L $49.15
BLANC,CLAIRE $20.14
BLANCO,LYNDSEY L $10.90
BLANDFORD,MONICA R $12.81
BLANDING III,JAMES D $15.24
BLANE,SERRITA $34.08
BLANKENSHIP,THEODORE $27.84
BLANKS,LYNDA Y $20.35
BLANTON III,ROBERT W $6.04
BLATCHFORD,EDWARD S $23.68
BLAZY,SANDRA J $25.23
BLEDSOE,JUSTIN $25.66
BLEES,JAMES JOSEPH $23.63
BLEES,MEGAN $16.00
BLENDHEIM,CORY S $46.67
BLEVINS,ANDREW $14.89
BLEWETT II,PIERCE NOURSE $20.83
BLIZZARD,ALAN $5.14
BLOCK,SUZANNE $10.61
BLOCKCOLSKY,BRIAN $16.69
BLODGETT,BEVERLY $6.56
BLOGETT,JAMES L $1.23
BLOMBERG,LANA $27.49
BLOOMBERG,FEMININA G $28.25
BLOOMER,BOBBIE $5.40
BLOOMFIELD,JONAS D $29.49
BLOOMQUIST,AARON $31.30
BLOSSER,DAVID $18.75
BLOUGH,CARRIE $33.58
BLOUGH,CHRISTOPHER C $43.38
BLOUNT,ROSALIND $26.22
BLOUNT,SCOTT $17.21
BLUE GLACIER LLC $36.24
BLUE,VANDER D $14.98
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BLUME,ELIZABETH ANN $22.15
BLUME,MICHAEL D $19.55
BLUMENTHAL,MARK $19.83
BLUSH LLC $27.33
BLY,HARRIET $11.97
BO,THOMAS $15.44
BOARDMAN,MICHELLE $36.42
BOATMAN,TONI MICHELLE $11.41
BOAZ,ZAKEIA SHAI $11.00
BOBERICK-DUFFY,MARLENE F $37.54
BOCAST,MARGERY L $0.15
BOCATCH,CLAUDE R $2.39
BOCOX,GREGORY $14.88
BOE,ANGELA $11.76
BOEHLE,DULCY JEAN $12.73
BOEHM,MEGAN $15.29
BOERNER,CATHERINE W $26.72
BOETTCHER,WILLIAM $9.68
BOGDZIEWICZ,THOMAS Z $12.14
BOGENRIFE,SHELLY D $21.41
BOGGESS,STEPHANIA R $9.17
BOGGS,ADRIENE $11.12
BOGLIN,TIA $42.49
BOHAC,DOUGLAS K $25.40
BOHALL,JASON T $21.75
BOHLEN,EVE $24.62
BOHLMAN,SHANE M $19.78
BOHMAN,KRISTOPHER M $21.13
BOHRER JR,LESLIE L $17.09
BOISVERT,JEFFREY C $2.66
BOJKO,VERONICA L $10.19
BOLAR,CAROLINE $4.78
BOLDEN,VINCENT $15.80
BOLDT,TIMOTHY J $9.42
BOLEN,THOMAS $37.84
BOLER,SCOTTY F $1.11
BOLES VI,JOHN G $16.06
BOLES,CATHERINE $25.93
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BOLES,JENNY $3.03
BOLIN,CHRIS G $14.48
BOLIN,KIMBERLY $14.69
BOLLING,JOCQUELYN L $1.77
BOLTON,DAVID H $16.46
BOLTON,JAMEANE $37.96
BOLTON,MICHAEL $32.55
BOLTZ,CLIFF $66.95
BOLTZ,JOSEPH $19.57
BOMA,BRITTANY KEISNS SHANETTE $0.56
BOMBACK,THOMAS W $12.92
BOMBERGER,NOELLE $15.03
BON,JEREMY A $43.12
BOND,CASEY $20.69
BOND,JAMES A $31.13
BOND,PAUL M $26.47
BONEBRAKE,JACOB $5.74
BONERTZ,AMY $10.06
BONHAM,MARK A $12.66
BONIN,DANIEL E $20.41
BONNES,VALERIE $7.89
BONNETT,THOMAS R $0.83
BONNEY,RAMEY MAY DAWN $11.33
BONTRAGER,VERDELL $15.88
BONZER,ELIJAH RAY $13.47
BOOKER,LATRENA N $18.45
BOOL,HAYLEY S $18.65
BOOTH,ADAM R $19.24
BOOTH,JANICE E $57.53
BORAAS,CHRIS $18.30
BORCHARDT,MAIE $7.64
BORCHERT,AMIE $7.59
BORCK,GREGORY T $16.76
BORDEN JR,MICHAEL D $5.89
BORDERS INC $2,102.77
BORER,MEGAN $31.78
BORG,CAPRICE A $32.80
BORGHESE,MICHAEL S $15.92
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BORING,TAMERA $37.16
BORJA,ROSAN L $44.75
BORKOWSKI,VALERIE L $32.82
BORLAND,MARGO $65.83
BORN,LOIS L $4.99
BORRIELLO,JEFF $25.25
BORROZ,BRENDA RENEE $22.13
BORSTAD,JERRY $18.35
BORUFF,CATHERINE $7.91
BOSARGE,JOSEPH $14.35
BOSCH,JUDITH $42.31
BOSKOFSKY JR,CHRISTOPHER $51.42
BOSLET,NANCY K $20.95
BOSLEY,CHRISTINE MARIE $1.65
BOSLEY,RUDY $4.29
BOSSERT,MORGAN J $11.43
BOSSETTE,FREDA LYNNE $9.45
BOSTEK,ORRIN $33.97
BOSTER,BRYAN $20.03
BOSTIC,MICHAEL SHANE $34.06
BOSTON,ED $15.85
BOSTON,TINA M $45.23
BOSWELL,LACHELLE $17.71
BOSWORTH,COREY $7.81
BOTTIMORE,MARK DAVID $21.72
BOUASAVANH,CHAIED SYE $21.48
BOUBEL,GARY A $32.21
BOUCHARD,SHANNON $19.06
BOUIE,JOSHUA $30.71
BOUKNIGHT,DAVID E $4.64
BOULDEN,RANDY $14.91
BOULOMMAVONG,DALAPHONE $29.87
BOUNCE LLC $118.56
BOUNDS,GEORGE S $26.17
BOUNDS,TONY K $20.61
BOURDUKOFSKY,DIONISY JR $18.34
BOURGEOIS,SUSAN $57.94
BOURNE,JAMES J $26.68
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BOURQUE,JORON J $27.76
BOUTSOMSI SALON GROUP INC $133.05
BOUWENS,NICHOLE A $56.36
BOUYER JR,NATHANIEL T $44.00
BOVE,SUSAN $17.70
BOVEE,WAYNE A ESTATE OF $21.00
BOWDON,TAMARA K $16.13
BOWE,ELIJAH $3.23
BOWEN JR,JOHNNIE F $43.42
BOWEN,ERIKA $52.71
BOWEN,JENNIFER A $19.25
BOWEN,LANA $27.80
BOWEN,MICHAEL K $19.51
BOWEN,NAOMI L $3.17
BOWEN,TERE LYNN $16.49
BOWERS,E G $11.08
BOWLER,JACOB $16.64
BOWLES,MICHAEL PATRICK $0.99
BOWLES,ROBERT M $5.71
BOWMAN,GARY R $11.22
BOWMAN,JACQUELYN $6.64
BOWMAN,SIDONIA $7.06
BOYCE,DIANA $10.52
BOYCE,KAREN D $28.37
BOYD,HEIDE $45.09
BOYD,JASON G $16.07
BOYD,JOHN B $37.06
BOYD,KIKO $18.19
BOYD,SHARI A $4.62
BOYD,VINCENT T $4.43
BOYDEN,WENDY L $19.20
BOYER,ADAM S $44.36
BOYER,DEVIN C $13.65
BOYER,RICHARD $47.85
BOYER,STEPHANIE $11.14
BOYETT,CHRIS S $20.64
BOYKO,CHANA $49.44
BOYLAND,MAURICE REGINALD $15.44
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BOYLES,SHERI $7.63
BOZEMAN,C SHANE $52.63
BRACEY,CHONGCILYN $24.13
BRACKEN,KEVIN $3.63
BRACKETT,JENNIFER $10.12
BRADBURY,LAURA $2.60
BRADEN,ROBERT D $12.93
BRADFORD,CHRISTY L $1.66
BRADFORD,JASON C $22.86
BRADFORD,JOHN E $16.47
BRADFORD,LEON $26.31
BRADFORD,TIARRA $1.60
BRADISON,BRENDA K $13.37
BRADLEY,FRANK D $21.09
BRADLEY,JUSTIN $2.64
BRADLEY,KELLY E $16.45
BRADLEY,RED $27.31
BRADSHAW,JOSEPH L $13.53
BRADY,SHANNON NS $27.04
BRAGA,JESSICA $3.42
BRAME,JUDY A $7.00
BRAMSTEDT,SUSAN $4.18
BRANAGAN,BRIAN $8.09
BRANCH,DERRICK R $15.31
BRANCH,GORDON $11.09
BRANCHFLOWER,SUSAN A $20.61
BRANDAL,SAMUEL M $11.72
BRANDENBURG,CORY $27.65
BRANDIMARTI,THOMAS J $9.94
BRANDON,ASHLEY $12.16
BRANDON,DAVID HAROLD $18.99
BRANDON,JON M $12.41
BRANDT,EDWARD A $23.67
BRANDT,FROILAN T $9.62
BRANDT,JENNIFER J $22.91
BRANDT,JOSEPH $18.01
BRANDWEIN,LOUIS $54.20
BRANNOCK,ROBERT LEE $14.71
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BRANNON,RANCE G $19.87
BRANSHAW,WHITNEY A $44.77
BRANSON,CASSANDRA L $17.98
BRASEL,RONALD L $21.88
BRASKET,KATHLEEN R $34.91
BRASSFEILD,THOMAS $21.50
BRASSFIELD,JAY $4.05
BRATTON,GARY $16.75
BRAULT,TABATHA $20.30
BRAUN,BARBARA J $10.57
BRAUN,CRYSTAL D $0.56
BRAUSE,COREY F $35.70
BRAVO,ANNA MARIE $2.51
BRAWLEY,TERESA A $3.11
BRAY,BRYANT O $109.02
BRAY,LANA A $30.77
BRAY,MARTIN $19.19
BRAZINGTON,NATHAN $19.09
BRAZIONIS,ADAM $33.39
BRAZOBAN-ALFONSECA,REYNALDO $8.21
BREAUD,MCKENZIE $17.68
BRECHBUHLER,CADIE A $41.52
BREINER,CHEMENE K $22.12
BREITFIELD,CHRISTIE LEE $25.46
BREJTFUS,SUNNY $7.77
BREKKE,ERIC DILLON $8.92
BRELAND,TAMMY $28.85
BRELJE,LINDSEY $6.40
BRELSFORD,KIRK A $51.05
BRENDTRO,THOR $33.41
BRENNAN,CAROLYN $65.75
BRENNAN,JULIA ANN $5.18
BRENNAN,JULIA MAE $11.75
BRENNEMAN,KAREN $48.86
BRENNER,EILEEN L $38.64
BRETLAND,RACHEL K $6.93
BRETT,JAMES M $1.82
BREWER,JANELL $1.57
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BREWER,LAURA $25.68
BREWER,MARY GLORIA $6.65
BREWER,SARAH C $34.74
BREWINGTON,DEVIN $20.89
BREWSTER,PAMELA JO $2.27
BRIAN,AIMEE $23.79
BRIARCLIFF LLC $39.05
BRICE,NANCY $6.14
BRIDENBAUGH,DAVID G $4.84
BRIDGEMAN,HEATHER M $8.30
BRIDGER,MORIS $8.44
BRIDGES,JASON W $23.72
BRIDGES,SARA B $17.66
BRIDGMAN,PHILIP B $5.49
BRIESE,LEVI $8.40
BRIGGS II,SHAWN $9.26
BRIGGS,ARIANA P $18.03
BRIGGS,JEREMY M $21.38
BRIGGS,LAVELL $12.17
BRIGGS,PATRICK $40.82
BRIGGS,RACHELLE A $15.79
BRIGHT,ANDREW $41.98
BRIGHT,RYAN A $23.37
BRIGHTBILL,TIMOTHY J $31.49
BRIGHTWELL,DAVID K $15.22
BRIGNON,WALTER $60.98
BRILEY,TINA $26.33
BRINK,ERIKA $12.59
BRINKER,CHRISTINA ELIZABETH $50.30
BRINKLEY JR,JOHN E $8.40
BRINKLEY,NATHAN C $0.60
BRINKMEYER,EMILY $19.49
BRINSON,BILLY T $47.58
BRISCO,CASEY $28.15
BRITT,BRANDON T $28.49
BRITT,NORA $48.57
BRITTAIN,JACK W $19.92
BRITTINGHAM,JOHN $25.96
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has the icon image of a pair of binoculars. Pressing the binocular icon will also result to the display of the Find dialog box.

BROACH,AUSTIN $12.28
BROACHE,SARA $37.07
BROCK,ANTHONY GABRIEL $33.54
BROCK,LEEANNA DEE $10.65
BROCK,STUART M $14.45
BROCKETT,ALEXANDER $7.74
BROCOLETTI,ALEXANDRE $12.25
BROGAN,CASEY $12.39
BROILES,CHRISTINE N $9.51
BROLLIER,STEPHANIE $10.42
BRONNER,JOHN D $1.79
BRONSON,NICHOLAS $27.13
BROOKE,JERRY B $20.88
BROOKING,LARRY $6.55
BROOKS,DONALD H $3.86
BROOKS,DONALD LESLIE $45.60
BROOKS,DONNA J $14.41
BROOKS,KEN $0.94
BROOKS,LOIS $20.95
BROOKS,ROBERTA L $20.35
BROOKS,TIM $51.10
BROPHY,ELIJAH J $1.03
BROPHY,KAREN $35.29
BROQUET,KATHLEEN A $14.13
BRORSON,CARLY E $24.04
BROSCHEIT,JULIE $6.97
BROSH,FRANK J HUNTER $21.40
BROSZ,KEITH $19.50
BROTEN,ERIK P $28.37
BROTHERTON,TORI $5.36
BROTHWELL,FLOYD $4.43
BROUGHTON,GLORIOUS $0.10
BROUHARD,BRENT $12.36
BROUILLETTE,ROBERT $17.58
BROUSSARD,LEIGHANN $15.77
BROWDER SR,MICHAEL L $29.52
BROWER,GREGORY CHALMER KIRRUK $33.73
BROWER,LEWIS $7.04



Name Allocation

Chugach recently mailed 2010 Capital Credit Allocation letters to its former members.  The letter stated an incorrect allocation 
amount on the letter.  If you received one of these letters, you may confirm the correct amount of your allocation by searching* 
for your name in the list below.  

*There are three ways to search for your name:                                                                                                                            

1. Press CTRL plus F on your keyboard.  A FIND dialog box will appear on the PDF reader.

2. Click on the Edit menu, and locate-click the Find command.

3. Locate the Find tool button on the toolbar of the PDF reader (most commonly under the File menu bar). The Find tool button 
has the icon image of a pair of binoculars. Pressing the binocular icon will also result to the display of the Find dialog box.

BROWER-STEWART,MARTHA $14.43
BROWITT,DANIEL A $9.30
BROWN JR,RICHARD J $4.17
BROWN,ANDREW NEIL $3.10
BROWN,AUBRAY $7.23
BROWN,BERNARD $8.22
BROWN,CARRIE A $16.85
BROWN,CASSANDRA J $21.54
BROWN,CHRIS $18.86
BROWN,CHRISTOPHER W $25.75
BROWN,CONRAD $0.84
BROWN,CRYSTAL G $12.63
BROWN,CURTIS M $33.55
BROWN,DANA L $17.02
BROWN,DANNIELLE $48.84
BROWN,DAVID JAY $17.84
BROWN,DEREK $12.25
BROWN,DESTINY SHARION $27.14
BROWN,EDWINIA $10.01
BROWN,GERALD B $16.30
BROWN,GLORIA A $12.54
BROWN,GREG N $7.56
BROWN,IAIN C $32.18
BROWN,JADE $5.46
BROWN,JAMES W $33.80
BROWN,JASI $11.97
BROWN,JENNIFER M $34.00
BROWN,JESSICA N $16.08
BROWN,JODI R $19.54
BROWN,JONATHAN J $0.64
BROWN,JULIE S $25.04
BROWN,JUSTIN S $1.96
BROWN,KEITH $16.80
BROWN,KHIA C $59.96
BROWN,KIM A $3.79
BROWN,KIMBER-LEE $7.98
BROWN,KIZZY L $33.25
BROWN,KYLIE $1.25



Name Allocation

Chugach recently mailed 2010 Capital Credit Allocation letters to its former members.  The letter stated an incorrect allocation 
amount on the letter.  If you received one of these letters, you may confirm the correct amount of your allocation by searching* 
for your name in the list below.  

*There are three ways to search for your name:                                                                                                                            

1. Press CTRL plus F on your keyboard.  A FIND dialog box will appear on the PDF reader.

2. Click on the Edit menu, and locate-click the Find command.

3. Locate the Find tool button on the toolbar of the PDF reader (most commonly under the File menu bar). The Find tool button 
has the icon image of a pair of binoculars. Pressing the binocular icon will also result to the display of the Find dialog box.

BROWN,LARRY $9.66
BROWN,LEE A $53.22
BROWN,LINDA $12.17
BROWN,LINDA JANE $16.28
BROWN,MATTHEW $31.70
BROWN,MELANIE ANASTASIA $20.25
BROWN,MICHAEL E $24.59
BROWN,MICHELLE J $6.38
BROWN,NORMAN C $37.17
BROWN,PATRICK T $28.84
BROWN,RAESHEL $0.18
BROWN,REBECCA L $8.75
BROWN,REN $1.80
BROWN,ROBERT G $2.89
BROWN,ROGER L $75.11
BROWN,RONALD A $36.39
BROWN,RONALD E $14.24
BROWN,ROWENA $55.31
BROWN,RYAN $8.48
BROWN,SEAN E $20.93
BROWN,SHERRI L $42.54
BROWN,STANLEY $21.33
BROWN,TYRELL S $10.51
BROWN,VERNON $34.13
BROWN,VIVIAN ELAINE $14.01
BROWN,WILBUR $1.52
BROWN,ZACHARY B $1.30
BROWNLEE,JENNIFER H $50.88
BROZEK,ROBERT J $4.63
BRUCE D WIESMAN TRUST $122.12
BRUCE,AARON $8.25
BRUCE,SAM $17.42
BRUEHWILER,HEIDI K $8.86
BRUFFETT,ROY JOHN $16.43
BRUHL,JAMES $17.93
BRUM,STEPHEN G $55.91
BRUMMEL,BARBARA $21.17
BRUNEAU,JON S $5.72



Name Allocation

Chugach recently mailed 2010 Capital Credit Allocation letters to its former members.  The letter stated an incorrect allocation 
amount on the letter.  If you received one of these letters, you may confirm the correct amount of your allocation by searching* 
for your name in the list below.  

*There are three ways to search for your name:                                                                                                                            

1. Press CTRL plus F on your keyboard.  A FIND dialog box will appear on the PDF reader.

2. Click on the Edit menu, and locate-click the Find command.

3. Locate the Find tool button on the toolbar of the PDF reader (most commonly under the File menu bar). The Find tool button 
has the icon image of a pair of binoculars. Pressing the binocular icon will also result to the display of the Find dialog box.

BRUNELLE,BETHANY BROOKE $30.34
BRUNELLE,JASON A $32.65
BRUNER,AMY J $19.36
BRUNER,WILLIAM B $23.69
BRUNNER,CHRIS $9.62
BRUNSON,DEJANEE R $6.57
BRUNSON,WALDREANA $26.97
BRUNSVOLD,JUSTIN A $143.31
BRUSCHI,ROBERT $5.54
BRUSENHABER,MICHAEL $1.44
BRYAN,RONALD I $64.88
BRYANT,DUSTIN T $6.53
BRYANT,ETHAN $8.24
BRYANT,JOLENE $65.33
BRYANT,JULIE $60.07
BRYANT,JULIE A $1.37
BRYANT,LINDA LEE $16.54
BRYANT,LINDSEY $31.23
BRYANT,ROYCE $40.45
BRYANT,STEVEN R $43.03
BRYS,JACIE LIN $38.84
BRYSON,JEAN M $11.76
BUCCELLATO,JOSEPH A $16.10
BUCCELLATO,SAMANTHA $4.77
BUCHANAN,JO ANN $13.03
BUCHANAN,REGINALD N $46.48
BUCHHOLDT,THELMA $53.24
BUCHTA,CHRIS J $10.01
BUCKHEISTER,WILLIAM $57.18
BUCKLES,LENORA $6.22
BUCKMAN,DOUG $35.89
BUCKMEIER,TERI L $53.82
BUCY,JACILYN $17.00
BUDAR,BARBARA E $0.45
BUDD,ROBERT J $10.07
BUDDE,BRETT $3.44
BUDENSKI,JARED $17.58
BUDROW,LISSA C $5.74



Name Allocation

Chugach recently mailed 2010 Capital Credit Allocation letters to its former members.  The letter stated an incorrect allocation 
amount on the letter.  If you received one of these letters, you may confirm the correct amount of your allocation by searching* 
for your name in the list below.  

*There are three ways to search for your name:                                                                                                                            

1. Press CTRL plus F on your keyboard.  A FIND dialog box will appear on the PDF reader.

2. Click on the Edit menu, and locate-click the Find command.

3. Locate the Find tool button on the toolbar of the PDF reader (most commonly under the File menu bar). The Find tool button 
has the icon image of a pair of binoculars. Pressing the binocular icon will also result to the display of the Find dialog box.

BUECHNER,JOHN $19.73
BUELKE,KEVIN D $24.53
BUENARTE,CRISANTO $5.36
BUETTNER,CURT $2.71
BUGARIN,ROLAND MITCHEL F $15.66
BUHER,KATHI W $24.29
BUHLER,MELISSA $12.85
BUHOLM,AKSEL $6.80
BUITRAGO,KARLO ANDREZ $70.93
BULAICH,TRACY L $11.41
BULAONG,EDGARDO $22.71
BULLOCK,KELSEY FIDELIS $30.35
BULLOCK,VALERIE $18.28
BULLOCK,YALONDA N $4.19
BUMANGLAG,TABITHA $28.11
BUMPUS,ROSLYN M $8.61
BUMSTEAD,M PAMELA $13.22
BUNCE,BRIAN C $18.77
BUNCH,JULIE $17.91
BUNDY,MEGAN M $21.28
BUNDY,VICTORIA R $15.68
BUNJIT,PHITHAK $26.38
BUNKER,GERALD L $9.81
BURCELL,MARK $15.64
BURCELL,TERRI-ANN $6.92
BURCH,ANDREW $13.45
BURCHARD,JESSICA $12.64
BURCHELL,MICHAEL $12.22
BURDEN,BUFFY $1.71
BURDEN,CARL C $11.53
BURDEN,KRISTINA $31.19
BURFORD,DAVID $16.37
BURG,AARRON E $40.76
BURGAN,WILLIAM $47.09
BURGESS,EVANGELINA $11.12
BURGESS,JERRY P $23.54
BURGESS,JOHN M $22.60
BURGESS,KEVIN $43.04



Name Allocation

Chugach recently mailed 2010 Capital Credit Allocation letters to its former members.  The letter stated an incorrect allocation 
amount on the letter.  If you received one of these letters, you may confirm the correct amount of your allocation by searching* 
for your name in the list below.  

*There are three ways to search for your name:                                                                                                                            

1. Press CTRL plus F on your keyboard.  A FIND dialog box will appear on the PDF reader.

2. Click on the Edit menu, and locate-click the Find command.

3. Locate the Find tool button on the toolbar of the PDF reader (most commonly under the File menu bar). The Find tool button 
has the icon image of a pair of binoculars. Pressing the binocular icon will also result to the display of the Find dialog box.

BURGMAN,KELSIE $15.41
BURINDA,BRYAN $37.86
BURKE III,EDWARD A $10.28
BURKE,JANELLE $8.01
BURKE,KATELAND AMANDA $5.78
BURKE,KEITH D $50.85
BURKE,MAUREEN A $46.52
BURKEL,TANYA A. $14.81
BURKE-MATSON,ANNA $9.34
BURKHART,KENNETH J $15.12
BURKOFF,ANASTACIA E $11.20
BURKS,JANE $5.12
BURLEY,DAVID $9.07
BURNELL,JAZON D $31.57
BURNETT,LINDSEY $6.26
BURNHAM,MIKE $15.32
BURNS,JOSHUA R $38.41
BURNS,KENNETH M $2.17
BURNS,PENELOPE A $0.99
BURPEE,ADAM L $19.99
BURR,CONNIE S $32.85
BURR,KEVIN $15.30
BURRELL,DON $1.88
BURRESS,JOHN $17.63
BURRIL,SEAN $17.41
BURRILL,EMERALD $5.70
BURRIS,DAVID C $27.72
BURROUGHS,HATTIE M $19.67
BURROW,SHAWN C $27.84
BURROWS,CYNTHIA F $9.08
BURROWS,JON P $120.42
BURRUS JR,FRANK $3.06
BURSETH,STEPHEN J $3.62
BURT,ALICIA T $6.30
BURT,APRIL D $4.88
BURT,CHRISTINA $42.41
BURT,LINDA JO $11.48
BURT,PENNY $15.62



Name Allocation

Chugach recently mailed 2010 Capital Credit Allocation letters to its former members.  The letter stated an incorrect allocation 
amount on the letter.  If you received one of these letters, you may confirm the correct amount of your allocation by searching* 
for your name in the list below.  

*There are three ways to search for your name:                                                                                                                            

1. Press CTRL plus F on your keyboard.  A FIND dialog box will appear on the PDF reader.

2. Click on the Edit menu, and locate-click the Find command.

3. Locate the Find tool button on the toolbar of the PDF reader (most commonly under the File menu bar). The Find tool button 
has the icon image of a pair of binoculars. Pressing the binocular icon will also result to the display of the Find dialog box.

BURT,SEAN $13.45
BURTON,DEBBIEANN T $15.96
BURTON,JEFFREY $20.00
BURTON,RUSTAN D $34.13
BURTRUM,MICHAEL W $7.80
BUSBY,SUSAN RANAE $0.73
BUSH,CASSANDRA J $33.68
BUSH,KAY F $28.66
BUSH,LACY N $18.81
BUSH,LOIS $13.01
BUSH,NATALIE R $19.93
BUSHNELL,RHEN $21.11
BUSS,ROBERT J $21.64
BUSSA,SONYA D $0.77
BUTCHER,AUDREY $3.55
BUTCHER,DAVID HAROLD $38.91
BUTCHER,JOHN R $21.75
BUTCHER,PAUL $41.02
BUTKOVICH,ELIZABETH $20.95
BUTLER,BRIA $23.73
BUTLER,CAROL J $28.03
BUTLER,DAWN R $6.33
BUTLER,GARRETT $31.95
BUTLER,KIMBERLY $4.43
BUTLER,LEE $1.94
BUTLER,MATTHEW S $28.04
BUTLER,STEPHANIE $24.90
BUTLER,WILLIAM T $3.63
BUTLER-SMITH,SUSIE $49.36
BUTTERFIELD,MITCH $24.11
BUTTON,DAYNA $12.09
BUYZE,SCOTT $13.13
BUZA,MICHAEL $11.33
BUZAREWICZ,CHARLES $0.50
BYBEE,SARAH LEE $22.11
BYE,DANA $7.71
BYERLEY,DAVID S $31.31
BYERLY,FRANK $26.69



Name Allocation

Chugach recently mailed 2010 Capital Credit Allocation letters to its former members.  The letter stated an incorrect allocation 
amount on the letter.  If you received one of these letters, you may confirm the correct amount of your allocation by searching* 
for your name in the list below.  

*There are three ways to search for your name:                                                                                                                            

1. Press CTRL plus F on your keyboard.  A FIND dialog box will appear on the PDF reader.

2. Click on the Edit menu, and locate-click the Find command.

3. Locate the Find tool button on the toolbar of the PDF reader (most commonly under the File menu bar). The Find tool button 
has the icon image of a pair of binoculars. Pressing the binocular icon will also result to the display of the Find dialog box.

BYERS,E C $19.87
BYERS,RILITSA WALKER $12.17
BYERS,WINNIE $49.32
BYLKOV,ROMAN $7.33
BYRD JR,WILLIAM S $20.10
BYRD,FLOYD L $12.20
BYRD,MARTIAL T $19.03
BYRD,MITCHELL DEAN $7.99
BYUN,HAE GYU $22.63
CABANSKI,MARGARET $14.89
CABASAG,LAKI CHAI $7.85
CABLE,BRYAN $18.53
CABLE,CHRIS B $16.97
CABRERA,ABNELL $9.57
CABRERA,MAXIMO PRUDENCIO $12.63
CABRERA-ESPINAL,YONAHTHAN $23.91
CABRIDO,LAHELA K $7.18
CACY,ROSELYNN $64.49
CADET,ERIC $21.21
CADIGAN,GLORIA $69.47
CAFE EXCELLENCE ALASKA $104.36
CAFFERATA,DAVID P $0.69
CAFMEYER,ALFRED $15.75
CAGE,LAURA $1.42
CAHILL,ALMA $13.36
CAHILL,FRANK $0.70
CAHILL,NICOLE $18.16
CAHILL,PETER $35.53
CAHOON,NICHOLAS $29.07
CAIN,ANNE $7.52
CAIN,BRANDON $35.54
CAIN,G ALLEN $14.11
CAIN,JESSICA $2.03
CALATA,JOEL M $7.38
CALDAROLA,JAMES $25.40
CALDERIN,JOSE E $3.82
CALDWELL,BRYAN OLIVER JAMES $9.45
CALDWELL,CLIFFORD A $32.18



Name Allocation

Chugach recently mailed 2010 Capital Credit Allocation letters to its former members.  The letter stated an incorrect allocation 
amount on the letter.  If you received one of these letters, you may confirm the correct amount of your allocation by searching* 
for your name in the list below.  

*There are three ways to search for your name:                                                                                                                            

1. Press CTRL plus F on your keyboard.  A FIND dialog box will appear on the PDF reader.

2. Click on the Edit menu, and locate-click the Find command.

3. Locate the Find tool button on the toolbar of the PDF reader (most commonly under the File menu bar). The Find tool button 
has the icon image of a pair of binoculars. Pressing the binocular icon will also result to the display of the Find dialog box.

CALDWELL,HEATHER $26.55
CALDWELL,SALLY $7.58
CALL,ELLEN M $7.95
CALLAHAN,MACKENZIE $8.28
CALLOWAY,LOUIE $11.35
CALT,JAMES M $2.62
CALVERT,JARRED $5.52
CALVIN,MARSHALL A $12.38
CALZADA,SUSANNE $4.17
CAMACHO,MARIA $30.53
CAMBRA,JENNIFER $2.03
CAMBRIA,MICHELLE $22.44
CAMERON,HILARY $13.09
CAMPBELL,CHRISTOPHER $17.12
CAMPBELL,DAVID $5.66
CAMPBELL,DOUG PAUL $4.43
CAMPBELL,GREGORY S $13.02
CAMPBELL,JILL D $36.99
CAMPBELL,JODIE $2.12
CAMPBELL,KIM C $2.07
CAMPBELL,LUKE $13.14
CAMPBELL,MARILYN $13.09
CAMPBELL,R D $25.88
CAMPBELL,SHAUN M $6.85
CAMPBELL,SUZANNE M $3.02
CAMPOAMOR JR,FERNANDO $30.75
CAMPOAMOR-BUBEN,TAMMY $28.48
CANADY,MAE $14.73
CANDELARIA,ALBERT $1.04
CANGE,SUSAN M $5.56
CANNELL,JONATHON M $13.25
CANON,MYLLER $1.11
CANTAL,KENNETH $2.63
CANTRELL,CHRISTINA B $25.43
CANTY,BRIAN $6.42
CANTY,TAITESHA S $11.49
CAONG,MARIVEL $7.82
CAPALDO,KARI $35.94



Name Allocation

Chugach recently mailed 2010 Capital Credit Allocation letters to its former members.  The letter stated an incorrect allocation 
amount on the letter.  If you received one of these letters, you may confirm the correct amount of your allocation by searching* 
for your name in the list below.  

*There are three ways to search for your name:                                                                                                                            

1. Press CTRL plus F on your keyboard.  A FIND dialog box will appear on the PDF reader.

2. Click on the Edit menu, and locate-click the Find command.

3. Locate the Find tool button on the toolbar of the PDF reader (most commonly under the File menu bar). The Find tool button 
has the icon image of a pair of binoculars. Pressing the binocular icon will also result to the display of the Find dialog box.

CAPEHART,STEPHANIE L $4.96
CAPERTINA,JUDY P $3.95
CAPURRO,DAMON A $36.56
CARADINE SR,DAMEYION S $36.51
CARAMANZANA,LOU $17.05
CARBUCCIA,FLAVIA $26.71
CARDENAS JR,JOSE $29.43
CARDENAS,JANELLE FAYE $20.01
CARDON,PHILIP $6.86
CARDOSO,EZEKIEL $18.47
CARDWELL,KENNETH $9.94
CARDWELL,MICHAEL $8.30
CAREW,LINDA $4.54
CAREY,ADAM C $30.44
CAREY,ALEXANDER $17.92
CAREY,COLLEEN $43.37
CAREY,DAVID ELLSWORTH $3.51
CARHART,COLLEEN $18.18
CARL,LISA MAE $7.74
CARLEY,CAROLYN $16.66
CARLEY,CURTIS N $17.99
CARLI,MICHELLE L $42.64
CARLIN,CLYDE $30.14
CARLISLE,HEATHER $17.81
CARLO,MELINDA $4.04
CARLO,WILLIAM $11.20
CARLON,SAMANTHA $44.35
CARLOS,FRANCES M $3.08
CARLOS,VERONICA $55.06
CARLOUGH,CYNTHIA A $8.07
CARLOUGH,DALE $16.26
CARLSEN,TRAVIS $35.78
CARLSON,BRANDON $1.40
CARLSON,DARLENE J $48.21
CARLSON,DAVID R $8.75
CARLSON,DUSTIN $15.90
CARLSON,DUSTIN L $2.97
CARLSON,JEFF $28.73



Name Allocation

Chugach recently mailed 2010 Capital Credit Allocation letters to its former members.  The letter stated an incorrect allocation 
amount on the letter.  If you received one of these letters, you may confirm the correct amount of your allocation by searching* 
for your name in the list below.  

*There are three ways to search for your name:                                                                                                                            

1. Press CTRL plus F on your keyboard.  A FIND dialog box will appear on the PDF reader.

2. Click on the Edit menu, and locate-click the Find command.

3. Locate the Find tool button on the toolbar of the PDF reader (most commonly under the File menu bar). The Find tool button 
has the icon image of a pair of binoculars. Pressing the binocular icon will also result to the display of the Find dialog box.

CARLSON,KEVIN R $7.52
CARLSON,STEVE A $25.57
CARLSON,TIANNA $1.14
CARLSSON,SYLVIA M $38.43
CARLTON,LAUREN $5.71
CARLTON,RUSSELL E $4.19
CARLTON,VICKI A $26.27
CARMAN,GERALD K $32.72
CARMANY,LAURA B $10.58
CARMICHAEL,ELIZABETH $9.78
CARNEVALE,PATRICK J $3.76
CARPENTER,CHERYL R $14.98
CARPENTER,GREGORY W $18.65
CARPENTER,MELISSA $25.90
CARPIO,BESY DELOURDES $27.01
CARR,BRAD $17.38
CARR,CHRISTOPHER M $29.92
CARR,JAMES D $19.85
CARRANZA,MELISSA $15.19
CARRASCO,MANNY JOE $4.78
CARRAWAY,SIMON W $38.93
CARREIRA,NATHAN $33.85
CARRERA,JORGE $12.84
CARRERO,IAN $0.28
CARRICO,MARTA $15.98
CARRIER,KRISTINA $0.51
CARRIER,STEPHEN $17.21
CARROLL,DENNIS $38.89
CARROLL,JOSEPH L $10.99
CARROLL,LONNIE C $8.18
CARROLL,PAULA J $7.65
CARSON,JESSICA $4.23
CARSON,KATHLEEN $14.04
CARSON,STEVE J $19.32
CARSTON,JEANNE V $14.75
CARTER JR,NATHANIEL $23.36
CARTER,BRANDON $40.91
CARTER,CHRISTOPHER LEE $41.87



Name Allocation

Chugach recently mailed 2010 Capital Credit Allocation letters to its former members.  The letter stated an incorrect allocation 
amount on the letter.  If you received one of these letters, you may confirm the correct amount of your allocation by searching* 
for your name in the list below.  

*There are three ways to search for your name:                                                                                                                            

1. Press CTRL plus F on your keyboard.  A FIND dialog box will appear on the PDF reader.

2. Click on the Edit menu, and locate-click the Find command.

3. Locate the Find tool button on the toolbar of the PDF reader (most commonly under the File menu bar). The Find tool button 
has the icon image of a pair of binoculars. Pressing the binocular icon will also result to the display of the Find dialog box.

CARTER,CONSTANCE L $43.21
CARTER,DAVE $16.96
CARTER,DAVID A $33.30
CARTER,DOUGLAS J $49.18
CARTER,GEORGE A $44.75
CARTER,JOSHUA C $34.58
CARTER,LAKEISHA $33.44
CARTER,LIESL R $44.81
CARTER,MARGARET M $6.59
CARTER,ROBERT ANTHONY $4.62
CARTER,SCHEHERA MILOV $9.36
CARTER,TANYA L $39.45
CARTER,TREVORIS D $23.41
CARTER,VANESSA R $19.65
CARTY,JENNIFER $9.23
CARTY,MICHAEL O $11.45
CARULLI,RAYMOND $18.23
CARUSO,BRITTANY M $17.98
CARVER,ROBIN $34.91
CARY,LISA M $33.92
CASAREZ,ERICA M $24.22
CASCOLAN,RUFINO $51.46
CASE,JEFFERY R $16.71
CASE,MITZI $42.53
CASE,RICK L $2.42
CASE,SEAN $26.54
CASEY,CHRISTOPHER K $0.73
CASEY,GRIFFEN $11.46
CASEY,JOHN $11.87
CASEY,JUDITH $37.49
CASEY,KIM N $4.38
CASEY,MARY L $18.41
CASH,NICOLE $47.43
CASHILL,KATHERINE E $12.98
CASILLO,MARC $10.33
CASON,MINDY $33.80
CASPERSON,RACHEL M $9.40
CASSEL,ENOLA BABE $216.10



Name Allocation

Chugach recently mailed 2010 Capital Credit Allocation letters to its former members.  The letter stated an incorrect allocation 
amount on the letter.  If you received one of these letters, you may confirm the correct amount of your allocation by searching* 
for your name in the list below.  

*There are three ways to search for your name:                                                                                                                            
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CASTAGNO,JOHN $22.24
CASTANO-GIL,SERGIO MAURICIO $12.10
CASTENS OF ANCHORAGE LLC $753.41
CASTIGNETTI,DEBRA J $39.54
CASTILLO,CALEB J $18.77
CASTILLO,ELAINE $3.98
CASTILLO,MANUEL $36.99
CASTILLO,SHAYLA $0.62
CASTLE,KEEGAN L $2.83
CASTOR,ANNA $10.48
CASTRO,BEATRIZ $62.76
CASTRO,BENJAMIN M $3.35
CASTRO,CARLA J $9.08
CASTRO,JESUS M $9.99
CASTRO,KAREN $12.19
CASTRO,MARIA I $18.82
CASTRO,RICARDO $14.29
CASWELL,CHRISTINE $13.72
CATER,THOMAS L $4.79
CATES,PAUL H $29.84
CATOE,JO ANN C $49.39
CATOE,THOMAS $3.72
CATONE,CARL A $6.67
CATRON,JEREMY $5.10
CAUDILL,JOEY $8.42
CAVALLINI,PETER COLT $27.38
CAVANAUGH,MANDY $6.87
CAVENAUGH,MITCHELL B $3.13
CAVITT,STEVE $4.32
CAVOULAS,NICOLAS G $4.04
CAWVEY,JESSICA $24.10
CCI INC $21.89
CEBALLOS,JOSE IVAN $0.68
CEBUHAR,MARK $8.84
CECCHETTI,ELMO $10.46
CEDENO-SHIELDS,ALEXANDER X $15.82
CEDERGREEN,NOLA D $346.34
CELAYA-ESCOBAR,JORGE LUIS $31.00
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CELL ALAKSA $65.49
CELLOS,GAIL DEVASCON $33.59
CENTENO,DERRYL $71.08
CENTENO,MARK $38.07
CENTRAL SHOP LLC $35.34
CENTRILIFT-BAKER HUGHES INC $118.64
CENTURY 21 NORTH HOMES REALTY $124.50
CERNICH,KORD G $35.74
CERUTTI,JOYCE L $18.44
CERUTTI,KEVIN $86.54
CESTARO,LEONARD $52.85
CHA,EUN J $15.98
CHA,PA $62.50
CHACON,DAVID A $14.24
CHADWELL,MARK W $21.93
CHADWICK,BETTY $22.14
CHADWICK,JONATHAN $36.94
CHADWICK,ROBERT W $15.50
CHAFFIN,DONALD L $4.68
CHAFFIN,TRAVIS $8.38
CHAJON ENTERPRISES LLC $304.52
CHAJON,BRUNO R $15.38
CHAMBERLAIN,A R $40.74
CHAMBERLAIN,RACHAEL $34.43
CHAMBERLAIN,SARAH $5.30
CHAMBERLAIN,SHELEE M $19.20
CHAMBERS JR,GLANCE $59.63
CHAMBERS,ANDREW T $26.35
CHAMBERS,MARY K $11.17
CHAMBERS,TIFFANY $10.51
CHAMBLESS,JENNIFER $10.60
CHAMBOS,CHRISTOPHER N $17.66
CHAMPADA,VANH $15.74
CHAMPION,SEAN $11.16
CHAN,AARON C $25.32
CHANCEY,STACI $19.09
CHANDLER,CAROL $18.16
CHANDLER,CHARLES $10.36
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CHANDLER,JEFFREY $13.81
CHANDLER,REBEKA ANN $40.11
CHANEY,BERNADETTE L $19.51
CHANEY,ERIC $8.24
CHANEY,LINDSEY K $8.13
CHANG,ADAM $32.46
CHANG,GRACE W $6.57
CHANG,LA SONGLUE $29.40
CHANG,MOUMONG RICHARD $3.52
CHANG,STANLEY ENYU $4.74
CHANNELL,CLINTON $57.97
CHANTHA,DA $44.56
CHANTHABOUALY,JERAMY $34.90
CHANTHACHACK,DAO $30.21
CHANTHACHACK,KOUNGSAVANH $8.22
CHAO,CHI AN $8.02
CHAPMAN,MELONIE $19.32
CHAPMAN,STEVEN R $11.69
CHAPPELL,ANGELA D $27.26
CHARETTE,MARIA A $25.87
CHARLES,DANIELLE $10.35
CHARLES,DARLENE $14.08
CHARLES,KENT $61.65
CHARLES,RUTH $1.12
CHARLEY,EDNA $11.55
CHARLEY,STEPHANIE $11.88
CHARLIE,CLARE $16.12
CHARLIE,CLAYTON ANDREW $3.01
CHARLIE,MINDY S $31.57
CHARLSEN,MATT $31.46
CHAROONSOPHONSAK,PHOONSRI $0.89
CHARTERS,IAN $25.19
CHASE HOME FINANCE $7.08
CHATFIELD,PAXTON J $16.98
CHATHAM,NICHOLAS G $15.91
CHATMAN,ALONZO $10.95
CHAVELITA'S CAFE AND GRILL $19.56
CHAVEZ,CARLOS V $20.19
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for your name in the list below.  

*There are three ways to search for your name:                                                                                                                            
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CHAVEZ,LOUISA A $41.68
CHE,CHI FANG $1.66
CHEAL,CANDACE ELAINE $34.67
CHEATHAM,TERRANCE L $66.54
CHEEK,RALPH $64.91
CHEFFER,RICHARD C $64.68
CHEN,MICHAEL $0.37
CHEN,YU TZU L $0.37
CHENEY,CHRIS $2.76
CHENEY,DUSTIN $12.54
CHERNIKOFF SR,FRED $13.42
CHERRIE CHIROPRACTIC INC $111.24
CHERRY,DERRICK $6.48
CHERTKOW,BRUCE $7.18
CHESHER,JAMES $36.00
CHETROI,GHEORGHE $0.68
CHEUNG,DANIEL H $7.57
CHIA,JOHN R $0.79
CHILD,CAROL A $1.80
CHILDERS,MICHELLE R $2.33
CHILDS,CHRISTINA $26.01
CHILLIGAN,JASON $13.46
CHILSON,DELTON M $15.54
CHIMICS,LANCE $11.96
CHIN,LESTER $9.68
CHINO,TORU $1.01
CHIPMAN,DAVID $2.62
CHIRI,ALICE S $21.50
CHISKOK,ELIZABETH M $12.98
CHITTY,MARK C $37.24
CHIVINGTON II,CHARLES EDWARD $33.08
CHMIEL,MORGAN T $43.44
CHO,JOHN $2.93
CHO,JONG $19.59
CHO,JONG E $43.11
CHOE,JOSHUA $19.67
CHOI,ANGIE $6.91
CHOI,KEE H $16.73
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CHOI,SANG HOON $38.78
CHOINIERE,AMY $1.20
CHON,JONG SOON $12.19
CHOQUETTE,JEANIE $1.67
CHOUINARD,JOHN S $4.50
CHOY,ALLEN HENRY $733.91
CHRIEST,KATIE $10.18
CHRIEST,ROBERT S $11.38
CHRIST,JESSICA J $3.34
CHRISTENSEN,BILLE JO $1.04
CHRISTENSEN,CHARITY $0.62
CHRISTENSEN,JASON N $31.89
CHRISTENSON,CURT $12.26
CHRISTENSON,KAYCEE $55.81
CHRISTENSON,LEEANN $1.00
CHRISTENSON-BOYD,RITA L $5.19
CHRISTIAN,BRUCE $38.88
CHRISTIAN,ERIC J $7.23
CHRISTIANSEN,ANDREW HANS $13.54
CHRISTIANSEN,CURT C $1.24
CHRISTIANSEN,DIANE M $17.77
CHRISTIANSEN,LYDIA $4.51
CHRISTIANSEN,MARTHA A $19.00
CHRISTIANSEN,PETER H $28.08
CHRISTIANSEN,TIFFANY DAWN $15.03
CHRISTIANSON,SELVEN $32.50
CHRISTIE,JULIAN $22.18
CHRISTINE,DOUGLAS ANTHONY $16.69
CHRISTION,TOWASKI M $33.61
CHRISTOPHER,DEBORAH $12.64
CHRISTOPHER,MICHAEL ROBERT $10.20
CHRISTOPHERSON,DEAN $11.19
CHRISTOPHERSON,JODI L $21.10
CHRISWELL,JOHN F $5.18
CHRONIC,STEVE W $48.93
CHU,KIL YOUNG $12.92
CHUBB,TYLER J $16.79
CHUITT,RACHEL K $23.86
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CHUKWU,FELICIA $5.66
CHULICK,JANICE M $11.61
CHUN,EUNMI $7.56
CHUNG,JINSOO CHRISTOPHER $13.44
CHUNG,KEUM HEE $22.79
CHURCHES,SHARON L $2.41
CHURCHILL,NELLMARIE ROSE $6.17
CIAMILLO,MICHAEL J $30.02
CIARLO,MARGIE $11.37
CICHOSZ,WINNIE S $4.01
CICHOWSKI,DAVID R $6.09
CIEPLAK,JAMES J $22.69
CINQUEGRANI,SAL $18.95
CITI MORTGAGE INC $0.87
CLAGGETT,JAN H $27.79
CLAIBORNE,STEPHANIE R $10.84
CLAMP,LARRY $33.55
CLANCY,KRISTIN $30.21
CLANCY,SUSAN $14.47
CLAPPER,ANDREW $46.54
CLARK JR,ARTHUR $23.02
CLARK,CARL E $37.44
CLARK,CATLIN $13.23
CLARK,CHRISTINA T $21.87
CLARK,CONNIE $7.55
CLARK,DONNA $0.41
CLARK,DUSTIN $14.64
CLARK,ERIC W $29.87
CLARK,GERALD K $40.24
CLARK,IAN R $22.65
CLARK,IVAN J $11.58
CLARK,JOE $35.32
CLARK,JOHN $24.17
CLARK,JOHN R $52.18
CLARK,JOSHUA $12.45
CLARK,JOSHUA J $19.10
CLARK,KEVIN M $16.62
CLARK,LINDA S $30.92
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CLARK,MARK $13.88
CLARK,MARKUS $8.49
CLARK,MARLOW E $10.48
CLARK,MEGHAN C $7.26
CLARK,MICHAEL $5.66
CLARK,MICHAEL ROBERT $22.42
CLARK,NICOLE M $19.26
CLARK,SANDY $58.99
CLARK,SHANNON K $35.76
CLARK,SHARON L $19.79
CLARK,STEVEN A $30.29
CLARK,SUSAN E $35.94
CLARK,TRAVIS J $1.37
CLARK,VICTORIA L $9.27
CLARKE,COLIN N $10.21
CLASBY,CHARLES K $25.33
CLASBY,ERICKA E $11.53
CLASBY,SCOTT I $31.76
CLASS,KEVIN $4.05
CLAUNCH,URSULA M $9.79
CLAUSEN,SARAH $18.06
CLAWSON,DOUGLAS L $8.51
CLAY,KRISTY A $26.63
CLAYTON III,ROY C $4.20
CLAYTON,WILMA $19.67
CLEARY,CONNOR $12.60
CLEEK,ANNEE $14.48
CLELAND,LESLIE D $59.31
CLEM,BRIAN E $33.46
CLEMENT,FRANK $27.23
CLEMENT,JEFF W $3.17
CLEMENTS,JASON G $142.55
CLEMMONS,ROBERT H $46.46
CLEMONS,DARLENE $1.43
CLENDANIEL,GLORIA $5.24
CLENDENNING,JACOB T $18.26
CLERC,PHILIPPE $6.34
CLEVELAND,DIXIE $28.06
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CLINICAL ONE $11.24
CLINKENBEARD,MICHELLE M $12.19
CLINTON,JAMES A $22.48
CLONINGER,CORRY M $28.62
CLONINGER,VICTOR G $5.43
CLORE,BENJAMIN $17.58
CLOSE,TANYA MARIE $112.03
CLOSSON,KEITH $5.69
CLOUD,CHRISTINE $7.85
CLOUD,JACKIE S $26.44
CLOUSE,CAROL F $36.77
CLOW,ORDORM $10.70
CLOWE,NICOLE L $16.13
CLUBB,VERLA J $18.48
COATES,DAVID $14.74
COATS,CAROL S $20.87
COATS,KRISTINA R $7.39
COBB,DAVID C $34.62
COBB,DOROTHY $26.01
COBB,PATRICIA A $0.87
COBLE,ROXANNA $4.50
COBLE,SHIRLEY $50.02
COCCO,HELENA $22.37
COCHRAN,BREANNA $16.85
COCHRAN,JESSIE $17.44
COCHRAN,LORI D $18.78
COCHRAN,PATRICK $9.74
COCHRAN,YASMEEN A $1.24
COCHRANE,MELANIE $50.32
COCKRELL,HEATHER $1.03
COCKRELL,TYLER $8.16
CODDINGTON,CATHERINE $28.26
CODNER,JEROMY ROBERT $12.96
COE,DAVID L $9.15
COE,HELEN $21.31
COE,JENNIFER $3.09
COELHO,STACY $33.47
COFER,SAMANTHA RAE $9.78
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1. Press CTRL plus F on your keyboard.  A FIND dialog box will appear on the PDF reader.

2. Click on the Edit menu, and locate-click the Find command.
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COFFEY,ESKER W $19.66
COFFEY,JAMIE D $82.07
COFFMAN,RICHARD LEE $15.58
COFIELD,LISA A $10.13
COHEN,AMIHAY $8.18
COHEN,DEREK M $24.86
COKE,COLLEEN $12.28
COKER,DONALD WILLIAM $15.79
COLBERT,LORI A $5.17
COLBY,BRANDON J $11.39
COLBY,MICHELLE $16.51
COLE,CHAD $1.62
COLE,JAMISON M $60.59
COLE,MARK A $6.28
COLE,STEPHANIE J $32.14
COLE,TINA M $2.25
COLEGROVE,JEANETTE A $1.08
COLEMAN,JEFF A $20.59
COLEMAN,KAYLENE $42.98
COLEMAN,LEAH D $77.32
COLEMAN,RUTH A $16.37
COLEMAN,TAMMI $45.47
COLEMAN,TARA $6.54
COLLET,ANTHONY $8.67
COLLIER,CHARLES A $6.10
COLLIER,RICHARD E $14.35
COLLIER,TERRY $6.64
COLLINS,CARRIE E $14.57
COLLINS,CARRIE N $12.23
COLLINS,CHERYL L $3.85
COLLINS,DAVID F $4.57
COLLINS,GREG M $8.68
COLLINS,JOHN L $37.82
COLLINS,JOHNNIE $6.78
COLLINS,PAULA $53.02
COLLINS,ROY $46.17
COLLINS,SHAKEIA $13.54
COLLINS,STEPHEN E $4.61
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COLLINS,THERESA $3.67
COLLINS,TIMOTHY W $11.77
COLOMA,FERDINAND C $22.02
COLON,ALLEN JAVIER $18.44
COLONELL,KAREN $2.71
COLONELL,MARLA J $12.35
COLVIN,BRANDON $1.24
COLWAY,CHRISTA M $21.08
COMBS,ANDREA $13.69
COMBS,NGANGIANG V $21.29
COMBS,SHAD $42.83
COMER,DONALD R $14.47
COMFORT,KENNETH W $17.78
COMMACK,ANTONIA $5.61
COMMACK,LOANNE L $22.01
COMMERCIAL INVESTMENTS $18.78
COMMUNITY DEVELOPMNT INSTITUTE $785.97
COMNENOS,GEORGE M $18.51
COMPEAN,JOSEPH $31.70
COMPTON,ALLEN T $24.93
COMPTON,CHRISTOPHER $4.61
COMPTON,SALLY A $1.48
CONDON,WILLIAM $16.56
CONDREY,JASON $138.01
CONDUCY,LEIGH J $1.25
CONGLETON,GARY B $35.75
CONKLIN,DALE $1.02
CONLEY,ANDREW F $22.01
CONLEY,HEATHER M $19.48
CONN,KELLIE L $23.88
CONNAKER,CHRISTOPHER JOHN $32.70
CONNAKER,KEVIN D $10.50
CONNAKER,TIMI J $32.90
CONNELL,DIANA $7.63
CONNELL,JAMES H $18.53
CONNELL,STAN J $16.51
CONNER,JASON $18.07
CONNER,LATOYA $56.55



Name Allocation

Chugach recently mailed 2010 Capital Credit Allocation letters to its former members.  The letter stated an incorrect allocation 
amount on the letter.  If you received one of these letters, you may confirm the correct amount of your allocation by searching* 
for your name in the list below.  

*There are three ways to search for your name:                                                                                                                            
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CONNETT,JESSICA M $11.84
CONNORS,BRIAN E $1.10
CONNORS,STEVEN $24.46
CONRAD,ANGELIQUE R $19.33
CONRAD,DENNIS L $27.03
CONRAD,TIMOTHY $6.72
CONRIGHT,JACIT A $8.68
CONRIGHT,KELLY C $44.48
CONSTANTINE JR,GEORGE $60.81
CONSTANTINE,RUTH $23.10
CONTI,LACY $2.29
CONTRERAS,EULIN R $7.80
CONTRERAS,JESSICA $10.48
CONTRERAS,RAY $6.85
CONTRERAS,RUTH $12.73
CONTRERAS,SHERYL R $0.57
CONTROL CRAFT INC $23.97
CONWAY,LINDA M $5.36
CONWAY,MARIBETH $5.60
CONYERS,FELICIA E $25.87
COOK III,THOMAS C $2.35
COOK,ALAN $15.98
COOK,BREAUNA $29.82
COOK,CHARLOTTE L $27.09
COOK,CYNTHIA M $21.95
COOK,DALE L $2.51
COOK,JASON P $3.93
COOK,JEFFREY A $3.64
COOK,JESSE $4.80
COOK,JOSEPH A $9.94
COOK,JULIA R $14.13
COOK,KAREN $51.89
COOK,LESLEY $39.70
COOK,MAX S $37.33
COOK,MISTY $42.51
COOK,RICHARD T $5.17
COOK,SAMANTHA L $52.17
COOKE,ALISON D $11.78
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COOKE,TIFFANY ANN $15.08
COOLEY,CHRISTOPHER L $5.36
COOMBES,JOHN C $23.78
COOMBS,BRIDGET $12.19
COOMBS,DANIELLE $2.42
COOMBS,KEITH $32.01
COOMBS,LAUREL $10.79
COOMES,JASON B $11.49
COONS,GALEN F $9.66
COOP,LELAND R $33.05
COOPER JR,GUY T $14.06
COOPER,CASSIE RENEE $19.12
COOPER,DARIN $24.16
COOPER,LISA M $32.50
COOPER,MARY M $14.63
COOPER,NICOLE $20.21
COOPER,ROBERT $3.90
COOPER,ROSALEE $29.27
COOPER,SANDRA K $13.80
COOPER-BROWN,JESSICA $3.25
COOSE,CAROL SUE $4.43
COPE,PATRICIA $114.47
COPELAND,ADELE $12.68
COPELAND,JONATHAN A $24.65
COPELAND,MICHAEL $3.55
COPELAND,WILLIAM $28.81
COPELIN,CATHY $30.88
COPPE,MARILYN A $0.90
COPPOCK,JOSEPHINE ANITA $18.05
COPPOLA,FRED $32.05
COPPOLA,LEIGH $10.68
CORAY,GAIL D $18.81
CORBAR NORTH LLC $1.27
CORBIN,CHARLES R $62.75
CORBIN,GENEVIEVEE $16.38
CORBIN,MICHAEL $25.31
CORDERO,AMADO R $11.97
CORDERO,JOHNY VAZQUEZ $27.09
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CORDING,PAUL EDWARD $10.68
COREY,ADAM JOSEPH $24.62
CORFMAN,BRIANNE $6.14
CORKERY,CHARLENE $21.61
CORMACK,CHRISTOPHER $74.15
CORMANY,DAVID R $35.77
CORNELIUS,DAVID G $18.69
CORNELIUS,JANET S $11.49
CORNELIUS,JERRY $11.78
CORNELIUS,KIMBERLY $4.69
CORNELL CORRECTIONS OF AK INC $24.63
CORNELL,MATTHEW D $62.93
CORNETT,MATTHEW $13.72
CORNFORTH,JILL Y $7.25
CORONA,JOE $11.64
CORONADO,IRMA AMPARO $11.45
CORPUZ,KAREN MIRANDA $19.71
CORPUZ,SAM C $36.49
CORRAL,JAIME BALDEMAR $18.42
CORRAL,MALYN C $9.41
CORRENTI,JENNIFER $18.45
CORTES,PHALLON $14.31
CORTEZ,JUAN ANTONIO $24.61
CORTEZ,KRISTI $1.58
CORTEZ,RAMON $6.21
CORWITH,BESS ANNE $46.37
COSBY,CHRISTINE M $69.79
COSCIA,DONALD ALLEN $2.12
COSGRIFF,RACHEL $6.74
COSGROVE,DONALD M $44.86
COSGROVE,JEFFREY $54.61
COSGROVE,KENNEDY $40.98
COSIO,ARTURO $30.16
COSIO,TOMAS $36.73
COSPER,RANDAL $15.23
COSSETTE,MARGARET $10.79
COSSETTE,MARY $25.37
COSTA,SAMUEL $54.30
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3. Locate the Find tool button on the toolbar of the PDF reader (most commonly under the File menu bar). The Find tool button 
has the icon image of a pair of binoculars. Pressing the binocular icon will also result to the display of the Find dialog box.

COSTELLO,JOHN $36.13
COTE,DEBRA L $42.61
COTE,PAUL $14.05
COTHREN,BRYAN $6.98
COTNER,DAWN $9.28
COTTRELL,LILLIAN $14.47
COTTRELL,SHERMAN LEE $23.13
COTTRILL,MICHAEL R $27.34
COUEY,RICHARD $17.72
COULOMBE,JOSHUA M $38.72
COULTER,MATTHEW J $11.41
COULTER,RIKKI $10.87
COUNCIL,PRECYOUS P $29.83
COURSEY,CHRIS $1.69
COURTNEY,MATTHEW $39.37
COURTNEY,MICHAEL JAMES $56.32
COURVILLE,CHRISTINA $15.44
COUSIN,CARLTON A $56.33
COUTURE,GREGORY A $30.13
COUTURE,MELISSA M $24.47
COUTURE,STEVEN M $31.32
COUWENHOVEN,WAYNE $11.09
COVARRUBIAS,ELIJIO $4.51
COWARD,KATHY R $43.24
COWDERY,MINDY $51.92
COWELL,KENNETH C $31.35
COWLES,CAMERON C $14.26
COWLES,ROBIN $11.64
COX,AUDREY J $16.32
COX,BEVERLY W $1.18
COX,BRIAN EDWARD $5.79
COX,CAROLYN K $1.44
COX,CHARLES B $27.83
COX,DENA $16.63
COX,HOLLY KAY $62.73
COX,JOHN ONEAL $36.91
COX,KENNETH $3.46
COX,LAURA K $1.31
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COX,RAYMOND J $8.08
COX,ROBERT D $4.42
COX,VICKY G $23.30
COX-DAVIS,SHANNON D $9.75
COZAD,JENNIFER L $24.25
COZINE,SHAWN R $3.44
COZZEN,MARJORIE $50.78
CRABB,JOHN D $8.88
CRABTREE,WILLIAM A $1.53
CRADDICK,ETHAN $8.80
CRADDICK,JORDAN LEE $27.82
CRADDICK,KAYLI $5.37
CRAFT,MARY $8.43
CRAIG,BRIAN S $5.89
CRAIG,JASON $2.29
CRAIG,KRIS $4.72
CRAMER-SHOWERS,TINA $56.94
CRAMPTON,MARK E $7.25
CRANDALL,JAMES $50.35
CRANDALL,JESSICA $50.86
CRANE,DANIEL F $12.26
CRANE,DANIEL SCOTT $20.80
CRANMER,DEBRA $42.08
CRANSTON,CHRISTOPHER $2.11
CRANSTON,HILLARY $11.60
CRATTY JR,TERRY $18.19
CRAVEN,DARREN B $4.84
CRAVER,ERIC D $4.89
CRAVER,JUSTIN C $34.30
CRAWFORD,DONSEY $23.27
CRAWFORD,KRISTIN $3.50
CRAWFORD,REBECCA $0.27
CRAWFORD,RICHARD W $20.19
CRAWFORD,SHANDA M $1.61
CRAWFORD,TERESA E $19.37
CRAWFORD,WALTER E $30.09
CREAMEAN,PAMELA A $22.04
CREGLOW,CHRIS A $6.95
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CRESPO,CARLOS LUIS $8.86
CRESSWELL,SHANARA $9.49
CREWS,BRANDY D $16.89
CREZEE,GEOFF $36.66
CRIBBS,ERIC $34.18
CRIST,CYNTHIA M $52.61
CRISTLER,BRITTANI LOUISE $4.41
CRISWELL,ALICE J $19.12
CRISWELL,HEATHER $8.26
CROCIATA,CHRISTOPHER $3.35
CROCKER,BRANDY $8.75
CROCKETT,CHRISTINA MICHELLE $29.87
CROFOOT,BETTY F $6.43
CROFT,TERESA A $21.31
CROLEY,ROBERT R $14.88
CROMIE,JAROD $6.95
CRONE,SCOTTY $13.23
CRONIN,KAREN L $6.31
CRONIN,MARGARET A $21.67
CRONIN,MICHAEL S $17.27
CRONLUND,GWENDOLYN B $22.87
CRONLUND,JENNY $21.53
CROOM,HELEN D $12.39
CROSBY,LONNIE $1.79
CROSBY,SUSAN L $11.79
CROSS ROAD MEDICAL CENTER $10.49
CROSS,CARL A $2.24
CROSS,GEORGANA $32.47
CROSS,HEATHER M $37.10
CROSS,KATHY E $26.76
CROSS,LAURA $17.66
CROSS,NATHAN J $19.74
CROSS,SHANE $41.27
CROTTY,LIAM M $7.30
CROUSE,THOMAS $3.42
CROWDER,CHRISTIN $8.19
CROWELL,JASON $36.72
CROWLEY,KAREN A $6.02
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CROWLEY,VIRGINIA $9.70
CROZIER,SHANNA $35.25
CRUMBLEY,CRAIG J $21.82
CRUSE,TERESA L $46.85
CRUTCHFIELD,AMY C $21.78
CRUZ,ARIANNA R $4.80
CRUZ,EDWIN $19.24
CRUZ,JULIE I $18.44
CRUZ,MARILYN A $82.79
CRUZ,MARITES C $12.52
CRUZ,MIGUEL MENJIVAR $11.91
CRUZ,NICHOLAS A $47.84
CRYER,CURT $9.24
CUADRA,LUIS $13.44
CUAUTLE,ROBERTO $26.29
CUDIA,D DARLENE $25.81
CUEVAS,BALTAZAR $19.56
CUEVAS,BENICIA $4.02
CUEVAS,CASONYA $4.68
CUEVAS,VERONICA E $5.89
CUFFEL,GABRIEL JAVIN $37.82
CULBERTSON,MILDRED $2.38
CULL,ALICE WANDA $12.17
CULLEN,LORRAINE $31.14
CULP,JOHN D $23.59
CUMBERLIDGE,STEPHANIE MICHELLE $0.24
CUMMINGS SR,CHARLES $10.41
CUMMINS,ROBERT $54.83
CUNANAN,CHARLES $23.83
CUNANAN,ESPIRIDION RIVERA $59.86
CUNARD,BARRIE $28.76
CUNNIFF,BERNARD J $55.43
CUNNING,JAMES R $24.33
CUNNINGHAM,BRUCE L $25.13
CUNNINGHAM,BRYCE $39.19
CUNNINGHAM,CARRIE L $7.89
CUNNINGHAM,CHER LEE $12.31
CUNNINGHAM,HEATHER A $17.25
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CUNNINGHAM,JUDITH C $16.77
CUNNINGHAM,LISA R $21.09
CUNNINGHAM,MARCUS L $15.05
CUNNINGHAM,MERIDITH D $48.17
CUPP,CYNTHIA $28.18
CURETON,JANICE J $21.09
CURLEY,ANTHONY G $24.78
CURMAN,NICOLETTE D $19.41
CURNOW,LEK $27.25
CURNOW,PAUL $18.77
CURRAN,LISA V $21.54
CURRIER,BOBBY L $5.37
CURRY,MICHAEL $19.49
CURRY,SUSAN K $69.29
CURTIS,CARMEN  M $1.96
CURTIS,GLENN P $0.51
CURTIS,KEVIN P $31.52
CURTIS,MARJORIE $13.52
CURTIS,RICHARD W $2.10
CURTIS,SHANNON $15.61
CUSACK,RUSSELL $9.98
CUSACK,TRAVIS $28.76
CUSHING,REBEKAH Z $15.04
CUSHINGHAM,FRANCIS $3.39
CUSHMAN JR,CHARLES R $21.78
CUSHMAN,RYAN $21.68
CUSTOM TABS $59.98
CUTTER,KRYSTAL H $25.77
CUTWAY,BRADLEY WAYNE $53.71
CUYUCH,RHONDA $31.97
CUZZOCREO,CHRISTINE M $6.25
CYR,JOHN $78.36
CZOPEK,FAITH $13.67
DA SILVA,NIKKI $9.09
DABELOW,APRIL $14.57
DABNEY,TAWNYA MARIE $58.03
DABO,MARTINA $17.16
DAEWON INC $28.42



Name Allocation

Chugach recently mailed 2010 Capital Credit Allocation letters to its former members.  The letter stated an incorrect allocation 
amount on the letter.  If you received one of these letters, you may confirm the correct amount of your allocation by searching* 
for your name in the list below.  

*There are three ways to search for your name:                                                                                                                            

1. Press CTRL plus F on your keyboard.  A FIND dialog box will appear on the PDF reader.

2. Click on the Edit menu, and locate-click the Find command.

3. Locate the Find tool button on the toolbar of the PDF reader (most commonly under the File menu bar). The Find tool button 
has the icon image of a pair of binoculars. Pressing the binocular icon will also result to the display of the Find dialog box.

DAGOMOS,ERIC A $23.35
DAHL,CARA $12.05
DAHL,MALLORY L $1.19
DAHLE,MICHELE L $9.10
DAHLIN,MEGHAN L $9.12
DAHLSTROM,COLTER $10.83
DAHLSTROM,DEELA E $25.84
DAIGLE,ALICIA $23.74
DAIN,PATRICK J $12.27
DALE,RICHARD S $22.36
DALE,ZENITA N $22.86
DALESSANDRO,APRIL M $30.24
DALEY,BILL $3.86
DALEY,TOR $0.76
DALMAN,CHRISTOPHER $5.89
DALTON,CHANCEY ANN $1.76
DALTON,JANIE M $27.15
DALTON,KATHLEEN $5.64
DALY,DAVID JOHN $31.72
DAMIANI,JOSEPH $42.37
DANA,KEVIN T $9.06
DANCZENKO,DAWN $17.83
DANEY,JOYCE $2.37
DANIEL,SANDRA $55.86
DANIELL,KATHE $49.94
DANIELS,DARCY $95.29
DANIELS,GREG $13.63
DANIELS,RACHEL B $18.15
DANIELS,WALTER R $23.46
DANIELSEN,JOHN H $18.02
DANIELSON,ANDREW $4.78
DANIS,MAREK $7.91
DANN,JAMES E $10.94
DANNEHY,BARRY PATRICK $39.50
DANNER,DAVID J $8.83
DANNER,FRANK $1.75
DANTAS,LUCIENE F $21.98
DAQUEP,ANTONIO $1.89
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DARAN,MARIA TERESA $2.46
DARBY,SUE A $19.29
DARIO,RACQUEL B $14.99
DARIS,ASHLEE L $9.91
DARLING,CAMERON R $6.42
DARLING,MARY $17.86
DAROSA,DANIEL $15.78
DARR,ANNE $9.43
DASH,L CHRISTOPHER $28.16
DAUBEL,SCOTT P $9.58
DAUGHERTY,CAROLINE JO $35.42
DAUGHERTY,DAWN $36.78
DAUGHERTY,PAIGE $8.14
DAUGHERTY,VIRGINIA $32.79
DAUGHHETEE,CHRISTINE $11.85
DAUGHTERY,COLIN E $31.12
DAUGHTERY,KRISTA L $12.79
DAULT,CHRISTOPHER $33.98
DAUTH,SARAH J $44.48
DAVENPORT,ANTHONY W $41.86
DAVENPORT,EMILY $9.48
DAVENPORT,KELLEN REED $3.29
DAVENPORT,KEN L $27.22
DAVENPORT,MARY $7.49
DAVENPORT,SCOTT $62.75
DAVENPORT,THOMAS O $12.12
DAVES,ALEXANDER $21.33
DAVID,LEON N $29.58
DAVIDHIZER,LAVERN $19.71
DAVIDSON,AMANDA $2.28
DAVIDSON,ANDREW J $24.07
DAVIDSON,DEAN CALVIN $11.29
DAVIDSON,ERIKA A $17.30
DAVIDSON,GARRETT L $22.90
DAVIDSON,THOMAS $28.94
DAVIES,NICOLE M $31.17
DAVIES,SCOTT $5.20
DAVILA JR,RENE $26.80
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DAVILA,LOIS ANN $25.07
DAVIS III,ROBERT O $12.60
DAVIS JR,WILLIAM JAMES $5.29
DAVIS,AARON M $25.38
DAVIS,ALEXANDER $42.65
DAVIS,BECKY $23.82
DAVIS,BEVERLY S $34.31
DAVIS,BRAD $3.56
DAVIS,BRADLEY L $28.22
DAVIS,BREYON S $20.03
DAVIS,CAROLANNE $23.19
DAVIS,CLARK ALLEN $28.88
DAVIS,DAREN $33.80
DAVIS,DAVID J $4.23
DAVIS,DAVID M $14.67
DAVIS,DECARLOS $13.20
DAVIS,DENISE R $68.73
DAVIS,DORIS L $14.50
DAVIS,F SCOTT $43.78
DAVIS,GORDON $10.00
DAVIS,HANNAH A $24.53
DAVIS,HANNAH F $1.09
DAVIS,JAMES A $11.79
DAVIS,JAMES J $29.52
DAVIS,JASON $39.46
DAVIS,JENNIFER M $9.94
DAVIS,JESSICA J $62.34
DAVIS,JESSICA LYNN $23.83
DAVIS,JOHN A II $35.60
DAVIS,JUSTIN $22.25
DAVIS,KATHLEEN R $15.08
DAVIS,KATHY L $16.43
DAVIS,KATHY M $63.75
DAVIS,KAWAYNEE $2.91
DAVIS,KEYONNA $15.69
DAVIS,KIANA $12.08
DAVIS,KIP L $14.89
DAVIS,LEANNE M $30.42
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DAVIS,MATTHEW $13.94
DAVIS,MICKEY R $15.07
DAVIS,NATALIE C $12.67
DAVIS,ROSCHELLE DENISE $2.69
DAVIS,ROY F $60.62
DAVIS,SCOTT F $26.41
DAVIS,SHAEE $6.22
DAVIS,SHARLANA $26.59
DAVIS,SHELBY $14.84
DAVIS,STEFANIE $31.26
DAVIS,SUZANNE $45.41
DAVIS,TONISHA $18.06
DAVISON,BRANDY M $14.46
DAVISON,STEPHANIE $10.51
DAVIS-TURAK,ADAM S $5.22
DAY,BRYAN $27.44
DAY,KEENAN $16.11
DAY,MICHAEL N $15.57
DAY,SARAH A $55.01
DAY,STEVEN $0.09
DEACON,ARLENE DORIS $18.64
DEACON,LEONARD $5.22
DEAKIN,DIANNE $11.89
DEALBUQUERQUE,PAIGE $28.29
DEAN,ERIC N $50.10
DEAN,JOSHUA T $10.91
DEAN,MATTHEW JASON $92.67
DEAN,MICHAEL R $3.76
DEAN,SHERWYN $23.58
DEAN,TIFFANY $12.17
DEAN,TIMOTHY R $17.68
DEANS,LEWIS $19.87
DEARBORN,MELISSA L $1.58
DEARMOND,CRYSTAL M $11.87
DEARMOUN,DON $3.31
DEASON,ROBIN $10.35
DEAUSEN,DIANA $20.08
DEBELLIS,JEANNINE FLUER $18.83
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DEBERRY,BRITANI $34.62
DEBUCK,JACOB $34.06
DEBUSK,APRIL $7.23
DECKARD,KEVIN L $4.78
DECKER,ANGELICA M $11.79
DECKER,MARGARET $8.24
DECKER,YVONNE $3.75
DECOITO,DESIREE $15.62
DEDE,JOHN Q $6.27
DEE,JORDAN $10.21
DEES,BENNY WILSON $10.31
DEES,SHUN C $37.43
DEEVANNA,DAOLUANG $7.73
DEFAZIO,DIANA $19.48
DEFORD,SHAWN $1.62
DEFRANCE,TRACY $15.45
DEFUENTES-AYALA,MARY $26.26
DEGENHARDT,ROBERTA $3.17
DEGERING,TRACY T $1.20
DEGOLLADO,JUAN $15.36
DEGREGORIO,CORY $7.65
DEGROSS,KRISTIN W $40.67
DEGUZMAN,JONALYN $16.71
DEHART,AMANDA J $13.96
DEHOOP,THOMAS $48.00
DEINES,RYAN P $18.44
DEININGER,DAMIAN $16.26
DEISHER,TANIA HILLARY $20.94
DEITZ,ERNEST W $18.81
DEJDIE,RODOLPHE $9.24
DEJESUS,LEONIDA M $8.57
DEJESUS,LUCY A $15.90
DEJESUS,MIGUEL $7.55
DEJESUS,ROBERTO T $0.98
DEJESUS,SAADIA $17.10
DEKINE,EBONI N $19.94
DELA CRUZ,MAHELENE $44.46
DELACRUZ SR,JUAN E $22.15
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DELACRUZ,DAVID ANTHONY $2.96
DELAFUENTE,CHELSEY $43.05
DELAHOUSSAYE,TOMARA $17.28
DELANEY JR,FRANK E $34.99
DELANEY,MICHAEL $16.16
DELAPENA,GRACIA $7.84
DELARM,L WAYNE $1.03
DELAROSA,LOURDES B $30.54
DELAROSA,RYAN D $7.68
DELAVERN,JEAN M $13.21
DELEON,ALEXANDER $10.37
DELEON,JOAQUIN A $36.58
DELGADILLO III,JUAN $1.21
DELGADO,CONNIE RAE $35.98
DELGADO,LAURA M $0.93
DELGADO,LAURO $33.29
DELGADO,ROSEMARIE $14.08
DELGADO,SOPHIE M $2.85
DELIA,MILISSA $4.29
DELL,BARBARA A $20.42
DELLA SILVA,SHERI A $4.95
DELLA-MAGGIORE,JEANNE $11.12
DELLES,PENNY L $30.31
DELOACH,CLAYTON $12.88
DELONG,JOSEPH W $14.21
DELONG,MICHELLE M $0.14
DELOS REYES,CHRISTOPHER $0.77
DELOSSANTOS,JENNIFER FERNANDEZ $9.85
DELOZIER,STEVEN J $11.35
DELPH,TIMOTHY $51.55
DELPOZO,CHRISTINA $1.18
DEMARCO,BRIAN $41.34
DEMAREE,MICHELLE $16.98
DEMARSH,JUDITH $12.35
DEMBY,ELLIOTT $6.36
DEMERITT,SHERRIE A $40.80
DEMIENTIEFF SR,PHILLIP J $27.95
DEMIENTIEFF,BLANCHE $0.50
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DEMIENTIEFF,CHASITY $32.28
DEMIENTIEFF,MOSES $7.48
DEMIENTIEFF,SUSAN $6.47
DEMIT,JESSI L $2.87
DEMMY,ALEX A $21.20
DEMOORE,BLAKE $9.56
DEMPSEY,LAWRENCE $8.04
DEMPSEY,ROBIN $39.14
DENARDI,RANDALL H $31.09
DENDY,CHRISTOPHER WADE $20.65
DENG,MAROL $16.67
DENIS,ANNA $73.70
DENIS,DAVID ALBERT $10.03
DENNIS,CRYSTAL D $18.19
DENNIS,VIVIAN P $9.16
DENNY,BRENDON $4.87
DENNY,DIANE ELIZABETH $21.93
DENNY,LINDA $59.60
DENOMIE,KAYLA $11.04
DENONCOUR,TRISTAN $22.71
DENSLINGER,MARC J $7.29
DENSMORE,ROSEANN $17.96
DENTON,HEIDI $10.20
DEPAULIS,CELESTE J $16.55
DEPOMPEI-MORALES,JILL $33.31
DEPONTE,FRANK J $5.91
DEPTULA,DEVON C $2.86
DEPWEG II,RICHARD HENRY $20.00
DERAVIN,ZIZANIE E $22.31
DEROSSETT,RHONDA L $41.90
DERR,KIMBERLEE $25.95
DERR,MICHAEL $47.74
DERRY,KEITH C $1.36
DERUELLE,BRUCE $8.17
DERUELLE,LINDSEY $9.83
DESAW,CHRISTINA M $21.36
DESBIENS,SHERYL $9.07
DESCHAMBAULT,ANGELINA $5.52
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DESCHAMPS,WENDI $2.35
DESERT GOLD FINANCIAL INC $10.53
DESHER,SUE E $13.61
DESONIA,JILLIAN $3.06
DESPAIN,TRINITY $8.55
DESROCHES,TRACY $3.54
DESSERT,CHRISTINA L $2.21
DETA,GERARD $13.93
DETABLAN,NICHOLE $5.44
DETERS,FRANZ $38.93
DETIENNE,AMY $70.76
DETRICK,PHYLLIS $16.46
DETTMER,RICHARD E $42.40
DEUELL,JESSIE $26.31
DEUSCHLE,GABRIELLA H $63.65
DEVALL,BRIAN $8.30
DEVALL,CONSTANCE $14.72
DEVEAU,ANDREA L $5.52
DEVENS,JADE $2.94
DEVENY,STEPHEN M $26.68
DEVEREUX,AMY $8.07
DEVIESE,DAVID T $20.02
DEVINE,JAMES A $3.22
DEVLIN,HUGH $8.66
DEVORE,BRUCE H $15.59
DEVORE,DOUGLAS $63.58
DEWAN,MICHAEL $13.90
DEWAR,JESSE $11.19
DEWEY'S COOK INLET INC $237.69
DEWOLF,TIMOTHY $7.12
DHAKAL,DARI $8.33
DHL CORPORATION $469.65
DHUE,GARY $9.38
DIAB,JASMINE $9.51
DIANA,DEAN J $48.68
DIAZ II,LAZARO $21.74
DIAZ,CHRISTINA L $14.38
DIAZ,CHRISTINA M $25.59
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DIAZ,FREDDIE $23.88
DIAZ,GABRIEL $19.39
DIAZ,GINETTE $37.49
DIAZ,JOSE A $12.52
DIAZ,MARIA $61.36
DIAZ,RODRIGO A $45.74
DIAZ,TIMOTHY M $3.30
DIAZ-ARRINGTON,DIANA $9.86
DIAZ-RIVERA,DEBORAH EILEEN $10.68
DICAPRIO,JUSTIN P $21.18
DICK,GEORGE H $11.93
DICKERSON,ROBERT $17.39
DICKEY,CHARLES H $20.36
DICKFOSS,SANDI $21.97
DICKISON,CYNDI F $42.89
DICKMAN,DAVID $12.44
DICKSON,BARBARA $11.52
DICUS,JUSTINE $17.17
DIEDRICH,TIMOTHY J $6.00
DIEDRICH,TONI L $35.27
DIEHL,DAVID $137.42
DIEHL,RAINY $5.08
DIEP,NA $0.90
DIERICK,JOHN $12.04
DIERMYER,LESLIE S $17.04
DIETZ,KATIE M $11.69
DIFABIO,VINCENT $7.33
DIJULIO,JOSEPH H $26.60
DILISIO JR,DOMINIC $3.86
DILL,ALEXIS D $34.63
DILLARD,BEVERLY $27.76
DILLARD,KENNY RAY $21.61
DILLARD,MICHELE $28.96
DILLEY III,ROBERT PAUL $11.52
DILLON,MARIA $47.87
DILS,SCOTT $44.25
DIMAGGIO,PETER A $63.63
DIMASSIMO,DENISE $39.17
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DIMMICK,AILEEN $0.83
DING-HOW FOOT & BODY CARE $15.46
DINGMAN,MARIANNE $48.88
DINSMORE,ANDREW O $10.68
DINTIU,KARIN $57.79
DINTZNER,LINDA K $0.78
DIRAMOS,LUCKY MANUEL $18.45
DIRKS,VONNIE LYNN $12.38
DIU,MICHELLE $33.59
DIVERS,WAYNE A $7.67
DIX,DENNIS R $44.33
DIXIANO,WHITNEY RAYE $1.49
DIXIANO,WILLIAM MICHAEL $70.74
DIXON,BRIAN $9.31
DIXON,EMILY $5.46
DIXON,GLEN $46.87
DIXON,JEROTT $12.69
DIXON,KAROL L $19.94
DIXON,PRESTON R $8.08
DIXON,RENEE ANN $9.40
DIXON,SOLANGE S $38.68
DIXON,TOLETHA J $13.14
DIZON,AARON C $18.81
DOAK,LAUREN $15.79
DOAN,WILLIAM A $4.56
DOBBS,SARAH $2.42
DOBROVA,ARBERIM $26.80
DOBRYDNIA,TESIA $3.88
DOBSON,AMY M $7.90
DOBSON,AURORA $29.00
DOBSON,CHRISTINA $35.44
DOBSON,DONALD MARK $9.50
DOCKERY,BRUCE A $22.96
DODD,JULIE $13.47
DODD,SEAN $9.76
DODSON,BARBARA $23.94
DODSON,JUSTIN C $6.55
DODSON,ROCKY D $0.36
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DOEHL,ANIKA $24.05
DOERING,MARY SUE $25.54
DOERNER,KYLE T $73.18
DOERR,LINNZI E $25.65
DOERRY,MARKUS $0.66
DOETSCH,FRANCIS J $6.98
DOGAN,SYLVESTER $6.59
DOGGETT,RYAN $73.73
DOKOOZIAN CONSTRUCTION LLC $43.66
DOLAN,EULALIA $26.19
DOLCHOK,CHRYSALIS A $18.07
DOLD,ANASTASIA E $31.11
DOMBROW,JOSEPH $10.80
DOMBROWSKI,STEVEN J $26.73
DOMINGUE,APRIL $53.42
DOMINGUEZ,ALBERTO $2.95
DOMINGUEZ,AZURE E $16.23
DOMINGUEZ,H A $34.98
DON JOSES LLC $119.51
DONAHEY,SAMUEL JOHN $56.54
DONALDSON,LOY $6.20
DONALDSON,RACHAEL $21.02
DONELSON,DAVID M $1.63
DONEY,MACKENZIE $6.45
DONEY,MARIA $15.45
DONHAM,ANNA $11.30
DONHAUSER,MELANIE M $0.09
DONLEY,MICHAEL $12.80
DONN,TIMOTHY $27.74
DONNELLY,ASHLEY $17.82
DONNELLY,GUY W $27.09
DONNELLY,WILLIAM B $3.80
DONNITHORNE,MARK S $6.92
DONOHUE,KENNETH E $30.07
DONOVAN,CLEARY M $8.59
DONOVAN,CRAIG M $7.42
DONOVAN,RYAN $1.84
DONSON,PAULA $5.50
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DOOLAN,JULIE $21.14
DOOLEY,JOSHUA NATHANIEL $36.91
DOPORTO,VALERIE SUIRE $22.68
DORAL,MARITES B $6.92
DORAN,DAVID R $52.24
DORGAN,EVELYNN M $20.52
DORMAN,KENNETH $10.08
DORNBOS,JONAH $5.23
DORSEY,AUTUMN M $51.31
DORSEY,CASSANDRA E $48.47
DORSHKIND,JEANNE E $6.54
DOSS,JERRY C $36.59
DOTSON,BARBARA $58.86
DOTSON,SCOTT LEE $13.29
DOTSON,ZANE M $2.39
DOTY,KATHY $18.03
DOUCETT,ROBERT G $8.32
DOUD,RICHARD $13.21
DOUGLAS,DIANA $8.21
DOUGLAS,DODIE  G $17.79
DOUGLAS,JOHNATHON $2.62
DOUGLAS,LILLIEANNE $77.60
DOUGLAS,TRAVIS $4.88
DOUGLASS,RUSSELL A $31.97
DOUPE,ALECIA $6.83
DOWDELL,DEREK $2.53
DOWNES,KENNETH $21.08
DOWNEY,ASHLEE $6.71
DOWNEY,SHANNON $2.36
DOWNING JR,DANIEL J $34.15
DOWNING,CHRISTOPHER M $18.94
DOWNS,TODD $17.46
DOYLE,CARRIE $10.40
DOYLE,SPENCER $26.40
DOZARK,ASHLEY A $9.62
DR.VINYL $13.17
DRAGANO,VICTOR G $5.85
DRAIN MASTERS INC $33.81
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DRAPER,JAIME $0.93
DRAYTON,LEE $13.27
DREESE,RICHARD E $20.18
DREIER,BEN $4.85
DREIER,BRUCE W $15.96
DRENNAN,JULEE BECKER $28.00
DRESELY,SABINE $4.02
DREW,LAURA $3.28
DREW,LORETTA I $19.23
DREW,WENDY $16.58
DREWRY,NATHAN O $18.77
DREYER,HAROLD $23.40
DRISKILL,TRACY $15.11
DRIVET,MICHAEL $7.43
DRL INCORPORATED $130.87
DROEGE,HEATHER $7.33
DROLLINGER,E LEROY $48.72
DRONES,AYVORIE K $5.75
DROTAR,EVETTE M $12.52
DROWATZKY,PAULINE L $15.76
DRUMELLER,ELIZABETH $26.43
DRUMMOND,RODNEY $14.30
DUARTE,JACQUELYN M $14.95
DUBE,DANIEL $14.35
DUBE,JAMES M $26.47
DUBEY,ASHEEM $0.63
DUBINSKY,WILLIAM $31.81
DUBLIN,IRENE J $27.24
DUBOIS,BILL $12.24
DUBUISSON,EDWARD $46.20
DUBY,RAMONA S $11.45
DUCA,SERGIU $6.80
DUCKENFIELD,PACE A $2.76
DUCKSTEIN,MARY $11.92
DUCKWORTH,DOYLE J $21.30
DUDIK,MARYANA V $5.11
DUERR,ERIC R $8.01
DUFEK,JOHN D $124.42
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DUFEK,MELINDA R $15.72
DUFF,LARRY $37.61
DUFFY,SUSAN $18.33
DUFOUR,SCOTT S $12.37
DUFRESNE,THOMAS W $7.36
DUFRESNE,TIM $18.91
DUGAN,MINERVA $15.99
DUGAS,BRANDY N $0.93
DUGGAR,GRETCHEN NICOLE $6.25
DUGGINS,JOEL E $30.71
DUHON,ANGELA L $26.17
DUKAS,MARIE T $57.12
DUKE,LEAH N $36.57
DUMONT,CHAZ M $2.51
DUNAWAY,CHARLOTTE E $73.88
DUNBAR,STEPHEN G $20.15
DUNCAN,KELSEY LYNN $8.74
DUNCAN,SEAN $19.61
DUNEGAN,GERALD $20.04
DUNGEY,ANTWON $25.91
DUNHAM,DOLORES ESTELLE $33.06
DUNHAM,STEVE $8.35
DUNKLE,JOHN M $5.77
DUNLAP,ALICIA $8.86
DUNN,CATHERINE C $7.64
DUNN,CHARLENE $28.09
DUNN,EDWARD $10.46
DUNN,LAMAR A $25.03
DUNN,LEONARD $58.22
DUNN,ROBERT J $7.06
DUNN,SETH $32.30
DUONG,XUAN $34.04
DUPREE,TAMMY L $27.64
DUPUIS,FRANKIE $5.15
DURAN,MARY $4.07
DURAND,JOHN M $14.49
DURAND,JULIA N $4.99
DURAND,TAMARA E $26.71
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DURANONA,CHARLES A $21.60
DURBIN,NETA L $21.21
DURDEN,DARRYL $15.92
DURFEE,FRANK $6.34
DURTSCHI,TRAVIS $3.76
DUSHKIN,SIMEON $15.57
DUTART JR,CHARLES E $12.97
DUTTON-CARNEY,VICTORIA H $38.49
DUTY,THOMAS HEATH $19.57
DUVAL,DANA B $24.66
DUVALL,CHRISTOPHER LEE $1.71
DUVALL,RONNIE $14.71
DUVALL,SARAH $6.16
DUZENBERY,JEFFREY R $58.00
DWORAK,CONNIE M $38.62
DYBDHAL,JESSIE L $22.40
DYE,BRITTNI E $18.87
DYER JR,E FOSTER $48.17
DYER,JOHN T $8.47
DYER,PHILIP $26.17
DYGAS,AARON $25.12
DYJAK,BLAINE C $3.08
DYKSTRA,DEAN G $0.95
DYMOND,JOHN $32.06
DYNAMIC ENERGY GROUP LLC $179.01
EADDY,RAHARDA $14.33
EADES,ROBERT L P $38.15
EAGER,DORIS $6.19
EAGER,JACOB $8.67
EAGLE RIVER BOWL $595.62
EAGLEY,JASON T $20.46
EAKES,PRESTON $23.09
EAKON,DAWN M $13.96
EALES,BRIAN $3.94
EAMES,JOAN P $42.27
EARHART,BRYAN W $8.81
EARLEY,BRUCE DONALD $4.00
EARNEST,CATHERINE $26.47
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EARNSHAW,CHARLES M $4.18
EASLEY,SALLY $69.48
EAST,GLORIA $40.26
EASTLAKE,CHRISTIAN D $33.77
EBALLAR,REMEDIOS $15.95
EBBERT,STEVE $2.77
EBERT,RICHARD R $13.07
EBNER,LISA $41.32
EBONA,BARBARA $24.70
EBRON,JON P $12.26
EBS LLC $31.59
EBUE,EMMANUELLYNN ASPILLA $4.40
EBUE,ROSANO PANTALEON $9.77
ECHEVARRIA,EDWARD $11.22
ECHEVARRIA,LUIS N $14.80
ECHOLS,HEATHER $12.29
ECHOLS,MICHAEL BRANDON $0.68
ECKERT,RICHARD B $20.57
ECO ENERGY LLC $62.85
EDDY,KARRI $8.56
EDDY,RONALD $47.69
EDENSHAW,DEAN E $33.29
EDERER,JENNA M $10.77
EDGEMON,LINDA $22.31
EDGEWORTH,DWAYNE $11.30
EDGMON,SUSANNE $79.74
EDMAN,KIM $6.62
EDMISTEN,MANDY $26.68
EDMUNSON,CLETUS D $23.91
EDOH,KODJO L $20.32
EDOUARD,MIRIAM $33.71
EDWARDS,AUNDRIA S $4.73
EDWARDS,AURA D $85.59
EDWARDS,BRITTANY $13.57
EDWARDS,JASON $6.33
EDWARDS,JUDY E $3.03
EDWARDS,KIM A $2.93
EDWARDS,PATRICIA $10.24
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EDWARDS,TIMOTHY $1.54
EDWARDS,WAYNE A $2.92
EDWINS,MAGGIE $0.76
EERNISSE,RONALD $9.12
EGAN,TRACIE M $9.93
EGGEBROTEN,STEPHANIE M $20.91
EGGELSTON,DANIELLE $4.09
EGGLESTON,TERRY L $12.95
EGLOFF,JOHANNA $14.24
EGOAK,AMANDA $0.94
EGRASS,JONATHAN S $17.09
EGRASS,RENAE $3.62
EGUIRES,RYAN C $4.51
EHLERS,MATTHEW $8.24
EIBEN,THORSTEN $22.64
EICHENBERG,DORAN L $1.29
EICHINGER,JACOB A $12.48
EICHORN,DAYNA L $5.31
EILEEN D BENNETT REV TRUST $17.04
EILEY,DOROTHY Y $4.11
EIO LLC $1,252.01
EISSLER,FORREST $1.01
EKEMO,DORIS W $5.96
EKERHOLM,ADAM B $26.86
EKLUND,ERIC $55.52
EKSTRAND,MARIA E $22.01
ELAM,SUZHANNA $1.94
ELDE,BRANDEN L $0.99
ELDER,ANNA $1.21
ELDER,MARK $43.18
ELDRED,MARY R $28.49
ELDRED-TATE,KENNETH $14.54
ELDRIDGE,KRISTAL $50.97
ELDRIDGE,TRAVIS W $13.46
ELG,WADE $13.31
ELGARICO,ESTHER $7.35
ELGARICO,GEORGE $21.94
ELIE,CAROLINE $25.54
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ELIU,ROINE $14.83
ELIZONDO,CRYSTAL N $11.24
ELLENBURG,LEE R $62.29
ELLERT,KENNY $19.54
ELLINGBOE,TRAVIS L $32.68
ELLINGSON,LARRY L $22.62
ELLINGSON,TRAVIS $17.56
ELLINGTON,ROSE ANN $29.04
ELLIOTT,DELILAH $29.95
ELLIOTT,ELIZABETH W $33.02
ELLIOTT,HENRY J $0.77
ELLIOTT,JERRY $15.29
ELLIOTT,JOSHUA $9.85
ELLIOTT,JOSHUA $5.38
ELLIOTT,KEVIN KEITH $3.58
ELLIOTT,MICHAEL L $8.23
ELLIOTT,ROXANN M $1.52
ELLIS JR,DONALD LEE $34.12
ELLIS,ERIN $12.75
ELLIS,HAROLD N $16.64
ELLIS,JERMAINE $7.59
ELLIS,JESSIE $44.42
ELLIS,SOUKSAMAY $8.92
ELLISON,JENNIFER $2.22
ELLISON,RONALD M $27.27
ELMACHEHOUR,LYAZID $18.95
ELMER,MICHAEL T $33.82
ELMORE,CHARLES E $19.06
ELMORE,MICHAEL S $9.51
ELMORE,NELLIE $40.69
ELMORE,TOM J $15.78
ELMOSTAFA,MOEZELDIN $19.91
ELMUNDO,KAREN VALDEZ $42.16
ELOMARI,STEPHEN $3.01
ELS,JESSICA $27.74
ELSENHEIMER JR,RONALD B $33.79
ELSENHEIMER,SHIRLEY J $15.21
ELSEY-GERVEL,DEB $4.21
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ELVE,AMBER $2.47
ELVSAAS,LILLIAN E $26.17
ELZIG,JERRY C $16.96
EMBLY PROPERTIES LLC $1.73
EMERSON,ERIKA L $6.24
EMERSON,JAMES C $23.07
EMERSON,LISA G $10.93
EMERSON,MATTHEW D $30.38
EMERY,DEBBIE M $16.40
EMMONS,LINDA S $7.43
EMPIE,RONALD G $11.26
EMSLEY,DUNCAN BARRY $12.81
ENBYSK,MICHAEL $3.72
ENCABO,JENNIFER M $32.15
ENGEBRETSEN,MARTHA $16.23
ENGEBRETSON,JOHN H $20.28
ENGEL,MONICA M $3.55
ENGELBACH,ROBERT L $13.10
ENGELDINGER,JULIE $28.52
ENGLAND,ABRAHAM $13.36
ENGLAND,DAVID B $14.41
ENGLAND,GERALD T $9.90
ENGLAND,JAMES $20.75
ENGLAND,JAMES $9.94
ENGLAND,JUDD L $13.17
ENGLAND,KIMBERLY R $17.40
ENGLE,TODD $29.84
ENGLER,DIONNE $39.63
ENGLISH,AMY J $5.37
ENGLISH,CODY M $11.87
ENGLISH,DANIEL $15.85
ENGSTROM,SHERYL $4.24
ENNENGA,ATHENA M $18.36
ENNS,TANYA $8.95
ENRIQUEZ,JAMES $25.09
ENTERPRISE ENGINEERING INC $5.95
ENTERS,BRADLEY R $3.63
ENTZEL,KRISTOPHER $8.86
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EPPERSON,FRANK R $16.20
EPPERSON,TAY $5.54
EPPS,RODNEY D $15.69
EPPS,STEVE $65.01
EQUIVEST MORTGAGE INCOME TRUST $221.25
ERA GALLERY HOMES $21.59
ERAMO,CHRISTOPHER R $28.50
ERICKSON,BILL E $0.89
ERICKSON,BRUCE $7.41
ERICKSON,BRYNA R $19.29
ERICKSON,HELEN L $10.29
ERICKSON,INNA $30.03
ERICKSON,KATHLEEN J $10.79
ERICKSON,LIANE P $22.12
ERICKSON,MICHAEL SEAN $9.58
ERICKSON,SHEILA S $6.13
ERKINS,GREGORY $2.97
ERMELOFF,LEONTY $11.87
ERNST,MARY R $71.73
ERVIN,LEANN $13.51
ERWIN,RYAN $0.70
ESCAMILLA,DENISE S $26.77
ESCHBACHER,SYLVIA ANTOINETTE $28.86
ESCOBAR,RANDOLFO $4.28
ESCOLTA,CHASTITY R $39.19
ESIPOV,EGOR $24.98
ESIPOV,EKATERINA S $15.47
ESPENSHADE,VERNA B $4.63
ESPINOZA,AMY $1.31
ESPINOZA,DEREK J $12.06
ESPINOZA,JUAN $26.60
ESPRESS YOURSELF COFFEE LLC $73.77
ESTATE HELEN J MASON $27.64
ESTATE JAMES E CALLAHAN $18.61
ESTATE OF AARON JOSEPH $13.64
ESTATE OF ALBERT G SHIER $39.35
ESTATE OF ALEX L CALUGAN $8.01
ESTATE OF ALFRED HANISCH $51.82
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ESTATE OF ANN RICK $13.20
ESTATE OF ANNE OBAR $20.69
ESTATE OF BARBARA K DOUGHERTY $53.42
ESTATE OF BOOKER T HUDSON $31.56
ESTATE OF CARBREY FINKBINER $8.76
ESTATE OF CARL R KRON $248.54
ESTATE OF CARMELLA M FURNACE $6.25
ESTATE OF CAROL FINKE $3.74
ESTATE OF CHARLES E HANDY $2.46
ESTATE OF CHAROLETTE D JENSEN $26.75
ESTATE OF CHONG H FLACK $14.05
ESTATE OF CLINTON L MCCORMICK $30.84
ESTATE OF DAVE A ANDERSON $21.75
ESTATE OF DAVID A DROEGE $12.67
ESTATE OF DAVID H CONRAD $20.95
ESTATE OF DELWIN L SEEBA $43.69
ESTATE OF DENNIS L MCCRACKEN $4.19
ESTATE OF DENNIS RUHLE $9.49
ESTATE OF DEXTER PALK $2.49
ESTATE OF DORORTHY T YOUNG $8.66
ESTATE OF DOUGLAS C BELL $4.63
ESTATE OF EARL J JOHANNES $5.13
ESTATE OF EDWARD L OWENS $41.33
ESTATE OF EDWARD M DESAPIO $76.04
ESTATE OF ELEANOR A BUSHUE $5.44
ESTATE OF ELIZABETH J CRAIN $53.69
ESTATE OF ELIZABETH S SCHARPER $27.61
ESTATE OF ERIC S LOGAN $35.60
ESTATE OF ETTA M SCHANDELMEIER $12.65
ESTATE OF EVELYN CHAMBERLAIN $23.35
ESTATE OF FRANK L BARRUS $29.35
ESTATE OF FRED A ARMSTRONG JR $14.28
ESTATE OF GAIL R FLORIO $17.22
ESTATE OF GEORGE D MOHR $7.80
ESTATE OF GEORGE R BROWN $39.87
ESTATE OF GEORGIA I STEWART $17.03
ESTATE OF GRANT MORLEY $2.29
ESTATE OF HALLERAN JR WILLIAM $32.12
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ESTATE OF HARVEY F SHADE JR $49.87
ESTATE OF HERMINIA VILLARAMA $43.94
ESTATE OF HORACE D JOHNSON $91.86
ESTATE OF HOWARD ADAMS $57.70
ESTATE OF IRENE  HARTWIG $11.95
ESTATE OF JACK L YOUNG $13.56
ESTATE OF JAMES J HANSFORD $29.93
ESTATE OF JAMES L BOWLES $83.08
ESTATE OF JAMES L MCSHARRY $9.02
ESTATE OF JAMES M ERESMAN $6.45
ESTATE OF JANAE K MEINEL $20.55
ESTATE OF JANE E NOBLETT $54.00
ESTATE OF JANE K KURTH $12.21
ESTATE OF JEAN A ROMIG $125.09
ESTATE OF JEAN R MAHONEY $19.76
ESTATE OF JEFFRY L NEUROTH $13.95
ESTATE OF JO ELLEN HUDSON $29.66
ESTATE OF JOANNE K EMERY $11.60
ESTATE OF JOHN C FOUNTAIN $37.86
ESTATE OF JOHN D RICHARDS $22.13
ESTATE OF JOHN H HERD $14.02
ESTATE OF JOHN R FEHRENBACHER $41.65
ESTATE OF JOHN STRAUSS $5.96
ESTATE OF JOHN STROHMEYER $5.11
ESTATE OF JOSEPH C BYERLY $24.34
ESTATE OF JOSEPH H WILBUR $16.77
ESTATE OF JOSEPH MILJAS $14.45
ESTATE OF KAREN M POWELL $15.88
ESTATE OF KENNETH E SMITH $8.13
ESTATE OF KINGSTON G COX $40.75
ESTATE OF KRISTIAN J HARRIS $10.12
ESTATE OF KYUNG S JUNG $6.92
ESTATE OF LEE PREUIT $38.29
ESTATE OF LEEROY H PONDER $29.26
ESTATE OF LEIF L LOBERT $30.55
ESTATE OF LEO FRELIN $44.74
ESTATE OF LEROY M MCDONALD $27.32
ESTATE OF LESTER E BROWN $88.93
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ESTATE OF LESTER H BATE $35.73
ESTATE OF LETA F SMITH $31.07
ESTATE OF LINDA M GORSCHE $24.33
ESTATE OF LINDA TAYLOR HOPPER $36.16
ESTATE OF LORRAINE PAPE $5.66
ESTATE OF LUTHER KALLAM $45.02
ESTATE OF MARCELLA PEGGY JACKS $21.53
ESTATE OF MARCELLA STURGEON $34.54
ESTATE OF MARGIE G CARLSON $11.11
ESTATE OF MARJORIE E YOUNG $14.78
ESTATE OF MARK DERR $25.49
ESTATE OF MARK J WADDELL $50.73
ESTATE OF MARY JO MUNDINGER $37.34
ESTATE OF MAXINE A KELLY $23.04
ESTATE OF MERLYN D GRUHN $8.44
ESTATE OF MILOSLAV (MIKE)SVEC $10.55
ESTATE OF MINNIE A SMITH $38.01
ESTATE OF MONICA J CARROLL $22.46
ESTATE OF NEIL E TSCHUDI $23.22
ESTATE OF NELL RYAN $55.28
ESTATE OF NITA E AMICK $2.72
ESTATE OF NORMA SILOOK $2.24
ESTATE OF OLA MAE MITCHELL $41.35
ESTATE OF PATRICE GERSTER $3.01
ESTATE OF PATRICIA BROCKWAY $7.31
ESTATE OF PEGGY A BURGIN $14.35
ESTATE OF PERCIEVAL S MALPAYA $32.97
ESTATE OF PHILIP RAUCH $7.01
ESTATE OF PHILLIP D EELLS $19.01
ESTATE OF PORTIA D PHILLIPS $18.36
ESTATE OF RANDALL W FARRIS $40.51
ESTATE OF RAYMOND E FONTENOT $48.75
ESTATE OF RAYMOND P CODERRE $27.61
ESTATE OF REINO OLAVI VANA $9.88
ESTATE OF RICHARD D SINGAAS $27.23
ESTATE OF RICHARD JOLICOEUR $11.05
ESTATE OF ROBERT A DUNLAP $43.93
ESTATE OF ROBERT W JANES $66.08
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ESTATE OF ROBINSON,C L $32.97
ESTATE OF ROGER A RANCH $26.93
ESTATE OF RONALD M RISCH $131.93
ESTATE OF RONALD W JONES $31.95
ESTATE OF ROSEMARY WIESE $13.59
ESTATE OF RUTH M MOEN $18.47
ESTATE OF RUTH M. SEVERN $20.51
ESTATE OF SAMUEL DENNIS $63.13
ESTATE OF SCOTT B DICKINSON $43.85
ESTATE OF SHARON A BOYLES $24.52
ESTATE OF SMITH ROSE F $7.01
ESTATE OF STANLEY S SMITH $16.17
ESTATE OF STELLA V COOLEY $74.48
ESTATE OF STEPHEN R DREW $49.47
ESTATE OF SUE ANN HOEFLER $32.72
ESTATE OF T KATHY ZIMMERMAN $43.34
ESTATE OF TALLULAH HANKINS $2.46
ESTATE OF TAMMY L FAUSETT $16.35
ESTATE OF THERON ACKERLY SMITH $94.72
ESTATE OF THOMAS A SCOTT III $11.20
ESTATE OF THOMAS C FUGLESTAD $79.93
ESTATE OF THOMAS E CICARDO $20.21
ESTATE OF THOMAS E GARASICK $1.10
ESTATE OF THOMAS G AUS $30.60
ESTATE OF THOMAS J THOMPSON $24.46
ESTATE OF TIMOTHY BOGIE $23.54
ESTATE OF TIMOTHY J WRIGHT $52.06
ESTATE OF VIRGIL E COWGER $17.99
ESTATE OF VIRGINIA J SMITH $13.05
ESTATE OF WALTER E SHANE $24.39
ESTATE OF WALTER J HICKEL SR $53.15
ESTATE OF WILLIAM E KARN $10.76
ESTATE OF WILLIAM J NIXON $10.67
ESTATE OF WILLIAM K RIZER $45.22
ESTATE OF WRAY E BRADLEY SR $1.11
ESTATE OF YVONNE CASSITY $3.76
ESTATE OF ZIGFRED TIFENTAL $5.79
ESTATE WATKINS II MELVIN GLEN $17.76
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ESTELL,ASHLEE $3.37
ESTELL,MATHEW S $32.54
ESTENSEN,JEFFREY LEE $5.96
ESTES,CHRISTINA $1.95
ESTES,CYNTHIA A $2.21
ESTES,MARGARET $30.84
ESTES,WILLIAM $16.16
ESTRADA,JODI $10.00
ESTRADA,LORENZO $26.06
ESTRADA-MORTON,TITO $23.40
ESTRELLA,ALEXANDER $22.50
ESTRELLA,NOEMI $8.39
ESTRELLA,VICTOR R $34.42
ESZLINGER,STEFANI $8.68
ETERNAL LOVE MINISTRY $47.17
ETIENNE,MARON $32.52
ETIENNE,MISHANDRAY $13.86
EVANOFF,SAM D $41.12
EVANS,ALTA $19.40
EVANS,BEULAH A $15.32
EVANS,CORY B $14.86
EVANS,CRYSTAL $32.16
EVANS,DANTERRIO D $32.46
EVANS,EBONY A $29.89
EVANS,ELIZABETH HOLLY $7.89
EVANS,JANE $37.12
EVANS,JASON R $10.01
EVANS,JOHN C $17.64
EVANS,LA SHON $67.32
EVANS,MARCI Y $19.43
EVANS,MELVA $5.78
EVANS,REGINALD J $21.26
EVANSON,TYLER $12.24
EVARTS,TERRIE D $45.72
EVELAND,JANE A $1.80
EVELL,ERIN $23.13
EVENSEN,DARREL E $10.15
EVENSON,ASHLEY $11.57
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EVERARD,MEGHAN $12.44
EVERETT,PAUL D $24.36
EVERLY,TONI $16.07
EVRIDGE,JIM $67.42
EWALD,ANNA $18.42
EWING,MARY E $4.34
EWING,TERRIJO M $5.88
EXECU-LODGING LLC $92.77
EXECUTIVE MANAGEMENT SVCS $0.60
EYECOM INC $151.71
EYLER,LISA $68.30
EYTCHISON,JACKIE A $12.43
EZIUZOR,ONUORA $11.00
FAALEO,FAALAA $1.52
FAALEO,UILI S $26.63
FAAMULI,PAUL A $6.86
FAATILIGA,TOGIA $20.28
FADAOFF,JOSEPH $11.06
FAEO,ELIZABETH $40.70
FAGAN,JOSHUA $26.36
FAGG,JOSHUA T $8.04
FAIR,JAMES A $20.24
FAIR,JOHN $29.92
FAIRBANKS,PAUL $13.45
FAIRBANKS,VANESSA $34.56
FAIRBROTHER,DAVID R $35.08
FAIRCHILD JR,CHARLES $20.81
FAIRCHILD,HEATHER $5.47
FAIRCLOUGH,TROY $86.71
FAIRWEATHER,STACEY $10.25
FAITH,COREY $15.82
FAJARDO,JAZZ M $31.27
FALCONE,MIRCEDEZ $5.98
FALCONER,EVAN MARIE $4.64
FALES,TIFFANY $19.96
FALETOI,FILMENA D $8.22
FALLDORF,MIKE H $26.26
FALLER,JESSICA ELAINE $16.37
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FALLICO,HISA D $23.12
FALLON II,SHAUN $14.49
FALLON,JOSEPH T $38.04
FAMA,JACOB E $6.92
FANENE,ERIC $19.96
FANOGA,OFISA $34.93
FANT,JONATHAN $8.30
FARALAN,RACHEL $10.09
FARICY,CHRISTOPHER $18.03
FARIS,JANE ANN $29.24
FARIS,STELLA M $19.72
FARKAS,GERARD L $4.81
FARKAS,JORDAN C $25.91
FARLEY,JAMES $55.87
FARMER,KYLE $31.04
FARMER,MICHELLE $10.25
FARR,SAMANTHA $20.64
FARRAND,KIMBERLY $14.63
FARRAR,JAMES $14.15
FARRENS,MICHAEL $17.34
FARRIS,ASHLEIGH $15.96
FARRIS,GEORGE J $34.48
FARRIS,STEVEN $32.18
FARROW,DUSTY D $7.94
FARROW,PATRICIA C $22.27
FARROW,RACHELLE MICHE $31.82
FARTHING,BRYAN $12.13
FASIMALO,SIOLOPAU $26.23
FASSBENDER,BETH A $11.17
FAST,DUSTIN $5.90
FASTENAL COMPANY $117.92
FATHER,GEORGE $27.60
FATHKE,DEBRA $26.30
FATHLULLAH,SIDIQ $10.07
FAULKNER,CURTIS A $6.96
FAULKNER,JESSICA $1.35
FAULKNER,RON L $0.68
FAUMUINA,ELIZABETH M $33.88
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FAUMUINAN,FAALOGOIFO $31.48
FAUST,JOSHUA $0.42
FAUST,ROBERT PATRICK K $7.23
FAVORITE,TONI M $18.01
FAWBUSH,JOSHUA $21.86
FAWCETT,VICKIE M $13.68
FEA,LEALOFI $14.78
FEARNSIDE,RICHARD J $6.56
FEBLES,DAMARIS $43.16
FECHTMEYER,PHILIP $8.34
FEDOROVA,LYUBOV $49.05
FEDROWISCH,ERIC $30.34
FEE,JOSHUWAH ERIC $51.75
FEENSTRA,BENJAMIN $43.63
FEENSTRA,BENJAMIN A $1.54
FEHLEN-WESTOVER,RHONDA L $46.87
FEINMAN,KENNETH $13.22
FELDER,HEATHER E $4.94
FELDER,KAREN M $33.46
FELICETTY,LARISA $11.83
FELIX,BETHANY $74.76
FELIX,CARMEN A $29.43
FELIX,KRISTENE $40.60
FELIX,STEPHANIE $2.97
FELLMAN,LUKAS H $46.73
FELT,ALLAN V $29.27
FELTMAN,ROBERT P $29.09
FELTMAN,WANDA $12.55
FELTON,IVAN $4.23
FENDRICK,ALISON RUTH $29.11
FENN,SUSAN $40.30
FENNEL,HEATHER $1.65
FENNELL,SCOTT J $21.48
FENSKE,ANDY $1.52
FENTON,REID F $7.23
FENTON,ROBERT $10.33
FENTON,ROBERT S $14.77
FENTON,TAYLOR J $24.45
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FENWICK,JOHN $25.84
FERANDEZ,DENNIS $20.85
FERATI,FAIS $0.19
FERBER,LISA $6.67
FERENCE,THOMAS $15.66
FERGERSON,ASHLEY $16.66
FERGUSON JR,WILLIAM H $32.71
FERGUSON,ANTHONY $4.93
FERGUSON,CHRISTE L $5.36
FERGUSON,DONALD EDWARD $27.19
FERGUSON,DOUG $6.17
FERGUSON,JENNIFER D $7.87
FERGUSON,JOHN C $31.17
FERGUSON,JONATHAN $7.63
FERGUSON,SAVANA BROOK $26.68
FERGUSON,SOPHIE $11.97
FERMANTEZ,HERMINGILDO $35.16
FERNANDEZ,ALEXIS $5.11
FERNANDEZ,ERIK $2.96
FERNANDEZ,JENNIFER $10.23
FERNANDEZ,MIGUELITO $2.70
FERNANDEZ,RAMON $44.10
FERNANDEZ,SERGIO $11.41
FERNANDEZ,SUDIRMAN $2.35
FERRARA,ELIZABETH $1.95
FERRARA,THOMAS W $3.50
FERRARIO,GUALTIERO M $26.89
FERRE,SHIRELLE $16.65
FERREIRA,MICHELLE A $4.53
FERRIS,CHRISTOPHER E $25.37
FERRIS,CURTIS $12.87
FERRISS JR,GARY D $14.53
FERRONE,ANTHONY $12.21
FERRY,EDITH $7.69
FERRY,ROCHELLE $0.75
FETTER,LYNDA L $11.32
FETTERLY,JASON G $11.92
FICK,DALE $22.73
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FICK,QUIANNA $6.22
FICKEL,LETITIA C $59.60
FICKLIN,BRYAN L $7.83
FIDEL,BRADLEY ALAN $20.49
FIDOTI,KATHLEEN L $25.05
FIEDLER,JEFF $23.56
FIEDLER,SHELLEY $47.91
FIEL,ANDREAS $17.43
FIELD,GARRISON $11.42
FIELDING,DAVID M $4.04
FIELDING,THOMAS AARON $36.60
FIELDS,ALLENE B $6.88
FIELDS,PHILLIP R $7.96
FIELDS,STEVEN L $14.49
FIELDS,TAMARA $43.42
FIERMONTE,SHAYLA M $9.25
FIERRO,BRYAN $20.45
FIERRO,MICHELLE C $6.84
FIGAS,JAMES DEAN $5.63
FIGUEROA,DULCE R $19.00
FIGURA,MARTIN J $13.32
FIKE INDUSTRIAL CONSTRUCTON $14.50
FIKE,BONNIE $3.26
FIKE,BRETT $57.78
FIKES,DIANE $22.85
FILER,SHELLY $54.33
FILLEY,JACQUIE $8.27
FILO,JOHN $61.87
FILOIALII,FAAUIAO $14.08
FIMPEL,RYAN JAMES $9.98
FINDLAY,BRIAN S $5.00
FINDLAY,SANDRA $25.42
FINK,MICHAEL $20.30
FINLEY III,JOHN WASHINGTON $7.30
FINLEY,PHILLIP M $16.53
FINNECY,SHAWN $12.59
FINNEGAN,MICHAEL $7.24
FIORE,JOEY $32.08
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FIORUCCI,RICHARD C $30.87
FIRME,VICTOR LEE $7.41
FIRMSTONE,RICHARD A $8.15
FIRST CME CHURCH $13.91
FIRTH,SCOTT $15.34
FISCHER PROPERTIES $684.26
FISCHER,DONNA R $8.46
FISCHER,JONATHON $19.08
FISHBURN,RALPH $2.16
FISHER,BRAD ALEN $2.92
FISHER,DENNIS $40.80
FISHER,EDNA $3.95
FISHER,HEIDI $16.74
FISHER,JOAN E $16.85
FISHER,JUDY A $68.02
FISHER,KENNETH H $21.63
FISHER,KENYA $28.70
FISHER,KRYSTINA $12.61
FISHER,LARRY $22.77
FISHER,NICOLE $20.66
FISHER,NIKKI $44.89
FISHER,RICHARD M $0.05
FISHER,ROBERT L $22.42
FISHER,VERONICA N $18.39
FISKE,LAWRENCE E $34.32
FITCH,ANDREW L $59.07
FITCH,ROSEMARIE $15.49
FITZATRICK,CAITLIN A $30.61
FITZGERALD,SEAN M $14.39
FITZGERALDS,MICHAEL $37.34
FITZHUGH,NANCY $58.82
FITZPATRICK,JEFFREY $21.39
FLACK,ANDREW P $1.38
FLACK,JOSEPH $14.78
FLAGG,MARCIE L $6.59
FLAGG,ROBERT T $34.63
FLANAGAN,MEAGHAN $22.65
FLANAGAN,SHAWN $35.41
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FLANIGAN JR,MICHAEL R $8.76
FLANNERY,BRIAN E $36.15
FLANNERY,CHANDRA L $6.45
FLAUGHER,DANNY $14.14
FLAVEL,GERALD R $29.93
FLAVEL,JANET LEA $17.71
FLEAGLE,MICHAEL R $9.37
FLEISCHER,SARA E $11.03
FLEITMAN,TRACY J $49.09
FLEMING,CAMERON $12.48
FLEMING,CHRYSTOPHER $44.02
FLEMING,ELIZABETH W $39.89
FLEMING,J $33.78
FLEMING,NANCY A $11.02
FLEMING-BROWN,CAROL $3.78
FLESTER,TONYA R $4.99
FLESTER,ZACHARY $19.29
FLETCHER,ALLEN $16.83
FLETCHER,CATHY $15.81
FLETCHER,JODY M $12.38
FLIGHT,JENNIFER $26.50
FLINK,KATHLEEN E $2.83
FLINNER,JOSHUA $15.78
FLINT,LANCE L $4.69
FLITT,JACOB HRA $13.91
FLORENCE,SARAH $15.51
FLORES,BROC $19.02
FLORES,CARLOS F $14.15
FLORES,CHRISTOPHER P $33.03
FLORES,CRYSTAL A $5.31
FLORES,MARCO $6.45
FLORES,XAVIER A $14.85
FLORES-GAUTAM,INDIRA $20.87
FLOTTE JR,MARIO D $22.49
FLOURNOY,JOHN J $24.44
FLOWER,ANITA $34.38
FLOWERS,TONYA R $56.55
FLOYD,ASHLEY K $38.46
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FLOYD,JEROME ROBERT $16.37
FLOYD,KELLY $3.60
FLYE,JOSHUA $27.11
FLYNN,JULIE $10.65
FLYNN,MARIE ANGEL C $18.87
FODE,LOUISE $13.86
FODERARO,JAMES A $7.58
FOERCH,JOHN B $28.33
FOGLE,CHARLES $7.98
FOGLIA,ROBERT $27.82
FOLEY,MARY JO $13.50
FOLGER,CHARLISA $18.76
FOLI,ANGELICA $6.11
FOLI,JONATHAN $3.18
FOMAI,GARDINIA S $3.46
FONDAW,KIM C $13.90
FONG,CONSTANCE D $39.13
FONOTI,SALEVASA PUSA $64.91
FONTAINE,SARAH D $4.88
FONTANA,PHILLIP A $26.07
FOOSNES,ALAN $7.68
FOOTE,DANIEL $11.10
FOOTE-JONES,ALEXANDRA $7.33
FORBES,KEITH L $4.04
FORBES,MARGARET A $8.75
FORBES,MARK RANDALL $12.05
FORBES,RITA $41.75
FORD,ANGELA L $33.42
FORD,BRADLEY $16.68
FORD,COLETIA $13.01
FORD,DENNIS E $30.73
FORD,EDMUNDO $27.56
FORD,ERIC J $3.70
FORD,LANORRIS $31.35
FORD,LEONARD $13.70
FORKNER,PATRICIA $17.01
FORMAN,MICHAEL S $5.57
FORREST,DENISE M $25.24
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FORRESTER,DAVID RAY $30.73
FORRESTER,MYLINDA $4.96
FORSTER,BANNIE $10.92
FORTENBERRY,HOWARD DAVID $28.02
FORTIER,TASKA N $28.75
FORTNER,THOMAS W $2.34
FORTUNE,KHRISTA $8.22
FORTUNY,MIKEL R $24.59
FOSS,DAVID $80.52
FOSSLER,DEANNA $23.59
FOSTER,CHARLA $13.80
FOSTER,CHARLES E $27.81
FOSTER,CHERYL $22.32
FOSTER,DANIELLE L $19.42
FOSTER,DEBRA $16.30
FOSTER,JIM F $0.44
FOSTER,KRISTIE $26.04
FOSTER,LAURA $28.62
FOSTER,MARY SUE $105.27
FOSTER,REHTA M $27.62
FOSTER,RICHARD N $4.06
FOSTER,VANESSA B $15.54
FOURNIER,SHAMRA L $10.56
FOUST,ANN-MARIE $15.89
FOUTS,SEAN $16.79
FOWLER,GIA $19.76
FOWLER,KALA D $24.88
FOWLER,KEVIN L $19.16
FOWLER,PHILIP E $0.86
FOWLER,ROBIN $14.13
FOWLER,VALTON D $41.04
FOWLER,W H $25.83
FOWLEY,KATHERINE $14.57
FOX,AUNALISA MAE $2.12
FOX,JENNA R $0.42
FOX,NATHANIEL $28.34
FOX,NELSON $2.82
FOX,NICOLE $5.13
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FOX,NINA J $27.40
FOX,REBECCA A $6.26
FOX,ZANDRA O $31.37
FOXGLOVE,NED $14.22
FRABLE,TRACY LYNN $16.87
FRAIN,WESLEY S $4.37
FRAKER,ROSE $20.69
FRALEY,AMANDA $7.10
FRALEY,LINVAL L $11.57
FRANCIS,KATHERINE $28.89
FRANCIS,MELODY J $31.40
FRANCIS,STEPHEN R $30.94
FRANCISCO,FEMIA $31.78
FRANCO III,JESS J $2.96
FRANCO,NICK $14.75
FRANCOIS,GREGORY $0.28
FRANK,ALLISON $12.97
FRANK,TERESA A $6.05
FRANKENBURGER,ASHLEY L $17.01
FRANKFORTER,MATTHEW J $53.54
FRANKLIN,GARY L $33.31
FRANKLIN,M THERESA $32.66
FRANKLIN,WESLEY $19.79
FRANKLINE,ADNEL L $6.58
FRANKS,SORINA F $34.49
FRANKSON JR,CLEMENT $3.68
FRANKSON,MARGARET A $14.72
FRASER,PATRICK $52.91
FRATES,FRANCES C $39.14
FRAY,SANDRA M $21.08
FRAZEE,JAMES J $52.92
FRAZEE,MELINDA $22.49
FRAZER,WENDY $41.26
FRAZIER,ANNETTE $3.30
FRAZIER,CHAD $2.10
FRAZIER,JACALYN K $30.96
FRAZIER,KAREN T $19.70
FRAZIER,MARK S $29.18
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FRAZIER,NICHOLAS BLAINE $40.51
FRAZIER,ROBIN K $47.17
FREDERICK,JOHN H $35.69
FREDERICK,JUDY C $14.20
FREDERICK,MICHAEL $34.72
FREEDMAN,KENNETH F $32.94
FREEMAN INVESTMENTS INC $55.90
FREEMAN,DAVID K $1.17
FREEMAN,KARA $28.25
FREIJE,ANTHONY M $4.42
FREITAG,THEODORE F $8.43
FRELIN,JOSEF J $45.69
FRENCH,DEBRA J $7.37
FRENCH,DENIS D $37.79
FRENCH,JAMES B $45.31
FRENCH,KEVIN $26.66
FRENCH,SAM $36.23
FRENCH,TERESA S $9.33
FRENSDORF,JEFFREY R $9.27
FRESH,TAYLOR JAI $14.97
FRESWICK,JUSTIN $28.12
FRETHEIM,GLEN A $21.04
FRETWELL JR,RICHARD D $25.22
FREY,KIM $0.41
FRIAL,LAUREANO C $52.62
FRIARS,NERISSA $11.93
FRICK,WILLIAM J $37.19
FRIEDLY,MARY $50.62
FRIEDMAN,JEFFREY $5.49
FRIEDRICH,LAURA $14.46
FRIEMERING,CORAL M $11.53
FRIEND,DAVID R $8.69
FRIESE,STEPHANIE I $11.50
FRISBY,ANNA D $1.99
FRITH,DOUGLAS WILLIAM $2.88
FRITZ,AMANDA M $13.48
FRITZ,SHIRLEY A $14.10
FRITZAL,ALAN $5.88



Name Allocation

Chugach recently mailed 2010 Capital Credit Allocation letters to its former members.  The letter stated an incorrect allocation 
amount on the letter.  If you received one of these letters, you may confirm the correct amount of your allocation by searching* 
for your name in the list below.  

*There are three ways to search for your name:                                                                                                                            
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FROESCHLE,JERRY $45.24
FROLOV,EVDAKIA $17.27
FROST,ADELHEID R $17.50
FROST,ELIZABETH J $33.92
FROST,WILLIAM D $51.37
FRY,NICHOLAS A $13.57
FRYE,CASSANDRA $36.84
FRYE,RICHARD E $193.40
FRYE,STEVEN L $2.83
FU,MINHJOHNNY G $4.73
FUCCI,RAQUEL $33.32
FUCHS,LORETTA A $24.00
FUENTES,EUGENIO VARGAS $3.98
FUENTES,HEATHER $16.91
FUENTES,JACQUELINE $28.96
FUENTES,MARIA $12.89
FUGATE III,JOHN CLYDE $26.10
FUHLER,JUSTIN H $22.63
FUHR,KRIS $31.40
FULKERSON,ALFRED R $9.78
FULKS,NEAL $4.96
FULLER,JOHN E $3.80
FULLER,KELSEY LEIGH $24.43
FULLER,OCTAVIA $16.97
FULLERTON,PATRICK A $40.93
FULSANG,NEIL EVAN $30.67
FULTON,MARY M $43.98
FULTON,ROBERT L $4.10
FUNEZ,RACHEL $15.73
FUNK,KENNETH A $5.24
FUSTER,LUIS E $56.70
GABELMAN,HEATHER $3.39
GABRIEL,LAURA A $4.14
GACHUPIN,CYNTHIA $23.03
GADDY,JAMES FRANK $14.23
GADOMSKI,DEBORAH $8.15
GADSON,CALVIN $10.02
GAEDE,KELLY $8.14
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GAETOS,EILEEN RAE $6.09
GAGE,ALAN L $24.67
GAGE,DEBORAH $31.63
GAGE,ESTHER N $43.49
GAGE,SCOTT $27.42
GAGNON,BRANDI L $8.02
GAGNON,GARY E $14.85
GAGNON,PETER W $2.21
GAIDUK,POLI $48.49
GAINES,GARRETT C $6.76
GAINES,MARGARET LEA $14.65
GAINES,ROLLAND D $30.54
GAITAN,MARLEN N $21.45
GALACE,JENNIFER $13.74
GALACE,MICHAEL L $12.21
GALAIDA,MARY $3.29
GALARZA,ANTONIO $1.42
GALEKOVICH,BOB $59.16
GALEKOVICH,HARRY $3.94
GALEY,IRENE M $5.03
GALINDO,MARGIE D $1.65
GALIOTO,KAY LYNN $3.55
GALIPEAU,CODY $4.68
GALLAGHER,BRIGID $21.12
GALLAGHER,KARLA L $45.47
GALLATIN,AMIEE $13.53
GALLEGOS,PATRICIA $32.33
GALLIHER,KIRA L $4.08
GALLION,JASON $35.63
GALLO,ROBERTO $19.58
GALLOSO-RANKIN,DANE P $3.71
GALLOWAY,ANTHONY D $30.61
GALLOWAY,RICHARD W $20.70
GALLUP,PATTY L $45.27
GALOIA,FAATONU (TONI) $16.63
GALTERIO,VINCENT L $25.04
GALVAN,KATHY $21.71
GALVES,JAMIE $0.40
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GALVEZ,ELIAS $8.16
GALVEZ,ESTER M $2.05
GALVIN,DEBBRA S $12.04
GALVIN,PATRICK $66.93
GAMAGE,ALAN $74.52
GAMBLE,BUTCH L $20.27
GAMBOA,ENDY $23.36
GAMMARANO,KEYLA $0.62
GANGL,MELISSA $5.23
GANGWER,JANICE T $23.01
GANGWER,JOEL $13.52
GANN JR,ROBERT C $31.64
GANN,JONATHAN G $11.93
GANO,JACOB R $12.41
GANOPOLE,DEIDRE S $12.80
GARASSINO,GIOVANNI $27.67
GARAY,HERMAN M $15.11
GARBOWCZ,MONIQUE $17.25
GARCES,RYAN $96.45
GARCIA JR,ANGEL L $7.60
GARCIA,CECILIA $25.65
GARCIA,CRISTALINA A $13.43
GARCIA,DANIEL $19.88
GARCIA,DENALI $15.58
GARCIA,DIANE $9.02
GARCIA,JOSE E $0.09
GARCIA,JOSHUA J $25.25
GARCIA,JOVANNA K $1.48
GARCIA,MARCUS JOSEPH $13.15
GARCIA,MIKE T $10.70
GARCIA,NANCY $12.86
GARCIA,RENE P $16.93
GARCIA,RICARDO A $21.31
GARCIA,ROSE $1.97
GARDNER RAUN,CASSANDRA $12.87
GARDNER,CATHY $18.35
GARDNER,DONALD $1.56
GARDNER,R C $100.45
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GARDNER,S MCLANE $39.85
GARDNER,TRACIE J $9.53
GARECHT,JANET $20.87
GARLOCK,BRUCE $8.26
GARLOUGH,JEFFREY $3.80
GARMAN,DONNA M $36.69
GARNER,CHERELLE $13.71
GARNER,PAMELA ANN $17.38
GARNESS,BRADLEY SCOTT $31.59
GARRETT,CECIL E $14.24
GARRETT,SCOTT H $24.50
GARRETT,TARA MARIE $17.33
GARRISON,LINDA $35.13
GARRITSON,CHAD R $3.32
GARROUTTE,CHET $13.22
GARTMAN,SARAH N $35.09
GARVEY,CRYSTAL $24.23
GARVIN,BENNETT R $24.06
GARVIN,SHANIECE L $10.67
GARZA,APRIL $14.14
GARZA,BREHL $10.32
GASAWAY,HEATHER $20.63
GASKELL,MICHAEL L $10.47
GASPERLIN,DAN $37.94
GASS,KIMBERLY MARIE $22.65
GASSER,ELIZABETH M $18.13
GASTROCK,JASON S $2.66
GATES,JENIFER J $18.31
GATES,JESSICA $3.42
GATES,MICHAEL L $9.01
GAUGHAN,DARSEN R $33.20
GAULT,JUDY $16.38
GAUTHIER,AARON $4.42
GAUTNEY,SUZANNE $2.18
GAVIN,WILLIAM LAWRENCE $2.67
GAYLARD,CHRIS $37.40
GAYNOS,STEVE $41.03
GAYTON,ALBERT $4.76
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GAZMEN,JAY S $0.04
GEANES,CHIVONNA $11.52
GEARHART,KATHY $5.36
GEARHART,RACHEL E $22.10
GEASAN,DENNIS LEE $16.95
GEBHARDT,JEREMY $1.66
GEE,E DARLENE $18.77
GEER,GARY E $15.46
GEESIN,AMANDA $18.15
GEFFE,LAVONNE P $51.73
GEHRMAN,RANDI $11.82
GEIGEL,BENJAMIN $4.10
GEIGLE,MARCIE KIM $30.25
GEISDORF,AMANDA $29.26
GENERAL BUSINESS MACHINES $227.06
GENEROUS,STUART $25.87
GENSLER,HOLLY R $41.66
GENTLE CARE SERVICES INC $26.84
GENTNER,MARITA $1.84
GENTRY,AMY L $37.69
GENTRY,ELIZABETH $20.17
GENTZEL,COURTNEY $14.81
GENUNG,ERIN RENEE $2.07
GEONORTH LLC $174.22
GEORGE,FAYE H $31.22
GEORGE,JOSEPH ANTHONY $26.21
GEORGE,MARCIA $6.02
GEORGE,ROBERT J $5.47
GEORGE,STACY EVETTE $2.59
GERBIG,LYNN C $14.39
GERHARZ,KATHERINE ELIZABETH $20.17
GERMAIN,SARAH $1.33
GERRARD,ALEX $26.95
GERTEISEN,STEPHEN $33.42
GERVAIS,JOHN C $24.71
GERVAIS,MATTHEW T $17.27
GESE,DANIEL $14.44
GETER,MICKIE $22.55
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GETTIER,MONIQUE $14.26
GHORMLEY,LAURA $18.22
GHOSH,SHUBHRAN J $59.68
GIALOPSOS,KIMBERLY $17.43
GIAMONA,JESSICA $3.72
GIANCOLI,JOSEPH $1.23
GIANNINI,PETER $14.08
GIBBONS,MELVIN A $80.75
GIBBONS,NANCY $41.37
GIBBONS,SHAWN $11.27
GIBBONS,SHAWN D $27.72
GIBBS,DUSTIN ELLIOT $51.24
GIBBS,ERICA S $12.06
GIBBS,LORI J $26.99
GIBBS,RENDY $17.05
GIBBY,BOBBY S $1.95
GIBERSON,ERIN L $17.25
GIBLER,DORA $12.81
GIBLIN,GERARD M $12.82
GIBSON,CARNELL $5.63
GIBSON,DWAIN LEE $17.89
GIBSON,JESSI S $38.37
GIBSON,MILLIE J $24.17
GIBSON,NELSON W SR $5.36
GIBSON,ONDAR JR $4.60
GIBSON,SUSAN H $52.49
GIBSON,TIMOTHY B $57.45
GIBSON,WADE MORGAN $32.97
GIDDENS,CHRISTOPHER ANTONIO $42.41
GIEBEL,MICHAEL $20.75
GIELAROWSKI,JUANITA V $20.47
GIFFORD,TERRY L $29.28
GIGLIO,BRAD $15.79
GIKUUDIRO,ANGELINA $10.54
GILBERT,AMBER $10.60
GILBERT,DARIEN J $29.18
GILBERT,JAMES R $21.42
GILBERT,JOHN W $6.11
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GILBERT,JOHN W $12.51
GILBERT,KARSANDRA DIANNE $6.58
GILBERT,LINDA J $20.24
GILBERT,LISA $52.42
GILBERT,MARY J $20.08
GILBERT,NICHOLAS $12.42
GILBERT,RECHILDA M $11.75
GILBERT,SCOTT M $9.82
GILCHRIST,LANCE M $19.36
GILDEN,AMELIA H $2.64
GILDERSLEEVE,JOSHUA $10.48
GILDNER,DEBORAH J $41.61
GILES,CHRISTINE A $38.34
GILES,STACIE $2.02
GILIAM,ERIC $17.82
GILKEY,DELOIS $9.40
GILKEY,ED $12.02
GILKEY,ELASHIA $27.78
GILL,RANJODH S $1.10
GILL,TABITHA D $8.23
GILL,WILLIAM H $25.81
GILLESPIE,GHISLAINE $34.74
GILLETTE,JASON $4.71
GILLETTE,JENNIFER ROBIN $9.28
GILLIES,EMILY M $30.44
GILLIHAN,HEATH B $14.29
GILLILAND,K D $1.84
GILLILAND,RICHARD E $14.55
GILLIN,PATRICK D $19.54
GILLION,DERRICK $15.51
GILLIS-ROBINSON,DIANNE $57.70
GILLS,TOM W $17.75
GILLSON,DELORES $37.19
GILMAN,LARRY D $26.31
GILMAN,MICHEAL $6.63
GILMORE,DARWIN L $9.09
GILMORE,MELISSA $33.45
GILMORE,SANDY $5.13
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GILTZ,KAREN $3.75
GIMENO,ROMAN D $5.78
GIMMESON,MICHAEL $122.80
GINGRAS,MARGARET A $1.13
GINN,ROBERT E $11.75
GINNETT,STEPHEN $48.19
GIOFFRE,GABRIEL $90.00
GIORDANO,JOEY $26.88
GIRALDO,SHELLEY J $51.79
GIRDWOOD FOREST FAIR $3.44
GIRMSCHEID,MARK $21.48
GIROUX,WINTER D $2.87
GIVENS,DAVE K $13.61
GLAFKE,TROY J $9.82
GLASGOW,DAVID L $7.79
GLASS,JOHN D $30.95
GLEAVE JR,THOMAS F $5.64
GLENN,MATTHEW $25.91
GLORIOSO,HAPPY $22.03
GLOVER,DONNA M $70.12
GLOVER,FRED $16.51
GLOVER,J MARK $51.30
GLOVER,JOHN MURRAY $5.63
GLOVER,LAURA A $10.66
GLUTH,JULIA $7.10
GOAD,MEGAN $50.43
GOARD,CHRIS S $43.16
GOARD,OLIVER $9.81
GOBROSKI,TONY $6.60
GOCK,JILLENE K $21.06
GODEL,LAURA L $7.64
GODFREY,AMY $17.52
GODIL,SHABBIR $15.84
GODINEZ,DONNA $81.53
GODOY-GARCIA,HEIDI J $9.96
GODWIN,PAUL V $21.51
GODWIN,SARAH ELIZABETH $8.48
GODWIN,TODD $20.89
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GOEHRING,HAROLD $13.80
GOEHRING,HARVEY $15.70
GOETTEMOELLER,MATTHEW W $39.01
GOETZ,CHARLES R $5.66
GOETZE,STEFAN H $50.21
GOFF,JERI K $7.43
GOINGS-SCHUBIN,SHAWNA $23.26
GOJENOLA,CURT A $14.78
GOJENOLA,LINSEY $22.78
GOLD STAR PRINTING $58.60
GOLD,JACQUELIN $23.02
GOLDADE,CHRISTOPHER R $22.23
GOLDADE,LYNN CARNELLA $53.03
GOLDEN BRIDGE INC $151.63
GOLDEN YEARS ASSISTED LIVING $22.14
GOLDEN,DWAYNE J $41.41
GOLDMAN,ASHLEY $11.30
GOLDSBERRY,CARMILL $5.95
GOLDSTEIN,AIMEE L $72.22
GOLIAN,REBECCA K $56.67
GOLICK,MICHAEL $14.28
GOLLIHUGH,DANIELLE S $7.11
GOLLY,TRACY $14.87
GOMES,KOLTON $18.73
GOMEZ,CARLOS J $13.87
GOMEZ,JONATHAN $3.15
GOMEZ,JUAN DE DIOS $5.78
GOMEZ-MACEDO,IVAN DAVID $28.51
GOMIS,JACQUELINE $19.83
GOMOLA,MATTHEW $14.45
GOMOLUCH,LACY $14.22
GONDEK,JACOB $13.30
GONION,LAURA $5.04
GONION,RENEE $2.71
GONKA,YANCY REX $35.30
GONZALES,CHERYL L $13.41
GONZALES,COURTNEY $18.51
GONZALES,DELTA $17.58
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GONZALES,MADISON $18.98
GONZALES,ROMA $7.08
GONZALES,STEPHANIE $13.28
GONZALES,VICTOR $13.20
GONZALES-EVAN,JESSICA E $50.89
GONZALEZ JR,RODRIGO R $16.79
GONZALEZ,ANGELA $0.47
GONZALEZ,CARLOS R $131.89
GONZALEZ,CHRISTINE $57.04
GONZALEZ,GILBERT $28.25
GONZALEZ,IDA L $4.13
GONZALEZ,JAVIER $15.08
GONZALEZ,JENNIFER $9.81
GONZALEZ,JOSE D $51.78
GONZALEZ,JOSE U $25.25
GONZALEZ,JOSEPH GE $26.98
GONZALEZ,JUAN LUIS $4.87
GONZALEZ,LEONARDO $9.47
GONZALEZ,PEDRO $20.44
GONZALEZ,RENE J $26.33
GOOD,LINDA H $36.95
GOOD,TAYLOR $7.98
GOODE,ARTHUR RUDY $60.52
GOODE,KELVIN $2.26
GOODE,LUCY ANNSUSAN $31.58
GOODE-BOUCHE,JENNIFER $21.81
GOODMAN,AMY $48.78
GOODMAN,DONALD W $21.50
GOODMAN,ERIN $19.31
GOODMAN,KELLI $34.51
GOODMAN,KENDRA K $17.40
GOODMAN,LEE D $27.48
GOODMAN,MARGIE D $5.14
GOODMAN,PHYLLIS $19.03
GOODSON,BRANDON $14.53
GOODWIN,CRYSTAL G $24.31
GOODWIN,PAMELA $4.49
GOOLEY,ROBERT $3.19
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GOOLSBY,KATHRYN $1.09
GOOSSEN,TABEA $0.44
GORDAOFF,ROBERTA M $1.71
GORDER,ROBERT $28.32
GORDER,SCOTT $66.03
GORDNER,STEVE M $6.31
GORDON,ANTHONY W $2.32
GORDON,MICHAELLE $12.80
GORDON,SELENA $98.53
GORDON,VICTOR A $8.22
GORDON,YORDANOS $6.34
GORE,KASANDRA $6.22
GORE,MARTHA $6.95
GORENCA,AGRON $10.50
GORHAM,AARON M $12.29
GORHAM,CLAY B $8.16
GORHAM,TIMOTHY J $28.58
GORLICH,MARYKATHERINE $9.88
GORMAN,BOB F $13.61
GORMAN,RICHARD B $21.62
GORUP,CASEY CHRISTOPHER $19.48
GORUP,STEWART A $8.89
GOSCHKE,MATTHEW $9.08
GOSS,JAMES M $85.98
GOTHE,ALETHA $3.23
GOTHE,GLORIA L $30.34
GOTTESMAN,SHERYL J $15.42
GOTTSCHALK,JANICE B $56.73
GOUGH,SIMEON F $25.25
GOULD,CLIFFORD $5.99
GOULD,HEATHER $23.31
GOULD,TIMOTHY F $11.02
GOVER,LONNY D $4.09
GOVERNALE,JACOB T $13.44
GOVERNALE,JOSHUA L $4.07
GOVIG,KIMBERLY F $14.74
GOWDY,DEBORAH $51.81
GOWER,GAYLORD MARK $32.36
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GOWER,SCOTT M $9.28
GOYETTE,RENEE K $31.66
GOYNES,JASON $1.23
GRABBE,ROLLAND $24.43
GRADY,JENNA RAE $12.01
GRAFF,DANIEL D $21.84
GRAFF,MICHELA M $2.24
GRAHAM JR,CHRIS $35.24
GRAHAM,CELESTE L $0.34
GRAHAM,CURTIS $45.42
GRAHAM,DOYLE R $28.96
GRAHAM,JAMIE J $41.79
GRAHAM,JEREMY L $10.18
GRAHAM,JOHNATHEN A $3.71
GRAHAM,MICHELLE N $25.20
GRAHAM,NED $4.04
GRAHAM,NICOLE L $24.97
GRAHAM,RUTH M $35.74
GRAHAM,TAMMY J $14.67
GRAHAM,TIMOTHY G $30.29
GRAHAM,WARREN K $6.63
GRAHAM,WILDON $29.13
GRAHEK,DEBORAH $6.80
GRAIKA,JEREMIAH D $19.80
GRAJCAREK,CAMILA $11.46
GRALEWSKI-BAUGUS,LYNNE MARIE $36.11
GRANBERRY,KEITH $27.71
GRANDE-REYES,RAMON ANTONIO $16.66
GRANGE,RUSSELL $2.35
GRANGER,TERRANCE L $31.55
GRANT,BRANDON $34.10
GRANT,JOSHUA $26.24
GRANT,KAREN $15.26
GRANT,KYLE J $26.67
GRANT,LAUREN $5.57
GRANT,THOMAS W $4.64
GRANT,WALTER $38.19
GRAPER III,HENRY E $35.98
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GRAPHIC ARTS CTR PUBLISHING CO $10.98
GRASER,CARYL LEE $46.45
GRAVELLE,PATRICIA $40.12
GRAVENMIER,TERI $17.59
GRAVES,ASHLEE $19.31
GRAVES,FRANCIS M $71.97
GRAVES,MITCHELL L $4.85
GRAY,A KATHLEEN $6.43
GRAY,AARON $59.19
GRAY,ART R $25.41
GRAY,BRUCE $7.24
GRAY,CORDELL $46.42
GRAY,JESSE C $9.44
GRAY,JULIA G $25.85
GRAY,LORING $10.40
GRAY,MARK A $32.28
GRAY,SARAH $24.70
GRAY,SHAYNA $23.83
GRAY,THOMAS L $17.15
GRAY,TRAVIS L $8.97
GRAYSON,SARA ELISE $28.66
GREEAR,AMANDA $5.19
GREEAR,QUENTIN P $7.91
GREEFF,KIMBERLY A $16.01
GREEN ENGINEERING INC $13.73
GREEN,AMBER MICHELLE $8.15
GREEN,BRIAN M $7.67
GREEN,CYNTHIA $61.93
GREEN,DANIEL $25.17
GREEN,EDNA $30.28
GREEN,FLOYD T $15.87
GREEN,HEATHER $16.69
GREEN,JASON O $8.63
GREEN,JEFFERY R $78.58
GREEN,LAUREL $28.68
GREEN,MARY ELLEN $8.47
GREEN,NICOLE K $7.33
GREEN,ROBERT A $16.74
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GREEN,ROBLYN L $5.41
GREEN,TARA R $28.04
GREEN,TARRY $11.29
GREEN,THOMAS A $2.44
GREEN,THOMAS F $32.86
GREEN,TINA OMAN $17.31
GREENAWAY,MICHAEL $72.16
GREENBERG,JEREMIAH $6.14
GREENE,AARON M $22.85
GREENE,BEN A $6.95
GREENE,CHELSEA $11.95
GREENE,ERIC $14.33
GREENE,GAIL C $30.46
GREENE,GEORGE $8.85
GREENE,GEORGE C $1.18
GREENING,ADAM $5.16
GREENLEAF,ANGELA $35.88
GREENWELL,GARY $24.87
GREENWOOD,ADIZ L $7.50
GREER,JASON $17.49
GREER,KELLY $44.84
GREGG,DAVID $82.98
GREGG,MICHAEL RAY $18.39
GREGOROFF,ERIC G $18.16
GREGORY AUGUSTINE BROWN REV TR $16.98
GREGORY,DORA $4.31
GREGORY,JESSE $18.06
GREGORY,MATTHEW R $25.81
GREGORY,SAM $6.78
GREIG,DAVID J $4.25
GREINER,CHARLES A $28.70
GREKOWICZ,GRETCHEN N $49.57
GRELLA,CODY $10.12
GREMINGER,THERESA $23.97
GRENDAHL,ANDREW $9.34
GRENDAHL,SHAWN $12.64
GRESHAM,CLAIRE $8.99
GRESHAM,COREY $14.27
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GRESHAM,DAVID $9.11
GRESHAM,MATTHEW C $27.82
GRIBAA,NAIM $3.76
GRIEBE,GUNNESSA $24.97
GRIEGO,DANIEL S $8.33
GRIESER,KRISTEN M $26.84
GRIFFIN,CHRISTIE $2.77
GRIFFIN,KENNETH W $42.17
GRIFFIN,MATTHEW B $1.52
GRIFFIN,NICOLE $22.43
GRIFFIN,SHELLY LYNNETTE $32.15
GRIFFIN,WILLIAM B $19.04
GRIFFIN,WILLIAM T $4.25
GRIFFIS,MARK D $3.19
GRIFFITH,AKARA $9.84
GRIFFITH,BRIANA $26.32
GRIFFITH,JEFF $34.19
GRIFFITH,KIMMER $30.12
GRIFFITH,MIKE $30.04
GRIFFITH,TRACEY L $25.73
GRIFFITH,TREVOR $7.50
GRIGGS,KAREN K $20.59
GRIM,JAMES W $12.85
GRIM,SANDY $37.84
GRIMES,AMBER $14.40
GRIMES,BETH $31.13
GRIMES,JUSTIN D $7.71
GRINER,SHANNON L $38.15
GRISSOM,KELLY $14.46
GROCHOW,GARY $21.26
GROEN,SARAH A V $20.89
GROGAN,KRIS $56.23
GRONHOLDT III,PETER P $5.95
GROPP,DORA L $57.81
GROSS,JESSE $7.97
GROSS,TERRY D $52.14
GROSSMAN,MONICA W $31.56
GRUBB,MATTHEW $15.98
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GRUBE,JADE KATHERINE $19.69
GRUE,LINDA $1.89
GRUENEBERG,JEREMY $16.63
GRUMELOT,CAREY R $1.83
GRUND,HELEN $20.78
GRUNDELAND,KURT R $41.98
GRUNWALD,ROBERT $4.53
GRZEBYK,JESSICA $8.65
GUANZON,ROSALINDA $11.43
GUARDERAS JR,JOSE M $44.36
GUARDIAN FLIGHT INC $33.30
GUDITZ,RALPH $9.36
GUDOR,CRISTINA $0.21
GUENTHER,ROBERT T $20.96
GUERDAN,ELIZABETH J $14.72
GUERRA,CALEAH ROSITA $13.22
GUERRA,ELIAS $13.47
GUEVARA,FERNANDO A $6.54
GUGISBERG,KYLE R $30.21
GUIEL,OFELIA I $18.83
GUILD,CASEY E $4.49
GUINTU-HERNANDEZ,CORNELIO $3.45
GULIYEV,TOGHRUL $15.71
GUM,EDWARD NOAH $20.02
GUMLICKPUK,WASSILIISIA $5.11
GUNDERSEN,LARISSA $20.17
GUNDERSEN,NICHOLAS $1.58
GUNDERSON,ROBERT E $9.11
GUNN,NANCY $8.50
GUNN,RODD $27.45
GURISKO,CYNTHIA $43.46
GURULE,ANTHONY $3.52
GUSTAFSON,LINDA K $10.03
GUSTAFSON,MICHAEL $18.28
GUSTIN,BRYAN $40.01
GUSZREGAN,ELIZABETH $0.86
GUTHRIE,DAVID ALAN $37.74
GUTHRIE,DAWNYELL E $46.94
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GUTHRIE,JOHN R $8.05
GUTHRIE,RYAN $2.46
GUTIERREZ JR,MAURO $19.92
GUTIERREZ,RAMON $35.43
GUY,HEIDI NOELLE $13.62
GUZMAN,ANTONIO $4.85
GUZMAN,LISA Y $35.39
GUZMAN,MARCO $8.00
GUZMAN,MICHAEL E $25.43
GWINS LODGE $936.75
HA,JOHN P $9.79
HA,SONGHO $5.86
HAAKENSON,CHERYL BETHEL $13.38
HAAR,RICHARD $4.35
HAAS,JEANNE L $22.29
HAAS,STEVEN $63.19
HAASE,JUDY $1.26
HAASE,LESTER EUGENE $0.06
HABEL,LAUREN $6.53
HABERLE,THOMAS M $8.98
HABERMANN,THOMAS M $2.19
HACK,ALISSA L $44.91
HACKER,KATHRYN A $28.38
HACKETT,AMANDA D $13.97
HACKETT,JAMES D $1.50
HACKNEY,KARA JUSTINE $7.15
HADDAD,CAROLYN $61.62
HADDAD,ELIZABETH A $17.01
HADDAD,LAURA A $6.53
HADDEN,STEPHANIE $12.05
HAECKER,LACEY A $3.30
HAFER,PAUL $43.32
HAFOKA-MEE,NORMA G $49.18
HAGAN,JESSICA A $8.13
HAGBERG,ADAM $60.56
HAGBERG,LUCY $26.06
HAGELUND,CHERYL L $56.44
HAGEN,FLOYD $3.08
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HAGEN,RICHARD G $54.00
HAGERTY,NATASHA $11.58
HAGESTAD,VAN DANE $32.49
HAGGITT,SHANNON R $12.92
HAHN,MARI $7.68
HAHN,RANDALL JR $2.58
HAHN,ROBERT M $46.64
HAHN,YANA I $45.51
HAILEY,MICHELE $42.52
HAINES,JESSICA $15.40
HAINES,JOHN $49.19
HAINES,KALEEN M $1.95
HAINES,MICHAEL $10.14
HAISMAN,CHELSEA $4.20
HALE,ALAN B $12.60
HALE,CAROLYN D $12.66
HALE,LORRAINE $16.72
HALE,MARTHA A $15.70
HALE,SHANNON E $13.69
HALE,SIMON $12.78
HALEY,ERNEST P $17.73
HALEY,SHERIDAN K $4.76
HALFMAN,CARTER J $9.18
HALL,ARTAVIA $7.07
HALL,BACARRI R $16.32
HALL,CARRIE $6.38
HALL,CECILIA C $4.71
HALL,CHENA $20.52
HALL,CHRISTI N $46.71
HALL,DEBORAH J $36.18
HALL,DOUGLAS W $25.13
HALL,E YVONNE $46.56
HALL,EDWARD $4.53
HALL,EILEEN A $13.76
HALL,FRANCES M $27.44
HALL,JEREMY $7.50
HALL,JOSEPH S $11.93
HALL,JULIA KYONG $26.22
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HALL,KRISTY $28.62
HALL,MADELYNN M $23.58
HALL,MICHAEL E $18.99
HALL,SHIRLEY R $26.17
HALL,STEFANIE LYNN $15.33
HALL,TAMMY L $41.79
HALL,TINA $3.34
HALL,TONY $43.35
HALL,VALERIE L $10.28
HALL,VELDEE $7.40
HALLADAY,BRITTANY $7.87
HALLBACK,TRENA K $16.76
HALLUM,MARION $7.50
HALPIN,JAMIE $17.80
HALTNESS,EDWARD E $0.16
HALVORSON,KEVIN $31.90
HAM,MELANIE $4.15
HAM,RAMONA A $42.03
HAM,SAING $19.18
HAM,WON SHIK $2.73
HAMANN,JACLYNN NICOLE $5.20
HAMBY,KATHLEEN C $3.71
HAMEL,LINNEA M $16.16
HAMEL,MATTHEW $5.16
HAMILL,STACIE L $25.24
HAMILTON,ROBERT S $20.32
HAMILTON,ROSE M $42.54
HAMLETT,MARSHA $10.27
HAMLIN,DIONNE $36.00
HAMMETT,ELIDA E $12.64
HAMMILL,BRENT $85.96
HAMMINGH,KIMBERLY J $8.36
HAMMOND,CORDARRELL $8.24
HAMMOND,FRITIZI A $15.25
HAMMOND,JESSICA $18.94
HAMMOND,KENNETH $21.58
HAMMOND,ROBERT $5.52
HAMPEL,MICHELE $54.99
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HAMPTON,AMY $20.61
HAMPTON,CHRISTOPHER B $11.36
HAMPTON,TERRY L $4.00
HAN,JOO HEE $34.05
HAN,PAUL J $14.51
HANCHETT,KEITH $7.38
HANCOCK,JOHN S $15.17
HANCOCK,MINDY J $19.40
HANCOCK,SHEILA $4.23
HANCOCK,STEPHEN W $8.26
HAND,CHARLES R $22.98
HAND,JACKIE S $17.56
HAND,TAMMY $3.17
HANDLOFF,MARK Z $12.28
HANEK,PAULA C $42.90
HANESANA,VALAILUCK $85.96
HANG,MAY YANG $1.01
HANING,JAMES $6.65
HANKE,ACE REED $5.59
HANKEL,RACHELLE L $6.31
HANKINS,JASON J $3.06
HANKINS,M D $23.88
HANKINS,MARY ANN $39.44
HANKINSON,LEWIS C $1.68
HANLEY,MARK S $45.07
HANLEY,MICHAEL S $39.83
HANLEY,STEPHANIE $6.48
HANNA,RICHARD T $1.68
HANNAH,BARBARA D $34.65
HANNAMAN,RON $7.59
HANNAMAN,SEAN $20.43
HANNAN,JANE M $1.96
HANNAN,NEESIA $12.06
HANNERS,ROBERT E $52.90
HANSEN,BEVERLY $82.86
HANSEN,BRENDA M $18.32
HANSEN,DARRIN JON $21.13
HANSEN,DEBORAH $28.01
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HANSEN,DENISE R $2.61
HANSEN,ERIC M $22.91
HANSEN,GARY $33.37
HANSEN,HARRY $1.85
HANSEN,HEATHER R $20.49
HANSEN,KAREN A $1.62
HANSEN,KELCIE $11.37
HANSEN,MATTHEW S $22.55
HANSEN,RACHEL ANGELA $17.32
HANSEN,SARA M $13.88
HANSMEYER,EVA $12.30
HANSON,AYLETT R $25.88
HANSON,BERNADETTE $4.79
HANSON,CHRISTINA $25.39
HANSON,KARI L $11.26
HANSON,KRISTIN $23.92
HANSON,MATTHEW J $14.74
HANSON,PIUS $3.57
HANSON,R L $26.89
HANSON,RICHARD $33.40
HANSON,STEVEN JAMES $15.49
HANSON,THOMAS E $13.39
HANSON,WESLEY $1.94
HANZEN,DEREK $4.16
HARBER,JUSTIN $3.17
HARBESON,RICHARD B $1.45
HARBIN,SARAH $20.15
HARBISON,TRAVIS $7.59
HARBUCK,KAREN $2.95
HARBURY,EMILY $13.05
HARCHAREK,BOB $8.44
HARDCASTLE,JEANETTE L $16.87
HARDESTY,DORIS S $6.95
HARDING,JENNIFER $5.63
HARDMAN,ZACHERY $16.34
HARDWICK,JOSELYN A $10.92
HARDY,ALITA $11.85
HARDY,ANDREA ELAINE $4.48



Name Allocation

Chugach recently mailed 2010 Capital Credit Allocation letters to its former members.  The letter stated an incorrect allocation 
amount on the letter.  If you received one of these letters, you may confirm the correct amount of your allocation by searching* 
for your name in the list below.  

*There are three ways to search for your name:                                                                                                                            
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HARDY,BRIAN $17.10
HARDY,DALE T $7.42
HARDY,DANIEL $3.51
HARE,NATE W $22.52
HARGIS,JOHN M $8.33
HARGIS,SUSAN M $35.66
HARGY,DAVID F $5.73
HARKLEROAD,TIFFANY M $43.58
HARLAMERT,MICHELLE L $1.45
HARLAN,TIMOTHY J $2.71
HARLESS,MARGOT $4.55
HARLING,JILL $23.90
HARMAN,STEVIE $27.52
HARMANS REPAIR STATION INC $14.65
HARMENING,MARCIA $20.87
HARMON,FLOYD $34.97
HARMON,JEFFERY SCOTT $12.87
HARMON,JJ $15.06
HARMON,JOEL W $59.39
HARMON,MICHAEL J $9.20
HARMON,MIRYAH $10.73
HARMON,SONYA T $21.86
HARNETT,NATHANIEL $5.94
HARNEY,BETTY $6.30
HAROLD,TANNIUS JEAN $40.93
HARPEL,HEATHER L $7.31
HARPER,LINDA $19.57
HARPER,NEIL R $14.50
HARPER,TIMOTHY $16.93
HARPER,WILLIAM LYNN $21.34
HARR,MELINDA K $14.31
HARRADEN,CASSADY L $8.80
HARRELL,EVA M $16.56
HARREN,JENNIFER L $3.48
HARRIED,AMOS $14.73
HARRIER,COLEEN $22.21
HARRIMAN,BETTY L $45.74
HARRINGTON,BRYON $15.04
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HARRINGTON,CHRIS $32.77
HARRINGTON,LANCE $3.44
HARRIS,ADAM C $13.99
HARRIS,ALEXIS $24.73
HARRIS,BRANDEN R $1.27
HARRIS,BRENDA D $22.64
HARRIS,CHERI L $15.31
HARRIS,DEBORAH $34.26
HARRIS,DEWAYNE $2.57
HARRIS,ERIC R $19.20
HARRIS,HEATHER M $15.61
HARRIS,HUGH I $3.95
HARRIS,INEZ ALVES $2.60
HARRIS,JAMES E $36.12
HARRIS,JASON D $11.28
HARRIS,JEFFERY L $15.76
HARRIS,JEREMY M $31.52
HARRIS,JERMAINE M $27.84
HARRIS,JESSE LEE $41.85
HARRIS,JOHN J $13.03
HARRIS,JULIUS F $28.50
HARRIS,KARLENE $25.32
HARRIS,MARILYN J $4.03
HARRIS,MARVIN N $17.14
HARRIS,NIKIA $4.69
HARRIS,PATRICIA C $27.82
HARRIS,TODD $47.68
HARRISON,ANNA LANGLEY $38.40
HARRISON,CRYSTAL $39.96
HARRISON,JACQUELINE S $2.11
HARRISON,JUSTIN MICHAEL $3.01
HARRISON,KELLY S $26.44
HARRISON,WENDELL L $30.09
HART,AARON NATHANIEL $18.45
HART,CHRISTIAN $80.06
HART,CONNIE $35.52
HART,DAVID $19.45
HART,PATRICK A $62.86
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HARTE,ERIN ELIZABETH $8.09
HARTGROVE,LISA $6.20
HARTH,JUSTIN W $13.21
HARTILL,MARNIE $6.81
HARTLIEB,ROBIN L $12.42
HARTMAN,TRINA M $8.68
HARTT,BARBARA $9.66
HARTUNG,DWIGHT JAMES $14.10
HARVEY,ALFRED E $15.48
HARVEY,BRETT $4.56
HARVEY,CLIFFORD A $13.12
HARVEY,KATHLEEN M $47.12
HARVEY,MICHAEL PAUL $27.47
HARVEY,PRISCILLA M $4.65
HARVEY,SHANNON T $4.57
HARVILL,JESSICA $14.12
HASEGAWA,S H $2.35
HASELDEN,MATTHEW $0.09
HASENAUER,GIOVANNA $12.60
HASKELL,DAYNE $35.19
HASKIN,KATRINA C $3.79
HASKIN,MICHELLE $39.55
HASKINS,MARLYS $25.06
HASKINS,TAMA $31.63
HASS,PAUL $16.17
HASSAKONBUREE,SUKANYA $22.91
HASSINGER,CHARLES $2.38
HATCHER,CHARLENE $17.01
HATCHER,JOYCE L $21.65
HATFIELD,CHRISTOPHER $26.70
HATFIELD,GARY W $50.98
HATFIELD,HILLARY $33.55
HATFIELD,JEREMIAH M $42.93
HATFIELD,MELVIN $24.46
HATHAWAY,JAKE B $9.91
HATHAWAY,SANTANNA $59.11
HATTER,WANDA $13.98
HAUBRICH,STACIE M $21.82
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HAUGE,PER MIKAL $13.28
HAUGSTAD,MARK O $28.45
HAUGSVEN,AIMEE R $5.25
HAUSNER,YUNG SHIN $27.15
HAVARD,CONWAY $7.57
HAVELOCK,JOHN $16.72
HAVENS,MARY $18.81
HAWES,CHERLYN L $6.56
HAWI,MELKART F $43.80
HAWKINS,CRYSTAL $14.90
HAWKINS,JUDY $27.51
HAWKINS,KAREN Q $32.31
HAWKINS,KEITH A $7.75
HAWKINS,KENNETH $13.03
HAWKINS,MELODY $12.59
HAWKINS,MICHAEL $13.86
HAWKINS,RACHEL A $4.18
HAWKINS,RICHARD L $23.60
HAWKINS,RICKY $22.49
HAWKINS,SHANNON C $10.51
HAWKINS,TIANDREA $26.74
HAWKINS-BRANDT,KIMBERLY ANN $25.67
HAWKINSON,TERESA $9.11
HAWLEY,MACKENZIE $14.99
HAWN,LOUISA $1.35
HAWS,JULI $421.65
HAWTHORNE,WILLIAM $21.05
HAY,MICHAEL L $6.51
HAYDEN,TERRI SUE $26.94
HAYES JR,ROBERT L $22.21
HAYES,CARMEN L $40.71
HAYES,CHRIS L $12.93
HAYES,GLENN ARTHUR $24.58
HAYES,GORDON $15.89
HAYES,JOEL $31.32
HAYES,JOHN S $9.22
HAYES,JOSEPH $19.28
HAYES,KEITH W $6.55
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HAYES,KENNETH $10.32
HAYES,TUESDAY D $11.76
HAYES,WILLARD D $41.07
HAYNES,DONNA G $39.63
HAYNES,FREDERICK $47.57
HAYNES,JANET M $26.06
HAYNES,JOHN P $10.55
HAYNES,JOSEPH $64.92
HAYNES,NICOLETTE R $17.07
HAYS,LAURA L $44.69
HAYWARD,LATOYA $0.67
HAZARD,MARANDA $39.84
HAZELL,HELEN $13.29
HAZELWOOD,MICHAEL $15.69
HEAD,APRIL D $35.18
HEAD,KENNETH $20.68
HEADRICK,JENNIFER E $11.74
HEAGLE,CHRISTA L $15.83
HEANU,RONALD LEI ALOHA $10.82
HEAP,ROMAINE $17.69
HEARD,DEMONTRE $59.47
HEARN,JAMES G $14.72
HEARON JR,EMMET $175.47
HEASLEY,L W $27.50
HEATH,CAROL L $55.34
HEATH,JEREMIAH $27.64
HEATH,STEVEN R $57.12
HEATH,THOMAS L $14.73
HEBBE,SCARLETT R $28.79
HEBEN,HENRY $6.70
HEBER,TODD T $12.79
HEBER,TODD T $3.21
HEBERT,COLIN M $42.17
HEBERT,DANIEL $8.08
HEBERT,RAY D $3.47
HECKERT,CRYSTAL $13.32
HECKLER,DARLENE S $11.37
HECKMAN,GERTRUDE $29.12
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HECKMAN,PRISCILLA $0.42
HECKMANN,CHRISTINA $19.88
HECKMANN,JESSE $29.74
HECKSCHER,ASHLEY S $16.88
HEDDISH,JENNIFER A $3.90
HEDLUND-SMITH,TRACEY $23.13
HEER,ANDREW $74.17
HEFFERN,GENE $37.17
HEFFNER,SHEILA M $0.67
HEFNER,PAMELA J $19.40
HEGENDERFER,MATTHEW P $7.99
HEGSTED,AMBER ROSE $27.34
HEGTVEDT,HUBIE C $41.32
HEHNLIN,ANDREW J $12.28
HEIDEL,JOAN D $15.37
HEIDELBACH,KARL F $37.10
HEIDELBACH,ROBERT E $18.75
HEIDELBERG,NEISHA L $7.83
HEIDT,ROBERT $27.83
HEIEREN,JACQUELIN $7.14
HEILBRON,EVERT A $11.12
HEIMRICH,JUANITA $1.12
HEINECKE,WILLIAM J $28.41
HEINEMANN,DAVID $15.05
HEINOLD,JONATHAN D $7.55
HEINRICH,CANDACE $42.73
HEINRICH,RICHARD $28.77
HEIRLOOM PROPERTIES $0.10
HEISE,TZU LAN $13.31
HEISLER,ELIZABETH $38.12
HEISTEN,WILLIAM BARRETT $21.25
HEITMAN,KARL $24.63
HEITZ,JAMES R $9.09
HELANDER,KYLENE A $28.02
HELGESON,CHRISTINA H $30.11
HELM,AMANDA $5.72
HELMINEN,RUSSELL $3.77
HELTON,SHOSHANA $18.08
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HEMBREE,PABLO CESAR $10.93
HEMPLEMAN,LORI $18.56
HENDERSHOT,BROCK $5.54
HENDERSON IV,FRANCIS LAW $27.17
HENDERSON,CHAO HUI $14.37
HENDERSON,ERIN R $14.83
HENDERSON,KAREN S $3.78
HENDERSON,LANI $17.19
HENDERSON,LEONARD S $28.75
HENDERSON,RUSSELL $26.16
HENDERSON,VERNAL ARRON LE $18.32
HENDRICKS,DALLAS $35.89
HENDRIX III,SAMSON $6.53
HENDRIX,GREGORY $57.50
HENDRIX,MICHAEL W $19.20
HENDRIX,NANCY ANN $23.72
HENDRYX,EULELIA $14.99
HENNESSEE-ILOILO,LISA $23.27
HENNESSEY,BARBARA $2.17
HENNESY,QUINN $4.39
HENNINGER,DIANE G $13.40
HENNINGER,NICOLAS T $36.63
HENRIKSEN,LEIF $4.52
HENRIQUES,PAULINE $37.16
HENRY III,OSCAR $23.30
HENRY,BLAINE $22.97
HENRY,BOB $34.78
HENRY,CHARLIE $24.11
HENRY,DAVID C $57.66
HENRY,DOROTHY M $4.74
HENRY,GUY E $25.77
HENRY,JAMES $3.88
HENRY,JAMES M $39.14
HENRY,KEMBERLY $1.85
HENRY,LAURIE $15.31
HENSHEY,NATHAN H $37.02
HENSLEY,ABIGALE R $30.38
HENSLEY,BARBARA MELISSA $6.23
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1. Press CTRL plus F on your keyboard.  A FIND dialog box will appear on the PDF reader.

2. Click on the Edit menu, and locate-click the Find command.
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has the icon image of a pair of binoculars. Pressing the binocular icon will also result to the display of the Find dialog box.

HENSLEY,FRANCES R $8.74
HENSON,KELSEY H $24.15
HENTHORNE,LISA K $49.95
HENZ,SARAH T $8.70
HEPPE,KATHY MARIE $16.46
HERATH,MICHAEL C $12.93
HERBERT,REGINA E $24.21
HERD,DUANE $1.19
HERDA,JOHN J $30.28
HERDMAN,DOUGALD J $24.34
HEREDIA,MARIA LUISA $1.55
HEREIMI,SAMI $2.04
HERFINDAHL,RAINBO $36.78
HERING,SARA $1.45
HERITAGE,MARK $26.30
HERMANN,KIMBERLY A $8.18
HERNANDEZ,ALFREDO $15.89
HERNANDEZ,ALLAN B $44.73
HERNANDEZ,AUDELIA $22.01
HERNANDEZ,BRITTANY $2.29
HERNANDEZ,CHRISTA $3.18
HERNANDEZ,JENETTE $28.63
HERNANDEZ,JENNIFER $8.00
HERNANDEZ,JINKY $13.69
HERNANDEZ,JOANNA $19.67
HERNANDEZ,LORENA A $7.47
HERNANDEZ,LUCAS ALEJANDRO $2.36
HERNANDEZ,OMAR D $8.40
HERNANDEZ,PAUL $2.93
HERNANDEZ,ROLANDO Z $4.90
HERNDON,DAVID $10.37
HERNDON,NADEJDA M $1.45
HERREJON,KRISTINA MARIE $5.38
HERRELL,MARISA M $24.14
HERRERA,VALERIE S $36.89
HERRETT,MATTHEW I $4.01
HERRICK,GENE L $59.49
HERRING,BECKY $10.29
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has the icon image of a pair of binoculars. Pressing the binocular icon will also result to the display of the Find dialog box.

HERRMANN,DAVID W $11.33
HERROD,BARBARA $15.03
HERRON,RICK $0.58
HERRON,SALLY $9.92
HERSCH,DARYL L $28.46
HERSCH,DARYL L $17.02
HERSH,AARON $11.54
HERSHEY,ERIC FORREST $30.83
HERSMAN,WILLIAM G $0.47
HERT,DEREK $48.97
HERTRICH,CHRISTINE R $2.76
HESS,DOLPH $8.91
HESS,KIM K $26.13
HESS,MARCUS C $15.79
HESS,SANDI $6.37
HESS,SHANNON L $15.85
HESS,STEPHANIE J $6.14
HESS,TY R $52.37
HESS,VINCENT A $14.44
HESSER,KATHY J $34.00
HESSION,JACK $29.46
HESSON,CHAD $13.59
HESTES,KRISTIN M $16.91
HESTON,ROBERT C $2.46
HEUSSER,DAVID G $18.50
HEYWARD,LYDIA $4.61
HIBBERD,BRIAN M $3.88
HIBBERT,STEPHEN D $6.99
HIBBS,JUSTIN $30.72
HIBLER,ANDREW R $17.90
HICKEL,JANE $38.93
HICKEY,JOAN L $19.44
HICKEY,KEN R $5.55
HICKEY,NANCY $12.24
HICKEY,WILLIAM V $18.90
HICKLE,SCOTT $1.08
HICKLING,KAREN $51.59
HICKMAN,JEANNE $12.69
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1. Press CTRL plus F on your keyboard.  A FIND dialog box will appear on the PDF reader.

2. Click on the Edit menu, and locate-click the Find command.
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has the icon image of a pair of binoculars. Pressing the binocular icon will also result to the display of the Find dialog box.

HICKS,CHAD $2.36
HICKS,CINDY L $39.69
HICKS,DANIEL L $46.76
HICKS,TERESA A $22.21
HIDALGO,FLORENTINA $29.63
HIDALGO,JAIME P $14.47
HIDALGO,JERALD $22.17
HIETALATI,EHREN $17.43
HIETPAS,MIRANDA $30.07
HIETT,MICHAEL $33.02
HIGDON,JONATHAN T $3.42
HIGGINS,ARIEL $9.56
HIGGINS,MARY ANN $10.07
HIGGINS,THOMAS M $11.21
HIGH,KRISTIN S $7.54
HIGH,TAWNI $3.85
HIGHTOWER,TERRY $63.45
HIGLEY,KYLE $8.76
HILBRUENER,PHILIP $6.25
HILBRUNER,ANNA E $9.81
HILDEBRAND,SETH $3.45
HILGER,STEVEN D $6.93
HILGER,TIM J $7.81
HILL II,THOMAS S $31.61
HILL,ANDRYA $15.33
HILL,BYRON $2.95
HILL,CAROL J $16.62
HILL,CATHERINE $11.74
HILL,DARLA $12.99
HILL,GLENDA ELAINE $9.01
HILL,JESSE ALVA $21.62
HILL,KASSI J $26.00
HILL,KELLY $8.17
HILL,KELLY CHRISTOPHER $33.47
HILL,NANCY L $23.55
HILL,RYAN C $28.72
HILL,SABRINA $11.40
HILL,TRINA G $9.41
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3. Locate the Find tool button on the toolbar of the PDF reader (most commonly under the File menu bar). The Find tool button 
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HILLBURN,KATHY G $52.98
HILLIKER,DEENA MICHELLE $4.43
HILSON,STEPHEN L $37.85
HILTON,CINDY J $10.24
HILTON,GEOFFREY W $48.71
HILTY,CURTIS D $16.76
HIMEL,BENJAMIN R $26.73
HINES,COREY $9.67
HINES,GEORGE $11.33
HINES,VELENA J $20.66
HINGER,CRISTIN $42.55
HINKLE,ERIK R $6.92
HINMAN,MILDRED $1.45
HINOJOSA,PEDRO $4.84
HINSDALE,JUNE M $29.86
HINSHAW,MARTIN E $60.48
HINSHAW,MERRILEE KAY $16.57
HINSON,CHARLES M $45.29
HINTON,APRIL $32.37
HINTON,BRITTNEY SHANIQUE $34.83
HINTON,DAVICA $11.33
HIPKE,CHARLES $4.23
HIPOLITO,STANLIEGH $8.58
HIPSHMAN,LAWRENCE $1.91
HIRSCH,HALEY LYN $8.23
HIRSCHBERG,DANIEL ANDREW $17.52
HIRZEL,STEVEN R $25.94
HISPEED SOLUTIONS LLC $56.47
HISSONG,TOSHA SHAWNTE $10.17
HITCHCOCK,CHRIS $24.72
HITCHCOCK,LARZ $26.41
HITCHCOCK,RONALD $36.95
HITES,KELI $19.33
HIVELY,DONOVAN JAMES $23.93
HIXSON,DELYNN $7.86
HJALSETH,TWYLA S $19.98
HJELMAAS,THOR A $36.44
HMB INC $229.94
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has the icon image of a pair of binoculars. Pressing the binocular icon will also result to the display of the Find dialog box.

HMH-TEC LLC $56.67
HNATIK,WILLIAM J $53.69
HO,PO YAN $16.51
HOBACK,JOHNATHAN C $25.07
HOBAN,CHRISTINA A $31.80
HOBBS,HAILEY A $24.17
HOBKIRK,MORGAN $9.75
HOBLEY,JOSEPH C $10.74
HOBSON,ARLENE J $9.15
HOBSON,JENNIFER $12.14
HOBSON,MICHAEL D $13.38
HOBSON,RICHARD M $16.14
HOCH,JUDITH E $5.67
HOCKIN,JASON $24.69
HODGE,MARY C $27.38
HODGES,LAWRENCE A $22.37
HODGINS,JOANNE E $27.01
HODZA,MIRIAM $58.15
HOEFT,THERESA J $7.94
HOELDT,JENNIFER E $11.35
HOEY,JEFFREY B $4.36
HOFBAUER,MARY M $2.84
HOFF,CLIFFORD J $33.19
HOFF,GARY A $2.00
HOFFMAN,DEWEY $5.15
HOFFMAN,HANS A $18.07
HOFFMAN,JAMIE $13.01
HOFFMAN,JOHN B $27.57
HOFFMAN,KYLE A $27.15
HOFFMAN,MATTHEW J $33.20
HOFFMAN,ROD $12.54
HOFFMAN,VERONICA M $13.79
HOFFMEYER,RONALD P $61.50
HOFMANN,IAN L $54.39
HOGAN,ADAM R $5.66
HOGAN,CHRISTINA J $25.24
HOGAN,KLINTON C $0.75
HOGAN,ROLAND J $26.64
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3. Locate the Find tool button on the toolbar of the PDF reader (most commonly under the File menu bar). The Find tool button 
has the icon image of a pair of binoculars. Pressing the binocular icon will also result to the display of the Find dialog box.

HOGLIN,JAIME M $11.12
HOGUE,IDA MAE $17.36
HOLCK,PETER $0.62
HOLCOMB,MISTY $3.40
HOLCOMB,NATHAN T $17.95
HOLDER,ESCORITA L $20.62
HOLDER,JEFFREY A $47.77
HOLDER,TALLEE $17.02
HOLDERBEIN,KIMBERLEY $33.61
HOLFELD,KARL $15.65
HOLGERSON,RYAN $2.14
HOLIFIELD,CYNTHIA $14.32
HOLLAND,CHRISTOPHER M $8.42
HOLLAND,DAISY $3.15
HOLLAND,EARL $35.17
HOLLAND,FONTAI C $40.63
HOLLAND,KATHRYN M $23.36
HOLLAND,PAMELIA $40.27
HOLLAND,VIRGINIA J $32.08
HOLLERS,LEVI $19.27
HOLLEY,BARRY E $7.97
HOLLEY,PAUL J $19.87
HOLLIDAY,BLEIXEN $39.56
HOLLIDAY,NICHOLAS P $44.92
HOLLIER,SARAH $20.84
HOLLIMON,JASMINE D $4.29
HOLLIMON,WENDY $13.15
HOLLINGSWORTH,LAURA $45.87
HOLLINGSWORTH,PATRICIA S $6.38
HOLLIS,DARBY $8.66
HOLLOWAY,ASHTON J $6.49
HOLLOWAY,LETICIA $8.69
HOLMAN,KEITH L $25.53
HOLMAN,MICHAEL $8.26
HOLMAN,TIMOTHY $35.88
HOLMES,AARON A $11.41
HOLMES,BRUCE $58.78
HOLMES,CARL B $3.08



Name Allocation

Chugach recently mailed 2010 Capital Credit Allocation letters to its former members.  The letter stated an incorrect allocation 
amount on the letter.  If you received one of these letters, you may confirm the correct amount of your allocation by searching* 
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HOLMES,CASEY BRYANT $20.47
HOLMES,JENNIFER R $32.84
HOLMES,KIMBERLY $8.52
HOLMES,MARY L $81.14
HOLMES,MICHAEL $25.97
HOLMES,RODDRICK L $45.82
HOLMES,ROGER B $20.75
HOLMES,RYAN E $8.40
HOLMQUIST,CLIFTON $2.13
HOLOM,MICHELE $0.16
HOLOMSHEK,FRANK $15.53
HOLT,DELLA $0.43
HOLT,JEREMY R $4.95
HOLT,KAREN F $4.04
HOLTON,NOEL D $38.45
HOLTZMAN,DONNA K $30.70
HOLTZMAN,LARRY $18.95
HOLVOET,HEATHER $7.20
HOLVOET,JUSTIN MICHAEL $12.09
HOLWAY,DENNIS $21.35
HOLYFIELD,CLAY $10.60
HOMERDING,KRISTOFER R $13.09
HOMESTEAD,WILLIAM $3.94
HONEA,CHARLES E $63.05
HONEA,ROBERT $22.51
HONEA,RYAN $18.92
HONEYCUTT,ROBERT $2.25
HONEYCUTT,WILLIAM $16.43
HONG,ANDREW $13.46
HONG,OK J $11.49
HONG,SANG DUK $21.43
HONIG,BENJAMIN L $4.76
HONKOLA,DIANNA $21.78
HONKOLA,MATT $8.21
HOOK,TERRY E $179.72
HOOKS,JUSTIN R $1.42
HOOPER,MAYBELLE $57.80
HOOSIER,ERIC T $25.06
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3. Locate the Find tool button on the toolbar of the PDF reader (most commonly under the File menu bar). The Find tool button 
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HOOTCH JR,ALOYSIUS $19.51
HOOTCH,CHARLIE S $7.41
HOOVER,NICHOLAS LUKE $64.26
HOOVER,TIFFANY R $18.44
HOOVER,TIMOTHY $31.03
HOOYER,MICHAEL R $2.77
HOPE,CHRISTINE D $4.03
HOPKINS,ELGINA $16.12
HOPKINS,MARK $18.79
HOPKINS,MELEEKA $39.01
HOPPE,MARIA M $38.13
HOPSON,CLINTON $37.92
HOPSON,MOLLY R $4.89
HOPSON,MURIEL G $25.88
HOPSON,SARA $1.84
HOPSON,SARAH E $4.83
HOPSON-SUVLU,ABEL LEE $7.40
HORAZDOVSKY,ALLISON $11.15
HORDEMANN,FRANCES $2.04
HORN,BERNITA C $8.74
HORN,DAVID B $2.56
HORNBEAK,PAUL ANTHONY $18.74
HORNBY,DAWN $24.02
HORNBY,KEVIN $35.67
HORNE,CHARLOTTE $21.27
HORNE,JUSTIN $4.73
HORNI,JO $18.12
HORNING,JOELENE $9.61
HORST,ANITA R $76.52
HORTON,BECKY $11.42
HORTON,BEN $21.42
HORTON,JAMIE L $24.75
HORTON,POLLYANNA N $13.65
HORTON,TIA $33.84
HORVATIN,JULIA L $66.97
HORWITZ,ROBERT $21.68
HOSFORD,MICHELLE L $6.08
HOSKINS,JULIUS S $24.74
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HOSMAN,DALE $14.56
HOSTETLER,KATHRYN C $27.27
HOTCH,JASON L $26.74
HOTCH-HILL,WALTER $17.55
HOTI,NADINE B $29.79
HOTT,MURJANI $28.93
HOTVEDT,JUDITH ANN $8.99
HOUCK,JOHN $10.07
HOUGH,KELSEY $6.95
HOULLIS,DOUGLASS $1.29
HOUSER,RUSSELL K $1.19
HOUSER,SKIALA $14.87
HOUSTON,KEN $10.71
HOUTZ,SHANNON $23.33
HOVANEC,JUANITA $3.36
HOVANEC,SEAN MICHAEL $7.57
HOVIS JR,LOREN G $7.42
HOWARD II,MICHAEL $62.40
HOWARD W HANCOCK JR REVOC TRUS $81.64
HOWARD,AMBER ROSE $5.46
HOWARD,AMELIA D $14.38
HOWARD,AUSTIN $22.65
HOWARD,CHARLES $63.70
HOWARD,DANA $8.65
HOWARD,JOSEPH L $6.82
HOWARD,MARTY $32.92
HOWARD,NATASHA $17.51
HOWARD,RONICA LEANN $38.48
HOWARD,TARA D $20.10
HOWARD,THOMAS E $4.59
HOWARTH,CALEB $10.01
HOWE,JANE M $46.24
HOWE,TRAYCE $3.50
HOWELL,ANTHONY T $8.93
HOWELL,DORIS M $25.79
HOWELL,ELISHA J $1.78
HOWELL,HEATHER $30.08
HOWES,JESSIE $43.18
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3. Locate the Find tool button on the toolbar of the PDF reader (most commonly under the File menu bar). The Find tool button 
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HOWLAND,SEAN L $24.22
HOWLETT,BRYCE $4.40
HOXHA,SAMANTHA R $6.56
HOYT,KALEIGHT H $2.83
HOYT,NATHAN $16.47
HROVAT,DENIELLE L $2.85
HUANG,JASON $34.37
HUANG,SEAN H $10.19
HUBAUD,MATTHEW $7.55
HUBBARD,DANA M $11.26
HUBBLE,FAUNA $8.53
HUBER,BENJAMIN $7.69
HUBER,STEPHANIE $9.89
HUBER,TRACYE $48.38
HUBLEY,KIM E $58.38
HUBNER,CYNTHIA $8.11
HUCK,JOSHUA A $9.28
HUCKSTEP,SHARON E $11.42
HUDDLESTON,DEREK EDMUND $13.92
HUDDLESTON,JASON $7.23
HUDECEK,PAUL $3.62
HUDSON,ASHLEY M $11.55
HUDSON,CHRISTOPHER ASHLEY $30.72
HUDSON,DEANNA $1.25
HUDSON,KEVIN G $42.33
HUELIN,LISA $27.51
HUEZO,ERIKA X $7.03
HUFF,STEPHEN W $8.68
HUFFMAN,PATSY A $20.96
HUFMAN,JOSEPH D $44.22
HUGHES,BONNIE $20.41
HUGHES,CHRISTOPHER $9.40
HUGHES,DENNIS R $15.61
HUGHES,GARY M $26.50
HUGHES,JANE T $14.46
HUGHES,JOHN BRITON $35.27
HUGHES,JOHN C $26.35
HUGHES,PATRICK T $1.87
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HUGHES,RACHEL B $44.48
HUGHES,TYLER J $24.78
HUGHEY,RICHARD F $14.82
HUIZENGA,FELICIA $18.60
HULEBAK,ALICE $17.72
HULEN,DEBRA L $37.23
HULEN,MASON $6.38
HULIEN,TERRI K $46.91
HULL,JASON D $13.63
HULLOPETER,THOMAS D $22.10
HULM,MELINDA L $27.76
HULS,ALICIA MARIE $1.56
HULSTINE,AMANDA E $5.71
HULTBERG,JEFF J $48.85
HUMBERT,HERMAN P $16.10
HUMBLE,RON $4.98
HUMBLE,TRAVIS G $50.92
HUME,WILLIAM $38.64
HUMES,TODD CHRISTOPHER $11.89
HUMMEL,LAUREL $1.09
HUMPHERYS,TIMOTHY D $3.99
HUMPHREY,MEGHAN M $13.80
HUMPHREYS,JILLIAN $18.86
HUMPHREYS,RYAN $14.88
HUNEYCUTT,AARON $21.11
HUNGER,DONALD WILLIAM $39.97
HUNT,CHARLES K $21.11
HUNT,COURTNEY $8.81
HUNT,ERICA C $16.25
HUNT,HELEN E $2.24
HUNT,HOLLY K $8.00
HUNT,TRAVIS $1.86
HUNT,WAYNE $54.30
HUNTER FISHER TAXIDERMY $38.10
HUNTER,AARON SCOTT $52.41
HUNTER,DUSTIN E $3.99
HUNTER,KRYSTAL M $5.43
HUNTER,NATHANIEL A $1.57



Name Allocation

Chugach recently mailed 2010 Capital Credit Allocation letters to its former members.  The letter stated an incorrect allocation 
amount on the letter.  If you received one of these letters, you may confirm the correct amount of your allocation by searching* 
for your name in the list below.  

*There are three ways to search for your name:                                                                                                                            

1. Press CTRL plus F on your keyboard.  A FIND dialog box will appear on the PDF reader.

2. Click on the Edit menu, and locate-click the Find command.

3. Locate the Find tool button on the toolbar of the PDF reader (most commonly under the File menu bar). The Find tool button 
has the icon image of a pair of binoculars. Pressing the binocular icon will also result to the display of the Find dialog box.

HUNTER,NEIL $37.82
HUNTER,PHILLIP $3.39
HUNTER,SHELLY $19.65
HUNTER,URIAH D $7.52
HUNTER,VIRGINIA D $2.39
HUNTER,WILLIAM A $17.30
HUNTINGTON JR,HAROLD $8.65
HUNTINGTON,JOSEPHINE A $22.99
HUNTLEY,CURTIS SCOTT $36.58
HUNZIKER,JONG NYE $256.24
HURD,MICHAEL ANTHONY $20.89
HURD,STEPHANIE $8.84
HURD,VERA L $27.95
HURLBURT,JONATHON $16.45
HURLEY,DENISE H $10.15
HURN,MARQUITA E $30.51
HURSKAYA,DARYA $7.88
HURST,ALSION L $15.21
HURST,JEREMY $20.84
HURT,SHERRIE L $27.85
HUSKE,GERALDINE H $12.63
HUSSAIN,SYED $33.59
HUST,BRYAN R $16.03
HUSTAD,RIANN E $6.44
HUSTON,ERIC $13.11
HUSTON,LISA $10.93
HUTCHENS,CRYSTAL $9.40
HUTCHINS,ALEXANDRA $18.64
HUTCHINS,BARRY $58.71
HUTCHINS,PAUL M $19.52
HUTCHINSON,DAVID A $1.24
HUTCHINSON,RACHEL JANE $0.82
HUTCHINSON,SAMUEL O $14.22
HUTCHISON,TANYA $4.02
HUTTON,JAMES H $30.51
HUTTON,RICHARD E $39.79
HUTTUNEN,THOMAS R $17.14
HUYCK,ANDREA O $3.60



Name Allocation

Chugach recently mailed 2010 Capital Credit Allocation letters to its former members.  The letter stated an incorrect allocation 
amount on the letter.  If you received one of these letters, you may confirm the correct amount of your allocation by searching* 
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2. Click on the Edit menu, and locate-click the Find command.

3. Locate the Find tool button on the toolbar of the PDF reader (most commonly under the File menu bar). The Find tool button 
has the icon image of a pair of binoculars. Pressing the binocular icon will also result to the display of the Find dialog box.

HUZIEFF,SEAN R $16.30
HWANG,DAEICK $4.05
HWANG,GRACE $21.00
HYATT,KAREN $31.02
HYDE,ANGELA DAWN $34.99
HYDUKE,JENNIFER L $37.75
HYER,CHRISTOPHER $13.38
HYMAN,KYLER $42.95
HYRE,MICHAEL $40.89
HYUNG,MIN YU $12.63
ICEBREAKER FILMS LLC $303.71
ICHIHARA,CARMEN $26.21
ICI PAINTS $526.85
IDOM,VERSHAWN $26.55
IHDE,CHRISTINA $13.53
ILLMANN,STEVEN D $8.14
IM,SANG P $53.26
IMBO,ELIZABETH $0.24
IMDIEKE,SALLY L $82.22
IMHOF,DEBBIE L $4.54
IMLACH,HAILEY $5.82
IMOE,KAREN $14.55
IN,HUNG S $16.42
INCOME INVESTMENTS 2 $176.85
INDEPENDENT PILOTS ASSOCIATION $14.00
INFANTE,LINDA $14.24
INGALSBE,ELIZABETH NELLIE $6.03
INGERSOLL,PATRICIA $2.44
INGERSOLL,SHANNON R $21.31
INGHAM,JEFFERY $56.24
INGLE,LAUREN $8.67
INGLES,LUKE P $12.93
INGOLD,BRITTANY $13.41
INGOLD,JOHN M $24.27
INGRAM,ANDREW $138.33
INGRAM,BREANNA $12.81
INGRAM,CHARLES F $7.49
INGRAM,REBECCA L $13.32
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Chugach recently mailed 2010 Capital Credit Allocation letters to its former members.  The letter stated an incorrect allocation 
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3. Locate the Find tool button on the toolbar of the PDF reader (most commonly under the File menu bar). The Find tool button 
has the icon image of a pair of binoculars. Pressing the binocular icon will also result to the display of the Find dialog box.

INIS,GLENN M $33.02
INIS,WALTER G $32.35
INMAN,DUTCHY AJ $28.95
INMAN,JACOB M $9.61
INSALACO,MICHAEL EDWARD $44.21
INSLEY,PATRICIA $4.22
INTEGRATED LOGIC LLC $10.37
INTERNATIONAL AIRPORT LLC $470.99
INTERNATIONAL BRIDGE INC $97.16
INTERNATIONAL TROUT FISHING SP $2.37
IOANE,KORETTA M $13.94
IOSE,NUUULI P $34.18
IOSEFA,FULISIA $45.61
IRANY,LAURIE $2.99
IRBY,JANISE L $13.45
IRELAND,DANNY L $10.90
IRELAND,DONALD L $44.63
IRELAND,MICHELLE LEE $34.14
IREYS,JADE ANNEMARIE $59.46
IRISH,AVERY Z $13.48
IRONS,BRIANNE E $13.89
IRSIK,MARK D $14.40
IRVIN,LEONARD L $28.40
IRVING,DONALD M $65.10
IRWIN,FRANK $4.89
IRWIN,RACHEL $25.13
IRWIN,THOMAS P $33.98
IRWIN,VERONICA $52.34
ISAACSON,LISA $35.53
ISAAKO,IOLAMO $26.64
ISABELLA,TIMOTHY $24.56
ISAKSON,SHAWN R $37.58
ISBELL,KENDRA C $11.79
ISENBERG,BRANDON $18.32
ISENHART,AZALIA ELLIS $29.92
ISHIHARA,MICHAEL $21.70
ISLEY,ANGELA L $1.49
ISLEY,CHERYL A $31.54
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Chugach recently mailed 2010 Capital Credit Allocation letters to its former members.  The letter stated an incorrect allocation 
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2. Click on the Edit menu, and locate-click the Find command.

3. Locate the Find tool button on the toolbar of the PDF reader (most commonly under the File menu bar). The Find tool button 
has the icon image of a pair of binoculars. Pressing the binocular icon will also result to the display of the Find dialog box.

ISMAILOW,M ALI $28.03
ISRAEL,DAVID $10.68
ISRAEL,MALACHI B $12.86
IVAN,CATHERINE L $4.11
IVANOFF,IVY M $6.47
IVANOV,AME W $8.23
IVANOV,RACHEL S $9.61
IVERSON,JAMES P $8.55
IVERSON,JEFFREY $16.69
IVEY JR,CLIFFORD $7.96
IVY DAHLIN,DIANE $18.58
IYAHUK,MARY LOU $57.29
J D'S AUTO SHOP $91.70
JACK,DAWN M $36.86
JACK,LISA N $29.62
JACK,MICHAEL A $29.74
JACKSON HILL,ERIN $20.30
JACKSON,AMANDA $18.52
JACKSON,AMY $21.35
JACKSON,BETH J $81.42
JACKSON,CHARLES E $1.40
JACKSON,CHARLETTA $19.97
JACKSON,CHRISTOPHER $5.55
JACKSON,CHRISTOPHER R $8.31
JACKSON,CHUNNISEE $11.29
JACKSON,DANIEL LEWIS $8.95
JACKSON,DARRON B $39.63
JACKSON,JAMES $12.62
JACKSON,JUDITH D $1.56
JACKSON,KANIKA $5.06
JACKSON,MATTHEW D $5.41
JACKSON,MITCHELL $13.69
JACKSON,PEARL $9.62
JACKSON,SHINETHA SHANTA $16.16
JACKSON,TIMOTHY N $23.70
JACKSON,TIMOTHY W $4.35
JACKSON,TRACEY M $16.42
JACKSON,TYRA QUENAE $34.65
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Chugach recently mailed 2010 Capital Credit Allocation letters to its former members.  The letter stated an incorrect allocation 
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has the icon image of a pair of binoculars. Pressing the binocular icon will also result to the display of the Find dialog box.

JACOB,THOMAS G $17.53
JACOBS,JOHN K $28.90
JACOBS,MICHAEL $22.90
JACOBSON,JASON LOWELL $25.91
JACOBSON,KAYLEA M $17.26
JACOBSON,PATRICIA $14.10
JACOBY,CAROL L $17.13
JACQUES,TIMOTHY $22.55
JAEGER,LESLIE $7.22
JAIME,RHONDA $8.48
JAKSIC,NIKOLA $43.37
JALLOW,FATOU $19.12
JAMATTE-KELLY,WANDA $16.62
JAMES P SHELDON CO INC $319.39
JAMES,CHAD $5.82
JAMES,CHARLES R $35.81
JAMES,DEANNA M $12.95
JAMES,DORIS V $6.13
JAMES,ELIZABETH E $2.11
JAMES,ELIZABETH M $20.36
JAMES,ELLSWORTH $7.97
JAMES,KAYCE $5.78
JAMES,LESLEY GENE $11.41
JAMES,LORENDA P $2.79
JAMES,PATRICIA A $37.51
JAMES,ROSA L $28.53
JAMES,STEVE H $11.81
JAMES,THOMAS G $28.34
JAMESON,ANDREW $21.10
JAMESON,TIMOTHY J $14.57
JAMESTOWN,AMBER $18.98
JAMIESON,DEBORAH $6.47
JAMIESON,MEGAN L $41.01
JAMOUS,ABDULSALAM $1.07
JANES,MICHAEL R $59.63
JANES,STEVELINE T $13.66
JANKO,JAMIE A $11.53
JANKOWSKI,LESLIE A $12.99
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Chugach recently mailed 2010 Capital Credit Allocation letters to its former members.  The letter stated an incorrect allocation 
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has the icon image of a pair of binoculars. Pressing the binocular icon will also result to the display of the Find dialog box.

JANNECK,JODY $3.30
JANSSEN CONTRACTING CO INC $52.82
JANSSEN,CASEY J $20.30
JANSSEN,JESSE EDDEAN $12.45
JARIN-OCAMPO,ESTRELLITA $27.90
JARLSON,ANNA M $21.39
JARONIK,ANGELA L $11.37
JARRELL,ALFONZO $5.62
JARRETT III,WILLIAM DEXTER $25.67
JARRETT,PATSY $12.48
JARVI,KENNETH $44.58
JARVIS,NATHANAEL $21.65
JASPER,MACCARY $37.99
JAYNES,ANGELA MARIA $6.39
JEFFERIES,JOSEPH M $59.10
JEFFERS,JAMES $29.96
JEFFERS,RAY $17.98
JEFFERY,JERI $12.16
JEFFERY,MATHEW C $9.40
JEFFORDS,JESSICA M $11.39
JEFFREYS,SIDNEY L $6.94
JEFFRIES,JAN $38.93
JELINEK,KENNETH $0.10
JELLE,CAITLIN WALKER $6.53
JEMIN,MARY M $8.90
JEMISON,JOSEPH W $1.10
JEN,FON H $8.59
JENKINS,BEVERLY E $9.82
JENKINS,DONALD $61.64
JENKINS,EMILY ELIZABETH $22.80
JENKINS,JASON R $8.63
JENKINS,LUBBIE $35.26
JENKINS,RICHARD $49.13
JENKINS,SHILOH $18.11
JENKINS,VIDELLA B $35.48
JENNIGS,SUSAN P $18.20
JENNINGS,NICOLE $0.52
JENNISON,BRENT W $8.09
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Chugach recently mailed 2010 Capital Credit Allocation letters to its former members.  The letter stated an incorrect allocation 
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has the icon image of a pair of binoculars. Pressing the binocular icon will also result to the display of the Find dialog box.

JENSEN II,PHILLIP M $9.06
JENSEN,JULIE M $13.51
JENSEN,KRISTIN L $15.98
JENSEN,MARIE-LUISE $8.19
JENSEN,MICHAEL DALE $21.34
JENSEN,PATRICIA M $12.22
JENSEN,SEAN P $12.61
JENSEN,SHEREEN B $12.39
JENSEN,SUSAN $18.42
JEON,SUNGAH $31.28
JERICH,GREGORY A $5.48
JEROME,JUSTIN L $22.29
JERRY,ETHEL DENISE $21.21
JERUE,TERRI A $46.90
JESIC,LORA $1.41
JESSAL,AMANDA $16.01
JESSEN,DANIELLE $19.62
JESSEN,JULIE $17.58
JESSEN,STEPHANIE A $19.77
JESSOP,DANIEL E $40.38
JESSOP,JOSHUA L $5.90
JESSUP,ZAKIYA L $31.81
JESUIT VOLUNTEER COMMUNITY $77.27
JETTON,MARGARET $30.19
JEWELL,KEVIN R $21.73
JEWELL,MARCUS $15.24
JEWELL,SUSAN C $26.15
JIM,MARIETTA $19.82
JIM,MARLENE $3.76
JIMENEZ,CARMEN $17.32
JIMENEZ,PABLO $13.74
JINES,COURTNEY L $9.51
JINKS,CHARLES $40.26
JNO-LEWIS,JASON MARCELINO $11.34
JOE,PAULA $7.53
JOHANSEN,CHERIE S $11.88
JOHANSON,MELVIN D $5.75
JOHANSSON,LEO $38.15
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has the icon image of a pair of binoculars. Pressing the binocular icon will also result to the display of the Find dialog box.

JOHN DEER LANDSCAPES $41.89
JOHN M/IDA ASPLUND FAMILY TRST $106.11
JOHN,AGNES $31.51
JOHNNIE,BERT A $27.38
JOHNS,MICHAEL $32.22
JOHNS,NORMAN T $39.59
JOHNSON III,OSCAR L $12.13
JOHNSON,ALAN VERNON $5.99
JOHNSON,ALLISON M $5.90
JOHNSON,AMBER LEA $13.60
JOHNSON,AMY R $16.87
JOHNSON,ANDREA $4.11
JOHNSON,ANNETTE K $19.75
JOHNSON,ARACYA R $9.43
JOHNSON,ARIEL A $4.18
JOHNSON,BIRGET L $21.10
JOHNSON,BRENNON D $6.28
JOHNSON,BRENT $19.46
JOHNSON,BRIAN KEITH $6.19
JOHNSON,BRITTANY $2.78
JOHNSON,BUTCH $3.00
JOHNSON,CHARLES C $1.48
JOHNSON,CLINTON W $15.38
JOHNSON,CRYSTAL L $13.59
JOHNSON,CYNTHIA D $32.73
JOHNSON,DAKOTA $14.47
JOHNSON,DAMON J $0.50
JOHNSON,DARIUS P $13.60
JOHNSON,DARLENE M $23.46
JOHNSON,DAVID L $13.68
JOHNSON,DAVID WALTER $46.51
JOHNSON,DAVID WILLIAM $52.13
JOHNSON,DEAN O $30.65
JOHNSON,DEBORAH $6.67
JOHNSON,DEBORAH E $16.17
JOHNSON,DERRICK AUSTIN $6.87
JOHNSON,DIANE W $23.12
JOHNSON,DOUGLAS L $6.36
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Chugach recently mailed 2010 Capital Credit Allocation letters to its former members.  The letter stated an incorrect allocation 
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has the icon image of a pair of binoculars. Pressing the binocular icon will also result to the display of the Find dialog box.

JOHNSON,EMMA JANE $19.69
JOHNSON,HUBERT D $45.34
JOHNSON,JACQUELINE I $16.27
JOHNSON,JALANIE FAYE $28.50
JOHNSON,JAMES W $21.01
JOHNSON,JAY M $3.12
JOHNSON,JEFFREY L $9.20
JOHNSON,JENELLE $7.24
JOHNSON,JENNIFER L $16.32
JOHNSON,JERMAINE B $43.05
JOHNSON,JONATHAN DENNIS $21.94
JOHNSON,KARI M $22.89
JOHNSON,KAZ M $48.58
JOHNSON,KEITH L $24.99
JOHNSON,KELSEY D $49.96
JOHNSON,KENNETH E $19.10
JOHNSON,KENNETH L $16.52
JOHNSON,KIRBY L $80.43
JOHNSON,KRISTA $41.27
JOHNSON,KRYSTINA $16.58
JOHNSON,KYLE R $54.61
JOHNSON,LAURIE M $14.86
JOHNSON,LEROY L $40.52
JOHNSON,LEWIS T $5.26
JOHNSON,LISA A $9.51
JOHNSON,MADA SUE $31.31
JOHNSON,MARC $1.34
JOHNSON,MARK $30.26
JOHNSON,MARK A $2.71
JOHNSON,MARK D $38.58
JOHNSON,MARK J $37.20
JOHNSON,MARLENE $25.90
JOHNSON,MARY E $1.28
JOHNSON,MARY S $0.49
JOHNSON,MARYANN $9.27
JOHNSON,MATTHEW I $53.89
JOHNSON,MAYDEEN R $9.46
JOHNSON,MAYRA J $23.67
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has the icon image of a pair of binoculars. Pressing the binocular icon will also result to the display of the Find dialog box.

JOHNSON,MICHAEL D $12.02
JOHNSON,MICHAEL L $1.74
JOHNSON,MICHAEL S $16.45
JOHNSON,MICHELLE MARIE $21.87
JOHNSON,MIRANDA $32.10
JOHNSON,NICHOLAS R $3.82
JOHNSON,NICOLE $52.65
JOHNSON,NICOLE M $16.31
JOHNSON,NORMA M $50.71
JOHNSON,PHILLIP A $10.36
JOHNSON,RACHEL $29.80
JOHNSON,RANDY $3.78
JOHNSON,RANDY J $4.72
JOHNSON,RASHAD D $11.01
JOHNSON,RICHARD HOLLIS $46.54
JOHNSON,RYAN M $5.99
JOHNSON,SAJNE G $18.41
JOHNSON,SARAH E $21.56
JOHNSON,STEPHEN W $12.62
JOHNSON,STEVEN M $33.54
JOHNSON,SUSAN J $24.11
JOHNSON,SUSAN M $22.47
JOHNSON,TOMMY L $9.97
JOHNSON,TROY LEE $40.74
JOHNSON,TYRONE D $39.11
JOHNSON,VIRGINIA M $10.11
JOHNSON,WARREN N $28.06
JOHNSON,WILLIAM $17.01
JOHNSON,WILLIE $4.57
JOHNSON,ZACHARY $10.04
JOHNSON,ZELMA $5.63
JOHNSON-BATAC,JAMIE $5.88
JOHNSTON,ANNA M $12.04
JOHNSTON,HELEN R $25.46
JOHNSTON,JUDY L $10.64
JOHNSTON,KIMBERLY $15.17
JOHNSTON,MARJORIE $18.43
JOHNSTON,MATT S $21.88
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has the icon image of a pair of binoculars. Pressing the binocular icon will also result to the display of the Find dialog box.

JOHNSTON,SARAH M $25.41
JOHNSTON,SHAWN $35.98
JOHNSTON,WILLIAM $22.69
JOHNSTONE,IAN KEITH $0.99
JOHNSTONE-VINCENT,SUZETTE $7.45
JOINSON,ERIC P $7.66
JOKIEL,SUSAN M $10.12
JOLIBOIS,JON $0.54
JOLICOEUR,JENNIFER L $7.16
JOLICOEUR,ROBERT E $11.49
JOLLEY,ERICA $36.05
JOLLEY,MICHAEL G $23.21
JOLMA,DAVINA $44.68
JOLMA,KARI J $7.43
JONAS,BROOK N $1.51
JONES JR,RICHARD D $42.35
JONES,ADELINE A $41.37
JONES,AGNES A $52.88
JONES,ALANA $11.20
JONES,ALFRED P $74.00
JONES,ANDREA B T $46.06
JONES,CANDI R $1.02
JONES,CATHERINE J $35.26
JONES,CHRISTOPHER T $33.79
JONES,CORY $5.32
JONES,DAVID E $15.55
JONES,DAVID MATTHEW $2.93
JONES,DAVID R $9.20
JONES,DAWN D $21.38
JONES,DEBRA A $26.83
JONES,DENNIS ANDREAS $39.75
JONES,DEVON J $24.59
JONES,DWIGHT D $17.64
JONES,GEORGE W $34.58
JONES,GERALD E $26.68
JONES,JACOB JOSEPH $27.28
JONES,JAIME S $29.13
JONES,JAKEIRA D $6.15
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has the icon image of a pair of binoculars. Pressing the binocular icon will also result to the display of the Find dialog box.

JONES,JAMES MARTIN $9.45
JONES,JASON S $3.33
JONES,JAWAN M $56.44
JONES,JENNY M $37.70
JONES,JEREMY A $27.42
JONES,JEREMY M $35.51
JONES,JERID L $21.09
JONES,JOSHUA R $14.98
JONES,JUANITA $33.46
JONES,KERRY D $33.59
JONES,LAKIMYA D $23.51
JONES,LARRY D $43.48
JONES,LAURA $5.06
JONES,LESLIE $1.94
JONES,LEVELIN $53.24
JONES,MALEIKA $5.10
JONES,MARCHE $1.10
JONES,MARIE $16.55
JONES,MARISSA A $26.86
JONES,MARVIN $20.47
JONES,MARVIN L $45.44
JONES,MARY C $49.31
JONES,MELISSA  A $20.59
JONES,PATRICIA A $7.70
JONES,ROBERT W $44.97
JONES,RYAN $21.50
JONES,SEAN MICHAEL $34.72
JONES,SHAUN $62.12
JONES,SUSAN ANNE $33.54
JONES,TANIKA $8.10
JONES,TARA MARIE ROSE $7.80
JONES,TROY LESLIE $3.06
JONES,TYLER P $6.36
JONES,VIEANNA $25.43
JONES,VIVIAN A $38.93
JONES,WENDY L $21.85
JOOSTEN,KATHERINE ANN $1.50
JORDAN,JACOB ANDREW $7.89
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JORDAN,JOSHUA $46.78
JORDAN,KARI $51.07
JORDAN,TIFFANY L $30.40
JORDEN,LINDA $12.06
JORDET,IRENE ELLEN $8.23
JORDON,NICHOLAS L $35.97
JORGENSEN,GENE $9.29
JORGENSEN,MAKENZIE D $21.83
JORGENSEN,PETER O $10.57
JORGENSEN,SARA A $25.84
JOSEPH,MELISA S $40.65
JOSEPH,REGGIE P $31.61
JOSH,JANINE MAREE $18.15
JOSPEH,WILFRED $10.37
JOST,ERICK $39.48
JOSTEN-SEARCY,MELVIA J $9.31
JOVANOV,NADA $9.30
JOVANOV,RADENKO $26.19
JOY,CATHLEEN $9.95
JOY,CHARLES K $25.18
JOY,GARY R $20.86
JOYNER,JON H $9.17
JU,YANG MYOUNG $30.89
JUAREZ,KARIN  M $9.28
JUDD JR,JOHN $2.54
JUDD,TAMMY $16.42
JUETTNER,ROBERT $19.69
JULIEN,JOE $35.50
JULIUS,HAZEL $32.61
JUMP,DARYL $0.95
JUMPS,SATONYA $6.65
JUNE,HELEN J $21.46
JUNG,KYUNGWON $20.86
JUNKER,KALI ANNE $56.51
JURADO,RAY J $10.95
JUSTINIANO,ANNA $20.41
JUSTUS,ELIZABETH $28.60
KABAYA,PAMELA J $15.04
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KACZOR,APRIL L $20.44
KADISCH,WILLIAM N $7.03
KADRIU,NUREDIN $3.88
KADRIU,PEME $15.11
KADRIU,SHAIP $4.80
KAFLE,HARI $13.14
KAGAK,MARY R $34.71
KAH,SAMBA $15.36
KAHALIOUIMI,KAMIKO $8.66
KAHANANUI,DANA MOKIHANA $41.54
KAHLSTROM,DORA $45.93
KAHLSTROM,HEATH $73.81
KAHUTAK,DARRELL $9.69
KAIRAIUAK II,CHARLIE G $34.20
KAIRAIUAK,PHILLIP E $19.31
KAISER,BLAIR I $2.17
KAISER,HENRY $6.72
KAJIWARA,LINDA B $23.20
KALANICK,ANISHIA $10.26
KALETKA,JAMES $32.13
KALINA,DIANE $7.83
KALININ,NATALIYA M $4.83
KALININ,TATYANA $19.12
KALKOWSKI,MELODY $6.78
KALLANDER,KRISTY L $29.61
KALLANDER,KRISTY L $5.45
KALLANDER,LISA C $48.45
KALLMAN,CHARLES $41.58
KALMAKOFF SR,HARRY $15.89
KALMAKOFF,ANITA $47.19
KALMAKOFF,ARNOLD J $26.95
KALMAKOFF,JANET LEE $14.94
KALMAKOFF,JOLENE $33.73
KALOA,MARCO $37.09
KALPAKOFF JR,DENNIS $22.12
KALT,ASHLEY B $9.50
KALT,CODY $6.82
KAMEROFF,ANGEL $15.64
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KAMEROFF,CAROLYN M $19.90
KAMEROFF,SIERRA $3.96
KAMEROFF,WASSILIE $40.96
KAMEROFF,ZACHARIAH F $6.51
KAMINAGA,NAOYA $21.63
KAMP,ZACHARY ROBERT $28.71
KAMSTRA,RICHARD $2.89
KANE,DANA J $20.79
KANE,VANESSA $14.45
KANG,HOON $26.15
KANG,KI D $6.36
KANG,KYOO BOK $13.32
KANG,MICHA $2.55
KANGAS,JUDY ANNETTE $29.02
KANIA,JOSHUA $1.33
KAPLAN,CHRIS S $0.18
KAPLE,MATTHEW $20.20
KAPOLCHOK,JENNIFER M $1.63
KAPP,CHARLES $20.88
KAPPEL,ERICA $23.45
KAPPLER,RUBEN E $39.31
KARABEL,CHAD M $16.89
KARAGINIDES,REYNA ISABEL $21.95
KARASTI,CHALSIE $6.40
KARIAINEN,ERIK $41.13
KARLING,TIFFANY $14.11
KASAK,AGNES $30.70
KASAYULIE,MARK TRAVIS $17.77
KASER,GREG D $21.69
KASHEVAROF,NORMAN $24.06
KASHEVAROF,SHARON S $51.32
KASPER,DEGEN $4.88
KASSNER,BRITTANY $13.09
KASSUBE,DEAN A $32.97
KASTELER,SANDY $14.48
KASTERIN,SASHA R $18.41
KATARAKA,PATRICK $10.76
KATCHATAG,CINDY $14.36
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KATHLEEN'S CREATIVE CATERING $6.72
KATHMAN,VALERIE $32.18
KATIB,JOSHUA $4.31
KATTELL,TRICIA $6.24
KATZ,RALPH M $21.85
KATZKE,MARY R $21.44
KAUFMAN,JACOB $19.77
KAUFMAN,NICHOLAS D $31.79
KAUFMAN,TIMOTHY $14.81
KAUKE,KALENA M $26.44
KAUTHEN,CHARLES A $30.30
KAVANAUGH,MATTHEW T $2.79
KAWAGLEY,TAMAREE $26.49
KAWAGUCHI,BRYCE KIICHI $12.37
KAWAGUCHI,KIMBERLY $3.64
KAY,KARLI M $11.01
KAYE,LINDA $7.92
KAYODE,BENJAMIN A $22.04
KAYOTUK,FELCIIA RENEE $12.60
KAYSER,ADAM R $19.87
KAZIMIROWICZ,MATILDA $12.05
KEAN,ABIGAIL $33.28
KEARNS,DAWN M $25.25
KEARNS,LAURA L $12.26
KECKLER,SHERI $4.18
KEE,CLARINA $12.46
KEECH,MICHAEL L $124.51
KEEF,MARTY C $16.32
KEEFE,CARYLE $24.07
KEEFE,CINA $8.81
KEEGAN,MARK F $42.42
KEEGAN,STACY $29.11
KEEHR,GORDON $5.32
KEEL,EVA $19.88
KEEL,GARY C $36.66
KEEL,MICHAEL $14.95
KEELAN,DANIEL J $36.49
KEELER,PAUL $5.16
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3. Locate the Find tool button on the toolbar of the PDF reader (most commonly under the File menu bar). The Find tool button 
has the icon image of a pair of binoculars. Pressing the binocular icon will also result to the display of the Find dialog box.

KEEN,MATTHEW A $36.76
KEENAN,THOMAS $34.15
KEENER,JACOB JOSEPH $3.27
KEENEY,JEROME A $33.67
KEENHOLD,CHARLES $31.01
KEENHOLD,JACOB $14.77
KEENOM,CRAIG L $17.83
KEESE,LISA D $22.50
KEESLING,THANIEL L $1.41
KEGLEY,ROGER R $30.69
KEHLENBACH,LUANN $13.53
KEIJSER,JOHANNES $4.48
KEINER,BOB $18.87
KEITH,DEBBIE G $31.64
KEITH,GOLDA J $6.60
KEITH,KATHERINE $10.93
KEITHLEY,SHANNON L $21.09
KELESY,RONALD L $12.24
KELLER,CHRISTINA $3.70
KELLER,CHRISTOPHER DONALD $24.15
KELLER,DANIEL THOMAS $10.11
KELLER,DAVID J $21.18
KELLER,F H $41.03
KELLER,JAMIE M $4.40
KELLER,JI $7.59
KELLER,NINA F $70.16
KELLER,SHANE L $28.54
KELLER,WILLIAM J $0.52
KELLERMAN,FAITH C $2.96
KELLERMAN,JEFFRY MELBERT $51.11
KELLEY JR,PAUL A $3.44
KELLEY,BILLIE $33.14
KELLEY,CASSEY $2.08
KELLEY,DALE R $67.31
KELLEY,JONATHAN $36.49
KELLEY,LEN $4.99
KELLEY,RHONDA $5.72
KELLEY-HERRON,REBECCA $55.96



Name Allocation

Chugach recently mailed 2010 Capital Credit Allocation letters to its former members.  The letter stated an incorrect allocation 
amount on the letter.  If you received one of these letters, you may confirm the correct amount of your allocation by searching* 
for your name in the list below.  

*There are three ways to search for your name:                                                                                                                            
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KELLOGG,CHARLOTTE $19.56
KELLOGG,JOHN G $54.92
KELLSO,SHILAH D $23.27
KELLY II,JOSEPH $20.15
KELLY,CURTIS $7.00
KELLY,DANNY G $21.75
KELLY,DOUGLAS J $5.70
KELLY,EDWARD L $47.17
KELLY,JOHN P. $17.01
KELLY,JOYCE ANN $17.80
KELLY,PAUL R $8.24
KELLY,REBECCA $3.96
KELLY,SHERRY V $38.54
KELLY,VIRGINIA P $1.58
KELM,ERIC $15.55
KELONE,JOYCE M $20.28
KELSCH,NICKOLAS THOMAS GEORGE $23.13
KELSEY,ELLEN C $6.73
KEMNITZ,JACOB $33.40
KEMPEN,DOMINIQUE $23.35
KEMPTHORNE,CHRISTINA $3.19
KENAI PENINSULA BOROUGH $5.89
KENDALL,EDITH $13.11
KENDALL,JARRID $37.68
KENDALL,JEFFREY N $4.80
KENISON,DENETTE M $3.51
KENLEY,LOUIS C $36.44
KENNECOTT EXPLORATION CO $16.46
KENNEDY,CHRIS L $6.48
KENNEDY,ELIZABETH PAGE $41.88
KENNEDY,JAMES F $0.94
KENNEDY,KARL B $6.08
KENNEDY,LON M $40.36
KENNEY,MICHAEL J $3.27
KENNON,BRAD S $12.06
KENNON,LYNDON $10.59
KENNY,JOHN S $9.86
KENNY,RYAN $8.15
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KENSHALO,RACHEL M $13.60
KENT,ANNA E $0.93
KENT,BEN $51.41
KENT,KRYSTAL K $37.62
KENT,NATALIE ERIN $11.79
KEOGH,ROBIN JEAN $35.64
KERN,JESSE S $3.90
KERNS,SANDRA J $18.75
KERR,CATHY $2.26
KERR,JOSHUA $16.67
KERR,KAREN M $14.29
KERR,ROBERT LEE $17.52
KERR,TIMOTHY S $5.58
KERSBERGEN,MAX $18.98
KERSTETTER,JASON $31.05
KESLER,JUDY $18.84
KESSACK,PETER J $9.62
KESSNER,LINDA $9.73
KESTER,PRESTON $3.20
KESTING VETERINARY SERVICES $35.01
KETCHAM,PEGGY J $26.99
KETCHUM,JUDY $10.70
KETCHUM,MEGAN P $11.30
KETTERER,EDWARD R $68.75
KETZLER JR,ROGER E $27.11
KETZLER,DERICK E $14.41
KETZLER,ROGER E $48.91
KEVILLE,KATHI $17.88
KEWAN,DEANNA $8.34
KEYS,KARYN $14.21
KEYS,MICHAEL F $33.86
KHAN,IMRAN $3.31
KHENDEK,ALYSIA C $4.37
KHOTESOUVAN,BAY $25.60
KHOTESOUVAN,JOE $13.02
KIANA,LARRY $15.96
KIBLER,RODNEY $5.71
KICHURA,STEPHEN $13.95
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KIDD,JOHN K $15.20
KIDDELL,KATHLEEN M $26.84
KIECKBUSCH,KYLE $33.38
KIEFER,PAUL $42.97
KIEFER-ODONNELL,RICHARD A $14.53
KIEHN,BRADLEY $15.81
KIERNAN,WILLIAM F $16.80
KIESE,MICHELLE L $5.22
KIESTER,RYAN L $2.26
KIGURADZE,OLGA $6.57
KIHN,LAURA M $72.15
KIKUCHI,ANDREA L $41.21
KILDAIRE,MICHAEL $3.10
KILELEMAN-POWERS,LUCIA $20.95
KILGORE,MICHAEL L $7.09
KILLEBREW,CRYSTAL $5.73
KILLEBREW,ROBBIN L $14.08
KILLION,THEA $7.88
KILLORAN,MEGAN $34.68
KILPATRICK,CONNIE $19.12
KIM,ANNA CHOE $33.55
KIM,CHONG BAE $12.53
KIM,CHONG S $46.62
KIM,DEAN S $16.89
KIM,HEE YONG $7.73
KIM,HEECHUL $26.27
KIM,HYOUNG $12.06
KIM,JOSHUA Y $21.85
KIM,KI PYUNG $2.47
KIM,KWANG SUK $1.00
KIM,MICHAEL CT $7.07
KIM,PETER SEONG $19.94
KIM,PONG CHAE $40.39
KIM,PONG K $2.84
KIM,SANG SEOK $27.83
KIM,SHANNON $39.30
KIM,SUN TAI $12.35
KIM,TONY $64.82
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KIM,VERONICA $9.31
KIM,YOOJIN $63.39
KIM,YOUNG SOOK $3.60
KIMBALL,LAWRENCE H. $10.70
KIMBERLIN,THOMAS L $6.45
KIMBLE,DAVID G $20.76
KIMES,CHRISTOPHER $16.71
KIMMEL,MARTIN A $6.54
KIMMEL,RHYS $4.15
KIMMET,MEGAN $15.51
KIMOKTOAK,DARRELL D $7.25
KIMURA,MASAHIRO $3.68
KINCAID,HOLLY ANN $5.14
KING OF CLUBS LLC $58.29
KING,AUSTIN S $14.50
KING,BRETT ROBERT $3.38
KING,BYRON $22.89
KING,CHRIS $30.93
KING,CHRISTOPHER $4.04
KING,DANIELLE $4.20
KING,DEBORAH $16.88
KING,DONNA G $40.70
KING,GUSSIE T $4.43
KING,JACK A $3.58
KING,JILL L $11.86
KING,JOSHUA R $8.90
KING,KISHON J $7.13
KING,L JO $2.66
KING,PATSY L $57.43
KING,PATTI M $52.90
KING,RICHARD ALDEN $0.51
KING,SAMUEL $15.63
KING,SHANNON R $5.48
KING,SHIRLEY M $26.66
KING,TERRI $95.55
KINGERY,JERRY $49.99
KINGERY,JOEL $14.23
KINGRASAPHONE,SUI $62.09
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KINGRASAPHONE,SUI $50.47
KINGSFORD,CHAD $24.02
KINGSLIEN,PAMELA $5.83
KINI,KAMUELA $16.01
KINNE,TRAVIS $14.95
KINNEY,ASHLEY D $15.13
KINNEY,KRISTIN A $5.81
KINNEY,THOMAS $15.57
KINSCH,PETER K $7.20
KINSEY JR,TED M $7.97
KINSEY,JEFF $36.02
KINSEY,ROY LEE $13.72
KINZEL,ALFRED E $24.24
KINZEL,JEFF $3.34
KIRCHNER,ZONG X $13.99
KIRGIS,CASEY D $36.92
KIRGIS,MICHAEL $31.76
KIRK,DAVID $17.22
KIRK,LEONARD F $47.07
KIRK,PATRICIA $31.57
KIRK,RICHARD L $10.44
KIRKMAN,CASSANDRA $8.29
KIRKMAN,KIMBERLY $1.94
KIRKPATRICK,KYLIE $7.30
KIRKPATRICK,WILLIAM $9.45
KIRSCHNER,KHRISTINA L $6.95
KISOR,GREG $44.51
KISSELL,ALFRED J $1.74
KISSINGER,DAVID $0.93
KIST,CHRISTOPHER $6.21
KISTNER,JEFFREY A $17.67
KITAHARA,YOKO $10.26
KITCHENS,DAVID J $6.86
KITE,JEFFERY LYNN $9.06
KITIONA,TAVANA $12.59
KITTREDGE,BONNIE A $26.83
KIUCHI,STEVEN $8.15
KIUNYA,NELLIE C $52.08
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KIYAN,NOBU RALPH $0.34
KIYUTELLUK,ARLENE $12.11
KIYUTELLUK,GERALDINE $3.73
KIZER,BOB $17.05
KLAASEN,STEVE $58.06
KLADKHEMPETCH,SARINNA $46.76
KLAMER,STACEY $3.72
KLANN,KEVIN S $18.22
KLASWICK,ROBERT $9.35
KLEAN,KYLE $8.30
KLEIDOSTY,D-ANN M $27.33
KLEIN,SCOTT $17.75
KLEINERT,STEFON E $4.22
KLEMAN,ROBERTA L $18.52
KLEMOVITCH,WILLIAM S $38.70
KLEPZIG,ANDREA L $12.08
KLEWENO,ELIZABETH A $20.89
KLEY II,ROGER G $64.92
KLEY,JOSEPH J $47.12
KLIMOFF,SARAH H $17.15
KLIMP,ABBIE $10.61
KLINE,KEITH P $15.05
KLINE,MARK T $25.26
KLINEFELTER,KEVIN $7.16
KLINEFELTER,MARY LYNN $20.89
KLINGER,JAY $1.50
KLINGER,LISA $21.60
KLINGER,RYAN P $0.23
KLINKHARS,GLEN $36.16
KLIPPEL,BRITTANY E $8.15
KLOECKER,KIMBERLY $10.53
KLOEPFER,ROCHELLE MARIE $27.90
KLOTT,KEVIN $7.14
KLUNDT,MATTHEW J $3.72
KLUNE,LOUISE S $25.05
KMIECIK,BETHANY $12.44
KMS CONSULTING ENGINEERS $40.29
KNACKERT,KRISTIN $6.79
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KNAPP,ANNA G $15.39
KNAPP,DAVID R $17.50
KNAPP,PHILIP $34.05
KNAPP,TIMOTHY A $13.90
KNAPPMILLER,DAN $33.32
KNAUF,GRANT M $6.07
KNEER,WILLIAM CLARK $2.24
KNICELY,LEE $21.56
KNIGHT,GEORGIA $22.80
KNIGHT,GORDON W. $12.39
KNIGHT,JOEL $12.18
KNIGHT,L H $15.35
KNIGHTON,REBECCA A $13.09
KNIPE,FRED A $65.43
KNIPP JR,LOWELL M $4.26
KNODE JR,GARY LEE $6.26
KNODE,HEIDI M $31.88
KNOEDLER,NORMAN D $19.06
KNOEDLER,REBECCA M $1.74
KNOPP,LUCINDA $10.83
KNORR,KRISTINA H $6.19
KNOWLES,RACHEL $5.82
KNOX,FELIX $22.85
KNOX,ROSANNE C $1.60
KNUCKEY,SARAH $14.39
KNUCKLES,LISHA M $17.99
KNUE,JOHN F JR $28.08
KNUTSON,KENT $10.65
KNUTSON,NICOLE $3.62
KNUTSON,SHERI $9.87
KNYAZEV,ALEKSEY VLADIMIROVICH $8.42
KO,HARRY S $38.91
KOCH,CYNTHIA L $1.41
KOCH,SHERRI L $41.47
KOCHETOVA,IRINA LEONIDOVNA $12.93
KOEFF,KYRA M $31.35
KOEHLER,PAMELA $11.35
KOEHLER,RUTH $9.77
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KOEKKOEK,CONNIE $0.75
KOELZER,VERONICA $7.44
KOENIG,JOHANN S $13.36
KOENIG,SHIRLEY A $19.45
KOERPER,PAUL D $20.01
KOERSCHGEN,TONYA $23.56
KOETTING,STEPHEN $24.20
KOFFARD,SHELBY $14.33
KOHLER,DOROTHY L $21.39
KOHLER,JASON T $3.86
KOHLIN,JERI $14.39
KOITZSCH,TERRY $3.52
KOJI,KATHY $9.61
KOKEOK,ANNIE M $12.37
KOLB,DANA $29.26
KOLESKY,MATTHEW B $55.80
KOLIPANO,MICHAEL $11.21
KOLLER,IVY M $16.78
KOLOWINSKI,CHAD EUGENE $5.82
KONECKI,MARK L $13.60
KONECKY,SABRINA L $25.32
KONIGSBERG,CHARLES $17.69
KONIK,COREY $23.10
KONJUHI,FLORIJE $47.50
KONJUHI,NAIM $15.27
KONO,KAREN $24.50
KONRAD,BARBARA $30.52
KONRAD,KEN $19.96
KONSOR,JED $20.79
KOONOOKA,ASTA $21.41
KOONS,REBEKAH $12.17
KOONTZ,RAELEEN LANETT $14.03
KOONTZ,RODEL $3.50
KOPACH,BRANDON S $9.69
KOPACZ,KEVIN PAYONE $24.51
KOPECKY,PAUL $44.38
KORN,LEIGH A $11.77
KORN,MARY K $10.15
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KOROPP,JOHN $35.09
KORTE,JOSHUA E $27.95
KORTE,MICHAEL G $13.14
KORTE,THOMAS $38.95
KOSINSKI,ALICIA MAY $6.62
KOSINSKI,CHRIS R $2.04
KOST,LOUIS $22.58
KOSTAREVA,NATALIYA $8.72
KOSTEN,ESTHER $54.26
KOSTER,ANDREW P $1.34
KOSTIEW,HANNAH G $29.87
KOSZCZEWSKI,NICKOLE H $22.10
KOTTRA,GAIL B $6.64
KOUSEN,CORINA $34.78
KOVACEVICH,TERRY J $10.51
KOVACHICH,MICHELLE T $11.82
KOVAL,DONALD W $10.60
KOWALSESKI,KIMBERLY M $7.81
KOWALSKI,JARED $40.31
KOWATCH,ROBERT M $1.13
KOWUNNA,CLARA $3.88
KOZLOWSKI,MATTHEW $17.29
KOZUB,JEREMY R $10.42
KRAEMER-SPROIT,CAROLE A $12.05
KRAFT,CHERYL L $26.08
KRALICK,COREY N $17.49
KRAMER,MATHEW D $30.58
KRAMER,TED $25.93
KRAPFL,SHANNON $33.53
KRAUS,LOGAN C $35.57
KRAUSHAAR,LINDA E $26.44
KRAWCHENKO,TANIA $14.72
KREBS III,JOHN P $38.50
KREBS,STEPHANIE $10.84
KREH,LAREEN $15.97
KRESS,LESTER F $17.43
KRETSCHMER-DUNN,ALANNA $15.16
KRIDER,MONA $43.72
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KRIST JR,MARK W $8.33
KRISTIAN,SAMUEL J $45.53
KRITZ,MARCELLA $5.53
KROENING,JUSTIN D $7.82
KROH,ERIC $3.88
KROHN,SHELLY L $8.78
KROLIKOWSKA,ALEXANDRA $39.39
KROLL,CAROLINE L $24.88
KRON,BETSY P $25.21
KRON,JEFFREY A $26.25
KROPIDLOWSKI,DALE $8.57
KROSS,SARA $2.81
KROTO,DAVID L $17.84
KRUEGER,AUDREY $4.39
KRUEGER,BRIGETTE L $5.47
KRUGER,DAWNA J $10.20
KRUGER,LESLIE $10.88
KRUGER,NICHOLE $25.10
KRUPA,CLAUDIA V $1.84
KRUSE,SARAH M $10.24
KRUSELL,MICHAEL $30.13
KRUTH,BETSY G $37.88
KUBLY,KATRINA $16.10
KUBO,HIROSHI $22.53
KUBOSH,DERRICK $18.08
KUCERA,GREGORY BLANE $21.09
KUCINSKI,R M $52.44
KUDRNA,TRAVIS $39.16
KUEHN,STEPHANIE B $17.66
KUHARIK,SONG $6.95
KUHL,ZACH $29.61
KUHN,KAREN $24.87
KUIPER,TY $25.62
KUIPERS,ERIC J $33.48
KUK,HUI JU $11.46
KULA,PAMELA C $7.79
KULICK,MICHAEL P $0.50
KUMAR,KUNCHAM V $27.82
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KUMAR,SARWESH $12.72
KUMPULA,ROBERT $39.01
KUNAYAK JR,JUSTINA MABEL $5.30
KUNLE,DAVID $9.62
KUNTZ,MICHAEL $21.53
KUPCZYK,ALICIA $38.94
KUPER,CHRISTOPHER $23.16
KUPIEC,DAVID $52.54
KURCHINSKI,JANELL D $11.16
KURHAN,BRIAN $4.07
KURKA,JONATHAN $19.30
KURLAND,KEITH D $4.29
KURTH,BETH E $3.61
KURZ,JOHN E $9.39
KURZWEG,ERICH $4.47
KUSTER,TODD $8.00
KUTCHINSKI,VALICIA M $8.56
KUTLESA,MARK $29.34
KUTUK,JANIE LYNN $27.63
KUZNICKI,SHIRLEY $38.63
KVARFORD,TRACY $74.37
KVASAGER,MELODY K $4.62
KVERNPLASSEN,ERIK $3.97
KWAG,HEE $15.11
KWAK,YONG JU $12.11
KWON,JUNG DO $30.63
KYLE,AMANDA KATHRYN $6.11
KYSER,LIBERTY $9.01
LAAKSO,MICHELLE $2.77
LAAS,AMANDA M $5.85
LABAHN,KEESA C $34.31
LABELLE,COLLEEN $30.03
LABELLE,JANET $28.40
LABER,LINDA A $14.87
LABOUCANE,NIKKI LEE $13.81
LABOY,BRENDA LIZ $25.59
LABREC,AUDREY M $6.95
LABRIOLA,CANDACE M $24.21
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LABUEN,JACLYN $15.26
LACANGAN,JERRY $0.86
LACASSE,DANIEL $29.63
LACEY,BARBARA CHRISTY $33.54
LACHANCE,NICHOLE $6.03
LACKEY,DEBBIE $27.07
LADD,BRIAN J $43.17
LADNER,HAYWARD P $18.66
LADUE,AMELIA $5.58
LAFEVERS,BENJAMIN $2.81
LAFFERTY,ROSE MARIE $14.95
LAFOGA,ROSALIA $19.49
LAGNAS,DISSTON $12.66
LAGODA,NATALIA $17.95
LAGOS,LUIS $19.48
LAGRAND,GREGORY $34.53
LAGUNA,DESIREE $7.65
LAHTI,CHARLOTTE $26.66
LAIN,ERIC $1.48
LAING,KAREN K $7.87
LAINTZ,JEREMY J $13.72
LAIRD,AMANDA RENEE $25.83
LAIRD,FRITZIE $20.44
LAIRD,S PATRICK $21.76
LAITI,LONNA J $14.25
LAKEL,MARTIN T $6.81
LAKISA,MIRIAMA $35.69
LALAGA,ROSELYN V $17.35
LALKY,ASI $51.70
LAM,QUANG $4.15
LAM,STEPHEN TSZ TANG $3.84
LAMAR-PENERA,JESSICA A $8.52
LAMARSH,ALEXANDER $25.35
LAMB,DAVID C $39.21
LAMB,JOSHUA L $14.03
LAMB,LANCE A $15.85
LAMBERT,ABRAHAM R $13.08
LAMBERT,JEREMY $21.58
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LAMBERT,LARRY W $42.65
LAMBERT,MARGUERITE F $10.18
LAMBERT,PAUL J $18.33
LAMBOURNE,MICHELLE $17.82
LAMEBULL,JOSEPH $40.25
LAMKIN,DAVID J $15.11
LAMORE,GEORGE $8.27
LAMOTHE,ELIZABETH $7.42
LAMOTHE,JOEL D $8.94
LAMOUREUX,MARK J $7.72
LAMOUREUX,VINCENT D $8.60
LAMPE,AMBER $23.36
LAMPE,FLOSSIE R $0.92
LAMPERTI,THOMAS $43.00
LAMPLEY,JULIE $3.42
LAMROCK,EETTA $51.08
LAMSON,KATHERINE $22.35
LAMURIEL,FORRESTAR $3.21
LANCASTER,ROBERT C $29.54
LANCLOS,ELROY $24.76
LAND,MARY $29.14
LANDER,BRYCE $55.36
LANDERS,GENEVA $20.53
LANDERS,KAREN V $28.94
LANDERS,SHELLEY $30.47
LANDON,SHENNA $25.97
LANDOWSKI,MICHAEL $20.19
LANDRETH,CATHERINE A $15.98
LANDRY,NATHANIEL $29.11
LANE,ALISON B $14.30
LANE,CODY RAY $19.02
LANE,KENNETH $18.44
LANE,MARCIA M $3.12
LANE,NICOLE $27.30
LANE,PATRICIA $14.81
LANG,JENNY $23.27
LANG,SHEILA A $34.26
LANGDON,EDWARD P $20.05
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LANGDON,THELMA P $22.22
LANGE,LEONARD L $3.33
LANGENARD,TARA B $0.52
LANGENBACHER,KEVIN R $13.46
LANGER,TIM $27.00
LANGEVIN,PATRINA H $19.62
LANGFIELD FAMILY TRUST $21.59
LANGFIELD FAMILY TRUST $5.62
LANGFORD,CHRISTIAN $1.44
LANGFORD,DONALD $0.58
LANGFORD,MARK A $19.10
LANGLEY,KYLA $14.03
LANGLOIS,HEATHER $9.00
LANGLOIS,RYAN P $8.47
LANGVARDT,MEGGIE A $21.97
LANIER,JOYCE E $12.16
LANKFORD,ALAN $7.60
LANKFORD,NATHAN R $11.38
LANKFORD,SHANNA D $32.03
LANPHIERD,JILL M $7.55
LANSDEN,MICHAEL W $32.28
LANZ,JUSTIN $50.38
LANZ,STEPHANIE A $6.05
LAPHAM,ROBERT B $12.14
LAPIERRE,CARLA WILMA $17.10
LAPP,THOMAS $18.93
LAPPI,DAVID W $45.17
LARA,JOSEPH E $16.38
LARA,MARIA $7.07
LARAUX,CHARLES $7.51
LARAUX,COLLEEN $3.78
LARCHE,ANNE E $25.10
LARDENT,DARRYL S $2.18
LARGENT,KAREN $46.10
LARGENT,REGINA L $10.78
LARIBEE,PHILLIP $52.88
LARKEY,ALAN M $10.92
LAROCHELLE,CAMILLIA R $35.56
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LAROSA,MELISSA E $60.06
LARQUIER,ANN MARIE $16.36
LARRABEE,DANIEL S $28.46
LARRABEE,TERESA $44.91
LARRISON,KIM $17.05
LARSEN JR,CARL A $42.22
LARSEN SR,SIGFRIED $27.11
LARSEN,PERRY O $13.40
LARSEN,VONICE IRENE $49.89
LARSEN,WILMA $24.66
LARSH,SAMUEL $19.74
LARSON JR,JOHN $4.45
LARSON JR,RICHARD C $4.00
LARSON SR,WALTER $25.74
LARSON,ARIEL $12.53
LARSON,DARIS E $2.97
LARSON,EVELYN J $5.05
LARSON,GARRICK $40.86
LARSON,JAMES A $7.79
LARSON,JON DALE $50.98
LARSON,KELLEY $22.97
LARSON,MAUREEN $3.08
LARSON,MCKENNA KAYE $7.04
LARSON,NIK A $36.64
LARSON,ROBIN R $17.90
LARSON,RYAN ALFRED $13.29
LARSON,SHARON J $24.44
LARSON,SHAWN ROBYN $43.07
LARSON,TRENT $1.29
LARSON,VICKIE $38.97
LARVIR,DIANA $16.46
LASANEN,NATHAN $5.07
LASHER,BRENDAN $22.72
LASHLEY,SKYLER W $33.48
LASKIE,ERIC C $29.16
LASMARIAS,EMANUEL $3.35
LASSELLE,BO MORGAN $18.68
LASTRAGLIO,JAMES EZEKIEL $8.57
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LATHAM,TANYA M $11.28
LATTA,BILLY F $10.94
LATTA,RANDY $6.15
LATTIN,CHRISTINA $37.50
LAUATI,KAREN M $17.26
LAUDERT,MICHELLE ROSE $37.24
LAUDON,JANICE $47.86
LAUFISO,SALA $12.71
LAUGHLIN,HALI $5.56
LAUPP,ROBERT B $26.81
LAUREANO,FIOR D $6.71
LAURENCE,ANITA $96.22
LAURENCE,CHARLES $45.98
LAURENCE,MITCHELL R $14.94
LAURIN,KIRSTEN D $53.56
LAURION,FRED $36.32
LAURITSEN,HOLLIE $14.05
LAUSIER,COLETTE $9.67
LAUTERBACH,MAUREEN T $15.57
LAVALLEY,MARLENE $34.75
LAVALLEY,NATE $47.06
LAVOIE,RANDY $55.53
LAW,DERRICK $10.51
LAW,SANDRA D $24.74
LAWIE,LLOYD D $8.63
LAWLER,BRADFORD J $33.25
LAWLESS,ANTONIA ROSE $29.22
LAWLESS,TERESA $7.27
LAWLEY,SPENCER A $6.06
LAWRENCE,ANN P $8.89
LAWRENCE,BROOKE E $32.24
LAWRENCE,FAWN $15.31
LAWRENCE,JESSICA HELEN $13.54
LAWRENCE,JOHN R $2.24
LAWRENCE,KIMBERLY $10.44
LAWRENCE,LYNN $21.69
LAWRENCE,MICHAEL O $14.33
LAWREY,BERNADETTE $6.35
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LAWSON,CHRISTOPHER D $11.26
LAWSON,WILLIAM A $6.40
LAWTON,AMBER $20.89
LAYLAND,TASHA $42.57
LAYMAN,TAMMY D $33.23
LAYMON II,FRANK W $31.80
LAZAROWICZ,SCOTT $11.24
LE,DOMINIC $24.40
LE,THUY $14.13
LEA,AMICO JORDAN $25.60
LEA,JANIE L $27.05
LEA,LINDSEY ROSE $35.17
LEA,TARA R $14.23
LEACH,ALEXINE H $9.66
LEACH,MIKE J $17.90
LEACH,VERNA L $38.55
LEAHY,THOMAS A $22.28
LEAL,ALICE $7.00
LEAL,ELENA J $5.18
LEAL,GABRIEL $33.90
LEAL,XAVIER ARTURO $11.35
LEAR,MYRA $1.60
LEARNED,DEBRA J $17.47
LEATHERWOOD,BRANDON $11.33
LEATUALII,HIRAM V $9.22
LEAVITT,RHODA $2.51
LEBARON,SARAH $13.48
LEBER,JAYME L $29.83
LEBLANC,ROGER $41.87
LEBRUN,JACK B $58.00
LECATO,CHARLOTTE E $3.02
LEDET,JOSEPH E $23.11
LEDEZMA,SONDRA $21.94
LEDEZMA,SONDRA D $7.96
LEDONNE,RYAN MATTHEW $9.73
LEDOUX,WENDY L $0.15
LEDUE,SHEREEN M $7.73
LEE JR,GEORGE D $42.44
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LEE,ANNA MARIA $4.41
LEE,ANNA S $18.29
LEE,AUBREY $9.06
LEE,CANDICE S $8.95
LEE,CHAN D $19.32
LEE,CHER $37.48
LEE,CHRISTINA $24.44
LEE,CHUNG JA $10.55
LEE,EVELYNN M $14.00
LEE,GARY $13.96
LEE,H W $12.86
LEE,HEATHER K $23.23
LEE,HEEJOON $2.27
LEE,HERBERT $548.52
LEE,HUN N $13.91
LEE,JAE S $16.07
LEE,JEAN E $0.48
LEE,JEFFREY T $23.15
LEE,JIM DEE $51.53
LEE,JIMMY CHASHIA $33.11
LEE,JOHN $9.95
LEE,JOHN K $1.78
LEE,JOHN P $28.66
LEE,JOHN SUN $13.56
LEE,JULIE R $62.75
LEE,KA $9.65
LEE,KEE $22.68
LEE,KOU $61.54
LEE,KRISTINA A $47.60
LEE,LESLEY F $20.13
LEE,LOU $1.04
LEE,MEGAN $15.95
LEE,MICHAEL $36.94
LEE,MICHAEL S $15.08
LEE,PHENG $24.27
LEE,RYAN S $16.98
LEE,SAI $35.78
LEE,SANG JUN $51.64
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Chugach recently mailed 2010 Capital Credit Allocation letters to its former members.  The letter stated an incorrect allocation 
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3. Locate the Find tool button on the toolbar of the PDF reader (most commonly under the File menu bar). The Find tool button 
has the icon image of a pair of binoculars. Pressing the binocular icon will also result to the display of the Find dialog box.

LEE,SHANNON $7.43
LEE,STATE $14.75
LEE,SUNG M $13.59
LEE,THOMAS $10.66
LEE,TONG $42.37
LEE,UN OK $19.33
LEE,YONG H $9.00
LEE,ZA HER $58.30
LEE-EVANS,NANCY $15.53
LEE-KAUPE,ZOYA $6.40
LEFFEW,JENNIFER $35.24
LEFLER,EMILY $23.15
LEFOR,MISTELLE L $42.46
LEGATO,JON E $27.42
LEHMANN,MELINDA $20.66
LEIB,LYNETTE $32.27
LEINBERGER,DONALD $5.57
LEIR,COLLIN M $17.72
LEISCHNER,RANDI $2.69
LEITH,JEANETTE L $34.03
LEITHAUSER,TRACEY J $9.32
LEITUALA,LAALAAI $28.33
LEIVA,KATRINA L $13.93
LEKANOF,ANNA $6.28
LEKANOF,ERICA NINA $16.78
LEMAITRE,JON $27.31
LEMAY,BENJAMIN $4.38
LEMBKE,KEVIN $4.47
LEMOINE,MATTHEW T $3.26
LENAHAN,LIN $39.62
LENAHAN,MICHAEL $23.73
LENGYEL,STEFAN $18.10
LENHARDT,TAMRA $34.31
LENIU,LUTENA $2.60
LENKSZUS,CARRIE $6.43
LENT,BRETT $26.35
LENTES,SUSAN $17.64
LENTFER,TORI SUSAN $8.63
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for your name in the list below.  

*There are three ways to search for your name:                                                                                                                            
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LEO,MARIA MIGUELINA $23.87
LEON,LORENA $6.67
LEONARD JR,MELVIN ELLSWORTH $10.14
LEONARD,ERIC F $1.53
LEONARD,KATHERINE $36.61
LEONARD,LATONYEA T $51.63
LEOTA-TULI,LILLIAN $26.17
LEQUIRE,PAUL $2.75
LERAY JR,KARL $37.94
LERRO,KATHRYN T $19.59
LESCOE,JESSICA B $10.83
LESLIE,JACOB $8.75
LESLIE,JOSHUA J $23.32
LESLIE,LU A $40.44
LESNIKOWSKI,BETHANY $3.59
LESOWSKI,SARAH $4.01
LESSER JR,FREDRICK $3.27
LESTENKOF SR,BARRY P $37.13
LESTENKOF,PAMELA $11.71
LESTENKOF,VERA $10.80
LESTER,DEBRA D $26.25
LESTER,DESIREE $2.87
LESTER,RICHARD $24.50
LESTON,JESSICA DARLENE $6.57
LETOURNEAU,RENE $8.83
LETT,KELLYE $12.21
LETTS,COURTNEY B $1.74
LEUER,MARISSA $0.34
LEUNG,VICKI $7.96
LEUTELE,KRISTI $12.33
LEVAD,NATHAN $16.76
LEVARDI JR,THOMAS JOHN $13.41
LEVAULT,DEREK J $3.54
LEVENDOSKI,CHRISTOPHER $4.78
LEVESQUE,DANIEL $36.73
LEVIN,EUGENE M $7.80
LEWALLEN,BRIDGET $43.13
LEWELLING,BRIAN $0.28
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LEWIS & TED & BRYAN QUINN LLC $35.24
LEWIS,ALEXIS $8.48
LEWIS,AMY $4.39
LEWIS,BERNADETTE L $12.99
LEWIS,BETTY $7.73
LEWIS,BRIGITTE M $15.69
LEWIS,CASEY A $14.29
LEWIS,CHERYL $16.07
LEWIS,COLE $5.69
LEWIS,COURTNEY $11.22
LEWIS,CRYSTAL $7.98
LEWIS,DAISY A $13.63
LEWIS,DENISE W $28.27
LEWIS,EDNA L $4.11
LEWIS,GENE E $33.11
LEWIS,JENNIFER M $30.17
LEWIS,JOSEPH T $2.10
LEWIS,JOSHUA $46.54
LEWIS,KEITH $9.78
LEWIS,KEVIN B $19.63
LEWIS,LANA $12.56
LEWIS,REX $9.77
LEWIS,ROBERT N $31.23
LEWIS,ROSELYN $27.91
LEWIS,RUTH ANN $41.13
LEWIS,RYAN L $1.53
LEWIS,RYAN LEE $35.71
LEWIS,SHERMAN R JR $17.76
LEYDON,TOM $2.43
LEYNES,DAVID $0.95
LEYSA,HILARION L $2.51
LI,MICHELLE $11.49
LIAN,EUGENE J $0.77
LIBERT,CHRISTINA $14.50
LIBKE,ALLYN $11.29
LIBURD,ANN C $31.39
LICATA,MARYETTA $12.73
LICKINGTELLER,MARC $26.04
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LIDDLE,PATRICK R $16.32
LIDSTER,WILLIAM $34.33
LIEB,JAMES $21.64
LIEB,MADELINE $29.84
LIEBLER,SUSAN B $46.19
LIEBNER,MEREIDI S $3.75
LIEBNER,SUE $12.64
LIEGL,KATHLEEN A $23.51
LIELASUS,MICHAEL J $31.96
LIGHT,MICHAEL J $23.99
LIGHTFOOT,ANGELIQUE M $4.69
LIGHTSEY,JOSETTE M $2.98
LILES,KEITH A $3.80
LILLESTOL,JANNE $7.62
LILLIBRIDGE,RASDA $19.37
LILLO,JO ANN $8.66
LILLY,TIMOTHY $10.92
LIM,MARY FRANCES THERESE B $9.78
LIMBIRD,JESSICA $9.34
LIMBO,UZZIAS G $20.89
LIN,CHRISTINA C $12.29
LINCE,SHANNON $24.63
LINCOLN,LEAH J $10.45
LINCOLN,MEGAN CAROL $18.91
LINCOLN,STEVEN H $0.15
LIND,DEIRDRE $12.48
LIND,KONAN E $5.92
LINDBERG,ASHLEY N $6.61
LINDEMANN,JAMES W $23.92
LINDEN,DAVID A $9.03
LINDFORS,SHERRI $2.40
LINDHORST,JALENE $22.43
LINDLEY,ALECIA $38.76
LINDLY,GRADY A $24.59
LINDSAY,NORMAN R $24.29
LINDSEY,CHREE $2.87
LINDSEY,KEITH $5.20
LINDSEY,MARGARET J $22.54



Name Allocation

Chugach recently mailed 2010 Capital Credit Allocation letters to its former members.  The letter stated an incorrect allocation 
amount on the letter.  If you received one of these letters, you may confirm the correct amount of your allocation by searching* 
for your name in the list below.  

*There are three ways to search for your name:                                                                                                                            
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LINDSEY,MELODY A $10.52
LINDSTROM,ALBERT R $2.47
LINDSTROM,MILDRED $19.20
LINDSTROM,RYAN $6.84
LINEHAN,SHAWNA M $11.42
LING,BILLYE JANE $9.26
LINLEY,BRAD T $32.52
LINTON,RICHARD J $13.16
LISBOURNE,CLARA $33.23
LISENBY,ASHLEY $12.21
LISH,DESIREE $29.00
LISH,ROSEMARIE $23.82
LISICIC,OLGA $6.06
LISKA,JENNY $35.79
LISSI,AIDA $1.91
LISTON,DONN R $31.74
LISTON,MOLLY $2.97
LITSON,JESSICA $13.94
LITTLE JR,KAY $28.24
LITTLE,ARYNN LOUISE $28.01
LITTLE,COREY $1.93
LITTLE,MARC $21.92
LITTLE,WILLIAM J $17.57
LITTRELL,JAMES R $17.82
LITTRELL,KYMBERLY D $24.29
LIU,PENG CHU $5.86
LIUA,SUSAN $11.47
LIVINGSTON,ROBERT $72.18
LIVINGSTON,ROBERT W $21.18
LIVINGSTON,STEFFAN $18.10
LIVINGSTON,TERENA H $27.74
LIVINGSTON,THOMAS E $1.91
LIVINGSTONE,ANNE $7.87
LIWANAG,KRYSTAL J $7.65
LLANOS,JULIO E $4.32
LLANOS,RACHAEL $27.49
LLEWELLYN,SHANA E $37.68
LLOYD JR,JOEL D $41.67
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LLOYD,BRUCE $0.73
LLOYD,LAUREL V $48.69
LLOYD,SHANTI $9.33
LOCHNER,MARY JEAN $12.29
LOCKARD,MEAGAN S $30.79
LOCKE,EMILY $13.87
LOCKE,JOE A $15.34
LOCKE,MARY JO $24.54
LOCKE,MATTIE $1.35
LOCKES,MICHA $20.60
LOCKHART,ANNA L $31.34
LOCKHART,CHRISTOPHER M $28.68
LOCKHART,JOHN J $47.85
LOCKHART,MELISSA $38.84
LOCKHART,RAYMOND $10.75
LOCKLEAR,JEREMY $14.27
LOCKUK,ELENA $10.88
LOCKWOOD,AMY M $41.15
LODOEN,G PAUL $26.50
LOEFFLER,DENNIS L $13.85
LOERA,GONZOLA $18.24
LOESCHER,ANNELEISE MARIE $32.04
LOEW,MELANIE T $23.35
LOEW,SAMUEL $54.36
LOEWEN,REUBEN $8.38
LOGAN,BRIAN $14.11
LOGAN,CHARLES D $9.68
LOGAN,HIAWATHA $18.19
LOGAN,JAMIE $1.76
LOGER,CHAD $17.82
LOGES,KENDRA M $12.38
LOHR,HIRAM DANIEL $2.79
LOHRKE,ALISON Q $26.59
LOLESIO,PAMATA K $61.83
LOMBARD,MELANIE B $5.45
LOMBARDI,NICOLE $1.75
LOMBARDO,STEVEN $18.31
LOMONACO,ERIKA $36.99
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LONDON,CARRIE $26.10
LONDON,MICHAEL $5.47
LONG,ASHLEY $1.60
LONG,CAROL ANN $3.97
LONG,CARRIE LEE $34.63
LONG,NICOLE $6.31
LONG,ROBERT D $42.93
LONG,TONIA $6.52
LONGAZA,PATRICIA J $13.48
LONGDEN,MARK R $48.02
LONGLET,KATHRYN E $9.73
LONGOBARDO,DOMINIC $122.93
LONGWITH,MICHAEL J $24.17
LONSDALE,MARTHA $29.23
LONTZ,ERIC $29.69
LOOMIS,BRADY $34.55
LOPEMAN,TRACI $74.71
LOPER,DEBORAH $46.60
LOPEZ,AMPARO E $53.87
LOPEZ,CURTIS J $35.76
LOPEZ,CYNTHIA M $1.51
LOPEZ,JAYME M $7.05
LOPEZ,JUAN M $18.09
LOPEZ,JULIANA RIVAS $2.76
LOPEZ,LISA $15.80
LOPEZ,TRACY MAE $10.56
LOR,MAI SHOUA $39.81
LORAH,APRIL L $23.96
LORAN,KELLY $12.87
LORD,SHIRLEY A $12.76
LORENSON,ROBERT $4.78
LORENTZEN,JOHN $35.95
LORENZ,DORENE $30.20
LORETO,JULIO $1.96
LOSE,RICHARD J $19.71
LOTEN,JENNIFER $72.15
LOTO,LIKA $0.52
LOTT,GEMMA D $27.99



Name Allocation

Chugach recently mailed 2010 Capital Credit Allocation letters to its former members.  The letter stated an incorrect allocation 
amount on the letter.  If you received one of these letters, you may confirm the correct amount of your allocation by searching* 
for your name in the list below.  

*There are three ways to search for your name:                                                                                                                            
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LOUANGAMATH,AMONE $14.50
LOUDON,STAN K $16.79
LOUGHMAN,KATIE $30.02
LOUIE,JANELLE $12.79
LOURY,ROLAND $17.64
LOVE,CHRISTIE JO $18.55
LOVE,DEBBIE L $38.98
LOVE,ROBERT W $15.87
LOVE,SCOTT $18.14
LOVE,SHANNA $40.02
LOVELACE,RACHEL $29.43
LOVELACE,SHELI L $10.87
LOVELESS,SUPAMIDT $13.79
LOVING,GRACE $8.43
LOW JR,PHILLIP P $1.83
LOWE,ADRIAN G $51.94
LOWE,ALLEN $5.99
LOWE,DAWN M $23.23
LOWE,GARY $40.82
LOWE,PATRICK $13.65
LOWELL,WILMA $4.57
LOWER,PATTI J $2.91
LOWN,RACHEL $19.62
LOWNDES,NEOMA $2.78
LOWRY,O BURKE $5.01
LOWRY,SCOTT $16.66
LOWRY,STEPHANIE $11.04
LOWTHER,MIC $5.21
LOYD,AMY L $38.71
LOZA,HECTOR $39.18
LUBANKO,ELISE A $5.58
LUBECK,BRIAN S $5.73
LUBERSKI,A BRUCE $12.43
LUBKE,HEIDI L $23.36
LUCA,JAMES R $33.00
LUCAS,CYRENE $31.60
LUCAS,KRISTEN R $3.13
LUCAS,SUSAN W $32.15
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LUCEY,SARA ANN $17.92
LUCHER,DAVID L $35.47
LUCILLE GILMORE IRREV TRUST $11.32
LUDWIG,JOHNNA L $19.61
LUDWIG,RAINER $38.36
LUE,MERCEDES C $18.87
LUECK,LUPITA R $8.31
LUERAS,MELANIE G $5.22
LUFF,DARRELL B $42.36
LUFF,PHILLIP L $36.55
LUFKIN,MICHAEL PATRICK $1.36
LUGO,AYANIRIS $29.68
LUGO,JOSE A $51.35
LUHT III,RICHARD I $14.81
LUIKEN,HOLLY R $15.37
LUKE,GARY $4.77
LUKEHART,JOHN S $2.94
LUMBA,SHERILL MANACIO $4.80
LUMPKIN,JOSEPH E $4.82
LUNA,ESTHER A $29.02
LUNA,RUBEN $12.95
LUND,SHARLAE $51.80
LUNDBERG,GARY T $52.31
LUNDQUIST,SCOTT P $32.59
LUNN,SHANNA M $27.45
LUOMA,LUCINDA $8.73
LUPER,MICHAEL $7.67
LUPIEN,STEPHEN J $4.74
LURTSEMA,JEAN $44.68
LUSH,JENNIFER A $45.17
LUSSY,HENRY P $2.94
LUSTIG,BEN $15.13
LUTHER,JOSHUA DAVID $25.77
LUTZ,JEFF $12.72
LUZNY,NATHAN S $9.47
LYALL,STEPHEN M $14.80
LYBARGER,EUGENE $3.50
LYKE,JOAN R $2.94
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LYLES,ASHLEY $18.61
LYLES,DEMOND T $43.67
LYLES,LINDSEY $27.56
LYMAN,JOSEPH $76.00
LYNCH,DEANNA $12.57
LYNCH,JONATHAN $7.46
LYNCH,RAQUELL $5.08
LYNCH,SHAWN DOUGLAS $8.80
LYNCH,STEVEN G $44.15
LYNCH,TIMOTHY P $47.24
LYNN,JAMES ERIC $2.41
LYON JR,REUBEN G $29.00
LYON,ANN E $54.07
LYON,SABLE L $13.19
LYONS,MELINDA KAY $23.52
LYONS,STEVEN D $40.07
MA,LIU SHIH $12.19
MAASKE,MELISSA $36.90
MABE,BRENT T $41.35
MABRY,BRIENNE $4.80
MABRY,GABRIELLE M $26.70
MABRY,JAMES R $11.89
MACARANAS,MARCELINO P $4.29
MACARTHUR,DOUGLAS D $5.61
MACARTHUR,ELAINE $25.21
MACDONALD V,GRAHAM D $20.05
MACDONALD,NICOLE A $22.89
MACDONALD,THERESA M $24.87
MACE,JOSEPH CHARLES $21.51
MACH,MELANIE MAE $12.09
MACHESKI,CYNTHIA $4.01
MACIAS-MASON,CARLOS $31.39
MACK,CHELSIE $47.13
MACK,DOLORES M $34.38
MACK,EARLENE $7.35
MACK,JUAN D $24.27
MACK,OPAL $33.90
MACKELL,JENIFER NIKOLE $12.40
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MACKENZIE,JIM A $20.41
MACKEY,BARRY $11.96
MACKEY,ROBERT C $42.55
MACKIE,DANIELA $13.86
MACLELLAN,MICHAEL W $96.70
MACLEOD,VANESSA $1.95
MACMILLAN,ELISE $9.41
MACMILLAN,ERIN E $33.33
MACMULLEN,RUTH L $73.61
MACON,CHALENE $18.24
MACON,TINA R $11.21
MACRAE,JANE A $19.36
MADDAMMA,AMBER R $4.97
MADDAMMA,JEREMY $6.97
MADDEN,DAVID S $29.16
MADDEN,SPENCER C $3.52
MADDOX,JOSHUA B $15.38
MADSEN,AURORA SOURS $7.76
MADSEN,LAVON $1.71
MADSEN,SARAH $2.76
MADSEN,THEODORE E $15.03
MADSON,CARL C $30.14
MADSON,GLEN $14.47
MAEDER,LAURIE $3.60
MAEGER,KYLE $6.23
MAGA,STEVE S $15.42
MAGALLONES,WILLIAM $8.97
MAGANA,TRINIDAD L $0.78
MAGAR,MATTHEW L $7.98
MAGARARU,LEONARDO $24.74
MAGDANZ,ANDREW JAMES $12.81
MAGESTRO,SUSAN $24.82
MAGGARD,JANICE L $13.95
MAGID,JEFFREY $51.62
MAGNUS,MARC HAROLD $499.76
MAGNUSON,AMY $35.06
MAGNUSON,NANCY L $53.50
MAGUIRE,BRANDON $14.28
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MAHAUSAY,MARY LOU $14.70
MAHLE,DEBORAH $4.69
MAHMOUD,NAYER M $2.97
MAHON,JACINDA $28.49
MAHONEY,JESSE R $37.19
MAHONEY,TERESA ELLEN $24.06
MAHUGH,LARRY $79.12
MAIER,ANGELIQUE M $1.78
MAINES,MISTY A $18.76
MAISONAVE,SARAH ANN $17.69
MAIURI,FRANCES $11.50
MAJEWSKI,DUSTIN $25.32
MAJOR,JOANN G $16.17
MAJOR,STEVEN R $4.36
MAKAROV,EGOR $5.03
MAKELA,SHERRY $14.08
MAKI,RICHARD $45.82
MAKOOL,REBECCA A $0.89
MAKUAKANE,TAMMY RACNELLE $21.78
MALAELOA,ATAULOMA $20.15
MALCOLM,MELISSA E $5.96
MALCOM,REX C $26.68
MALCUIT,CARLA JO $10.76
MALDONADO JR,ANTONIO $2.29
MALDONADO,HENRYK $3.06
MALDONADO,JAIME $9.14
MALE,JAMES D $25.17
MALEVICH,RYAN $20.13
MALIK,FRAOOQUE B $6.99
MALING,ELLEN P $11.92
MALLER,BRIAN $9.84
MALLEY,CAMERON P $17.55
MALLORY,PAUL $31.73
MALLOY,BRIAN $11.22
MALLOZZI,DONALD $9.11
MALM,CARMEN C $16.93
MALNAR,DONALD $19.46
MALNARICK,TAL $5.66



Name Allocation

Chugach recently mailed 2010 Capital Credit Allocation letters to its former members.  The letter stated an incorrect allocation 
amount on the letter.  If you received one of these letters, you may confirm the correct amount of your allocation by searching* 
for your name in the list below.  

*There are three ways to search for your name:                                                                                                                            

1. Press CTRL plus F on your keyboard.  A FIND dialog box will appear on the PDF reader.

2. Click on the Edit menu, and locate-click the Find command.

3. Locate the Find tool button on the toolbar of the PDF reader (most commonly under the File menu bar). The Find tool button 
has the icon image of a pair of binoculars. Pressing the binocular icon will also result to the display of the Find dialog box.

MALONE,CORA FRANCES $14.55
MALONE,JOHN F $20.36
MALONE,THEODORE $59.14
MALONE,VALLIE G $13.56
MALONEY,APRIL E $27.55
MALONEY,JOHN E $25.83
MALOTKY,TYLER J $10.02
MALPAYA,VERONICA E $6.75
MALUPO,IUNISE L $45.67
MALUTO,MELLIZA $17.46
MALUTO,ROBERT $67.59
MANDARIN KITCHEN LLC $134.47
MANDEL,PETE D $22.47
MANDERSON,WANDA $2.84
MANDT,JILL $2.85
MANDT,MARK $19.45
MANGINO,SUSAN $3.52
MANGLONA,NICOLE $24.60
MANHIRE,PATTY $11.45
MANITISA,ANA P $10.26
MANN,EDNA MARIE $2.37
MANN,JERRY W $49.23
MANN,MONICA L $40.77
MANNER,CHRISTINA $0.45
MANNING,BRITTA $39.86
MANNING,SUE A $2.21
MANOOK,KATHERINE $12.47
MANOR,SADIE E $24.89
MANRIQUEZ,MICHAEL R $19.84
MANSFIELD,CHRISTINA $17.21
MANSHADI,SAEID $8.06
MANTOOTH,CHADA $7.96
MANUFEKAI-KEAWEAMAHI,ANGELICA $14.24
MANUMIK,HUNTER ROY $32.74
MANWARNING,JAN C $56.84
MAO,DAVID $33.47
MAPLES,DIANE S $9.90
MARCH,BRANDY L $8.16
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has the icon image of a pair of binoculars. Pressing the binocular icon will also result to the display of the Find dialog box.

MARCHAND,SARAH $5.07
MARCHANT,EZ $16.84
MARCIL,ROGER B $35.00
MARCOTTE,ANNE M $2.75
MARES,AMANDA COLETTE $8.40
MARIAN,GARY $7.79
MARIAN,JUSTEN $30.17
MARION,KATHY $7.06
MARKELL,DENYSE A $25.89
MARKELL,MELISSA $13.85
MARKHAM,DAVIN $33.70
MARKIN,ROMAN $14.66
MARKLE,SCOTT A $1.78
MARKLEY,KASEY $0.90
MARKOVICH,MICHAEL J $18.44
MARKS,DONNA L $14.60
MARKS,HAROLD LELAND $39.35
MARLEY,ANDREA $30.54
MARLOW,JESSICA $75.14
MARMAN,DANIEL $39.01
MARNELLI,MICHAEL R $18.65
MAROK,KIMBERELY $11.84
MARQUETTE,KATHERINE $18.19
MARQUEZ,HERMIE $2.56
MARQUEZ,RANDOLPH $32.20
MARQUEZ,RUTH $1.71
MARQUIS HOMES INC $1.11
MARQUIS,AGNES M $10.01
MARQUISS,JAN L $512.76
MARRERO-DELACRUZ,FELICIA $5.43
MARRION,AMANDA $9.43
MARSAU,KRYSTAL $9.91
MARSAU,MICHAEL $4.90
MARSH,CHRISTINA $44.26
MARSH,JONATHON D $13.64
MARSH,MARK C $7.41
MARSH,NATASHA $17.74
MARSH,ROBERT M $8.09
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Chugach recently mailed 2010 Capital Credit Allocation letters to its former members.  The letter stated an incorrect allocation 
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has the icon image of a pair of binoculars. Pressing the binocular icon will also result to the display of the Find dialog box.

MARSH,TAMARA $23.68
MARSHALL,CHARLES R $11.45
MARSHALL,CHERI $21.90
MARSHALL,DANIEL S $19.95
MARSHALL,JOANN $22.87
MARSHALL,JOSEPH B $2.53
MARSHALL,KAYLA $5.32
MARSHALL,MATTHEW P $31.83
MARSHALL,ROWAN $21.59
MARSHALL,STERLING $4.44
MARSHALL,THOMAS V $68.97
MARSON,CHRISTOPHER $14.63
MARTEL,JUSTIN K $19.76
MARTHALLER,SUSAN M $21.26
MARTIN,ANN MARY $22.29
MARTIN,ANTOINETTE M $24.03
MARTIN,BRANDI D $7.18
MARTIN,CYNTHIA LYNNAE $12.70
MARTIN,DAVID E $6.33
MARTIN,DEBBIE J $20.63
MARTIN,DOUGLAS $3.16
MARTIN,ERIC $25.01
MARTIN,FRANK E $6.07
MARTIN,GARRETT $14.53
MARTIN,GARY L $24.86
MARTIN,HILARY $13.59
MARTIN,JAMES D $24.88
MARTIN,JEFFREY C $29.58
MARTIN,JESSICA L $18.01
MARTIN,JULIE $2.29
MARTIN,KATHERINE $12.59
MARTIN,KIM $0.35
MARTIN,LASHELLI S $24.21
MARTIN,LISA S $2.11
MARTIN,MAITLAND $16.41
MARTIN,NICK $25.05
MARTIN,PAMELA J $29.00
MARTIN,RACHEL N $17.90
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has the icon image of a pair of binoculars. Pressing the binocular icon will also result to the display of the Find dialog box.

MARTIN,ROBERT TYLER $5.71
MARTIN,SHANNON $20.64
MARTIN,SHAWN E $9.71
MARTIN,STEPHANIE $18.13
MARTIN,STEPHEN Z $12.59
MARTIN,TANYA R $10.78
MARTIN,THOMAS G $34.79
MARTIN,THOMAS J $13.62
MARTIN,TONY D $33.31
MARTIN,VICTOR M $16.71
MARTIN,VIRGENIA E $32.90
MARTINEZ II,DAVID $1.65
MARTINEZ,AARON $4.59
MARTINEZ,BRENDA LEE $15.90
MARTINEZ,CONSUELA M $11.96
MARTINEZ,DAVID ANDRES $22.96
MARTINEZ,DEREEK $2.76
MARTINEZ,JESSICA R $11.75
MARTINEZ,MARY C $12.79
MARTINEZ,MICHELE D $27.66
MARTINEZ,PATRICIA E $20.04
MARTINEZ,PATRICK $9.37
MARTINEZ-DIZON,NICOLE $27.94
MARTINEZ-PARRA,GIOVANNI $23.99
MARTINI,SARAH $30.30
MARTINSON,JANELLE M $4.08
MARTONE,MEGAN CLARE $3.70
MARTYN,PARKER $21.54
MARTZ,LYNN H $1.29
MARVER,HEATHER K $1.00
MARX,JEFFERY A $15.08
MASALOSALO,TOMMY $10.26
MASANGCAY JR,DANIEL A $33.42
MASCIARELLI,JAKE A $4.21
MASCORRO,GABRIEL $10.37
MASKREY,DANIEL $83.48
MASON,ANDREW $38.82
MASON,ANDREW J $16.92
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has the icon image of a pair of binoculars. Pressing the binocular icon will also result to the display of the Find dialog box.

MASON,CAROL J $5.87
MASON,COREY D $16.15
MASON,EARL M $8.14
MASON,JACOB $43.24
MASON,JAMES R $10.61
MASON,MARY C $4.82
MASON,STEPHANIE G $52.04
MASSA,MARJORIE A $30.71
MASSARO,GUY A $71.14
MASSENBURG,MONTEL A $17.94
MASSEY II,MICHAEL D $24.71
MASSEY JR,WILLIAM $23.56
MASSEY,JEFFREY J $37.45
MASSEY,KAREN K $42.27
MASSEY,ROBIN $39.35
MASSEY,RYAN K $12.86
MASSEY,WILLIAM EUGENE $150.54
MASSEY,ZANETTA $69.25
MASSICOT,SOTHIA $26.63
MASTASCUSA,MARY $20.29
MASTERS III,JOHN W $13.32
MASTROCOLA,JOSEPH A $3.34
MATEO,MIGUEL $16.99
MATHENA,STEFANI $35.60
MATHENY,DEBORAH $38.87
MATHES,DESTINY $29.62
MATHIASON,VANESSA $6.79
MATHISEN,LEE ANN $16.96
MATHLAW,JOSHUA $15.72
MATICH,JESSICA R $17.47
MATIN,MOHAMMED ABDUL $27.87
MATSUOKA,STEVE $30.65
MATTHEWS,APRIL LOUISE $7.18
MATTHEWS,JESSICA B $6.23
MATTHEWS,JOANNE E $46.28
MATTHEWS,LINDA $6.04
MATTHEWS,RHONDA $24.19
MATTIE,JACOB F $16.22
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has the icon image of a pair of binoculars. Pressing the binocular icon will also result to the display of the Find dialog box.

MATTINGLEY,SARAH FAULKNER $1.02
MATTOON,SHILOAH $2.28
MATTSON,AARON SAMUEL $24.30
MATTSON,DAN R $47.31
MATTSON,TAYLOR J $37.09
MATUKONIS,RALPH J $40.61
MAULDIN,TIFFANY $32.15
MAULE,DANIEL J $25.89
MAUNEY,JAMES L $0.70
MAURER,JEFFREY L $23.56
MAURER,KEITH $8.26
MAXEY,SHELLEY GRIGSBY $20.01
MAXON,JENNIFER N $21.47
MAXWELL,BRAD A $6.96
MAXWELL,CARLA $34.33
MAXWELL,JOHN H $6.69
MAXWELL,PAULETTE C $16.64
MAXWELL,RYAN C $36.48
MAY,JASON ERNEST $34.96
MAY,JASON M $9.87
MAY,LAURA ANN $50.51
MAY,NATASHA MARY $16.33
MAY,ROBERT D $4.23
MAY,TAUZSALETT $24.48
MAYE-CROSBY,SONYA $8.83
MAYER,BRANDI LYNN $16.58
MAYER,CARRIE E $14.36
MAYER,CLAUDE C $26.83
MAYES,DAMON E $39.68
MAYES,JAYMES $31.91
MAYFIELD,JEREMY D $11.04
MAYHAK,DANNY $5.88
MAYS,BRYAN $23.45
MAYSER,EVA $24.01
MAZE,KEVIN L $15.29
MAZOCH,WILLIAM $25.73
MAZZARO,JENNIFER ANN $10.62
MCADAMS,ROSEMARY L $15.34
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has the icon image of a pair of binoculars. Pressing the binocular icon will also result to the display of the Find dialog box.

MCADARA,JOSEPH C $4.63
MCADOO,AIMEE CHEREE $29.39
MCAFEE,DOROTHY $29.47
MCAFFE,C P $44.74
MCAFFEE'S FLY SHOP $4.40
MCALISTER,CANDACE KAYE $53.74
MCALISTER,DEBRA $0.62
MCALISTER,SOMJIT $4.99
MCALLISTER,DAVID $26.00
MCALPINE,WILLIAM $26.44
MCANDREWS,RAYMOND $3.51
MCBRIDE,DONNA $59.90
MCBROOM,GUY A $12.40
MCBURNETT,PATRICK $0.15
MCCABE,RACHEL M $9.56
MCCAGHREN,MICHAEL G $9.07
MCCAIN,CHRISTOPHER S $37.73
MCCAIN,THOMAS $9.00
MCCALL,LOLA $14.33
MCCALL,MELISSA $22.15
MCCALLISTER,LISA J $9.00
MCCAMISH,JON M $10.76
MCCAMMON,LEE $9.25
MCCANN,DOUGLAS $65.60
MCCARRON,MICHAEL $14.08
MCCARTER,STEVEN $1.53
MCCARTHY,MARTHA O $20.54
MCCARTHY,MARY $6.38
MCCARTIE,DAMIO Y $10.42
MCCARTIE,THERON W $9.01
MCCARTNEY,DON $14.24
MCCARTY,DANIEL PAUL $22.03
MCCARTY,JENNIFER J $13.65
MCCARTY,SHAWN $7.41
MCCARTY,TONYA M $32.23
MCCASKEY,KENNETH R $11.33
MCCASLIN,JUDY K $7.27
MCCAUGHEY,LEANN CHRISTINE $8.56
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has the icon image of a pair of binoculars. Pressing the binocular icon will also result to the display of the Find dialog box.

MCCAULEY,COREY J $13.35
MCCAULEY,ELIZABETH $15.74
MCCAULEY,RINA $10.43
MCCHESNEY,HEATHER L $32.57
MCCLAIN,ANDREA C $6.41
MCCLAIN,LUCAS $10.35
MCCLAREN,JOSHUA D $11.94
MCCLARIN,JASON O $14.89
MCCLEARY,THOMAS R $25.73
MCCLELLAND,JESSICA J $36.79
MCCLELLAND,ROBERT H $62.13
MCCLOUD,CANDICE $6.58
MCCLURE,ANITA $5.53
MCCLURE,BOYD D $27.23
MCCLURE,LAWRENCE S $2.84
MCCLURE,LISA C $41.14
MCCLURE,LORI $11.88
MCCLURG,DIANE L $33.00
MCCLUSKY,CORINNA $24.45
MCCOLLOR III,ALAN C $36.25
MCCOLLUM,RON D $25.54
MCCOMAS,ALBERT $1.42
MCCOMAS,KARA $12.23
MCCOMBS,ZACHARY $22.38
MCCONNELL,ERIKA $7.18
MCCOOL,SHARON $11.55
MCCOOL,WESLEY A $16.29
MCCORD JR,EMIL $37.91
MCCORMACK,VICKI L $19.40
MCCORMICK,BRENDAN $3.94
MCCORMICK,CHARLES A $17.68
MCCORMICK,RYAN $9.70
MCCOSKEY,DANA $21.35
MCCOURT,NICOLE $6.58
MCCOY,KARAMETOS $18.61
MCCREA,EMILY $10.71
MCCREADIE,MORGAN D $11.37
MCCRUM,ERIN MICHAEL $19.26
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has the icon image of a pair of binoculars. Pressing the binocular icon will also result to the display of the Find dialog box.

MCCULLOCH,KATHLEEN J $8.87
MCCULLOUGH,K SHANNON $11.35
MCDANAIEL,MITCHELL $9.44
MCDANIEL,CAROL L $48.41
MCDANIEL,JULIA $12.39
MCDANIEL,LEIGH G $17.90
MCDONALD,CHRIS $28.25
MCDONALD,LARESSA $13.07
MCDONALD,MATTHEW R $1.43
MCDONALD,MICAH D $15.46
MCDONALD,PATRICK M $31.49
MCDONALD,PHOEBE $15.44
MCDONALD,ROBIN R $9.54
MCDONALD,SCOTT ALLEN $5.18
MCDONALD,SHALINA $10.09
MCDONALD,STEVEN $4.99
MCDONALD,SUSAN IRENE $6.73
MCDONALD,WILLIAM S $6.42
MCDONELL,MATTHEW T $11.87
MCDOUGAL,RONALD ADAM $7.99
MCDOWELL,BENJAMIN $25.28
MCDOWELL,MARTHA A $35.92
MCDUFFIE,JOHN $29.76
MCELDOWNEY,CHARLES $29.75
MCENULTY,WILMA ANN $35.06
MCEWEN,TAYLOR HARRIS $8.67
MCFARLAND,VELDA $7.90
MCGATLIN,JAMES RAY $4.30
MCGEE,ANITA $20.38
MCGEE,CARRIE $50.33
MCGEE,GABRIEL M $23.05
MCGEE,JERRY $27.70
MCGEE,LAWRENCE $67.51
MCGEE,STACEY JEAN $12.21
MCGHEE,JOSEPH $28.76
MCGILL,TRAVIS A $24.65
MCGINTY,BRENT $25.55
MCGINTY,SHAYNA L $9.57
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has the icon image of a pair of binoculars. Pressing the binocular icon will also result to the display of the Find dialog box.

MCGLASHAN,DIANNA $1.38
MCGOURN,MARI $20.94
MCGOVERN,PHILIP CARLETON $32.43
MCGOVERN,TERENCE S $12.20
MCGOWAN,MICHAEL G $7.57
MCGOWAN,ROSEMARY $15.88
MCGRATH,BROOKE $18.87
MCGRATH,TIM S $10.97
MCGREGOR,MARILYN $29.04
MCGREW,JOHNNY $19.63
MCGUIRE,CHRISTOPER B $30.81
MCGUIRE,FRANCES M $6.22
MCGURGAN,FRANCIS E $0.56
MCHUGILL,MELISSA $20.07
MCILROY,DAVID S $2.27
MCINERNEY,TIBONY $1.35
MCINTOSH,DAN $6.26
MCINTOSH,MAXINE $39.56
MCINTYRE,GILBERT $5.99
MCINTYRE,HALEY N $26.61
MCINTYRE,KEVIN $33.56
MCINTYRE,MICHELLE $17.87
MCKAY,ANDREW LLOYD $17.92
MCKAY,ELIZABETH J $40.68
MCKAY,JARED M $58.01
MCKAY,ROBERTA A $38.09
MCKEAN,JANET $16.63
MCKEE II,LOWELL ELMER $8.09
MCKEE,DONALD E $21.33
MCKEE,JEREMY LEE $25.13
MCKENNA,TIA R $11.59
MCKENSON,JORDAN $17.99
MCKENZIE,CLYDE L $18.74
MCKENZIE,ERIN $33.25
MCKENZIE,MARY E $5.74
MCKENZIE,PATRICIA G $33.31
MCKENZIE,WILLIAM C $5.96
MCKERLEY,ROBYN MICHELLE $15.21
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MCKEWIN,NANCY MARIE $4.78
MCKIBBON,SUSAN M $39.43
MCKIM,KAY $52.11
MCKINLEY,BRENDA $50.15
MCKINLEY,ERIKA D $11.80
MCKINLEY,LEVI $19.12
MCKINLEY,MARY B $12.97
MCKINNEY,AMANDA $5.13
MCKINNEY,CURTIS W $1.51
MCKINNEY,PETER LEE $1.76
MCKINNON,HENRY $14.38
MCKINNON,JENNIFER ERIN $12.26
MCKITRITK,MANDY $1.63
MCKNIGHT,ALICIA R $23.67
MCKNIGHT,LISA A $2.32
MCKOWN,SANDRA $18.98
MCLACHLAN III,NORMAN B $9.20
MCLACHLAN,DOUGLAS L $7.94
MCLAIN,JIM $8.00
MCLAIN,MICHELE K $2.38
MCLAIN,MICHELE M $51.84
MCLANE,MICHAEL $5.92
MCLAUGHLIN,BRENNA $12.63
MCLAUGHLIN,HUGH $26.99
MCLEAN,JIMETTE ROSE $28.99
MCLEAN,SUSAN S $18.87
MCLEES,JANET J $69.42
MCLELLAN JR,RICKY ALLEN $9.67
MCLEOD,LEITH C $28.27
MCMAHAN,TIMOTHY $37.23
MCMANAMY,SHELLY $59.23
MCMANUS,DAVID N $48.16
MCMANUS,KIMBERLY LOUISE $0.76
MCMANUS,KYLE N $15.95
MCMICHAEL,GEORGE $26.46
MCMILLAN,VIRGINIA $18.19
MCMILLEN,BASIL $5.37
MCMORRIS,DANIELLE ROSE $13.21
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has the icon image of a pair of binoculars. Pressing the binocular icon will also result to the display of the Find dialog box.

MCMULLEN,JENNIFER $1.08
MCMURRY,MARNA $11.33
MCNABB,DONNA J $12.53
MCNALLY,DAVE $18.80
MCNEAL,PAMELA GAYE $25.26
MCNEESE,TANA C $30.05
MCNELLY,TRENT $34.77
MCNIFF FOREE,MARY E $87.31
MCPHERSON,CRYSTAL $22.77
MCQUEARY,FRANK E $482.75
MCQUIVEY,ALAN $14.17
MCRAE,KAREN $2.83
MCRAINE,SAMAYA $172.61
MCSWAIN,MICHAEL $47.07
MCVAY,BRETT A $0.41
MCVETTIE,JOHN A $15.97
MCVEY,JOHNATHAN $22.21
MCVICAR,CRYSTAL $2.52
MCWASHINGTON,ANDREA $1.42
MCWETHY,KYLE JOHN $55.52
MCWHORTER,BRUCE $0.98
MCWHORTER,SCOTT $13.76
MCWILLIAMS,SHAWN P $67.43
MEABON,ANGELA B $22.68
MEABON,HEATHER $5.85
MEAD,JESSICA I $13.52
MEAD,JOE $8.83
MEAD,SYLVIA $6.72
MEADE,CASEY L $10.17
MEADER,MOLLY B $30.58
MEANS,LANORA G $34.33
MEAUX,PATRICK J $14.45
MECHAM,STACY $14.20
MEDINA,CEZAR M $40.57
MEDINA,MARK A $18.75
MEDINA,MARLENY L $11.70
MEDINA,MICHELLE $10.62
MEDLEY,DAVID B $11.29



Name Allocation

Chugach recently mailed 2010 Capital Credit Allocation letters to its former members.  The letter stated an incorrect allocation 
amount on the letter.  If you received one of these letters, you may confirm the correct amount of your allocation by searching* 
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MEDVEDEVA,MARIA $11.17
MEDVEDEVA,MARIYA L $4.24
MEDYANIKOV,DMITRY $3.52
MEEHAN,MICHELE L $14.55
MEEKER,DAVID A $9.60
MEEKS,LON B $20.84
MEEKS,SAMANTHA $32.92
MEGANACK-HOOVER,RACHEL M $17.68
MEHL,KATHRYN $1.65
MEHRER,NICHOLAS ADAM $18.45
MEHTA,HITEN $46.60
MEHTA,NIHAR J $14.47
MEIER,JUANITA $45.46
MEIER,SHELDON J $14.59
MEINEN,MARK A $12.65
MEISLER,MARGARET L $40.89
MEISTER,BROOKE $37.82
MEISTER,NICK F $60.16
MEJIA,YVETTE $35.32
MELCHERT,DWAYNE L $0.17
MELENDEZ,BENJAMIN $11.43
MELENDEZ,JOSE $10.62
MELIA,SHARRY $8.82
MELTON,DERRICK $26.83
MELTON,KYEME C $45.82
MELTON,LOIS $49.74
MELTON,TOM $5.40
MELVIN,CARLOS R $8.07
MEMBRILA,FABY $28.47
MENDEZ,RAUL $13.36
MENDEZ,TROY $5.22
MENDOZA,CORINA $23.27
MENDOZA,JANE $68.71
MENDOZA,MICHAEL $4.97
MENESES,CARLOS RAUL $14.79
MENESES,HANNAH JORGENSON $32.38
MENG,MELISSA S $18.17
MENGISTEAB,NURIA L $14.95
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MENHENNETT,JEREMY ALAN $19.62
MERCER,JOSEPH S $10.67
MERCHANT,MARK A $1.11
MERCIER,MATTHEW $47.25
MERCILL,JAMIE RADENE $12.60
MERCULIEF,ELIZABETH L $20.21
MERCULIEF,JESSE L $6.06
MERCURE,JOSEPH $23.36
MEREDITH,TERESA R $1.47
MERIDETH,STEPHEN $4.66
MERKOURIS,DANIEL $25.36
MERKUSHEVA,MARGARITA Y $23.41
MERLI,ADAM $52.92
MERRICK,LANCE $14.10
MERRILL FIELD UPHOLSTERY $70.89
MERRILL,CLARICE $18.77
MERRILL,DIANE G $73.99
MERRILL,ERICA Y $15.87
MERRITT,AARON S $23.11
MERRITT,LORA C $12.20
MERRITT,SOMER $7.63
MERRITT,SUSAN $70.92
MESCEDA,ALEXIS M $6.33
MESENHIMER,G G $68.12
MESINAS,JESUS $1.80
MESSICK,KELLY $6.54
MESSICK,MIKE $4.95
METE,WINN $6.95
METHOD,ROSANNE L $20.38
METS,MISTY $30.59
METTERT,JEFF $51.67
METZ,NORMAN A $15.46
METZKER,SHERIE A $39.85
MEWBORN,JAMES C $13.91
MEYER,APRIL $37.76
MEYER,KRISTI N $21.35
MEYER,MARGARET $64.76
MEYER,RYAN MATTHEW $31.85
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MEYERS,CECILA L $28.76
MEYERS,LORAN $13.55
MEZANO,REBA $19.28
MICHAEL,KARI $39.84
MICHAELS,JACK M $25.01
MICHAELS,TOMI $11.64
MICHAUD,KYUNGA $14.28
MICHEL J BIERI $88.41
MICHEL,STEPHANIE A $2.32
MICHELE,ANZIMEE R $13.52
MICHELS,MATTHEW $7.68
MICHIE,JOSHUA $7.98
MIDDAGH,STEVEN $9.16
MIDDAUGH,DANIEL LAWRENCE $12.55
MIDDLETON,CHRISTOPHER A $16.26
MIDDLETON,MICHELLE S $38.11
MIDDLETON,RICHARD COLLIN $51.11
MIDNIGHT SUN CONSTRUCTION LLC $9.44
MIDTHUN,JENNIFER $15.48
MIEURE,HOPE N $26.71
MIGNERY,ZACKARI $3.72
MIHM,TARA L $27.15
MIKA,TOPETO $51.33
MIKKELSON,SUSANNA $90.68
MIKKONEN,KAARINA $2.18
MILAN,AMBER N $22.69
MILAN,BRENDA D $45.57
MILAN,LINDA $120.20
MILEFSKI,M LISA $5.01
MILENKOVIC,MATTHEW $13.02
MILES,DEVIN T $0.95
MILES,JAMES C $7.15
MILES,SARAH $6.29
MILETTE,AUTUMN $1.83
MILETTE,KAELA N $10.16
MILEUR,RANDY $6.00
MILEY,SHEILA M $9.20
MILHAM,TESLYNN $15.92
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MILIONTA,ROGER $6.99
MILJOUR,DIANNA N $22.56
MILLAR,CARINA $24.55
MILLEA,STEVE W $56.27
MILLER,ANDREA LEE $28.45
MILLER,ANTOINETTE $16.43
MILLER,ATLEE $4.56
MILLER,BARBARA A $10.11
MILLER,BONNIE $8.05
MILLER,CARRIE $24.46
MILLER,CATHERINE H $27.48
MILLER,CHRISTOPHER D $4.23
MILLER,CONARD $3.60
MILLER,CRYSTAL A $6.92
MILLER,DANIEL $3.90
MILLER,DEJANIRA $20.17
MILLER,DEVAN M $29.44
MILLER,EVELYN L $16.60
MILLER,EVELYN M $14.68
MILLER,FRANK C $30.19
MILLER,JANET C $8.06
MILLER,JASON R $9.02
MILLER,JENNIFER $0.07
MILLER,JERRY SHANE $45.25
MILLER,JESSICA R $40.88
MILLER,JIMMIE D $18.16
MILLER,JORDAN J $33.91
MILLER,JOSEPH $18.93
MILLER,JOSEPH P $8.43
MILLER,KIMBERLY $4.98
MILLER,KURTIS $17.14
MILLER,KYLE A $15.06
MILLER,KYLE W $3.89
MILLER,LEE DAVID $24.87
MILLER,LOUIS $116.25
MILLER,MARIBEL L $37.20
MILLER,MARTIN R $11.01
MILLER,MELISSA MARIA $12.38
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MILLER,MICHAEL A $13.10
MILLER,MICHAEL F $12.63
MILLER,NATHAN K $9.89
MILLER,PATRICK S $11.03
MILLER,SHAYNE $18.35
MILLER,STACY $12.39
MILLER,STEPHEN $84.33
MILLER,SUSAN RANA $28.77
MILLER,TERRY $11.24
MILLER,THRESASA $6.03
MILLER,TIMOTHY J $1.99
MILLIGAN,CYNTHIA L $4.22
MILLMAN,KIMBERLY $18.89
MILLS JR,GERALD $11.01
MILLS,ARMINDA M $1.24
MILLS,ASTIN M $6.68
MILLS,BRIAN C $86.56
MILLS,GEORGETTE L $20.63
MILLS,KATELYN $4.34
MILLS,SHERRY $95.31
MILLS,TED $11.40
MILLS,THAD $32.28
MILLYARD,BRIAN L $10.42
MILTON,COLETTE $21.66
MILTON,KRISTINE $7.28
MIMS,DOUGLAS $9.85
MIMS,MATTHEW C $11.27
MINABOWAN,REX E $4.19
MINAKER,JAMES R $12.70
MINARD,TAMMY J $20.00
MINER,KATHERINE A $50.97
MINERT,SUZANNE A $13.02
MINGORI,RAINELL $7.59
MINSCH,SHARON M $28.73
MINTON,JAMES C $1.92
MINTON,LYNNE M $16.42
MINUGH,KERI $38.52
MIRAGLIA,MARK S $10.53
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MIRANDA,BYRON $31.22
MIRANDA,EUGENE $15.50
MIRANDA,GREG $4.90
MIRANDA,JANETTE $22.40
MIRANDA,YENY L $3.61
MIRANDA-GOMEZ,CRYSTAL $15.24
MISENCIK JR,WILLIAM P $16.10
MISGEN,PATRICK $44.67
MISHA'S HAIR DESIGN INC $22.23
MISSEL,MARIAN C $16.13
MITCHAM,DANIEL G $14.56
MITCHELL II,J VINCENT $19.43
MITCHELL JR,GARY $3.70
MITCHELL,ALANDA A $13.12
MITCHELL,ALYSIA A $9.65
MITCHELL,CALUM $38.68
MITCHELL,CLAUDIA $9.16
MITCHELL,CRISS $16.31
MITCHELL,CRYSTAL B $29.11
MITCHELL,DEBORAH S $33.72
MITCHELL,ERNEST $1.54
MITCHELL,HOLLY DAWN $40.45
MITCHELL,JACQUELINE A $49.24
MITCHELL,JOSEPH G $20.49
MITCHELL,KELLY L $9.41
MITCHELL,KRISTIN $15.31
MITCHELL,MAURICE $19.62
MITCHELL,MICHAEL P $4.28
MITCHELL,MONICA M $2.24
MITCHELL,SANDRA E $2.02
MITCHELL,SANDRA K $13.86
MITCHELL,SCOTT A $9.24
MITMOEN,AUDRA $16.51
MITTENDORF,JENNIFER $69.57
MIX,DANIEL F $1.13
MOALA,PETER $8.07
MOATS,ROBERT A $8.78
MOBLEY,MERNA M $15.36
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MOBRATEN,LAURA $18.07
MOCKRIDGE,NICHOLAS $56.97
MODEROW,HANNAH $20.08
MODRELL,CHELSEY $13.21
MOE,EVAN $2.94
MOE,GERALEE $0.49
MOE,SHIRLEY $15.53
MOELLENBRINK,ANNA JOY $5.33
MOEN,ROGER DENNIS $11.30
MOESGES,GUENTER $31.57
MOESH,CHANEL $7.91
MOEVAO,MALELEGA $4.21
MOEVAO,PAULINE F $19.93
MOFFATT,AUTUMN $32.74
MOFFET,JEFFERY $7.33
MOILES,STEFANIE R $2.04
MOJICA,EDWARD PEREZ $4.43
MOJICA,IRENE B $49.89
MOLAIE,SIAVASH $6.76
MOLDENHAUER,TREVOR $36.92
MOLE,DEBORAH L $38.49
MOLIA,CINDY $35.08
MOLINA,KRYSTAL $7.67
MOLINA,VINCETE M $3.62
MOLL,KENNETH $30.20
MOLLICA,CHRIS ELLEN $60.12
MOLLICA,ROBERT $2.81
MOLT,LISA $26.13
MOMOSOR,SUSANNA $4.52
MOMPOINT,JENNIFER A $31.49
MONAGHAN-PRICE,EILEEN $23.28
MONCION-LANTIGUA,SHIRLEY $20.56
MONDOK,DAVID EVAN $31.45
MONEYWORKS INC $64.61
MONFREY,KATHLEEN $13.06
MONGEAU,VERENE C $24.37
MONKS,CHRISTOPHER $13.72
MONKS,NORMAN L $13.35
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MONOSSO,FRANK $24.83
MONROE,CALVINA KATHY HANNAH $33.35
MONROE,MARK A $8.73
MONROE,RICHARD J $12.34
MONSEN,RUTH N $12.11
MONSFIELD,KAREN E $44.05
MONSIVAIS,MATILDA $18.98
MONSON,MELODEE A $15.23
MONTAGUE,PATRICIA $6.70
MONTANA,RICARDO C $47.00
MONTANEZ,JOHANNA CAAMANO $55.96
MONTANO,LINDSEY M $6.01
MONTEAU,PAULETTE K $19.59
MONTGOMERY III,JOHN $48.08
MONTGOMERY,HEIDI L $16.58
MONTGOMERY,JAMES R $6.98
MONTGOMERY,MARY O $7.48
MONTGOMERY,MEAGAN $6.48
MONTGOMERY,SHAWN A $8.07
MONTGOMERY,TRASK $17.10
MONTIEGEL,BERNARD A $3.62
MONTORELLO,MARISSA $24.06
MONTOYA,FRANCISCO $5.56
MONTOYA,MICHAEL A $5.13
MOODY,ANGELA $0.75
MOODY,CENA N $19.76
MOODY,LYNDA $19.22
MOODY,TIERRA L $17.83
MOON,CHRYSTAL M $126.93
MOON,INHEE $15.24
MOON,KATHLEEN $19.68
MOON,TALLEY $16.51
MOON,YOUNG $7.92
MOONIN JR,HERMAN N $16.01
MOONIN,MARGARET $33.05
MOORE,ALAN R $4.53
MOORE,ANTHONY $10.08
MOORE,ANTHONY R $14.59



Name Allocation

Chugach recently mailed 2010 Capital Credit Allocation letters to its former members.  The letter stated an incorrect allocation 
amount on the letter.  If you received one of these letters, you may confirm the correct amount of your allocation by searching* 
for your name in the list below.  

*There are three ways to search for your name:                                                                                                                            
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MOORE,APRIL $0.90
MOORE,BONNIE MARIE $19.90
MOORE,BROOKE D $51.68
MOORE,CECIL G $29.66
MOORE,CHRISTOPHER S $9.14
MOORE,DANIEL $30.98
MOORE,DANIELLE $51.76
MOORE,IRENE $0.81
MOORE,JAMIE R $23.91
MOORE,JASON A $33.90
MOORE,JESSICA N $6.72
MOORE,JULI A $5.61
MOORE,JULIA ANN $171.86
MOORE,KADELL $46.74
MOORE,KAMERON V $18.27
MOORE,KARALEE $14.80
MOORE,KATHRYN $11.72
MOORE,LYNDZY LEEANN $9.59
MOORE,MAE $35.84
MOORE,MARCELLUS $53.06
MOORE,MARISSA $4.86
MOORE,MIKE $0.84
MOORE,MORTIMER MICHAEL $8.49
MOORE,PHILLIP $18.86
MOORE,RICHARD D $32.31
MOORE,ROBERT B $40.31
MOORE,SANDRA G $9.51
MOORE,SHELLI $23.05
MOORE,SHERLANN D $30.30
MOORE,TANYA FAYE $11.68
MOORE,TERRY L $1.75
MOORE,THERESA L $23.52
MOORE,THOMAS L $32.89
MOORE,TILLIE L $12.50
MOORE,WHITNEY $8.19
MOORE-KROLL,LYLE $6.30
MOORES,BRACKSTON $21.82
MOOSE PASS BA MISS $50.11
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MOOTER,KATHERINE $2.68
MOQUETE,WILFREDO $16.83
MORA,MARCO F $29.47
MORA,PATRICK $5.28
MORADA,ROSEN $3.26
MORAKHOVSKY,VLADIMIR $12.95
MORALES JR,MIGUEL ANTONIO $13.24
MORALES,SARAH $15.65
MORAN,AMANDA $14.70
MORAN,BETTY $24.64
MORAWITZ,LINDA A $12.55
MOREAU,ADAM J $0.10
MOREHOUSE,COOPER $1.24
MOREHOUSE,SCOTT $15.47
MORELLI,ROBERT M $27.48
MORELOCK,AMANDA J $3.83
MORENO,DAVID $35.43
MORENO,RONNIE $23.56
MORENO-JONES,MARILU $38.60
MORGAN,GREGORY $7.99
MORGAN,JULI M $5.62
MORGAN,KEVIN D $57.51
MORGAN,KRISTIN M $31.64
MORGAN,PAMELA $8.74
MORGAN,ROBERT B $28.70
MORGAN,ROBERT P $6.21
MORGAN,SHANNA $17.83
MORGAN,VERONICA M $10.25
MORGAN,VIRGIL $30.93
MORGANTHAL,KEVIN $22.23
MORING,VIRGINIA A $20.24
MORINO,ALICE $39.36
MORITZ,CHRISTINE $35.68
MORITZ,PIPER CHEYRESE $5.16
MORK,JACOB $12.59
MORLEDGE,DUSTIN $12.04
MORLEY,LOUANN $39.56
MORNER,ELIZABETH $42.88
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MORNING,TRACEY $25.75
MORNINGSTAR,DEJANORA $32.41
MORNINGSTAR,NATHAN W $42.77
MORPHIS,ERIC $91.75
MORRELL,THOMAS $15.14
MORRELL-BLEDSOE,CYMONE $17.83
MORRELL-BLEDSOE,KIM V $28.01
MORRIS,ALICE $23.62
MORRIS,ANNMARIE $12.29
MORRIS,ASHLEY $20.91
MORRIS,BRIAN $52.28
MORRIS,BRIAN M $65.77
MORRIS,DAVID KEITH $49.37
MORRIS,ELLA $1.24
MORRIS,JANET E $40.65
MORRIS,JESSICA A $7.62
MORRIS,KENNETH R $12.34
MORRIS,MICHAEL W $17.38
MORRIS,PETER WILLIAM $2.45
MORRIS,RANDY $26.04
MORRIS,RENEE $23.85
MORRIS,SEAN W $25.09
MORRIS,SHARAE E $35.07
MORRIS,SHASTA $43.99
MORRIS,SYLVIA N $7.36
MORRIS,XAVIER $2.92
MORRISETTE,MICHAEL T $143.42
MORRISON,ADRIANA $14.16
MORRISON,AMY L $2.13
MORRISON,CASSANDRA R $13.70
MORRISON,CHAD M $20.91
MORRISON,CLIFFORD A $12.82
MORRISON,DOUGLAS $3.18
MORRISON,ERIC J $10.29
MORRISON,JAMIE J $24.45
MORRISON,JANET C $20.19
MORRISON,JOSEPH NORMAN COLLIER $2.54
MORRISON,LEANNE $41.63
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MORRISON,LINDA MARIE $20.20
MORRISON,MEIKE $51.75
MORRISON,REX A $12.33
MORRISON,SHERYLIN $2.66
MORROW,MAGGIE $11.19
MORROW,MATTHEW J $2.99
MORROW,RON $57.57
MORSE,REBEKKA $7.24
MORSE,TONI E $14.92
MORTENSEN,DAVID L $11.52
MORTENSON,JERRY ANDREW $6.92
MORTENSON,MARY $10.07
MORTHLAND,CARRIE $41.63
MORTON,DEANN $4.20
MORTON,ROBIN M $30.28
MORZO,WINIFREDO K $12.53
MOSCOSO,MATTHEW $5.05
MOSELEY,ASHLEY NICOLE $41.04
MOSELY,CHRISTOPHER J $1.61
MOSENG,RANDY J $17.23
MOSER,BENJAMIN T $28.35
MOSES,CHRISTINE D $12.89
MOSES,GREGORY CURTIS $5.74
MOSES,PAUL J $27.85
MOSESIAN,JOANNE $5.03
MOSKAL,TINA $10.04
MOSLAK,KIM $1.12
MOSLEY,CASSIE $27.34
MOSLEY,DERRICK $4.38
MOSLEY,REGINA EMILY $23.80
MOSS,SOH-MIN $15.51
MOTA,ENRIQUE $14.22
MOTION INDUSTRIES INC $16.00
MOTLEY,DANA $7.32
MOTTOLA,PAULA $8.99
MOTUGA,FELICITY $19.62
MOUA,JAY $11.10
MOUA,PHONG $17.64
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MOUA,SAMANTHA $53.55
MOUSTAKIS,J L $28.16
MOVSESSIEN,BEVERLY $14.23
MOYER JR,BENJAMIN R $4.83
MOYER,TYLER J $10.21
MOZIE,HARRY L $13.64
MRAZ,GEOFFERY D $21.70
MUA,GEOVAN $45.11
MUA,PAHUAB $30.02
MUCKENTHALER,RAMONA $42.57
MUELLER,BRENDT $8.65
MUELLER,ELAINE $15.69
MUELLER,INA $61.70
MUELLERLEILE,ERNEST $163.17
MUETZ,TINA $2.54
MUFTUOGLU,MEHMET $1.33
MUHOVICH,WILLIAM H $5.80
MUKPIK,JOSEPH A $20.42
MULCAHY,JOSEPH F $28.59
MULHERN,JESSICA $4.44
MULLEN,MARCINE G $39.13
MULLER,ANDREW R $37.46
MULLER,HARRIET $53.06
MULLER,JUANITA $32.68
MULLIS,CYNTHIA $47.02
MULLIS,SAMUEL $25.81
MULNEAUX,LARRY $26.26
MUMFORD,MONICA K $23.35
MUMMERT,JONATHAN $7.09
MUMPOWER,LORI $39.91
MUNALEM,KATHERINE $7.82
MUNAR,CHRIS $17.78
MUNAR,JAMIE LEE $28.79
MUNAR,REBECCA $32.71
MUNCIE,RUSSELL $9.64
MUNCY,BRIAN D $9.48
MUNCY,EVERETT $8.50
MUNDORF,SUSANNE $14.33
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MUNFORD,CHELSEY $4.70
MUNHOLLAND,LAURA V $48.08
MUNN,JACQUELYN $22.53
MUNN,TOBIN Z $10.46
MUNOZ,BRENDA $15.14
MUNOZ,JOSETTE M $39.54
MUNSCH,TED $38.66
MUON,SAMNANG $4.47
MURASAKI,YUKI $26.83
MURATI,ROBERT $49.11
MURCHISON,MARCUS $11.57
MURPHY,CHRIS W $12.19
MURPHY,DAVID ANDREW $15.13
MURPHY,DUKE EVAN $15.49
MURPHY,JAMES D $90.00
MURPHY,KELLI $28.20
MURPHY,KELLY M $36.05
MURPHY,MATTHEW P $13.74
MURPHY,MICHAEL P $53.45
MURPHY,SAMMY $12.60
MURPHY,SHERRY G $2.60
MURPHY,SIGURD E $62.77
MURPHY,THOMAS $11.70
MURRAY,ERIC ROLAND $2.16
MURRAY,JACKSON S $63.07
MURRAY,JASON $26.77
MURRAY,PAUL $53.58
MURRAY,RAEAN E $8.49
MURRY,JOHNATHAN $24.57
MUSGRAVE,CLINT $2.05
MUSGRAVE,MISTI $10.34
MUSGROVE,NILDA C $13.36
MUSQUIZ,JOSHUA P $15.59
MUSSELMAN,JASON $20.98
MUSSER,CLINT $6.34
MUSSMAN,CHRISTOPHER S $8.32
MUSSONE,MICHAEL K $40.88
MUTCHLER,CODY $7.55
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MUZZEY,MORGAN L $23.22
MWALIMU,DEIDRA $1.56
MYAS,KAREN D $24.93
MYERS,CAROL A $30.08
MYERS,LINDA LEE $21.75
MYERS,LINDA N $82.31
MYERS,MARK D $47.40
MYERS,MEMRY $24.41
MYERS,RICHARD $12.15
MYERS,STEVE A $15.74
MYERS,URSULA $12.42
MYERS,WILLIAM A $9.07
NA,HUIAE $20.02
NABORS,RODNEY $47.53
NABOULSI,YARA $7.88
NACE,MALIA $3.75
NADING,CURTIS L $2.59
NAE,AILEEN $4.15
NAEA,LYNOL $7.58
NAEHU,TIMOTHY M $20.68
NAGARUK SR,GERALD $8.93
NAGARUK,NATHAN $1.41
NAGLE,JONATHAN $8.43
NAGY,ANNE D $1.88
NAGY,MICHAEL D $17.40
NAIAD CORP $12.66
NAKADA,SIMONE $2.63
NAKADA,YURIO $10.37
NAKAMURA,GEORGE $0.99
NANALOOK,CLIFFORD $12.60
NANALOOK,KRISTY $0.60
NANCE,IMPALA M $14.81
NANEZ-TOVAR,ARMANDO $5.35
NANIQ SYSTEMS LLC $92.94
NANNESTAD,JENS $1.88
NANOK,FRANCIS JOHN $3.63
NANSEN,FREDERICK FAAVALE $11.21
NANTES,GILBERTO $17.49
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NAPIERALA,BURT $11.49
NAPOLEON,ALLISON $7.22
NAPOUK,MARY $49.86
NARANJO-AGUASVIVAS,MILAGROS $10.56
NARRON,JANELLE M $8.26
NASER,KASHIF A $19.94
NASH,AARON $24.96
NASH,ROBERT S $31.03
NASHOANAK,AMANDA C $11.13
NASHOLM,ERNESTINA $18.11
NASON,SANDRA $15.44
NATHAN,ROBERT S $44.40
NATHANSON,STEVEN E $166.47
NATIONS,ANDRA M $29.25
NATIVIDAD,MARK J $1.71
NAUHEIM,ROB $23.48
NAVAROLI,EVA $2.15
NAVARRO,JAMIE $19.74
NAVARRO,LOWANA $38.81
NAY,JACOB A $17.90
NAY,MILES $23.99
NAYLOR,BOBBY W A $22.25
NAZWORTH,ERIC $30.10
NEAL,PATRICK M $24.48
NEAL,RODRICK K $30.39
NEEL,GARY $0.87
NEFF,MATTHEW $45.18
NEGRI,KYLE $19.06
NEGUS,KIMBER $15.25
NEHER,MARY $10.03
NEILSON,AISLINN B $7.82
NEILSON,KACIE $4.56
NEJAD,BRI N $20.85
NELSEN,JESSI M $7.13
NELSON JR,KENNETH F $32.30
NELSON JR,PERRY $11.74
NELSON,ALVIN J $55.58
NELSON,ANDREW L $24.54
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NELSON,CARLOS $36.84
NELSON,CHERYLON P $0.78
NELSON,CONNIE $39.58
NELSON,DAVID ANTHONY $40.63
NELSON,DON $45.51
NELSON,EDNA MARIE $43.07
NELSON,ERIC $11.37
NELSON,ERIN $23.96
NELSON,FRANKLIN W $29.74
NELSON,GREGORY D $9.92
NELSON,JACOB B $4.81
NELSON,JEANNE $24.37
NELSON,JENNIFER M $23.22
NELSON,JOSEPH E $11.49
NELSON,JOSEPH M $19.70
NELSON,JUDITH $11.93
NELSON,KAYLA J $17.58
NELSON,KOLEAN LYNN $0.61
NELSON,KYLE $6.22
NELSON,LYDIA A $27.98
NELSON,LYLE L $41.32
NELSON,M TERESA $13.82
NELSON,MARC $34.22
NELSON,MARIA $12.88
NELSON,MARIAH J $12.34
NELSON,PAMELA $20.72
NELSON,PATRICK S $25.68
NELSON,SANDRA K $22.35
NELSON,SCOTT L $21.53
NELSON,STEVE $15.99
NELSON,TATIANA $24.16
NELSON,THOMAS LEE $1.72
NELSON,TIFFANY M $38.28
NELSON,WILLIAM M $15.61
NENAHLO,THOMAS LAMBERT $23.96
NERAL,ALBERTO $1.79
NERFLI,MATTHEW $13.20
NESS,CORY A $7.30
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NESS,DOUGLAS G $4.52
NESTOR,JANIE D $36.25
NESTOR,TOBIAS $11.13
NEUERBURG ENTERPRISES LLC $91.75
NEUMANN,ROSALIE J $24.97
NEUMANN,URSULA $21.43
NEUMEISTER,DANIEL P $32.48
NEW FIT INC $127.04
NEW,PAUL SCOTT $37.85
NEWBERRY,DANIELLE $18.93
NEWBILL,LIDIA $6.75
NEWBY,J S $50.44
NEWCOMB,JESSICA L $5.77
NEWCOMER,WILLIAM H $13.12
NEWELL,KELLY $5.49
NEWELL,LESTER H $73.03
NEWHALL,LARINA $39.98
NEWMAN JR,PAUL A $31.76
NEWMAN,CHARLES $23.63
NEWMAN,HEATHER S $26.58
NEWMAN,KELLY L $28.40
NEWMAN,MARK A $0.91
NEWMAN,SARAH $15.93
NEWMAN,SHERRY D $32.42
NEWSOM,AMANDA N $44.14
NEWSOM,DEBORAH L $23.15
NEWTON,FANNY JO $20.08
NEWTON,JASON L $4.10
NEWTON,KIMBERLY L $16.98
NEWTON,MELISSA $20.46
NEXGEN LLC $34.87
NEXT LEVEL MARKETING INC $189.51
NEY,JASON E $2.29
NEY,ROGER $28.61
NEYHART,HOLLY $25.18
NGAYAN,SIJAM BOTTO $78.56
NGUYEN,BRENDA $30.46
NGUYEN,CINDY A $21.17
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NGUYEN,DOAN $3.56
NGUYEN,HAI $7.08
NGUYEN,HONG THI $15.44
NGUYEN,NGOC BICH $92.64
NGUYEN,NHA D $9.82
NGUYEN,THIENHUONG $52.32
NGUYEN,TRAM ANN $23.40
NGUYEN,TUAN $9.17
NGUYEN,VAN T $48.22
NHEP,SALEN $15.91
NIAMPRASERT,CHUTHARAT K $6.49
NIBBELINK,RANDALL F $42.38
NICELY,JOHN F $30.34
NICELY,MEGAN J $26.39
NICHOLS,ALEXANDRIA $6.95
NICHOLS,ANDREW $39.98
NICHOLS,ASIA $20.91
NICHOLS,DANNY $32.12
NICHOLS,JOHN D $11.67
NICHOLS,KENNETH S $29.21
NICHOLS,PHILLIP ANTHONY $2.29
NICHOLS,SHERI $20.11
NICHOLS,WESLEY $2.03
NICHOLSON,ENCHANTE $13.15
NICHOLSON,MELODIE J $95.77
NICHOLSON,REUBEN $6.30
NICHOLSON,TIFFANY $23.97
NICK,MOSES M $19.98
NICKELL,TRUDI T $0.34
NICKOLIE,CHARLES M $24.07
NICKRAVESH,SHEVA T $6.92
NICOLINI,JILL $6.42
NICOLLS,RODGER D $14.03
NIDIFFER,ERNEST T $36.50
NIEBERGALL,JANE $76.95
NIEDERMIER,THOMAS M $52.29
NIELSEN,ANDREW D $3.76
NIELSEN,CINDY $2.41
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NIELSEN,EILEEN $17.31
NIELSEN,FREDRICK $31.86
NIELSEN,LAVERNA M $3.14
NIELSEN,SUSAN VIRGINIA $3.00
NIETO,PAUL J $62.24
NIETO,THOMAS $15.39
NIEVES,LUIS A $18.03
NIEVES,MISTY $46.53
NIGHTINGALE,BETH $6.44
NIGHTINGALE,THOMAS R $29.89
NIHIPALI JR,JEROME $17.72
NILLO,JAZELLE A $11.71
NIMMO,JESSIE $3.54
NIPPER,BONITA KAY $43.21
NIPPER,DANIELLA M $13.64
NISLEY TRUST,JEFFERY D $1.80
NITSCH,STEPHANIE A $12.72
NIX,NANCY A $14.63
NIX,TRACY $18.01
NIXON JR,TOMMY K $26.01
NIXON,STEVE $16.39
NIXON,VONDA O $11.00
NLN,NKIA $18.25
NOA,AAITUI F $3.16
NOAH,HARRY A $11.52
NOAH,PATRICK H $37.35
NOBEL,DESIREE $29.94
NOBLE,GINA M $8.94
NOBLE,PEGGY $40.64
NOBLE,TAKIYAH $7.92
NOGG,DAVID A $4.77
NOLAN,GENEVA L $63.37
NOLAN,JACQUELINE H $5.55
NOLAND,CAROLYN $2.61
NOLDE,BRENT $2.56
NOLIN,MARTY $30.45
NOLTON,DAVID $3.28
NORATAK,SHAWNA $8.74
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NORATUK,CHUN-NI $32.24
NORDBY,JEFFREY S $55.26
NORDGAARD,KJELL $4.16
NORDHOUGEN,T E $25.48
NORE,IVER $7.70
NOREEN,DIANE $36.60
NORGARD,PEGGY $11.80
NORGARD,RICHARD J $12.69
NORMAN,DEBBIE A $18.66
NORMAN,KARNELIA J $18.58
NORMAN,MARCEL $46.74
NORMAN,RUTH ANN $27.15
NORMAN,TYRONE W $24.71
NORMAND,GARI $14.96
NORRIS,JOHNNY D $64.34
NORRIS,SYLVIA $12.75
NORTH MAIL INC $444.96
NORTH,JOSEPH C E $8.13
NORTHCUTT,T J $35.82
NORTHERN COMMANDERS LLC $44.04
NORTHERN LATITUDE CEA,LLC $23.87
NORTHERN SALES COMPANY $171.90
NORTHERN TRUST REAL ESTATE $0.93
NORTHLAND SERVICES $12.65
NORTHWEST AIRLINES INC $2,294.69
NORTON JR,JEFFERY L $32.53
NORTON,DONNA M $16.62
NORVELLE,JANICE $30.34
NORWOOD,HOLLY $27.05
NOSICH,JACQUALINE ANN $5.15
NOTAR,PATRICK $15.98
NOTHSTINE,LAI HINH $15.22
NOVAK,TODD J $7.14
NOVELLI,JUDY $13.72
NOVOSAD,CINDY L $21.44
NOVOTNY,DESIREE $21.21
NUGGET CONSTRUCTION INC $39.88
NUILA,PAMELA $7.33
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NUNES,EDGAR $6.63
NUNEZ,MARIA $9.33
NUNEZ-PACAS,LUIS GERARDO $11.38
NUNLEY,DAWN M $0.74
NUNLEY,KIMBERLY R M $4.73
NUNN,JENNEFER MARIE $58.99
NUNU,BETSY $38.15
NUSLEIN,JAMES A $33.49
NUSS,MARK $42.23
NUSS,MICHAEL $4.48
NWOKORIE,CHIDIEBERE $27.28
NYCE,GEORGE $14.77
NYE,BRIANNA $24.21
NYSTUEN,CHARLES T $15.19
OAKDEN,JEANNE M $24.69
OAKES,GAREY L $12.48
OAKLAND,JEANINE P $3.78
OATES,HAZEL T $56.35
OBANA,SONNY $7.51
OBEN,ARLENE $2.95
OBERG,SCOTT $34.79
OBERLANDER,MELISSA $1.82
OBERRENDER,DANIEL C $18.02
OBEY,NAOMI R $7.85
O'BLENESS,CASEY $23.46
OBOYLE,RICHARD J $23.75
O'BRADYS BURGER & BREW $75.23
OBRIEN,BILL $12.06
OBRIEN,CHRIS $31.60
OBRIEN,DEANNE C $41.16
OBRIEN,JOSEPH S $13.74
OBRIEN,KELLY $16.41
OBRIEN,PAMELA J $14.02
OBRIEN,SEAN J $3.89
OBRIEN,STEPHEN J $36.66
OCASIO PORTALATIN,NAUDY A $16.40
OCH,ANN E $11.80
O'CONNOR,BART $22.18
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3. Locate the Find tool button on the toolbar of the PDF reader (most commonly under the File menu bar). The Find tool button 
has the icon image of a pair of binoculars. Pressing the binocular icon will also result to the display of the Find dialog box.

O'CONNOR,DAVID J $48.97
OCONNOR,JOHN P $30.14
OCONNOR,KERRY I $27.59
OCONNOR,M MADELINE $4.89
OCROTTY,HILDA M $41.97
OCTUCK JR,SEAN $7.14
ODEKIRK,TIMOTHY $9.45
ODELL,SHARON S $50.73
ODLE,DIANE $16.51
ODOM,BRANDI $33.54
ODOM,CHERYL $7.37
ODOM,DESMOND $11.53
ODOM,GARY $6.11
ODOM-BROWN,NATASHA L $4.15
ODOMIN JR,NICK $7.03
ODONNELL,CHARLES F $82.17
O'DONNELL,COLIN $16.40
O'DONNELL,ROBERT G $16.96
OEDING,GUILLERMO $6.91
OELRICH,SHEILA $23.01
OESER,CHRISTOPHER $83.72
OESTERBLAD,PHILLIP M $17.81
OETKER,JOSEPH $36.97
OFARRELL,PATRICK $40.21
OFIU,LINENI $71.56
OGDEN,PATRICIA $2.00
OGLESBEE,GARY $7.66
OGLETREE,ANGELA $39.22
OGLETREE,DUSTIN $17.78
OH,MACK $12.24
OH,TAE HI $13.88
OH,YOUNG JOO $26.75
OKAKOK,JIMMIE MIKE $20.39
OKAKOK,JUNE $19.35
OKKONEN,EERO $10.38
OKONEK,KENNETH J $8.47
OKTOLLIK,HELEN $14.07
OKTOYAK,CAROLINE $19.91
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has the icon image of a pair of binoculars. Pressing the binocular icon will also result to the display of the Find dialog box.

OLANNA,CYNTHIA L $30.03
OLBERDING,MIKE $2.25
OLD,RAELENE ROSE $13.52
OLDENBURG,KRIS A $4.91
OLDHAM,ETHANN CLAIRE $4.75
OLEARY,NEIL J $39.49
OLEARY,PAUL $22.59
OLENICZAK,TAMARA $16.10
OLER,SHERI $31.72
OLGS LLC $28.53
OLIVARES,FERNANDO $18.27
OLIVE,VINCENT $34.16
OLIVER,ANKEVIOUS $16.80
OLIVER,JAY P $17.98
OLIVER,JOAN L $3.80
OLIVER,L RICK $31.05
OLIVER,LILIENI $23.95
OLIVER,RUBEN P $46.43
OLIVER,THOMAS R $0.07
OLIVERA-LOPEZ,LUIS M $13.13
OLIVIER,ROBERT W $49.87
OLLICE,JAMES $102.14
OLMSTEAD,JANET $2.24
OLO,TUIVALELOUOLA J $30.89
OLRUN-KIOKUN,BEATRICE $1.28
OLSEN,ALAN R $27.48
OLSEN,JESSICA $21.67
OLSEN,SHARON L $5.84
OLSON JR,JOHN OLE $6.93
OLSON,ALEXANDRIA $3.08
OLSON,DOUG M $3.72
OLSON,EILEEN A $3.82
OLSON,EMALEAH $11.89
OLSON,JEFF D $18.03
OLSON,JULIE E $45.75
OLSON,LISA R $21.36
OLSON,ROBERT J $26.00
OLSON,ROGER LEE $26.59
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has the icon image of a pair of binoculars. Pressing the binocular icon will also result to the display of the Find dialog box.

OLSON,SCOTT $1.57
OLSON,VICKIE LEE $20.30
OLSON,VIVIAN E $12.76
OLSON,WESLEY $10.12
OLSSON,ERIK C $4.05
OMALIA,TIMOTHY $8.11
OMARA,KAITLIN $2.32
OMEGA,SYNTHICY $11.81
OMERNICK,DALE A $8.70
OMUOREH,RAMSEY $9.57
ONEAL,CYNTHIA $2.67
ONEAL,DEBORAH JEAN $5.06
O'NEIL,HEATHER J $12.39
O'NEIL,OLIVIA $21.55
ONEILL,COLIN M $23.13
ONEILL,MARGARET E $1.76
ONEY,ADRIENNE FLORA $16.09
ONEY,ANDREW T $19.60
ONO,JANICE $27.75
ONTIVEROS,CLAUDINE $24.76
OPPELT,TIMOTHY $36.76
OPPERMAN,MICHAEL L $2.51
OPSAHL,RICHARD J $4.49
OQUILLUK,WILLIAM $4.98
ORALLO,BELINDA $9.34
ORAZEM,CURTIS P $41.66
ORCUTT,DOUGLAS $5.95
ORCZEWSKA,JADWIGA $4.60
ORDILLAS,JAMES R $18.20
ORDUNA,RICARDO $26.38
ORELL,LAURIE J $6.70
ORGERON,BENJAMIN DAVID $45.35
ORIEN,O A $12.21
ORLOB,CAROL L $40.15
ORLOFF JR,GEORGE $12.77
ORLOFF,JOAN $0.41
ORLOFF,JONANA $19.37
ORLOSKY,DANA $39.66
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has the icon image of a pair of binoculars. Pressing the binocular icon will also result to the display of the Find dialog box.

ORLOVA,GALINA $5.08
ORMOND,SARA $26.69
ORNDOFF,ROBERT $33.29
ORNELAS,AMY $1.08
ORNT,NICHOLAS A $6.55
ORONA,VICKY $4.72
OROPEZA,MARY P $10.46
OROZCO,CARLOS $25.99
OROZCO,LUCY M $7.38
ORR III,ARTHUR WILLIAM $3.78
ORR,KRISTINE R $4.45
ORR,LESLIE K $34.79
ORR,SHANNA N $6.18
ORR,SUSANNA H $23.45
ORRISS,FAITH $20.91
ORSTAD,ROBERT D $17.51
ORTEGA,MARLENA $38.55
ORTEGA,MITCHELL $11.74
ORTEGA,OMAR $40.10
ORTEGA,YLKA $0.67
ORTHMANN,ANDREW $3.29
ORTIZ,BRYAN T $19.25
ORTIZ,JESSICA $13.55
ORTIZ,NOE $30.20
ORTIZ,ROSEMARIE $3.21
ORTIZ,YASHIRA $9.59
ORTWIG,MICHAEL $1.11
OSBORN,ALAN E $8.40
OSBORNE,CATHY LYNN $10.97
OSBORNE,DAN J $8.99
OSBORNE,RONALD $0.16
OSCAR JR,THOMAS F $24.55
OSTEN,KENDRA C $24.33
OSTER,JASON $13.74
OSTLER-LISTON,SHALINA L $76.72
OSTLUND,MICHAEL B $27.42
OSVATH,DOUGLAS $21.43
OSWALD,JOYCE $15.08
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has the icon image of a pair of binoculars. Pressing the binocular icon will also result to the display of the Find dialog box.

OSWALD,RONNIE $24.40
OTENBERG,J R $5.80
OTERO,BERNARDO $3.43
OTJEN,TARA $40.56
OTNESS,LAURA $5.41
OTT,RUSSELL $43.88
OTTER,JEANE $32.31
OTTESEN,RYAN E $6.81
OTTINGER,LINDA $35.80
OTTO,CALEB M $2.21
OTTO,JOSHUA $12.39
OTTUM,DENIM SCOTT $16.63
OTTUM,JEREMY N $13.88
OUGHTON,ROBERT T $29.38
OUTHUEYSE,LUBA $29.04
OUTTEN,KENNETH $12.20
OUZOUNIDIS,LEAH R $3.31
OVERCAST,MICHAEL W $35.93
OVERLAND,MOLLY $20.75
OVERMAN,RUSSELL $22.39
OVERSON,MARK $24.71
OVERSTREET,MICHAEL $0.83
OVERSTREET,RACHEL $17.99
OWEN,FRED $57.52
OWEN,JAMES W $0.21
OWEN,SHANE M $20.75
OWEN,THERESA A $2.63
OWENS JR,PAUL M $2.53
OWENS,ABIGAIL M $8.55
OWENS,AMY $30.79
OWENS,ANNETTE R $10.84
OWENS,JOSE S $2.12
OWENS,PATRICK J $7.41
OWENS,REANNA B $6.59
OWENS,RICHARD T $37.75
OXBOROUGH,CHRISTINE $25.65
OXENTENKO,JO $83.29
OXFORD NORTHWEST LLC $4.98



Name Allocation
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*There are three ways to search for your name:                                                                                                                            
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has the icon image of a pair of binoculars. Pressing the binocular icon will also result to the display of the Find dialog box.

OXHOLM,GARREN LEE $4.89
OYAGAK,BERNICE $19.54
OYSTER,CHAD C $2.51
OYSTER,E J $0.93
OYSTER,THOMAS WADE $2.17
OZIO,BRANDI $3.38
OZOLS,TIJA L $14.58
OZUNA,CARLOS MANUEL $30.13
PAAKKI,KATHERINE $9.27
PABUSTAN,PAUL M $3.15
PACE,KEVIN M $6.76
PACKA,MATTHEW $8.42
PACKEBUSH,LAURI $33.15
PACKER,SHANIKIA $11.85
PACZKOWSKI,MELISSA $28.02
PADGETT,ALLISON AVRICH $3.28
PADGETT,JAMES E $9.77
PADILLA,ALFONSO G $6.30
PADILLA,DONOVAN $14.52
PADILLA,MANUEL $21.76
PAEPAE,LUA $10.03
PAEPAETELE,MALU $11.36
PAGAN,ROSSI $4.35
PAGE JR,ERNEST $16.06
PAGE,MICHAEL D $8.46
PAGE,RONALD L $7.77
PAGEL,BESSIE $6.97
PAGNOTTA,PATRICK J $8.78
PAGSOLINGAN,SASHA MAE R $23.69
PAGTAKHAN,JOSEPH S $6.80
PAHL,JOSEPH L $2.30
PAIGE,ALISA $12.42
PAK,JOSHUA $15.47
PALACIO,JULIO $85.50
PALAGYI,TERRY $36.41
PALENCAR,JAMES $7.20
PALEPUA,ENERETA $15.71
PALEY,ANNE H $24.52
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has the icon image of a pair of binoculars. Pressing the binocular icon will also result to the display of the Find dialog box.

PALIK,PALIKKUN P $20.69
PALISBO,SHANNON $8.41
PALK,GLADYS H $8.21
PALLICK,THOMAS $4.51
PALMATIER,KRISTOPHER A $15.95
PALMER,ALICE J $23.39
PALMER,ANDREA NICOLE $17.89
PALMER,CATHY $0.77
PALMER,G GARY $41.92
PALMER,GAIL $19.60
PALMER,JOHN $54.33
PALMERELLIS-MANGUM,JOVONN $4.27
PALMERO JR,EPHRAIM C $18.38
PALMSTEIN,PERRY M $63.41
PALONE,HEATH $16.77
PALSGROVE,RICHARD $32.74
PAMPLIN,RACHEL L $1.12
PAMPUSCH,TIM J $39.13
PANAGOPOULOS,STYLIANOS $29.59
PANAMAROFF,THOMAS $29.80
PANDA EXPRESS LLC $136.18
PANDA,MANMATH $26.91
PANDOLFO,LARRY $0.64
PANEMALAYTHONG,KESONE $26.30
PANNONE,MICHAEL L $2.27
PANONCILLO,GEORGE T $5.13
PAPRANIKU,REXHEP $1.67
PAQUETTE,JESSICA $42.86
PARA TOURS LLC $4.68
PARAOAN,MARK $9.61
PARAS,ELENITA D $10.61
PARCELS,MICHELLE $16.56
PARCHMAN,FRED $11.87
PAREDES,MELVIN $29.24
PARHAM,CATHY D $5.82
PARK PLAZA INC $3.42
PARK,CHAN R $21.34
PARK,DANIEL A $12.71
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has the icon image of a pair of binoculars. Pressing the binocular icon will also result to the display of the Find dialog box.

PARK,GINA $13.36
PARK,GUI JE $40.53
PARK,HANSUNG $23.30
PARK,HYANG SHIN $27.01
PARK,JUNGWOO $8.52
PARK,MONA A $21.22
PARK,PETER K $20.85
PARK,SEUNGHYUN $32.41
PARK,SONG JA $31.63
PARK,YOU-MI $10.76
PARKER,ANDREA M $11.18
PARKER,BILLY R $13.94
PARKER,CHAD $3.61
PARKER,CHERYL L $25.38
PARKER,CORINTHIAN $0.79
PARKER,DAVID E $14.30
PARKER,JESS $4.30
PARKER,MARILYN K $1.51
PARKER,MICHAEL $14.05
PARKER,MICHAEL F $13.45
PARKER,QUYNH $33.55
PARKER,SEAN W $20.08
PARKER,SHANNON $9.50
PARKER,TERRANCE KIENAN $16.04
PARKER,TYRONE M $4.86
PARKER,WANDA B $19.46
PARKER,WILLIAM R $49.93
PARKHOUSE,RONALD $60.24
PARKIN,JOANNE $19.58
PARKS,BENJAMIN $20.92
PARKS,DANIEL $29.88
PARKS,GRACE $43.82
PARKS,JOHN A $22.16
PARKS,TERESA M $60.67
PARMENTER,ALEXANDER $58.08
PARMENTER,JOEL M $29.80
PARMENTER,PHIL $67.00
PARNELL,JOE $18.35
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has the icon image of a pair of binoculars. Pressing the binocular icon will also result to the display of the Find dialog box.

PARNELL,SANDRA L $3.29
PARO,THOMAS $36.52
PARRAN,KIMBERLY K $28.26
PARRENT,CAITLIN $10.77
PARRIS,JUDITH $13.63
PARRISH,DANIEL $6.68
PARRISH,GARY $43.46
PARRISH,JAMES H $47.74
PARRISH,JONATHAN R $0.56
PARRISH,TERRI $50.48
PARROTT,NORMAN $1.88
PARRY,SHELLY K $9.66
PARSAD,RAJAND $16.37
PARSLEY,ERIN L $31.01
PARSLEY,JANICE $17.53
PARSON,KATRINA $9.39
PARSON,RUVONNE C $17.82
PARSONS,EILEEN D $18.43
PARSONS,EMILY P $15.03
PARSONS,PRECIOUS A $28.59
PARTCH,SERENA K $26.10
PARTRIDGE,MARILYN $3.13
PASCAL,JULIA M $1.36
PASCAL,ROBERT $5.31
PASEK,THOMAS LUKE $11.49
PASIA,VAIMOSO E $17.42
PASIEWICZ,SAMANTHA $16.88
PASITNAK,NORA F $11.87
PASOL,JERRY C $69.86
PASS,JAMIE $7.46
PASSI,ALLEN $55.03
PATE,GLENDA $12.19
PATE,RUSTY $2.63
PATKOTAK,MARLENE $23.04
PATKOTAK,MICHAEL JAMES $35.49
PATON,WILLIAM A $11.85
PATRICK,GOODMAN A $32.22
PATRICK,JEFF $9.85



Name Allocation

Chugach recently mailed 2010 Capital Credit Allocation letters to its former members.  The letter stated an incorrect allocation 
amount on the letter.  If you received one of these letters, you may confirm the correct amount of your allocation by searching* 
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has the icon image of a pair of binoculars. Pressing the binocular icon will also result to the display of the Find dialog box.

PATRONSKY,ROBERT A $3.14
PATTERSON,DAVID L $2.59
PATTERSON,JEREMY R $16.77
PATTERSON,JOHN R $21.51
PATTERSON,JONAS $26.29
PATTERSON,KATHRYN $7.74
PATTERSON,KRYSTINA M $32.99
PATTERSON,LYNETTE B $8.94
PATTERSON,MARILYN K $34.25
PATTERSON,NATHAN R $10.67
PATTERSON,ROXANNE E $9.09
PATTERSON,SCOTT $8.71
PATTIE,RICHARD $2.07
PATTON,CHRISTINA $19.42
PATTON,GRANT R $23.89
PATTON,IVY $4.85
PAUGA,FIAFIA C $7.35
PAUGA,MARTIN $7.26
PAUL,AMY M $11.05
PAUL,CRYSTAL $2.53
PAULSBERG,JAMIE $15.53
PAULSEN,KARRA R $6.76
PAULSEN,MICHAEL PAUL $51.73
PAULSEN,TYRONE P $0.83
PAULSON,ADAM J $26.77
PAULSON,BETTY $57.63
PAULSON,DALE $13.05
PAULSON,JENETTE $29.87
PAVEY,PETER $4.60
PAVITT,LINDA $36.46
PAVLAS III,EMMERICK JOE $26.32
PAVLATOS,MATT D $33.27
PAVLIK,ANGELA $8.00
PAVWOWSKI,KEVIN $25.09
PAWCIO,RAANAN M $13.03
PAWELEK,EDMUND T $23.97
PAYAO,MAXINE $35.67
PAYNE,JASON D $31.11
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PEACE,RANDOLPH J $14.77
PEACOCK,CHRISTOPHER $5.15
PEACOCK,JARIS $2.03
PEACOCK,LAHKA $2.24
PEAKE,JEFFREY $1.50
PEARCE,FREDERICK W $12.88
PEARCE,JON $12.41
PEARCE,LISA M $12.28
PEARCE,MICHAEL L $1.96
PEARMAN,SARAH R $31.77
PEARSON,CHARLES JOSEPH $4.62
PEARSON,DAVID $4.61
PEARSON,DAWNA $27.22
PEARSON,ROBERT W $3.13
PEARSON,TIANA $56.36
PEASE,WAYNE E $38.01
PECCI,CHRISTIAN L $32.72
PECK,SARAH $8.90
PECOR JR,WILLIAM C $11.50
PEDERSEN,CAROL K $18.60
PEDERSEN,TRISHA $16.24
PEDERSEN-SMITH,JEAN $35.63
PEDERSON,RICHARD J $31.14
PEDIGO,TERESA $34.57
PEDRO,JUSTIN $29.80
PEDRO,TRISHA M $5.79
PEETE,MICHAEL C $29.49
PEGUERO JR,SAMUEL $2.55
PEL,JOHNNY R $10.99
PELENATO,SAGATO M $31.09
PELFREY,HAZEL $27.55
PELFREY,NORMAN $6.63
PELLEY,AMY $22.67
PELLEY,ASHTON $29.58
PELLICCIARO,MARC $43.49
PELLICONE,ANTHONY $22.25
PELUPELU,NOHELANI $24.78
PEMPEK,ALISSA T $11.95
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PENA,ANA MARIA $21.43
PENA,ANGELA R $43.87
PENA,JESSICA N $24.92
PENA,ROBIN $13.94
PENLAND,JOSEPHINE $10.16
PENN,RACHEL $9.39
PENNEY,ROBERT C $25.75
PENNINGTON,JESSICA C $17.04
PENNO,REBECCA $13.30
PENTANGELO,MICHAEL $4.87
PENYAK JR,ANDREW P $46.57
PERDEW,JENNA A $1.48
PEREA,DAVID $10.86
PEREIRA,TYLER JAY $3.84
PEREYRA,DANIELLA J $0.71
PEREZ III,RAUL $8.91
PEREZ,ALICIA C $24.41
PEREZ,ANN M $1.51
PEREZ,ANTHONY $5.75
PEREZ,JOHNNY A $0.66
PEREZ,JOSE M $8.36
PEREZ,JOSHUA $4.86
PEREZ,MARIA A $9.39
PEREZ,MARIA CONCEPCION $3.23
PEREZ,MARTY $5.56
PEREZ,PATRICIA A $103.58
PEREZ,RANDY $13.64
PEREZ,VICTOR H $4.34
PERHAM,CHRISTOPHER $17.14
PERIMAN,MARY LAUREN $21.13
PERINI,ANNA $2.72
PERIUS,PAUL D $30.72
PERKINS,CHARLES $2.20
PERKINS,MITCHEL $29.19
PERKINS,NICOLE $5.89
PERKINS,PAUL DAVID $57.22
PERKINS,SCOTTIE $11.18
PERKINS,THOMAS F $22.29
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amount on the letter.  If you received one of these letters, you may confirm the correct amount of your allocation by searching* 
for your name in the list below.  
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3. Locate the Find tool button on the toolbar of the PDF reader (most commonly under the File menu bar). The Find tool button 
has the icon image of a pair of binoculars. Pressing the binocular icon will also result to the display of the Find dialog box.

PERONTO,JAMES $17.14
PERPICH,DANIEL $21.37
PERRAS,RUSSELL $0.36
PERRIN,ANDREW C $32.16
PERRINE,LUKE $28.57
PERRY,ADAM W $13.63
PERRY,AVONDA $9.01
PERRY,DANIEL $38.77
PERRY,FELICIA M $9.23
PERRY,HUGH J $25.76
PERRY,JAMES A $10.33
PERRY,JESSE A $4.60
PERRY,JOHN K $32.63
PERRY,JOSHUA A $18.86
PERRY,KRISTEN L $37.70
PERRY,MICHAEL ERNEST $8.76
PERRY,RAHSAAN HALEEM $5.86
PERRY,SETH N $15.37
PERRY,SHANNA M $13.72
PERRY,SHAWN M $12.08
PERRY,VICKI $17.61
PERRYMAN,HALEY ANN $11.18
PERSIA,CORINNE $5.73
PERSON,BERNIE D $11.68
PERSON,MATTHEW $6.99
PERSONS,ROBERT L $21.13
PERTHUIS JR,ALFRED EARL $24.28
PERTZSCH,BRIAN $13.48
PESIO,NOELLINDA $7.27
PETER,SCOTT $18.42
PETERS,CHARISSA $16.99
PETERS,EMMALI $8.63
PETERS,EVIE $9.79
PETERS,JOEL D $16.53
PETERS,MISTY D $15.88
PETERS,PATRICIA L $21.75
PETERSEN,CHRISTA L $16.80
PETERSEN,JENNIFER LEE $27.34
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has the icon image of a pair of binoculars. Pressing the binocular icon will also result to the display of the Find dialog box.

PETERSEN,MARY D $69.59
PETERSEN,MARY G $6.99
PETERSEN,PATRICK A $28.29
PETERSEN,ROSS A $6.98
PETERSEN,TAMARA H $13.54
PETERS-LANDLORD,TIMOTHY $4.57
PETERS-LEWIS,CLARA $13.31
PETERSON,B B $24.33
PETERSON,BETTY L $29.76
PETERSON,CHARLES E $17.38
PETERSON,DALE A $27.24
PETERSON,DIANE R $23.50
PETERSON,GAVIN L $84.53
PETERSON,JENNIFER R $30.69
PETERSON,JUSTIN $1.70
PETERSON,KAREN L $19.45
PETERSON,KERI $22.18
PETERSON,KRISTY C $39.37
PETERSON,LOREN $7.81
PETERSON,MERLIN D $15.19
PETERSON,MICHAEL ALAN $27.76
PETERSON,ROBERT W $54.27
PETERSON,T C $32.11
PETERSON,TRACY F $68.98
PETICOLAS,ANNE MARIE $24.64
PETRARCA,CANDY $18.77
PETRIE,BRENT N $31.26
PETRO STAR INC $24.45
PETROFSKY,MONIQUE V $5.69
PETROV,EVGUENI $15.12
PETSCHE,CAMILLA A $43.01
PETTIT,MELISSA $18.19
PFEIFER,DONNY $17.35
PFEIFFER,JAMES A $33.47
PFEIFFER,JOSEPH T $12.97
PFIFFNER,FRANK A $55.66
PFLEIGER,RODNEY L $107.38
PHAMKING,KIM $25.66
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1. Press CTRL plus F on your keyboard.  A FIND dialog box will appear on the PDF reader.

2. Click on the Edit menu, and locate-click the Find command.
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has the icon image of a pair of binoculars. Pressing the binocular icon will also result to the display of the Find dialog box.

PHAN,LIEN THI $8.69
PHELAN,MAILE C $16.43
PHELPS,BRETT $7.99
PHELPS,LAUREN A $23.29
PHELPS,VICTORIA $12.24
PHILBIN,JOSI $25.00
PHILEMONOF,ALEXIS $9.41
PHILEMONOFF,VANESSA S $3.00
PHILIP,SANDRA L $47.75
PHILLEY,TERRY G $6.62
PHILLIP,KEVON $36.13
PHILLIP,STEPHEN $11.47
PHILLIPS FIELD EQUIPMENT $326.84
PHILLIPS II,MICHAEL C $3.12
PHILLIPS,ALAN L $43.91
PHILLIPS,ALLAN $18.43
PHILLIPS,AMANDA MCCORD $21.29
PHILLIPS,COLLEEN R $31.62
PHILLIPS,COREY S $26.75
PHILLIPS,DAISY MARIE $38.24
PHILLIPS,DYLAN $9.90
PHILLIPS,JANINE $7.69
PHILLIPS,JAYME $25.08
PHILLIPS,JOCELYN $31.36
PHILLIPS,LANCE $26.47
PHILLIPS,LORRAIN $35.84
PHILLIPS,LORRAINE G $17.55
PHILLIPS,MARGARET $0.68
PHILLIPS,NARCISS BROOKS $13.29
PHILLIPS,RACHEL A $4.65
PHILLIPS,RALPH $31.61
PHILLIPS,RANDI R $8.43
PHILLIPS,TIFFANY $11.30
PHILLIPS,TRACI $14.89
PHILLIPS-BARTEE,CRYSTAL $33.03
PHILPOT,CRAIG $26.05
PHOENIX,DREW $17.48
PHUNG,CHANTHALY $0.93
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Chugach recently mailed 2010 Capital Credit Allocation letters to its former members.  The letter stated an incorrect allocation 
amount on the letter.  If you received one of these letters, you may confirm the correct amount of your allocation by searching* 
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has the icon image of a pair of binoculars. Pressing the binocular icon will also result to the display of the Find dialog box.

PICADO,ERIN R $19.50
PICKENS,ANDREA $7.14
PICKENS,JANETTE A $2.37
PICKENS,RAYMOND $12.10
PICKETT,PETRA S $2.59
PICKETT,SHANA $30.59
PICO,EDWARD A $11.76
PICUCCI,NORA L $36.52
PIEKNIK,NORI E $12.30
PIEPER,WILTON A K $18.28
PIERCE,HELEN C $18.17
PIERCE,JASON R $22.43
PIERCE,LAURA L $1.66
PIERCE,MICHAEL V $31.15
PIERCE,SCOTT $14.03
PIERCE,WILLIAM R $19.77
PIERSKALLA,MICHAEL $26.93
PIERSMA,JAY $16.76
PIERSOL,MARK $2.15
PIERSON,CHRIS R $56.26
PIERSON,STEFANIE $19.76
PIETROBONO,JEREMY SCOTT $6.88
PIGG JR,RAYMOND LEE $8.80
PIJUAN,FRANK X $15.57
PIKE,STEVEN C $11.97
PIKEY,ERIK E $36.61
PILAND,HAROLD W $4.95
PILAPIL,WILLIAM R $46.26
PILCH,JAMES R $0.99
PILKINGTON NORTH AMERICA $261.25
PILLSBURY,ROBERT $5.83
PILOTTI,ERIC BAKER $2.86
PILTZ,RICK $4.61
PIMPASALEE,NAVIN $19.63
PINATTI,MAUREEN J $12.13
PINDER,NICHOLAUS J $12.23
PINEDA,BONIFACIO $34.96
PINEDA,EDGAR A $2.55
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Chugach recently mailed 2010 Capital Credit Allocation letters to its former members.  The letter stated an incorrect allocation 
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has the icon image of a pair of binoculars. Pressing the binocular icon will also result to the display of the Find dialog box.

PINEDA,JOHN F $12.47
PING,PATRICIA $5.86
PINKSTON,ROBERT M $10.04
PINNACLE SECURITY LLC $42.79
PINNOW,DONALD WAINWRIGHT $18.43
PINNOW,MELBALEE $50.98
PINSON,STEFFAN D $4.60
PINTO,MATTHEW $1.59
PINTO,SOLOMON $6.88
PIPPIN,STEVEN $16.08
PIQUITERO,BETTY ROJAS $19.01
PISCOYA,BRIDGET RUBY $12.63
PISTER,VIRGINA M $1.24
PITCHER,CALLIANN C $3.76
PITCHFORD,KEVIN R $0.03
PITKA,STEPHANIE L $12.52
PITTMAN,BARBARA $10.79
PITTMAN,KIMBERLY K $26.97
PITTS,WATSON A $13.65
PITZKE,STROTHER J $37.32
PLANK,MARK A $3.40
PLANK,STEFANIE $14.48
PLANT,CAROLINE $34.21
PLANTE,BRIAN $10.33
PLASTER,HEATHER $1.91
PLATT,EUGENE T $16.33
PLAYER,CHAUTE $31.71
PLAYERS HOUSE OF ROCK $146.34
PLEASANT,ALEXIE $30.39
PLEASANT,JOSEPH WILLIE $2.00
PLEASURE,KAREN M $37.62
PLENGE,ADAM L $12.86
PLENINGER,BROOKS B $16.48
PLETT,KRISSY $21.03
PLONTA,SHANNON $16.03
PLONTA,SKYLER DAVID $27.45
PLUMLEE,MONICA $3.12
PLUMMER,DENNIELL $15.17
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has the icon image of a pair of binoculars. Pressing the binocular icon will also result to the display of the Find dialog box.

PLUNKETT,M $27.48
PLUTA,MARY KAY $33.07
POAGE,RICHARD $3.79
POE,WILLARD S $13.86
POEHLER,DEBORAH $36.47
POEPPING,MIKE $28.36
POHL,BERNADETTE $23.71
POINTER,BRYAN A $11.87
POINTER,ERIK $12.05
POINTER,RAYMOND C $24.49
POIRIER,JAMES E $16.43
POIRIER,MARC D $13.36
POIST,ANDREW $11.20
POLANCO,JULIO ANTONIO $29.95
POLAND,MARIE T $8.52
POLASEK,LISA $9.54
POLING,REBECCA $11.71
POLLITT,W HAROLD $3.87
POLLOW,TODD LEE $3.77
POLTA,DANIEL $2.71
POLVI,VANESSA $11.47
POMA,KIRSTEN L $10.60
POMELE,ELAINE $3.13
POMEROY,ASHLEY A $0.83
POMRANING,GRANT $2.93
PONDER,CHERYL $21.90
PONDER,DANIEL $15.07
PONDER,DONALD R $26.35
PONGCO,MAYO L $46.75
PONOMAREV,ALEX $0.85
POOL,CARYN M $13.14
POOL,JAMES M $7.33
POOL,MEGAN D $17.14
POOLE,HERBERT $46.70
POOLE,ROBERTA H $10.84
POOR,RANDALL W $19.86
POPE,ARLENE $44.65
POPE,DARLEEN M $20.52
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has the icon image of a pair of binoculars. Pressing the binocular icon will also result to the display of the Find dialog box.

POPE,PHILLIP $24.75
POPE,ROBIN $11.02
POPE,TENNILLE $47.22
POPESCU,MIHAELA $27.10
POPIEL,DAVID $14.09
POPOALII,MISIUOTI $15.12
POQUET,ALEXANDER $11.02
PORT,JOHN S $24.47
PORTER,ANGELA DL $23.37
PORTER,CARMARTRUS $41.15
PORTER,CHRISTOPHER B $2.30
PORTER,GEORGIA ANN $38.49
PORTLOCK,NORMA J $7.92
PORZIO,AVIEL $2.71
POSCIRI-REED,LISA M $6.79
POSEY,SARAH K $8.22
POSS,MICHAEL R $45.89
POTSANDER,HEATHER $10.19
POTTER JR,ALVIN J $41.79
POTTER,DENISE $18.56
POTTER,JOCELYNE M $14.95
POTTS,DANIEL J $24.90
POULK,SEAN J $92.17
POUNDS,TONI $18.91
POWELL,ADAM $10.67
POWELL,CRAIG P $8.68
POWELL,DAVID HAL $5.55
POWELL,DONALD A $12.84
POWELL,FELIX W $13.21
POWELL,FREDRICK J $14.35
POWELL,JAMES E $9.95
POWELL,LEANNE $34.89
POWELL,LINDA M $20.32
POWELL,LISA RENEE $20.17
POWELL,MARK A $44.17
POWELL,MARK J $7.07
POWELL,RAYMOND A $10.70
POWELL,ROBERT F $0.69



Name Allocation

Chugach recently mailed 2010 Capital Credit Allocation letters to its former members.  The letter stated an incorrect allocation 
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has the icon image of a pair of binoculars. Pressing the binocular icon will also result to the display of the Find dialog box.

POWER,CAMBRIA J $5.05
POWERS,CHANSUDA L $92.40
POWERS,JOE $17.64
POWERS,SHANNON $0.73
POZEN,LAUREN M $5.70
PRAETHONG,TOM $23.43
PRATT,ANDREW $7.68
PRATT,BRENDA L $21.62
PRATT,KEITH M $38.46
PRATT,LORIE A $17.94
PRATT,STACY N $17.80
PREBLE,BRIAN W $34.31
PREBLE,GARY $36.11
PREBLE,NATHANIEL J $16.93
PRECOURT,CASSANDRA $8.94
PREFERRED CORPORATE HOUSING $32.03
PREINFALK,SANDRA $44.58
PRENTICE,BETTY M $29.48
PRESLER,JUSTIN $25.89
PRESLEY,STEPHANIE $26.33
PRESS,VEDA $31.88
PRESTON,ANNE M $58.39
PRESTON,CHARLES G $44.56
PRESTON,KAYLEEN ANN $16.37
PRESTON,LAVINA $12.54
PRESTON,REBECCA L $19.35
PRESTON,TOBIAS J $8.04
PRESTWICH,TREVEN $4.80
PREUSSER,DAWN M $16.56
PREWITT,E EVA $1.94
PRIBYL,RICH $33.26
PRICE III,OSCAR C $18.93
PRICE,AMANDA B L $22.46
PRICE,DEBRA M $21.72
PRICE,DUSTIN O $9.30
PRICE,GABRIEL JOSEPH $20.35
PRICE,JONATHAN J $40.23
PRICE,JOSEPH E $18.50
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has the icon image of a pair of binoculars. Pressing the binocular icon will also result to the display of the Find dialog box.

PRICE,KRISTOPHER A $28.32
PRICE,MILES EUGENE $0.14
PRICE,ROBERT E $6.17
PRICE,TIFFANY $19.57
PRICE,VICTORIA A $18.18
PRICE,WILLIAM H $5.85
PRICE-SCHRUEFER,ROBERT $24.25
PRICHARD,NICOLE M $56.09
PRIDE,ARTREIA $16.23
PRIEBS,JACOB  V $8.24
PRIEBS,VERNON $11.43
PRIETO,EVA M $14.60
PRILLMAN,G B $20.75
PRINCE,DAN $22.42
PRINCE,EILEEN $12.99
PRINCE,LEAH M $21.05
PRINCE,MATTHEW A $26.09
PRINGLE,STEPHEN $5.68
PRISM ENVIRONMENTAL CORP. $1.04
PRITCHARD,MARILYN P $20.24
PRITCHARD,PATRICK A $12.53
PRITCHARD,THOMAS W $3.43
PRITCHETT,STEVEN R $4.18
PRITHANI,SHAILESH $16.30
PROBASCO,KRISTIN $5.48
PROCKISH,T MICHAEL $144.99
PROCTOR,LAURA N $39.73
PROEN,PATRICIA $8.88
PROFESSIONAL BEAUTY $96.84
PROFESSIONAL LEGAL COPY LLC $2.50
PROFFER,MEGAN E $2.75
PROFITT,CASSAUNDRA $25.76
PROKOPOWICH,LOGAN PAUL $54.89
PROKOSHEV,ALEXEY $12.51
PROPER,DAVID J $12.37
PROPES,BARBARA A $6.55
PROPST-JENKINS,KIMBERLY $44.27
PROSISE,ZACK G $11.69
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has the icon image of a pair of binoculars. Pressing the binocular icon will also result to the display of the Find dialog box.

PROSSER CONSTRUCTION CO $67.26
PROTOS,NICHOLAS $21.70
PROUTY,MONICA M $39.64
PROVISIO $41.98
PROWELL,JENNIFER $10.58
PRUDENT INVESTMENTS LLC $45.55
PRUITT,DUSTIN B $5.47
PRUITT,JOSHUA M $11.68
PRUITT,LACIE $18.83
PRUITT,M EILEEN $9.61
PRUITT,MICHAEL H $45.65
PUCKETT,BILL N $22.02
PUCKETT,FLORA $56.60
PUCKETT,REBECCA L $14.67
PUFF,JOSEPHINE $39.16
PUGH,KATHLEEN H $70.06
PULCINO,TAMRA M $43.95
PULIS,CLIFFORD L $11.08
PULLEN,ANDREW M $30.76
PULLEY,THOMAS $13.42
PULLING,LEANN C $0.69
PULLINS,HAZEL $20.66
PULS,ARTHUR $27.18
PURCELL,MICHAEL L $34.23
PURDY,JACK $39.47
PURDY,TIMOTHY ALLEN $28.36
PURNEY SR,RICK J $31.93
PURVIS,RAY A $16.97
PYRAH,FREDRICK W $14.75
QUAID,MATT D $0.77
QUALITY ONE $9.94
QUANSTROM,SAMANTHA J $22.08
QUANTRELL,MARY $26.18
QUATTLEBAUM,JACQUELYN $22.40
QUEK,ERIC $10.44
QUEPONS,BRENDA $0.53
QUESADA,ULISSES J $6.44
QUEZADA,GLORIA $10.87
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has the icon image of a pair of binoculars. Pressing the binocular icon will also result to the display of the Find dialog box.

QUIGLEY,DANIEL R $5.36
QUINN,MELINDA $5.82
QUINN,MICHELLE $7.41
QUINONES,KATHY F $15.35
QUINONES,SHARLEEN $25.94
QUINTON,PAMELA $16.82
QUIRK,DENNIS C $13.04
QUIRK,SPENCER $5.41
QUIRKE,MELISSA $1.73
QUIZNOS SUB $383.63
RA,JANG W $41.87
RAAB,MICHAEL $25.74
RAAS,ANTHONY $4.19
RABAGO,ROMELDA A $25.60
RABER JR,KEVIN WALLACE $5.32
RACETTE,JENNIFER $23.94
RADACH,KEN $0.32
RADAKOVICH,WANDA J $9.17
RADCLIFF,DONNA L $68.61
RADDING,SEAN M $16.76
RADER,NATHAN J $1.76
RADFORD,PHILIP M $46.61
RADIN,MICHELLE $9.36
RAFFUSE,NICHOLAS R $37.46
RAGAN,JULIE A $16.60
RAGEN COFFMAN,DEBRA J $30.18
RAGSDALE,AMBER $7.81
RAHRER,JOSHUA $10.76
RAIN PROOF ROOFING LLC $538.79
RAINER,MICHAEL A $23.81
RAITER,IRIS $20.64
RAJA,SOHAIL $6.89
RAKOSKI,GREG $6.30
RALPH,MICHAEL T $16.21
RALSTON,KARA $4.85
RALSTON,KATHERYN $10.63
RALSTON,MONIKA $19.67
RAMADANOVIC,ADAM ASLAN $11.37
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RAMBO,DAVID S $3.13
RAMBO,JAY J $10.74
RAMBY,LORETTA $26.60
RAMELB,ERIKA $7.58
RAMIREZ,CARLO $43.69
RAMIREZ,CHELSEA $2.35
RAMIREZ,DEBRA K $14.03
RAMIREZ,EDWIN $27.65
RAMIREZ,ESTHER $22.48
RAMIREZ,JESS T $21.60
RAMIREZ,MELISSA $49.81
RAMIREZ,SUZANNE $21.17
RAMISKEY JR,ELMER NORMAN $26.64
RAMOS,ANIEL JOSE $26.29
RAMOS,IVAN W $15.21
RAMOS,JOSE $45.42
RAMOS,MARCELLO $31.79
RAMOS,MARK A $3.05
RAMOS,RHEALEI $5.39
RAMOS,TIFFALYNH O $11.67
RAMOS,WYLIE $9.18
RAMOTH,MARTHA $2.33
RAMPMEYER,ROBIN J $47.53
RAMSDELL,PAMELA K $13.30
RAMSEY LAVOIE,YVONNE L $35.63
RAMSEY,RACHEL $22.99
RAMSTAD CONST CO $9.52
RANA,CLARO $33.47
RANDALL,AMBER DAWN $11.99
RANDALL,RONN $75.07
RANDALL,SHARON R $12.97
RANDELL,CRANDON $37.85
RANDOLPH II,JAMES E $26.80
RANDOLPH,MARVIN A $29.75
RANEL,BUDDY RODGER $27.09
RANEY,AMBER $39.93
RANEY,DONALD S $2.86
RANGER,BART $20.07



Name Allocation

Chugach recently mailed 2010 Capital Credit Allocation letters to its former members.  The letter stated an incorrect allocation 
amount on the letter.  If you received one of these letters, you may confirm the correct amount of your allocation by searching* 
for your name in the list below.  

*There are three ways to search for your name:                                                                                                                            

1. Press CTRL plus F on your keyboard.  A FIND dialog box will appear on the PDF reader.

2. Click on the Edit menu, and locate-click the Find command.

3. Locate the Find tool button on the toolbar of the PDF reader (most commonly under the File menu bar). The Find tool button 
has the icon image of a pair of binoculars. Pressing the binocular icon will also result to the display of the Find dialog box.

RANKIN,JOHN $12.92
RANKIN,KARYN $10.53
RAPPE,KAREN G $10.42
RAPPLEYE,CURTIS JOHN $14.13
RAQUEL,WENDY L $13.29
RASBERRY,SANDRA S $58.99
RASH,DIANA L $39.19
RASMUSSEN,BRYAN KEITH $2.05
RASMUSSEN,DEBBIE M $25.47
RASMUSSEN,LINDA K $15.78
RASMUSSEN,MATTHEW D $47.82
RASMUSSEN,ROBERT D $5.86
RASMUSSEN,ZACHARY ANDREW $11.95
RASMUSSON,JAMES F $16.87
RASOR,CORY $13.17
RATANA,SONGSAY $23.62
RATCLIFF,STANLEY G $28.62
RATH,JOSEPH $14.06
RATHBONE,JULIANNE $24.04
RATHBUN SR,RONALD P $23.08
RATHBUN,ANNA $16.56
RATHBURN,WESLEY $3.44
RATZ,VICTOR $34.52
RAUSCHER,JANET I $34.05
RAVAL,RODALYN P $20.46
RAVSTEN,HEIDI $17.46
RAWLES,OLVIS A $18.92
RAWLINS,CHARLES $12.02
RAWLS,SAMUEL $1.88
RAY,AUTUMN $11.97
RAY,CHRISTINE JESSICA $11.99
RAY,DEANNA A $42.53
RAY,PHILIP STEVEN $4.78
RAY,SHENAH $14.63
RAYBURN,SHEILA M $20.13
RAYMOND JR,TEDDY $20.03
RAYMOND,BOB $11.90
RAYMOND,CECILIA M $15.79
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Chugach recently mailed 2010 Capital Credit Allocation letters to its former members.  The letter stated an incorrect allocation 
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3. Locate the Find tool button on the toolbar of the PDF reader (most commonly under the File menu bar). The Find tool button 
has the icon image of a pair of binoculars. Pressing the binocular icon will also result to the display of the Find dialog box.

RAYMOND,JACQUELINE $27.19
RAYMOND,NICOLE $1.82
RAYMOND,ROBERT E $5.10
RAYNARD,DAMON L $2.18
RAYNOR,CHRISTOPHER JAMES $3.55
RAYPOLD,LISA K $15.71
RAZUMOUSKI,MIKALAI $7.03
REA,ROLAND $77.58
READ,DEBORAH $25.71
READ,RHETT T $8.68
REAGAN,KELLY $46.83
REAM,BRUCE $36.67
REAMER,ANNE MARIE $24.65
REAMER,EARL $25.35
REARDEN,SPENCER N $20.27
REARDON,KAGAN $1.68
REASOR,RICHARD S $2.47
REAVES,HOLLY ANA $4.48
REAY,MILES $35.13
REBISCH,MICHAEL J $66.07
REBISCH,MYRA $9.36
REBISCHKE,LAWRENCE $18.99
REBOL,AMANDA $36.28
RECKNAGLE,CAMILLE C $41.85
REDDICK,FRANK L $6.79
REDDING,TIARRA $31.44
REDDINGTON,JAMES J $9.64
REDDISH,BRANDON R $28.88
REDFIELD,KLISTA $20.59
REDFORD,CAYLEE $10.25
REDFOX,JENNIFER $11.68
REDICK,JENNINE $38.19
REDISKE,LYLA $19.82
REDLINGER,JENNA $22.69
REDMON,DAVID W $17.84
REDMON,DOUGLAS $30.94
REDMOND,JUDITH K $23.45
REDNALL,JOANNE R $36.92
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Chugach recently mailed 2010 Capital Credit Allocation letters to its former members.  The letter stated an incorrect allocation 
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3. Locate the Find tool button on the toolbar of the PDF reader (most commonly under the File menu bar). The Find tool button 
has the icon image of a pair of binoculars. Pressing the binocular icon will also result to the display of the Find dialog box.

REDNALL,JOSEPH F $0.04
REDNALL,SIDRA D $28.02
REED,AQUILA $3.70
REED,BETH L $4.98
REED,CORY D $43.00
REED,JAMES E $73.31
REED,JOHN P $0.71
REED,KYLE A $13.76
REED,LEWIS $18.86
REED,NINA $28.10
REED,PAULA $9.22
REED,RANDALL $21.67
REED,ROBERTA $51.15
REED,SCOTT M $11.12
REEDER,RINA $17.79
REED-SLATEN,DAWN $121.35
REEVES,CHARITY L $25.46
REEVES,MARY K $17.12
REEVES,MATTHEW T $19.67
REFT,NICHOLAS $12.12
REGAN,ELISSA $8.97
REGAN,ERIC B $32.53
REGER,GRACE $17.47
REIBER,HENRY L $11.42
REICH,AMELIA LOUISE $19.26
REICHERT,ANDREA $13.55
REICHERT,MARVIN $19.15
REICHWEIN,BONNIE J $2.18
REID,BRANDON J $17.44
REID,CINDY E $8.40
REID,CONNIE M $34.58
REID,KAREN R $22.61
REID,KRISTEN $24.23
REIMAN,JAMES BRYON $17.09
REINBOLT,ADRIANNE $3.56
REINERT,GEORGE R $33.88
REINKING,WENDELL $25.77
REINTJES,TREVOR $23.60
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Chugach recently mailed 2010 Capital Credit Allocation letters to its former members.  The letter stated an incorrect allocation 
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3. Locate the Find tool button on the toolbar of the PDF reader (most commonly under the File menu bar). The Find tool button 
has the icon image of a pair of binoculars. Pressing the binocular icon will also result to the display of the Find dialog box.

REISDORF,BROCK KYLE $23.70
REISENAUER,CASSIE M $46.35
REISHER,JODY L $30.25
REISINGER,AMANDA $15.51
REISNER,LORI $7.80
REMAX OF EAGLE RIVER INC $49.31
REMME,DENNIS $4.44
REMMY,SUNNY $5.82
REMOTE ACCESS TECHNOLOGY $48.86
REMSEN,KENDRA $20.28
REMUTO,BRYAN D $3.90
RENAUX,JENNIFER $5.60
RENFROE,LAVERNA C $38.79
RENGIIL,BABELDAOB $2.47
RENHARD,ESTAL $8.85
RENK,ALBERT EDWARD $6.55
RENK,RUSSELL $23.58
RENKERT,MILDRED $12.65
RENSHAW,ANGELENA $27.66
RESNICK,STEPHANIE E $5.41
RESTALL,CHRIS L $33.20
REUTER,RUTH E $2.41
REUTOV,ALEXANDER $65.04
REUTOV,ANDREW L $5.80
REUTOV,FORODOR $8.40
REUTOV,NATASHA $16.77
REV TRUST E A TOWER $60.63
REVEILLE,RONALD R $8.09
REVET,JOHN H $34.42
REVIS,MEGAN $6.24
REYES,MARJORIE $11.07
REYES,RITA M $23.97
REYES,SUZETTE $22.59
REYNA,JULIE K $12.55
REYNOLDS,ALEXANDRA $2.97
REYNOLDS,DEBORAH A $13.54
REYNOLDS,GREG D $25.62
REYNOLDS,MARY N $3.81
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Chugach recently mailed 2010 Capital Credit Allocation letters to its former members.  The letter stated an incorrect allocation 
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3. Locate the Find tool button on the toolbar of the PDF reader (most commonly under the File menu bar). The Find tool button 
has the icon image of a pair of binoculars. Pressing the binocular icon will also result to the display of the Find dialog box.

REYNOLDS,SANDRA $31.47
REYNOLDS,SCOTT AARON $10.37
REYNOLDS,SHELLEY M $19.20
RGM INC $28.97
RHEMA SAMOAN ASSEMBLY OF GOD $2.36
RHINE,GREG A $17.68
RHOADES,AUBREY D $20.70
RHOADES,DORRIS L $12.48
RHODE,JEROME M $17.55
RHODE,NAOMI $22.09
RHODEHOUSE,BRIAN A $17.85
RHODEN,BRENDON S $16.41
RHODENIZER,GENE $34.36
RHODES JOHNSON,KAREN C $3.54
RHODES,BRIAN $3.29
RHODES,LANCE ALLEN $45.48
RHODES,MARGIE $5.43
RHOLL,KELLY $7.94
RHOTEN,JENNIFER $7.06
RHYMER,BEVERLY $2.60
RHYNER II,RICHARD R $2.10
RICAURTE,WLADIMIR $13.87
RICCI,CHARLES $12.35
RICCIARDI,CARMEN A $41.30
RICE,CARTER $13.30
RICE,COREY $32.84
RICE,DARRELL R $16.75
RICE,DON R $10.51
RICE,EMMA $51.97
RICE,JEFF L $17.93
RICE,JESSIE CAMILLE $25.51
RICE,JOSEPH W $51.67
RICE,KATHLEEN S $18.55
RICE,MALLORY S $3.25
RICE,MICHAEL $19.50
RICH,DAVID J $0.90
RICH,EMMELI $39.32
RICH,TRESSA CAMILLE $35.58
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Chugach recently mailed 2010 Capital Credit Allocation letters to its former members.  The letter stated an incorrect allocation 
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has the icon image of a pair of binoculars. Pressing the binocular icon will also result to the display of the Find dialog box.

RICHARDS,DEBORAH LYNN $43.67
RICHARDS,KELLY $22.53
RICHARDS,MARY L $2.09
RICHARDS,MATTHEW DAVID $22.29
RICHARDSON,CHRISTEN M $7.17
RICHARDSON,CODI $19.12
RICHARDSON,DWAYNE A $3.25
RICHARDSON,JODI $20.92
RICHARDSON,JOSHUA $25.10
RICHARDSON,JOSHUA $24.65
RICHARDSON,JUSTIN A $22.85
RICHARDSON,PAULA K $47.27
RICHARDSON,WANDA $12.35
RICHEY II,ROBERT CHARLES $14.63
RICHEY,ADRIANE $5.54
RICHEY,STEWART R $41.52
RICHIE,SUSAN $2.17
RICKARD,BRIANNA LYNN $18.95
RICKEL,TERESA $35.32
RICKMAN,KATHY Y $0.66
RICKS,BRANDON P $10.77
RICKTEROFF,MICHELLE $23.08
RICO,SHARON $20.01
RIDAL,DAVID ALISTAIR $58.14
RIDDLE,CORI E $21.43
RIDDLES,MICHAEL $44.15
RIDENER,DONNA $0.60
RIDER,CELESTE $18.05
RIDGE,PETER $0.58
RIDGLEY JR,CHARLES E $13.80
RIDLEY,LORENZO $2.47
RIDLING II,JOHN C $24.50
RIEBEL,G KEVIN $4.43
RIEDEL,MONICA D $19.86
RIEDEL,STEVEN $0.56
RIEHN,JENNIFER LYNN-MARIE $20.17
RIEMER,ADAM $10.65
RIES,JAMES T $10.91
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Chugach recently mailed 2010 Capital Credit Allocation letters to its former members.  The letter stated an incorrect allocation 
amount on the letter.  If you received one of these letters, you may confirm the correct amount of your allocation by searching* 
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has the icon image of a pair of binoculars. Pressing the binocular icon will also result to the display of the Find dialog box.

RIGGINS,LATOYA A $16.85
RIGGS,ROBERT T $26.51
RIKER,KATHY L $17.04
RILEY,CAROLYN $21.29
RILEY,DARLENE F $11.05
RILEY,JOHN O $44.63
RILEY,STEVE D $30.63
RILEY,STEVEN B $30.29
RIMA,LAWRENCE R $12.97
RINCON,MICHAEL J $17.90
RINDOM,WILLIAM $26.91
RINKER,INGRID K $1.49
RIORDAN,DONNA R $31.32
RIOS,LYDIA $36.95
RIPPLE,ROSS $13.56
RIRIE,TRAVIS BURTON $4.77
RISDON,ANDREW $8.06
RISEBOROUGH,ALEX $7.52
RISH,DEBRA A $8.45
RISHFORTH,SARA $16.63
RISINGER,AMANDI $21.03
RISKO,BEVERLY M $9.15
RISLEY,RHONDA L $9.58
RISTE-SALTZMAN,AMANDA S $13.11
RISVOLD,ROSS H $42.21
RITCHEY,GAYANOR $15.29
RITTER,COREY $26.37
RITTER,CRYSTAL $3.00
RITTER,DAVID D $17.32
RITTER,SHELLY L $1.01
RITTMILLER,MIKE C $4.74
RITZ CAMERA & IMAGE LLC $60.41
RITZ,VALERIE A $7.98
RIVARD,DONALD T $13.93
RIVAS,AMPARO $9.02
RIVAS,JESSE E $16.62
RIVAS,SHIRLEY A $40.18
RIVERA III,JESUS $11.50
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has the icon image of a pair of binoculars. Pressing the binocular icon will also result to the display of the Find dialog box.

RIVERA MEDINA,JOSE R $22.43
RIVERA,CARLOS O $36.32
RIVERA,CINDY V $10.18
RIVERA,DAMIAN $9.08
RIVERA,FRANKIE $6.96
RIVERA,HERMAN $16.80
RIVERA,KRISTY R $40.05
RIVERA,LISA MARIE $40.21
RIVERA,LUZ MAE $75.50
RIVERA,QUERIDA MIA $21.12
RIVERA,TERESITA $52.05
RIVERS,KATHERINE $37.38
RO,MICHAEL TAE $10.83
ROACH,HEATHER $16.84
ROACH,JOVY E $15.12
ROACH,PATRICK A $3.12
ROACH,STEVIE $28.83
ROAN,CODY $2.93
ROBANCHO,BERNILYN V $34.21
ROBB,BRIAN $2.11
ROBBINS,DAVID G $21.69
ROBBINS,JOHNATHAN J $34.15
ROBBINS,KATHRYN $3.88
ROBBINS,KRISTINE J $3.39
ROBBINS,THOMAS S $0.19
ROBERDS,PAULA $35.98
ROBERSON,KIRA $10.25
ROBERSON,RENA TASHIA $9.39
ROBERSON,SEAN R K $27.09
ROBERTS JR,LAWRENCE J $20.70
ROBERTS,ALEX $31.19
ROBERTS,BOB $23.86
ROBERTS,CLAY $9.15
ROBERTS,EPHRAIM $11.75
ROBERTS,GREGG C $9.12
ROBERTS,JAMES L $9.52
ROBERTS,JASON A $11.15
ROBERTS,KELLY $19.31
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has the icon image of a pair of binoculars. Pressing the binocular icon will also result to the display of the Find dialog box.

ROBERTS,KERIN $10.82
ROBERTS,LYNN $34.31
ROBERTS,MARILOU $1.50
ROBERTS,RENE $27.25
ROBERTS,RICHARD L $33.17
ROBERTS,SARAH J $41.03
ROBERTSON,ANITA G $66.33
ROBERTSON,ANTHONY O $31.31
ROBERTSON,CHRIS $25.67
ROBERTSON,DEAN $1.14
ROBERTSON,JUDY $13.06
ROBERTSON,LAURA B $26.65
ROBERTSON,MICHAEL $11.07
ROBERTSON,NICHOLAS O $12.11
ROBERTSON,PHILIP $3.38
ROBERTSON,ROBERT B $8.01
ROBERTSON,SARAH L $12.29
ROBERTSON,STEVE $75.49
ROBERTSON,ZANDRA $18.15
ROBINSON MILLWORK INC $35.74
ROBINSON,ANTHONY $20.44
ROBINSON,ASHLEE $15.31
ROBINSON,EMILY $7.78
ROBINSON,JACOB $0.86
ROBINSON,JAMES O $3.92
ROBINSON,JENNIFER $31.57
ROBINSON,JEREMIAH $22.71
ROBINSON,JOHN M $38.83
ROBINSON,KRISTIN $1.63
ROBINSON,LINDA $11.02
ROBINSON,LINDA $50.98
ROBINSON,RAYMOND E $12.17
ROBINSON,SALLY L $52.92
ROBINSON,SARAH E $5.23
ROBINSON,SEAN $16.18
ROBINSON,SHERRIE $49.53
ROBINSON,TIERRA $9.48
ROBISON,ALIETA $16.43
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Chugach recently mailed 2010 Capital Credit Allocation letters to its former members.  The letter stated an incorrect allocation 
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has the icon image of a pair of binoculars. Pressing the binocular icon will also result to the display of the Find dialog box.

ROBISON,SARA $4.10
ROBISON,SHAWN O $1.76
ROBLES,ANGEL C $0.84
ROBLES,MARTIN $5.14
ROBLES,RAUL $14.80
ROBLOR INC $547.70
ROBSON,HANNAH $11.71
ROBSON,JOHN J $39.45
ROCERETA,JESSICA $36.09
ROCHE,BRAD $13.44
ROCHON,FRANCIS H $4.15
ROCK,GREGG C $10.74
ROCK,WILLIAM $88.50
ROCKEY,ANDREW C $27.83
ROCKVAN,JASON $13.60
RODE,PENNY $13.22
RODEWALD,ROBERT R $45.66
RODGERS,AARON S $48.51
RODGERS,DAVID S $14.50
RODGERS,IVORY R $3.46
RODGERS,JOHN $2.62
RODGERS,LANCE $36.81
RODGERS,TAUNI $9.25
RODMAN,CATHY $16.62
RODRICK,CANDICE $14.23
RODRIGUES,SCOTT KEKAULIKE $15.99
RODRIGUES,TALISA $9.65
RODRIGUEZ,ALICE INES $11.36
RODRIGUEZ,ALISHA $1.23
RODRIGUEZ,ANNE VANESSA $2.42
RODRIGUEZ,ANTHONY $42.44
RODRIGUEZ,CECILIA $16.18
RODRIGUEZ,CHELSIE $5.48
RODRIGUEZ,FELIPE J $7.40
RODRIGUEZ,FERNANDO LEE $16.22
RODRIGUEZ,JESSE $10.34
RODRIGUEZ,JOHN $18.18
RODRIGUEZ,KATHRYN A $4.01
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has the icon image of a pair of binoculars. Pressing the binocular icon will also result to the display of the Find dialog box.

RODRIGUEZ,KAZUKO $2.24
RODRIGUEZ,LUIS R $5.22
RODRIGUEZ,MANUEL $4.45
RODRIGUEZ,MARCY J $28.99
RODRIGUEZ,MICHELLE M $9.20
RODRIGUEZ,PATRICIA $1.42
RODRIGUEZ,RAEJEAN SUE $47.29
RODRIGUEZ,ROBERTO M $11.23
RODRIGUEZ,RYAN $15.74
RODRIGUEZ,VALERIE R $40.48
RODRIGUEZ-CARDENAS,NOEL $11.44
RODRIGUEZ-MCCOY,YOLANDA $32.43
ROE,CODY $9.61
ROE,JAMES A $29.26
ROE,VIRGINIA L $15.40
ROEDER,TAMMY L $34.63
ROEHL,BETTY G $12.38
ROEMER,STEFAN $5.90
ROGAN,JONATHAN $10.69
ROGAN,LAEL M $1.21
ROGERS,CHAYLA $25.79
ROGERS,CRISTY A $11.20
ROGERS,DIANNE $4.61
ROGERS,GARY $42.09
ROGERS,JENNIFER L $21.74
ROGERS,JERRY $19.98
ROGERS,KATHY $19.15
ROGERS,MARK E $12.10
ROGERS,OTIS $51.22
ROGERS,PATRICK J $29.12
ROGERS,SARA M $23.72
ROGERS,THOMAS W $26.98
ROHAN,M CELESTE $12.84
ROHAN,MAXINE $33.53
ROHDE,SHARON $8.58
ROHLEDER,ANDREW $45.31
ROHLF,JOAN E $41.35
ROHLFING,MARY $23.88
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has the icon image of a pair of binoculars. Pressing the binocular icon will also result to the display of the Find dialog box.

ROHLOFF,WILLIAM $5.04
ROHRER,LORENA $0.31
ROHWER,PAUL $12.14
ROJAS,VALERIA P $14.02
ROLAND,KAYLA A $1.36
ROLDAN,ANNARACHIELE T $2.59
ROLFE,JESSICA $3.78
ROLL,BENJAMIN $2.04
ROLLER,STEVEN $29.30
ROLLINS,REGINA $1.26
ROLLISON,KEVIN P $32.57
ROMA,ANTHONY M $27.42
ROMACK,IDA J $39.34
ROME,TERRI J $25.81
ROMER,BYRON K $5.50
ROMER,SANDRA $17.88
ROMERO,AMBER $13.44
ROMERO,BLAKE $20.69
ROMERO,GEORGE $37.24
ROMERO,MARY R $4.85
ROMERO,VERONICA FERNANDEZ $2.35
ROMEY,LINUS $27.47
ROMIE,ANECIA C $1.76
ROMINE,DOROTHY M $43.13
ROMOHR,KYLE $5.47
RONDEAU,DAPHNE D $5.18
RONDEAU,HYEJEONG $19.78
ROOD,PATRICK J $13.03
ROOKER,GARY $5.69
ROONEY,REBA A $27.73
ROOP,KEENAN $15.71
ROOSA,HELEN J $79.74
ROOT NUSS,CONSTANCE $3.81
ROOT,BRENDA $93.82
ROOT,GEORGE $16.60
ROOT,RUSSELL R $34.76
RORAFF,ARTHUR $40.89
RORISON,PHILIP JOHN $47.76
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has the icon image of a pair of binoculars. Pressing the binocular icon will also result to the display of the Find dialog box.

ROSALES,FERNANDO $37.95
ROSALES,WILFREDO $35.01
ROSARIO,DARLENE $13.80
ROSARIO,ERICKA A $15.27
ROSARIO,GIL MINA $10.40
ROSARIO,KATHY A $22.10
ROSAS,JULIE MARIE $1.53
ROSAUER,JAKE $0.45
ROSAY,DAVE $24.22
ROSE,ELIZABETH $59.61
ROSE,JAMES $7.47
ROSE,JAMES A $37.27
ROSELL,JASON LEE $19.28
ROSEN,SHANNON $43.87
ROSENAU,KRYSTAL $9.52
ROSENDALE,RICHARD $15.87
ROSENTHAL,MARA A $3.03
ROSEWARNE,RUTH DINEEN $10.07
ROSKELLEY-JOHNSON,ALEXIS J $13.38
ROSNER,AISLING MICHELLE $40.60
ROSS,BETTE J $52.81
ROSS,JAMES M $35.55
ROSS,JENNIFER $17.07
ROSS,MATTHEW O $3.13
ROSS,REBECCA $13.11
ROSS,ROBERT $49.32
ROSS,SHANNA $25.96
ROSS,TALENA $13.66
ROSSETT,JAMES B $6.68
ROSSI,DAWN $11.62
ROSSIO,TIMOTHY $0.91
ROSTANT,JUSTIN $16.08
ROSTER,MATTHEW A $17.71
ROTA,MICHAEL P $36.89
ROTH,BRITTNEY F $18.14
ROTH,DANIEL $22.93
ROTH,SHIRAH L $34.49
ROTHENBERGER,DANIEL $13.00
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ROTHER,STACEY M $21.70
ROTOLA,CHRISTIAN $2.51
ROUSCULP,CELENA V $20.69
ROUSE,JONAH J $2.82
ROUSE,MARIA D $25.83
ROUSH,HOLLY $7.47
ROUSSELL,BRYAN $49.55
ROUTH,CINDY A $26.67
ROUTT,DAVID $62.96
ROWE,ANGEL $24.78
ROWE,CHELSEA A $5.82
ROWE,CHERYL $0.57
ROWE,ECHO $17.43
ROWE,SHYLAH $6.98
ROWE,WILLIAM $48.13
ROWLAND,GEORGE K $1.16
ROWLAND,SCHRIE $30.40
ROWLETT,JERICA M $34.03
ROWLEY,DAN M $30.88
ROWLEY,JASON M $2.53
ROWLEY,WILLARD S $68.78
ROY,AMBER S $17.65
ROY,SHANNAN K $2.79
ROYAL,CHELSEA $10.16
ROYCE,WESLEY A $9.53
ROYLANCE,DONN H $1.82
ROYSE,SHANNON $5.03
ROZELLE JR,GARY D $5.26
ROZELLE,GARY $19.43
ROZELLE,JAMIE L $21.73
RUBEY,THERESA $13.97
RUBIN,DAVID $38.58
RUBINO,LAURIE $2.91
RUCANDO,MATTHEW P $0.82
RUCKER,BENJAMIN $11.49
RUDD,MICHAEL J $27.74
RUDD,SHARON $44.42
RUDDELL,SEAN P $4.85



Name Allocation

Chugach recently mailed 2010 Capital Credit Allocation letters to its former members.  The letter stated an incorrect allocation 
amount on the letter.  If you received one of these letters, you may confirm the correct amount of your allocation by searching* 
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RUDDY,SHAWN $10.21
RUDOLPH,BART H $19.88
RUE,KEVIN M $17.33
RUF,JONATHAN S $18.22
RUGE,CHRISTOPHER H $7.55
RUGGLES,DONNA $16.69
RUIZ,JAMES DANIEL $16.97
RUIZ,SANDRA K $2.91
RUIZ,SILVERIO $13.10
RUKOVISHNIKOFF,MELISSA $6.59
RUMBAUGH,GENEVA A $26.43
RUMJAHN,HARLAN $9.81
RUNDLE,CHERYL M $38.79
RUNKLE,JOHN R $7.23
RUOCCO,TREVOR $40.37
RUOZI,TENA M $74.63
RUPE,MARY M $27.47
RUPERT,DEBORAH E $4.65
RUPERT,KEN $28.83
RUPERT,KYLE JUSTIN $44.03
RUPPERT,DOUGLAS $57.80
RUPPERT,JEAN G $14.06
RUSH,DAVID L $4.74
RUSH,FRANCES $7.52
RUSHING,RICKY G $24.82
RUSHTON,RACHEL $4.46
RUSSELL,CATHY A $39.19
RUSSELL,CLARK $0.47
RUSSELL,ELAINE $31.71
RUSSELL,JENNIFER $17.82
RUSSELL,JESSICA M $14.14
RUSSELL,JUSTIN $17.77
RUSSELL,KATHRYN $18.52
RUSSELL,KEITH $8.42
RUSSELL,MICHAEL C $8.15
RUSSELL,MICHAEL L $35.41
RUSSELL,NICK $4.42
RUSSELL,STEPHNIE $14.40
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RUSSELL,ZACHARY J $8.24
RUST,CHARLES W $79.15
RUST,DAVID A $11.35
RUST,JESSIE M $31.43
RUSTAN,PETER $0.90
RUTAN,BETTE $33.79
RUTH,CANDACE ALICIA $42.58
RUTHERFORD-GREEN,AMON A $24.87
RUTKOWSKI,CHRISTOPHER JOSEPH $50.64
RUTLAND,BRANDON $12.86
RUTLEDGE,ANGELA R $11.16
RUTLEDGE,COLLEEN $31.11
RUTLEDGE,JOHN RICHARD $14.18
RUTLEDGE,TYLER RAY $10.58
RUTTENBERG,MARILYN DALE $0.73
RUTTER,DAPHNE S $34.97
RYAN AIR SRVC INC $144.35
RYAN,THOMAS $6.97
RYAN-EBERT,AMY $10.24
RYBCZYNSKA,REGINA T $4.07
RYBCZYNSKI,DIANA $26.44
RYDIN,SCOTT M $22.35
RYE,RICHARD T $6.03
RYERSON,DOUG G $23.58
RYLANDER,IVY $10.75
RYNONE,JACQUELINE LEANE $2.89
SAAM,MARGARET $17.23
SAATCHI,BEJAN $9.51
SAATHOFF,BRYAN J $36.01
SABALA,MICHELLE $11.33
SABATO,ANDREA $8.46
SABIN,ALISHA $7.64
SABIN,CHRISTOPHER J $35.12
SABIN,ROGER $12.68
SACDYPHOUD,BOUNMY $24.19
SACHSENMAIER,JOSHUA R $5.97
SACKETT,DOUGLAS J $15.97
SACKETT,SANDY $2.83
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SACLAYAN,REYNALDO $33.05
SADLER,CURTIS L $7.47
SADLER,VAN L $6.21
SAECHAO,CARRIE $22.06
SAECHAO,ELSIE $18.72
SAECHAO,JENISE $4.87
SAECHAO,KAO J $31.97
SAECHAO,TIAN SENG $21.00
SAENA,ONOSAI $40.45
SAENA,UPUIA C $51.74
SAEPHAN,LEWCHIE $10.42
SAETERN,CHENG JOY $8.40
SAETERN,KAO S $11.54
SAETERN,LAI HIN $25.46
SAETERN,LO MEUY $41.01
SAETERN,NAI S $14.15
SAETEURN,YAO $23.63
SAETRE,CHADWICK P $82.17
SAFFELL,AMBER $1.89
SAFFER,ERIN E $15.75
SAGEN,RICHARD $7.98
SAILELE,NATI $15.41
SAITO,GARNER $5.99
SAKRIS,DEREK $24.73
SALA JR,SEPELINI $61.19
SALAS,JOSE $9.37
SALAS,SALVADOR M $16.32
SALBERG,JUSTIN MICHAEL $25.04
SALDIVAR,NELLIE $25.03
SALES,TYRONE W $80.64
SALGUET,FLORELIZA $3.09
SALKELD,DAVID $16.39
SALLEE,DONNA $5.70
SALMON,JOSEPH $43.87
SALTER,SHAWN M $35.58
SALYER,MICHAEL $34.22
SALYER,NICHOLE DIANE $14.72
SALZMAN,KEITH R $20.38
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1. Press CTRL plus F on your keyboard.  A FIND dialog box will appear on the PDF reader.

2. Click on the Edit menu, and locate-click the Find command.

3. Locate the Find tool button on the toolbar of the PDF reader (most commonly under the File menu bar). The Find tool button 
has the icon image of a pair of binoculars. Pressing the binocular icon will also result to the display of the Find dialog box.

SAMARASINGHE,ASHANTHA $14.02
SAMBO,LOUISE N $21.48
SAMIA,RONALD $9.07
SAMIFUA,MARY $20.37
SAMPLE,DARREN C $6.97
SAMPLE,MATTHEW J $5.41
SAMPSON,BEATRICE R $12.56
SAMSON,VIOLA M $0.91
SAMUDIO,ANGELICA $54.14
SAMUELES,CHERRON $52.21
SAMUELS,JEFFREY D $17.58
SAMUELS,LAKESHA $27.95
SAMUELSON,ALLAN $24.19
SAMUELSON,JOHN C $5.29
SAN MIGUEL,JOHN A $16.05
SANCHEZ,CANDICE M $18.59
SANCHEZ,CAROL $11.03
SANCHEZ,JESSE $16.75
SANCHEZ,PEREGRINA $20.38
SANCHEZ,RAMONA G $28.84
SANCHEZ-LOPEZ,GLORIA A $3.12
SANCHEZ-ZAZO,RICHARDO $16.90
SANCULI,PATRICIA L $3.92
SAND LAKE TESORO LLC $68.37
SAND,LISA A $31.22
SANDEN,CHRISTA $20.68
SANDERLIN,BETHANY ADELL $18.81
SANDERS,EDWARD R $0.81
SANDERS,JENNIFER Y $6.91
SANDERS,JEREMIAH N $48.22
SANDERS,KATY $16.16
SANDERS,MARK A $27.05
SANDERS,MATTHEW $7.64
SANDERS,SAROYA L $15.75
SANDERS,SUSAN L $20.28
SANDIDGE,CHRISTA $21.63
SANDLIN,JENNIFER $4.99
SANDY,SUSAN $12.56
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SANFORD,IRINA $2.26
SANFORD,KENNETH G $20.33
SANFORD,LATONIA J $40.73
SANKEY,JOHN $11.54
SANOUVONG,LAMPHONE $10.57
SANTIAGO,ABRAHAM $6.52
SANTIAGO,JAMES $7.81
SANTIAGO,JOSE JR $1.57
SANTIAGO,MIGUEL $10.54
SANTIAGO-COLON,JERRY $17.52
SANTIESTEBAN,LIDIA R $9.23
SANTILLANA,JOANNA $17.69
SANTISTEVAN,EDDY $35.67
SANTOS,CARLOS ANDRES $2.19
SANTOS,JERRY A $11.61
SANTOYO,VERONICA $18.34
SANTUR,JHONY M $32.41
SANVIG,SEMI $30.13
SAQUILAYAN,ALLAN J $6.72
SARGEANT,KYLE Z $19.82
SARGENTO,AQUILINO $24.87
SARKISSIAN,LEON $1.71
SARKISSIAN,SONIG $20.03
SARNOWSKI,ALEKSANDRA $16.89
SASIETA,AMANDA G $12.84
SATCOM SYSTEMS INC $14.45
SATHER,AMY MICHELLE $37.53
SATORU,KODANI $14.49
SATOW,SARAH $8.49
SATTERFIELD,LINDEE $8.78
SATTERFIELD,RICHARD $19.40
SAUCEDO,HUMBERTO $2.79
SAUCIER,AMBRIA R $19.82
SAUNDERS,BARBARA J $15.57
SAUNDERS,JAMES $33.49
SAUNDERS,MELISSA $3.59
SAUNDERS-IRWIN,LORRIE $9.95
SAVAGE,ELISE IRENE $3.38
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SAVAGE,GAYLE W $23.89
SAVAGE,JAMES L $17.73
SAVAGE,KAREN H $6.25
SAVAGE,ROSEMARY L $2.21
SAVARESE,DANIELLE $26.99
SAVARY,RACHEL $8.85
SAVILLE,SUZETTE $2.43
SAVOIE,MEGAN $12.47
SAVOK,WILLIAM A $25.88
SAWADA,CONSTANCE $7.60
SAWYER,DEREK $57.20
SAYCHAY,RATSAMY $36.27
SAYEN,MELODY $62.66
SAYERS-FAY,KIMBERLY R $48.55
SAYLES,JOSHUA M $11.62
SAYRE,DAPHNE $9.52
SAYSANASY,SERIPHONE $11.30
SCAGLIONE,DEANNA $0.96
SCALETTA,NICOLE $18.37
SCANLAN,MEGAN K $30.02
SCANLAN-HODGES,BERNADETTE $4.57
SCANLON,JAY E $13.87
SCARLETT,SUSAN R $4.65
SCHACHER JR,RICHARD $31.09
SCHAEFER,EUNICE S $39.61
SCHAEFER,JARRETT $42.12
SCHAEFFER IV,JOHN WESTON $33.16
SCHAFER,MICHELLE $19.67
SCHAFER,SUSAN A $22.43
SCHAFF,DANIEL PHILLIP $11.99
SCHANDEL,JASON $14.49
SCHANDEL,KRISTI $32.28
SCHARTHI,STEPHEN T $9.87
SCHATZ,TINA J $14.82
SCHAUGAARD,MADISON $15.36
SCHEELE,STEPHEN M $24.62
SCHEFE,CANDACE $7.75
SCHEID,BRIAN $10.15
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SCHELIN,DONNA $14.72
SCHENKER,MADELINE L $12.12
SCHENKOSKI,JUSTIN B $20.16
SCHIAVI,MATTHEW $7.64
SCHICK,JON W $25.24
SCHIEFELBEIN,CHELSEY M $38.11
SCHIERHOLT,DARYL R $41.24
SCHILLEREFF JR,JOHN C $27.52
SCHINDLER,KEITH $17.24
SCHLABACH,JOHN $18.70
SCHLADER,WILLIAM PATRICK $14.46
SCHLAHT,SHERRI $33.45
SCHLEE,CONNI $6.76
SCHLEMME,ERIN L $37.84
SCHLINS,ROBYN $11.01
SCHLOSSER,SKYLA MARIE $12.89
SCHMELZER,KING $7.46
SCHMID,CATHERINE A $19.28
SCHMIDT,CHRISTOPHER N $4.09
SCHMIDT,CRAIG $1.18
SCHMIDT,DANIEL J $40.54
SCHMIDT,DARUS E $51.72
SCHMIDT,HEATHER $21.14
SCHMIDT,JAMES $2.16
SCHMIDT,JOHNATHAN M $13.56
SCHMIDT,JOSEPH J $34.63
SCHMIDT,RONNI L $12.70
SCHMIDT,SCOTT E $76.94
SCHMIDT,TYLER $23.53
SCHMITT,SUMMERLEE LORENE $2.12
SCHMOE,ZACH $3.88
SCHNEIDER,CATHERINE $41.90
SCHNEIDER,PATRICIA $12.51
SCHNEIDER,SHIRLEY A $19.19
SCHNEIDER,WILLIAM $33.20
SCHNEIDER,WILLIAM $11.21
SCHNELL,ANTHONY $26.17
SCHNELL,HEATHER MARLENE $6.79
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SCHNELL,SCOTT D $36.28
SCHNELL,TRENITIE MONIQUE $7.67
SCHNELL,TREVOR $40.83
SCHOEFFLER,KRISTOPHER R $8.64
SCHOENENBERGER,ANDREW $12.31
SCHOOLEY,JESSICA A $20.68
SCHOW,JOSEPH R $7.83
SCHRADER,KRISY $9.08
SCHRADER,RICHARD $7.43
SCHRADER,SUSAN M $11.51
SCHRAMM,DANIEL $27.11
SCHRECK,ANDREW R $35.56
SCHRECK,JUSTIN $16.54
SCHRECKENGHOST,CARA $27.42
SCHREINER,JAMES U $16.31
SCHRICKER,CHARLES $41.28
SCHROEDER,MARY JANE $32.60
SCHROEDER,SARA LYNN $18.78
SCHUBERT,LANCE H $1.37
SCHUELER,ERIC $4.53
SCHUERCH,NELLIE K $65.24
SCHUETTE,MARK $4.88
SCHULTE,PAUL $22.91
SCHULTZ II,KARL A $15.40
SCHULTZ,ALLISON $36.14
SCHULTZ,ARTHUR $1.17
SCHULTZ,BRENDA S $40.49
SCHULTZE,MICHAEL A $23.63
SCHULZ,CHRISTOPHER R $5.88
SCHULZ,JEFF $80.46
SCHULZE,JACQUELYN R $9.81
SCHUMACHER,ADAM J $24.83
SCHUMACHER,JAMES T $52.85
SCHURMAN,DARELL $10.39
SCHUYLER,GALE $31.80
SCHWAB,BRENT B $7.37
SCHWAB,JENNIFER J $47.19
SCHWALM JR,MACK H $18.31
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SCHWAN,MARTIN $3.54
SCHWARTZ,MELISSA $30.33
SCHWARZ,JAMES A $30.33
SCHWARZ,THOMAS $31.53
SCIBOR,KRISTIN $29.01
SCOFIELD,DANA $48.52
SCOFIELD,KEN $37.41
SCOFIELD,KERI ANN $20.57
SCOFIELD,STEPHEN $12.76
SCOTT III,EDSEL I $10.07
SCOTT,AARON F $23.96
SCOTT,AARON M $24.22
SCOTT,ALEXIUS RAY $38.83
SCOTT,CHRISTINA L $20.99
SCOTT,CHRISTINE $22.14
SCOTT,CHRISTINE A $27.45
SCOTT,DAVID M $24.69
SCOTT,DEBORAH $13.37
SCOTT,HANNAH $11.86
SCOTT,JENNIFER ROBIN $20.40
SCOTT,KATHRYN E $27.76
SCOTT,KEVIN J $41.62
SCOTT,LESLIE $35.08
SCOTT,MARDELLE $23.89
SCOTT,MEGAN R $17.98
SCOVELL,SIDNEY EUGENE $32.24
SCRIVENS,LARRY $22.25
SCRUGGS,MAYA A $12.30
SCUDDER,JON K $2.50
SEABOLT,DAVID $2.47
SEALE,JULE A $15.97
SEAMAN,RUSTY $23.92
SEAMONS,PETER $21.76
SEARS,JOSH W $16.47
SEARS,MICHAEL $2.77
SEARS,STERLING T $12.73
SEATON,CHRISTOPHER T $2.79
SEAWOOD,JERUSA V $4.99



Name Allocation

Chugach recently mailed 2010 Capital Credit Allocation letters to its former members.  The letter stated an incorrect allocation 
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for your name in the list below.  
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has the icon image of a pair of binoculars. Pressing the binocular icon will also result to the display of the Find dialog box.

SECCOMBE,PAMELA S $100.47
SECOMB,JOHN DAVID $6.30
SEDIVY,ANDREW D $15.04
SEE,REBECCA J $32.30
SEGO,ROBERT $9.10
SEIDNER,SHAINA $7.39
SEIFERT,ERLINDA $20.27
SEKI,ISAO $13.52
SELDERS,WHITNEY K $53.91
SELF,AMANDA $24.07
SELKOWITZ,DAVID J $18.74
SELLARS,MIKHAIL L $23.32
SELLERS,AZRIEL ISAIAH $4.94
SELLERS,GARY $45.33
SELLERS,JOHN W $24.20
SELLERS,MARY JEAN $6.39
SELLERS,ROBIN C $16.53
SELLERS,SHELBY R $14.90
SELLS,COLIN $19.40
SELMAN,JETT H $6.33
SELMAN-MURPHY,SUSAN KAY $10.54
SELMER,WAYNE L $15.69
SELTENRIGHT,ANA M $13.36
SELVES,JULIE $14.87
SEMEATU,ANA $48.62
SEMERARO,JOSHUA KARL $5.64
SEMIRYAZHKO,OLGA A $24.46
SENA,JACQUELINE D $42.28
SENE,REGINA $13.62
SENECAL,BRYAN W $5.70
SENESE,ALBERT $11.70
SEOK,JOUNG-UK $17.80
SEPPI,RUSSELL $19.12
SERGO,BENJAMIN LEE $0.81
SERJEANT,BECKY A $36.17
SERVILLON,STEVEN C $17.39
SESSOMS,JASON $3.75
SETCHELL,JULIE ANNE $35.50
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has the icon image of a pair of binoculars. Pressing the binocular icon will also result to the display of the Find dialog box.

SEVERSON,AARON JEFFERY $33.58
SEVERSON,JESSICA M $8.73
SEVERSON,RUTH $13.96
SEVIER,JOSHUA M $23.92
SEWARD,DARRELL $10.08
SEWARD,LORRIE $12.05
SEWELL II,ANTHONY E $5.46
SEXTON,JASMINE $7.97
SEXTON,RICHARD S $9.83
SEXTON,SUZANNE $13.35
SEYB,DONNA M $33.39
SEYMOUR,NATHAN $18.87
SEYMOUR,RYAN $19.49
SEYMOUR,ZACHARY D $42.33
SHABANI,LATIF $0.42
SHABOLIN,MAXIM V $0.49
SHADE,DONNA L $18.91
SHADE,HEATHER J $36.25
SHADE,LYDIA G $44.05
SHADLE,CANDACE L $19.14
SHADURA III,PAUL A $31.91
SHAE,JESICA $77.94
SHAFER,HEROLD E $6.56
SHAFER,JANE $9.39
SHAFER,KARY L $12.68
SHAFER,MARGARET MARIE $11.27
SHAFFER,IAN R $25.24
SHAFFER,JILL C $0.24
SHAGENA,LONNIE E $60.09
SHAIKH,NAEEM MUHAMMAD $29.47
SHANAHAN,TONY A $3.05
SHANGIN,NOAH $27.81
SHANIGAN,BRYANT T $5.55
SHANKLIN,STEPHANIE $7.74
SHANKS,JAMES BRANDON $28.44
SHANKS,RACHEL L $35.33
SHAPLAND,PHILIP T $4.12
SHAPPELL,STEPHEN A $27.65
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3. Locate the Find tool button on the toolbar of the PDF reader (most commonly under the File menu bar). The Find tool button 
has the icon image of a pair of binoculars. Pressing the binocular icon will also result to the display of the Find dialog box.

SHAPSNIKOFF,SHIRLEY M. $17.34
SHARKY,NOLA C $57.67
SHARP,JULIENA $23.67
SHARP,KELLEN $14.63
SHARP,LORI $0.44
SHARP,MICHAEL C $2.96
SHARP,VIVIAN C $19.94
SHARRAR,KAYCELYN M $2.11
SHARRON,CHRISTOPHER J $17.78
SHARY,R F $75.53
SHATILOV,EVGENY $5.72
SHAVINGS,MELISSA $6.70
SHAVINGS,SUSIE $12.53
SHAW,ADAM R $9.16
SHAW,ALEXANDER $22.85
SHAW,ANTHONY $4.12
SHAW,BRANDON $27.08
SHAW,BRIAN S $8.78
SHAW,CYNTHIA G $8.26
SHAW,GEORGIA G $33.73
SHAW,ISRAEL $41.33
SHAW,ROBERT $79.47
SHAW,ROBERT F $8.58
SHAY,RYAN H $4.02
SHCHEGLYUK,ANNA $7.22
SHEA,NICOLE $25.49
SHEA,RICKY E $16.14
SHEA,SAMUEL $6.93
SHEAFFER,JASON C $9.57
SHEAKLEY,ALICIA F $27.43
SHEARER,GREG EMERSON $13.86
SHEARS,GEORGIANNE $19.87
SHEARS,NICHOLAS $19.99
SHECKELLS,MARY E $13.34
SHECKLER,DALLAS $16.56
SHEEHY,NANCY $26.31
SHEFFIELD,MEGAN $21.39
SHELDON,COLLEEN M $7.43
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SHELDON,CRYSTAL L $4.91
SHELDON,HEATHER $9.82
SHELDON,JOHN RUSSELL $18.52
SHELDON,SHAUNA M $6.91
SHELDON,TRAVIS D $25.42
SHELL,STORMIE L $13.05
SHELLABARGER,ZACHARY $18.70
SHELLEY,CARRIE $29.27
SHELLEY,GALEN D $9.32
SHELLEY,JAY $12.69
SHELTERS,AMANDA $19.25
SHELTON,SHEELAH $38.29
SHEPARD,JODELL $39.05
SHEPHERD,ISAAC W $29.19
SHEPHERD,KAYLA D $29.16
SHEPHERD,MARK K $23.91
SHERBAHN,SHANNA M $2.50
SHERE,JOSHUA M $7.07
SHERFIELD,ROXANNE $56.27
SHERIDAN,REBECCA $3.69
SHERMAN,DUSTIN $58.94
SHERMAN,RYAN J $14.60
SHERRILL,RONALD E $6.55
SHERWIN,JESSI $18.02
SHERWOOD,CORRY J $6.64
SHERWOOD,JANET $20.49
SHERWOOD,JIDETTE L $8.57
SHERWOOD,K H $21.83
SHESHPARI,MAHSONTAN $2.63
SHETLER,COLISTA R $1.33
SHIDNIA,PETRA $0.79
SHIELDS,STACEY M $25.15
SHIGAKI,SHIN $7.47
SHIGENORI,TERASAKI $16.24
SHIM,EUN BO $19.32
SHIMEK,SUZANNE J $102.26
SHIN,JAMES $26.42
SHINABARGER,TRAVIS J $5.89
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SHINE,TONISHA $16.90
SHINLEVER,CHRYSTAL S $4.22
SHINSATO,JENNIE $16.59
SHINYA,HIROSHI $22.30
SHIPE,TIMOTHY $16.15
SHIPLEY,ANDREW $18.26
SHIPLEY,JEREMIAH M $24.80
SHIPLEY,JORDAN $24.04
SHIPMAN,DAVID $0.11
SHIPMAN,TANIA M $16.16
SHIRER,GEORGE R $39.85
SHIRLAND,JUSTIN C $4.41
SHIRLEY UPTON MARITAL TRUST $4.14
SHIRNBERG II,ROBERT R $127.06
SHIVERS,RICKY W $27.59
SHJEGSTAD,ERIK $34.18
SHLOSAR,ZACH $11.47
SHOBE,STEPHEN ROBERT $34.40
SHOOK,JANICE E $25.24
SHORT,JACK $20.59
SHORT,ROBERT B $24.10
SHOUGH,LORI C $32.40
SHOWELTER,KEVIN $14.48
SHRUM,JOHN $24.15
SHRUM,TINA R $4.17
SHUCK,STEVEN P $2.70
SHUMAN,WELDON J $27.49
SHUTE,BRIAN R $53.77
SIANOUTHAI,LAMNGEUNE $2.16
SIBLEY SR,PAUL WILLIAM $29.32
SIBLEY,JAMES $12.00
SIBOLE,BRANDIE M $13.63
SICKLES,MARK $22.77
SICOTTE,MICHAEL $15.12
SIDDIQUI,TARIQ A $27.82
SIDELL,MICHAEL B $6.51
SIEBERT,MARY ELLEN M $64.11
SIEBS,STEVE $50.22
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SIEG,MARK E $20.54
SIEVER,CHRISTIAN F $9.66
SIGLEY,TYLER MATHEW $14.57
SIGURDSSON,JOHN S $31.19
SIKORSKI,ANDREW $10.95
SILBA,DEANNE MARIE $3.97
SILBA,STEVEN $14.40
SILI,ANAPONI $4.49
SILKMAN,ROSS J $39.96
SILL,GRANT E $28.76
SILL,LAUREN $4.93
SILOOK,LISA $5.15
SILVA,IMELETA $17.60
SILVA,IOANE T $12.73
SILVA,NANCY $2.32
SILVER,ANDREW $12.14
SILVERNAGEL,ANTHONY A $12.87
SIM,MONA $15.68
SIMA,RADIM $30.20
SIMEK,GERALD J $8.29
SIMEON,ALLEN $55.54
SIMEONOFF JR,ALBERT W $10.21
SIMEONOFF,JOLEEN D $11.36
SIMIEN,JOHN $12.87
SIMMONDS,MABEL IDA $13.11
SIMMONS II,GRANT A $20.71
SIMMONS,LEANN K $10.35
SIMMONS,LEONARD A $3.69
SIMMONS,MEGHAN $15.32
SIMMONS,NAQUISHA DEVERN $34.88
SIMMONS,OLEN $11.42
SIMMONS,SEAN D $7.85
SIMMONS,SUE $12.42
SIMMONS,TONY R $31.99
SIMMONS,WILLIAM J $17.47
SIMMONS,WILLIE $18.10
SIMON,KALYN $0.56
SIMONS,JESSICA $22.10
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1. Press CTRL plus F on your keyboard.  A FIND dialog box will appear on the PDF reader.

2. Click on the Edit menu, and locate-click the Find command.
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SIMONS,THERESA A $29.10
SIMPKINS,JAMES E $12.86
SIMPSON,BRENDA GALE $18.45
SIMPSON,BRYAN $42.41
SIMPSON,CATHERINE A $10.31
SIMPSON,CUAHUTEMOC $50.04
SIMPSON,EUGENE W $48.96
SIMPSON,JILLIAN $4.89
SIMPSON,SCOTT $0.53
SIMPSON-SMITH,JAMIE $1.59
SIMS,CORRY L $1.91
SIMS,DEBORAH F $37.10
SIMS,JOHN B $7.91
SIMS,TANIA $24.39
SIMTON,ANNELLE $0.95
SIMURDAK,ELMER $37.66
SINCLAIR,AARON $8.08
SINES,MINDA $36.18
SINGER,PERRY $86.96
SINGH,DELORIS $24.96
SINKLER,JED $46.24
SINNETT,ROBERT S $19.36
SINYANGWE,NATHAN $38.30
SIONE,FAAOLOVITI L $25.90
SIONE,LOLE $1.91
SIPARY,GARY $36.87
SIRES,BARRY $40.95
SIRIPALAKA,TOBY $4.73
SIRMANS,JULIA $14.39
SIS,DEBBIE J $22.86
SISICH,JUSTIN $1.83
SISK,BRANDON $6.79
SISLER,JAN $17.17
SISON,GONZALO $36.43
SISSON,KATHERINE V $28.84
SITAGATA,TALILEVA SALIE $14.58
SITHIPHONG,PHONVILAY $12.43
SITHIXAY,KETMANY $10.95
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SIUFANUA,MELE $60.22
SIVALON,CARLA D $21.22
SIVERTSON,SHARLENE E $4.42
SIVILAY,DOUNGCHAY P $10.09
SIX JR,TIMOTHY D $28.48
SIX,CASSANDRA L $27.03
SIX,MAKALA $5.55
SIX,MATTHEW M $21.56
SIX,ROBERT C $10.03
SIZELOVE,SLADE $15.54
SIZEMORE,NORMA D $32.19
SJODEN,DANIELLE C $1.11
SKAFKESATAD,KRISTI L $20.85
SKAGGS,KALEA $5.71
SKAGGS,VERONIKA $126.43
SKALISKY,RACHEL $17.04
SKEEN,JESSICA L $27.55
SKELLY,JACOB $12.93
SKELTON,SHERI $13.86
SKIBINSKI,ANNETTE M $57.20
SKILES,SARAH $19.62
SKINNER,ELIZA N $24.48
SKINNER,HERBERT LORINZO $5.74
SKINNER,WILLIAM $24.66
SKITT,PATRICIA $9.90
SKIVER,BRYON D $44.93
SKOLNICK,CORTNEY $5.29
SKOUTAS,STEPHANIE C $15.99
SKRUKRUD,NATHAN DANIEL $18.86
SKUSTAD,CARL $81.24
SLACK,MAURICE $19.73
SLADE,SHELDON E $13.80
SLAGLE,TAMMY ANGELIA $27.69
SLATER,KRISTINA L $6.08
SLATER,PEARL $7.07
SLATER,ROBERT H $19.02
SLAUGHTER,JEFF A $8.19
SLAUGHTER,JEREMY S $21.68
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SLAUGHTER,ROBERT $8.00
SLAYMAKER,NATALIE $36.44
SLEDGE,ELLA W $33.55
SLEDGE,KATIE $13.44
SLIMP,THOMAS EVERETT $13.04
SLIVENSKY,DANIEL $27.42
SLOAN,TRAVIS $13.06
SLOANE,GATLYNN RICHARD $35.57
SLOCUM,MOLLY $11.76
SLONE,JEFF $23.63
SLOPER,LYNDSEY K $19.01
SM PROPERTIES $14.58
SMALLEY,BRIAN A $3.85
SMALLMAN,MICHELLE $6.80
SMALLWOOD,CYNTHIA N $33.44
SMALLWOOD,DANIEL D $13.37
SMALLWOOD,ERIK $5.07
SMALLWOOD,ROSA $18.99
SMALLWOOD,SAMANTHA $12.30
SMALLWOOD,TODD H $32.46
SMALLWOOD,TODD H $38.30
SMALLWOOD,TRAVIS LEE $24.22
SMART,EMMITT D $19.07
SMART,JEFFREY $24.38
SMEAD,RENEE $14.85
SMELCER,MATT $0.62
SMELKER,RENEE $39.25
SMESTAD,CRISTY M $29.78
SMITH SR,KEEN $7.72
SMITH SR,NICHOLAS R $18.29
SMITH,AARON M $9.43
SMITH,ALICE SHIRLEY $19.94
SMITH,AMY MARIE $8.75
SMITH,ANDREW J $3.80
SMITH,ANNE ELIZABETH $9.45
SMITH,ASHLEY RAE $2.36
SMITH,BERNARD L $12.74
SMITH,BOBBY A $20.01
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SMITH,BRADLEY C $33.84
SMITH,BRANT $2.92
SMITH,BRIAN S $68.70
SMITH,BRITTNEY L $11.59
SMITH,CAITLEN $8.33
SMITH,CAMERON J $15.58
SMITH,CHANTRELL MARJORIE $36.48
SMITH,CHARLENE M $2.25
SMITH,CINTHIA M $42.91
SMITH,CODY W $10.09
SMITH,CONSTANCE B $36.56
SMITH,CORINNA M $16.83
SMITH,CYNTHIA $4.35
SMITH,DANIEL J $18.84
SMITH,DAVID RANDALL $25.51
SMITH,DAVID RICHARD $50.44
SMITH,DENNIS J $24.59
SMITH,DENNIS R $34.39
SMITH,DESTRY $12.94
SMITH,DINOGAN S $29.19
SMITH,DOUG A $49.52
SMITH,DOUGLAS $48.10
SMITH,DOUGLAS L $16.07
SMITH,EILEEN $10.27
SMITH,ERIC A $1.67
SMITH,ERICK E $2.77
SMITH,ERIKA T $33.66
SMITH,EVERETT J $38.45
SMITH,GEORGE J $12.84
SMITH,GLENDA J $3.97
SMITH,GLORIA $1.29
SMITH,HOLLY $11.17
SMITH,ISAAC $33.20
SMITH,JACK L $14.13
SMITH,JAMES L $11.41
SMITH,JASON LEE $7.38
SMITH,JEANETTE C $32.43
SMITH,JEFFREY JAMES $15.58



Name Allocation

Chugach recently mailed 2010 Capital Credit Allocation letters to its former members.  The letter stated an incorrect allocation 
amount on the letter.  If you received one of these letters, you may confirm the correct amount of your allocation by searching* 
for your name in the list below.  

*There are three ways to search for your name:                                                                                                                            
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SMITH,JENNIFER L $27.59
SMITH,JEREMIAH M $52.91
SMITH,JERMAIN M $2.93
SMITH,JERRY L $7.42
SMITH,JESSE LEE ANDREWS $22.70
SMITH,JESSICA $3.70
SMITH,JOSHUA ALEXI $17.18
SMITH,JOSHUA ALLEN $4.17
SMITH,KARLI M $3.76
SMITH,KEITH $26.04
SMITH,KELSEY L $9.55
SMITH,LAUREN M $35.90
SMITH,LORNA $5.46
SMITH,LUKE H $7.22
SMITH,MARY ELLEN $6.43
SMITH,MARY J $19.80
SMITH,MEGAN J $6.34
SMITH,MELODY $23.21
SMITH,MICHAEL A $29.43
SMITH,MICHAEL F $55.30
SMITH,MICHAEL J $23.81
SMITH,MICHAEL L $24.74
SMITH,MICHAEL LANDON $6.62
SMITH,MICHAEL LAWRENCE $18.36
SMITH,MOLLY B $5.63
SMITH,NICHELLE E $5.49
SMITH,NICHOLAI $8.06
SMITH,NICHOLE R $0.49
SMITH,PATRICIA A $14.22
SMITH,PRINCESS L $3.84
SMITH,RANDOLPH $12.62
SMITH,REVATHY THIAGARAJAN $33.74
SMITH,ROBERT R $24.19
SMITH,RONALD E $7.39
SMITH,RONALD J $16.49
SMITH,SCOTT D $13.12
SMITH,SCOTT D $11.30
SMITH,SHANA S $21.11
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SMITH,SHANNON MARIE $3.70
SMITH,STACY L $27.76
SMITH,STOVER L $23.20
SMITH,TAMMI L $15.48
SMITH,TARIK $39.54
SMITH,TASHA T $27.09
SMITH,TATIANA M $25.30
SMITH,TEDDY D $7.66
SMITH,TERENCE K $7.81
SMITH,TIM S $3.13
SMITH,TONI MARIE $15.76
SMITH,TORIN $3.50
SMITH,TREY F $22.48
SMITH,VIOLA S $6.67
SMITH,WES $96.83
SMITH-CHIMEGALREA,HELEN $5.05
SMITHER,JOHNNA T $44.91
SMITHIES,WILLIAM D $22.82
SMULICK,DAVID A $17.40
SMULICK,ERIN M $14.55
SMYTH,MARC A $6.82
SNEDECOR,SUSAN A $0.95
SNEGIREV,CLAUDIA C $16.70
SNELL,BARBARA A $12.43
SNELL,ERIC $7.41
SNELL,GRADY $16.16
SNELLGROVE,CHELSEA $33.41
SNELSON,ROBERT D $38.93
SNIDER,JOHN $21.68
SNIDER,RICHARD G $4.66
SNITIL,ERIC J $1.12
SNODDY,AMOS M $36.68
SNODGRASS,JOSH $3.69
SNOFSKY,ANDREW $10.34
SNOOZY,CLARE $12.39
SNOW WHITE CLEANERS INC $83.83
SNOW,JOSHUA $38.68
SNOW,LELAROSE S $5.95
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3. Locate the Find tool button on the toolbar of the PDF reader (most commonly under the File menu bar). The Find tool button 
has the icon image of a pair of binoculars. Pressing the binocular icon will also result to the display of the Find dialog box.

SNOW,NICHOLAS $28.64
SNOW,RAYMOND E $4.54
SNOW,RYAN P $14.21
SNOWBALL,TIA M $9.38
SNYDER,CRAIG D $33.93
SNYDER,JASON $24.99
SNYDER,LAUREN $7.32
SNYDER,PATRICK D $22.00
SNYDER,STACY L $7.71
SNYDER,SUSAN $22.34
SODER,ATHENA $3.19
SOKCHEAT,KONG $9.00
SOLARI-SAUNDERS,BARBARA $18.66
SOLDER,LLAYLA $41.81
SOLES,JONATHAN D $10.07
SOLIA,FREDDY P $8.00
SOLIAI,AMANDA PAIAU $21.62
SOLIDUM,LORENA $19.80
SOLIE,RICHARD $38.70
SOLIS,OSCAR D $7.98
SOLLARS III,SAMUEL R $56.66
SOLOMON,JANICE $20.66
SOLOVYEV,NIKOLAY $32.47
SOMADUROFF,MICHAEL A $33.39
SOMBATRATANAKUL,RACHA CHADS $16.66
SOMERS,CLIFTON P $21.60
SOMERVILLE,DEBORAH L $16.40
SOMMERFELD,POLLY $37.61
SOMMERFELD,S R $72.82
SOMMERS,DENITA $17.14
SOMMERVILLE,SARAH $65.25
SONDGEROTH,MICHAEL S $4.50
SONG,KYEONG SHIK $24.21
SONNABEND,GREGORY L $3.06
SONNEK,SCOTT M $26.99
SONNEN,MICHAEL J $5.35
SONNIER,JIM $22.42
SOOALO,SAMANTHA M $12.04



Name Allocation

Chugach recently mailed 2010 Capital Credit Allocation letters to its former members.  The letter stated an incorrect allocation 
amount on the letter.  If you received one of these letters, you may confirm the correct amount of your allocation by searching* 
for your name in the list below.  

*There are three ways to search for your name:                                                                                                                            
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SOOKIAYAK,HANNAH $14.92
SOOSUK,SHERI ANNE $15.14
SOPER,KANDACE K $44.40
SOREL,CHRISTOPHER $14.81
SORENSEN,JACK $2.01
SORENSEN,KIRA R $2.00
SORENSON,LEAH $9.25
SORIANO,DIANNA-JEAN SALVANERA $19.31
SORRENTINO,ANGELA M $15.81
SOSA,CARMELLA VALDEZ $36.15
SOSA,ERCILIO A $13.86
SOSA,MIGUEL $7.04
SOTAK,MARY $6.44
SOTO,MARIA $16.32
SOTTILE,CINDY K $55.02
SOUCY,LARRY E $23.08
SOUKKOTH,SENGDAO $3.71
SOUND TRANSPORTATION INC $6.15
SOUNTHONE,BOUNMY (BONNIE) $27.11
SOURS,SUSIE $2.95
SOURS,SUSIE K $14.10
SOUTH,LOUISE $4.45
SOUTH,TATE L $15.97
SOUTHERN,JAMES M $9.77
SOUVANNAKASY,DOUANGSAY $2.67
SOUVANNASENG,BOUNGNANG $7.15
SOUZA,MICHELLE $17.51
SPADAFORA,MEGAN V $38.26
SPARGUR,BRADLEY R $5.94
SPARGUR,ERNEST M $0.47
SPARKS,ALLEN M $19.61
SPARKS,MARGARET $32.83
SPAULDING,MYUNG SIM $41.74
SPEAKER,JEREMIE $7.85
SPECKING,GLEN $32.39
SPEEDY,DAVID C $6.26
SPEER,CARRIE $13.94
SPEER,JERRY $9.07
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SPEER,LANNIE $24.08
SPELLECACY,CYNTHIA $18.87
SPELLER,TIFFANY $14.52
SPELLMAN,DOUGLAS $9.07
SPELLS,SUSAN R $22.66
SPENCE,MATHEW $19.16
SPENCER,BRUCE A $52.82
SPENCER,CHRISTOPHER H $47.86
SPENCER,CYNTHIA $1.29
SPENCER,DAVID C $8.06
SPENCER,JEFFREY $9.85
SPENCER,JOSEPH R $5.57
SPENCER,KIMBERLY JOY $18.59
SPENCER,MICHAEL S $22.93
SPENCER,ROBERT $21.06
SPENCER,THADDEUS $8.75
SPENCER,THOMAS H $8.41
SPENCER-BELZ,ELVA $12.24
SPETH,SARAH R $19.11
SPICER,HELEN $35.40
SPICZAK,SARA $35.93
SPIEGEL,HEIDI $17.92
SPIERS,DIANA $47.44
SPIES,AMY $48.96
SPILLER,LARRY D $1.00
SPILMAN,DIANE $42.82
SPINDLER,JAMIE JOHN ISAAK $2.92
SPINNER JR,CARL E $0.83
SPIR0SKA,KATERINA $12.44
SPITZ,MICHELA $35.05
SPOENMAN,CARL ADOLPHUS $30.63
SPOFFORD,JEANETTE L $19.65
SPOHN,DAVID A $10.40
SPOHN,JOHN A $4.79
SPOHNHOLZ,RICHARD $0.66
SPOHNHOLZ,RUDY $1.99
SPOONER,COLE B $17.89
SPORTS & SPINAL INJURY CL $9.81



Name Allocation

Chugach recently mailed 2010 Capital Credit Allocation letters to its former members.  The letter stated an incorrect allocation 
amount on the letter.  If you received one of these letters, you may confirm the correct amount of your allocation by searching* 
for your name in the list below.  

*There are three ways to search for your name:                                                                                                                            

1. Press CTRL plus F on your keyboard.  A FIND dialog box will appear on the PDF reader.

2. Click on the Edit menu, and locate-click the Find command.

3. Locate the Find tool button on the toolbar of the PDF reader (most commonly under the File menu bar). The Find tool button 
has the icon image of a pair of binoculars. Pressing the binocular icon will also result to the display of the Find dialog box.

SPRAGUE,ELLEN $18.10
SPRAGUE,KENNITH $21.69
SPRAKTIES,JOHN A $49.51
SPRATT,JOHN M $4.93
SPRIGGS,KEVIN $9.95
SPRINGER,MARGARET $15.83
SPRINGER,SHELLY $18.25
SPRINGHILL,DALE E $1.24
SPRINKLE,LEONA M $13.77
SPROUL,MICHAEL $21.92
SPROUSE,AMY $2.00
SPUNDAUGLE,MATTHEW $1.03
SPURGEON,JUDY A $61.06
SPURLIN,JUSTIN ANDREW $8.60
SPURLOCK,BRITTNEY $20.72
SRINIVASAN,NIVASA $17.26
ST ARMAND,BRYAN $9.56
ST CLAIR,CHAROLETTE $28.96
ST JOHN,DIXIE $23.64
ST JOHN,ROSS $16.60
ST JOHN,STEVEN $38.78
ST.GERMAIN,DANIEL $3.39
STABENOW,MICHAEL T $11.27
STAEBELL,TIMOTHY $8.33
STAFFORD,GAIL K $19.32
STAFFORD,ROBERT N $28.77
STAFFORD,TRACY $44.09
STAGER,SULUA L $6.16
STAGGS,GARY $17.79
STAHLIN,WILLIAM MAURICE $1.08
STAHNKE,GRAHAM $31.52
STALDER,REBECCA J $36.35
STALEY,MICHAEL A $2.97
STALEY,SIMEON $5.70
STALKER,KATHERINE D $4.69
STALLING,TYNESHA N $18.37
STAMM,ROBERT MARK $16.26
STAMPLEY,JONATHAN M $4.21
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STANCLIFF,SUSAN M $6.13
STANDIFORD,JIM $16.92
STANDRIDGE,SCOTT ALAN $8.23
STANDS,PATRICIA A $14.01
STANFIELD,BRIAN TROY $3.10
STANFIELD,LINDA $10.66
STANFIELD,NATHAN $24.13
STANFILL,KATHI R $48.28
STANGE,JAY $13.78
STANGL,GAGE M $25.97
STANGL,JEFFRI $3.73
STANKAN,CARLY J $0.73
STANLEY,BETTY L $33.05
STANLEY,CYNTHIA $10.23
STANLEY,MERINA S $21.50
STANSEL,JENNIFER AMBER $30.95
STANTON,LEROY $20.69
STANTON,TERRY $7.05
STARAITIS,JASON $5.90
STARBARD,AMY $20.20
STARBARD,VERA M $11.47
STARCEVIC,JEROME $13.04
STARHEIM,SCOTT $2.54
STARK,KENNETH $24.96
STARK,PRISCILLA $13.62
STARK,TONI A $13.27
STARKEY,ARCHIE $15.74
STARKEY,JUDY R $40.72
STARKS,ALISA M $87.19
STARNES,JAIMIE $10.20
STARR,CHAD $8.95
STARR,DANIEL C $51.90
STARR,DAWNETTE $18.02
STARR,JACQUELYN B $3.57
STARR,RONALD M $27.07
STARZEC,JAMES A $12.62
STASAK,JACLYNN $9.57
STASCHKE,HERMAN $9.61
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STASER,BREANN $16.91
STASH,SEAN W $18.28
STATEN,CURTIS E $8.00
STAUFFACHER,DAMMON B $38.96
STCLAIR,MATTHEW W $17.25
STCLAIR,MISTEE $37.32
STEBBINS,TIFFANY ANN $34.40
STEELE,DEAN A $35.34
STEELE,JACKSON $7.63
STEELE,JONESIA $46.00
STEELE,MARY E $16.54
STEELE,MICHAEL $12.78
STEELE,SONIA M $9.44
STEELMAN,CORY A $31.95
STEEN,RICHARD B $0.65
STEGALL,JAMES $61.82
STEGER,DARCY R $105.48
STEGER,RICHARD E $34.32
STEIN,CALVIN P $36.22
STEIN,JAMIE $9.07
STEIN,VERA $9.18
STEINBERGER,DON $23.87
STEINEL,KATE $8.58
STEINER,KELLIE L $32.04
STEINER,R BOB $14.88
STELLA,MARC $16.41
STELLWAG,DESERAE $0.40
STENBERG,RANDY L $52.90
STENEHJEM,BRYAN $4.66
STENEHJEM,JOHN E $34.16
STENGA,JENNIFER $5.29
STENGER,JEFF $11.55
STENNETT,LAURA $37.33
STENSON,MORGHAN $14.19
STENZEL,WERNER $6.28
STEPANOFF,KRISTA $11.61
STEPETIN,MARTIN N $14.13
STEPHAN,JENNIFER $37.75
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STEPHAN,NANCY $23.80
STEPHAN,NATASHA LYNN $6.70
STEPHENS,ALISIA $22.76
STEPHENS,SANDRA A $0.43
STEPHENS,STEPHANIE S $4.03
STEPP,MARY ANN $27.94
STEPPERS CONSTRUCTION INC $142.65
STEPUTIS,KYLE ROBERT $1.04
STERCHI,MATTHEW V $13.39
STERLING,MARK HARLAN $4.51
STERNHAGEN,MARLENE $31.98
STEVENS,CATHERINE $28.45
STEVENS,ELIZA M $24.25
STEVENS,GREGORY $2.80
STEVENS,JAMIE $51.41
STEVENS,KRISTEN $3.59
STEVENS,LYNN F $8.55
STEVENS,MARGARET L $53.89
STEVENS,MELISSA M $2.91
STEVENSON JR,JOE $1.20
STEVENSON,BEVERLY $10.29
STEVENSON,CHANTEL L $27.08
STEVENSON,KIMBERLY ANN $28.02
STEVENSON,LELA $5.90
STEVENSON,LELA $9.01
STEVENSON,MICHAEL $33.16
STEVENSON,SAMANTHA LAURA $9.06
STEWART,BETTY JANE $10.44
STEWART,BRANDON $7.31
STEWART,CANDICE M $9.19
STEWART,CARLETTA A $17.15
STEWART,CHARLES G $1.75
STEWART,DAVID $130.76
STEWART,JENNIFER $16.87
STEWART,JOSEPH A $9.05
STEWART,LAVINE M $24.05
STEWART,MARK $1.82
STEWART,MATT $25.11
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STEWART,RICHARD L $20.32
STEWART,STEVEN C $15.84
STEWART,WILLIAM L $25.48
STEWART,WYCIDRA $18.92
STEWMAN,TAYLOR $10.79
STIASSNY,AARON Y $22.56
STIASSNY,LLOYD $37.73
STICE,AMY ELIZABETH $45.56
STICHLER,STEVEN R $41.96
STICKEL,TED EVANS $11.87
STICKLAND,LESLIE E $6.92
STICKMAN,ADELE $18.12
STICKMAN,VERNON C $5.85
STIEBING,LEAH $18.72
STIEGELE,JOHN S $6.37
STIFFLER,HYON $8.64
STIGALL,ANDREA $3.55
STIGER,PATRICIA A $34.60
STILLEY,ZACHARY  B $8.47
STINE,KATIE JOY $11.07
STINSON,RACHEL M $3.13
STITT,DUANE $17.86
STIVENDER III,FRED B $10.62
STOCK,JESS T $8.23
STOCKEL,KAARI E $12.59
STOGSDILL,LINDSAY L $18.63
STOKES,TOM $7.44
STOKESBERRY,DANIELLE J $37.95
STOKLEY,DANIEL C $4.06
STOKOE,JOHN B $5.72
STONE,AMANDA F $38.36
STONE,KELSEY $19.36
STONE,MARJORIE $40.05
STONE,MORGAN $28.23
STONE,PETER $6.73
STONE,RANDALL $25.50
STONE,SHOSHANAH $32.86
STONEKING,JOSHUA ROBERT $13.59
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STONEROCK,STEPHAN $24.91
STOODLEY,DAVID J $16.54
STOOPS,TAMMIE L $51.90
STOPHLET,DREW M $8.92
STORAR,JUSTIN T $2.61
STORM,DAWN L $47.18
STORME,THERESA $10.18
STORMS,JUANITA $15.29
STOSEL II,DENNIS $11.67
STOTT,ROBERT JR $2.19
STOUT,CHRISTOPHER $28.03
STOUT,NICK A $0.25
STOUTE,ANDREW M $28.23
STOUTE,FRANCES L AVERY $11.07
STOVALL,MARY A $22.61
STOVER,KIMBERLY L $31.12
STOWELL,DOUGLAS J $12.08
STOWERS,MICHAEL S $45.28
STPIERRE JR,BRUCE W $21.63
STRACHAN,REBECCA J $43.50
STRAHAN,WADE $17.13
STRANGE,KENNETH S $40.05
STRANGE,LACEY L $21.61
STRANSKY,DAVID JAMES $13.36
STRATHMAN,DANIEL R $15.27
STRAUB,MICHAEL E $21.29
STRAW,CHRISTINA $33.97
STRAWN,SARAH LOUISE $34.27
STREBE,RENEE M $32.06
STREEBEL,MARC $14.18
STRELEC,JIMMY W $24.53
STREMCHA,RICHARD $5.40
STRICKLAND,EUGENE $9.24
STRICKLAND,MARGARET A $30.25
STRICKLAND,MARJORIE $17.59
STRICKLIN,CRYSTAL $13.46
STRICKLIN,MAURICE $25.03
STRID,CARL $8.93
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STRID,WHITNEY Z $9.85
STRINGER JR,DAVID D $17.82
STRINGER,JOHN F $22.51
STRODTBECK,SARAH $24.96
STROH,ADAM $20.34
STROMBERG,DESTIN $6.41
STROMBERG,JAN P $31.01
STRONG,ASHLEY $2.41
STRONG,BLANCHE M $20.13
STRONG,CHARLOTTE $35.65
STRONG,JOAN $31.93
STRONG,LAURA ASHLEY SY $4.55
STRONGHEART,TARA $11.85
STROUD,VIOLA $1.21
STRUB,CHARLES M $54.44
STRUM,PAMELA $11.27
STUART,ALISA VAUGHN $2.61
STUART,GREGORY $0.94
STUARTE,KATHLEEN $28.39
STUBBERT,ANDREA $27.30
STUBBERUD,SCOTT $31.55
STUBBS,DENNIS R $45.24
STUBBS,MARIA ESTELA $2.30
STUBLER,LAUREN E $4.03
STUCK,SHEILA A $25.47
STUCKART,SEAN $10.59
STUCKY,JENNY $69.54
STUDEBAKER,D D $14.73
STUDER,THOMAS $21.73
STUDSTILL,JACOB ALEXANDER $6.06
STULTZ,ROCHELLE C $3.70
STULTZ,SHARON D $8.77
STUMPF,DENYS $3.05
STURDEVANT,BRIAN CHARLES $2.53
STURM,MICHAEL G $12.35
STURRUP,JOSEPH N $7.73
STUTER,BRET J $20.13
STYNO,HEIDI B $23.89
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SUA,LEONE $5.50
SUAAVA,MALU $18.89
SUAFOA,JANET F $11.92
SUANHAIPHOL,PRAPAVADEE $26.69
SUDANO,THOMAS E $6.93
SUDARIA,ARNULFO $42.81
SUDARIA,GINA B $34.18
SUDARIA,LIBRADA AQUINO $34.62
SUDARIA,SHIRYL $18.78
SUEL,KENNETH L $45.95
SUEL,SELENA M $1.29
SUETOS,SONIA $5.54
SUGGS,STACY D $11.72
SUITER,DERRICK L $7.69
SUITER,DORENE $26.22
SUITER,LEONARD D $37.12
SUITER,SHEARY $73.76
SUITER,WILLIAM $5.12
SULLIVAN JR,FOUNT B $13.26
SULLIVAN,CLAIRE $16.01
SULLIVAN,CLARE $3.96
SULLIVAN,JEREMY $12.64
SULLIVAN,MELISSA $10.65
SULLIVAN,MERAIAH L $6.61
SULLIVAN,MICHAEL J $12.03
SULLIVAN,YVONNE $17.16
SUMMERLIN,JOSHUA $1.43
SUMMERLIN,STEFANI $61.37
SUMMERS,MARYLEAH $1.79
SUMMERS,VANESSA $3.21
SUMMERVILLE,RODNEY D $7.26
SUMNER,LEVI $17.51
SUMPTER,BENJAMIN $5.30
SUMPTER,LETHA $19.85
SUMPTER,RODERICK W $24.50
SUMROW,KATHERINE D $9.70
SUN,REMI Y $23.47
SUN,YING YONG $8.72
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SUNDARA,PHON $3.04
SUPERMAN,CODY J $36.34
SUPERNAW,LOREN $11.85
SUPINA,ANGELA $19.15
SUPINA,TYSON $16.27
SUPINGER,LACEY M $16.70
SURBER,MARK $12.37
SURLES,GABRIELLA M $6.94
SUROVICK,BRIDGET K $22.63
SUSKY,SANDRA S $0.98
SUSSEK,MARIE $5.86
SUTHERLIN,MARK R $52.35
SUTHERLIN,NINA $13.07
SUTTON,HELEN A $31.28
SUTTON,JACOB $15.78
SUTTON,LEVI $12.52
SUVA,MARK ALLEN $6.81
SUVLU,KATHLEEN $37.79
SUVLU,MARIE $22.68
SVABIK,THOMAS $25.89
SWAFFORD,STEVEN L $1.07
SWAIN,JOSEPH $10.29
SWANBERG,BARRIE $19.93
SWANBERG,LOIS B $33.49
SWANEY,SUMMER R $29.10
SWANGER,AMY D $14.69
SWANN,ROBBIE $39.88
SWANNER,RENO SCOTT $13.13
SWANSON STEEL COMPANY INC $6.40
SWANSON,BENNETT $3.50
SWANSON,LINDA M $52.50
SWANSON,ROBERT B $17.33
SWANSON,SARA $4.01
SWARTZ,KYLE S $14.22
SWARTZ,WARREN E $24.74
SWAYNE,NIKKI $25.65
SWEAT,KHALIQUAH $10.92
SWEATT,RICHARD L $7.63
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SWEENEY,ALICE $97.51
SWEENEY,BRIAN J $2.67
SWEET,JEREME $53.81
SWEET,PATRICIA K $18.83
SWEET,RON $29.21
SWEETWOOD,JIMMY D $15.17
SWENNING,DESIREE G $24.50
SWENOR,COLBY J $24.89
SWENOR,DAVID C $14.95
SWENSEN,MICHAEL $28.02
SWENSON,STEVEN W $4.53
SWENTEK,ANNAMARIE $14.15
SWETZOF,SALLY A $21.89
SWIFT,CATHLEEN $35.73
SWIFT,SHAUN W $2.59
SWINDLER,NESTOR E $2.65
SWINSON,JUSTINIANO $2.56
SWINSON,SHAWNA MICHELLE $33.22
SWIRES,ANDREA $0.64
SWISHER,GARY M $10.28
SWITZER,ASHLEY $4.36
SWORD,NICOLE $16.18
SYKES,JOHN $41.45
SYLVESTER,ASHLEE $6.75
SYNETTA,PEETE $6.97
SYNNER,CHARLES $6.42
SYREN,ANITA K $29.66
SZABO,JULIANNA CHAUNTE $28.27
SZARLETA,TONY $21.60
SZENDER,PAMELA $0.50
SZERLAG,JENNA $9.91
SZYMANSKI,CECELIA M $53.42
SZYMANSKI,MIKE $0.60
TABOR,CHERYL $16.00
TABOR,ROGER A $65.05
TABRON SR,REYNOLD J $75.87
TACAS,MAY PAISTE $13.70
TACKETT,LACEY $9.86
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TADOLINI,ANTOINETTE M $27.13
TADYCH,JOSEPH A $8.84
TAEALII,FATU $18.64
TAFOYA-RAMOS,PEDRO $1.99
TAFUNE,ASOFITU $7.50
TAGGART,WALTER C $3.86
TAINTER,ANDREW W $19.75
TAIVALKOSKI,JOHN D $14.40
TAK,HYUN I $10.66
TAKACS,FERENC $13.89
TALARO,ERIN $8.40
TALBERT,ALVIN H $13.06
TALBERT,KAREN J $17.40
TALBOT,LAURA $5.41
TALEAK,HARRIET J $7.98
TALHA,ELMOSTAFA $17.57
TALLMAN,JENNA $16.15
TAMARIZ,JAVIER G $15.28
TAMBORNINO,MICHAEL J $13.93
TAN,DADE $9.02
TANGMAN,LEVI $8.58
TANIUS,DANIEL P $16.62
TANNEHILL,JANICE NADINE $4.98
TANNER,JULIA $11.89
TAOSO,MANU $35.72
TAOTUA,AUSETALIA $16.53
TAPANG,HELEN $2.59
TAPIA,BIANCA $13.54
TARBERT,TONY R $2.24
TARRANT,HELEN K $14.39
TARVER,GARCIA $49.80
TATARKA,JESSICA COURTNEY $27.62
TATE,BRIDGET $1.57
TATE,CONNIE $2.49
TATE,STEVE $36.86
TATE,VANESSA H $35.32
TATUM,JORDAN $2.71
TATUM,LYNETTE $10.77
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TAUANUU,ALEXANDER $11.39
TAUSCHER,CHRISTOPHER A $19.33
TAUSZ,SHAWN MARIE $1.69
TAVITA,ASHLEY $8.64
TAVO,EMILY K $1.83
TAYLOR,ALBERT LEWIS $39.76
TAYLOR,ALEXANDRA $2.58
TAYLOR,BENHER R $64.40
TAYLOR,CHARLES D $5.60
TAYLOR,DARRIN $5.40
TAYLOR,DESMOND $20.04
TAYLOR,DORIS E $58.22
TAYLOR,FAALEASI $18.40
TAYLOR,GARY A $47.51
TAYLOR,GLENN $27.03
TAYLOR,JAMES RICHARD $7.35
TAYLOR,JAMIN H $21.48
TAYLOR,JANELL R $8.22
TAYLOR,JANICE I $47.50
TAYLOR,JENNIFER R $103.51
TAYLOR,JUSTIN A $25.07
TAYLOR,KYMBERLY A $31.36
TAYLOR,MARK $90.29
TAYLOR,MICHAEL SHAWN $54.30
TAYLOR,PHILLIP C $42.44
TAYLOR,ROSALINDA GILE $22.51
TAYLOR,TONY $54.93
TAYLOR,VERL L $6.65
TAYLOR,VIRGIE $19.36
TAYLOR,ZACHARY JOHN $1.83
TAYLOR-JACKSON,LISA L $6.53
TCB INC $52.58
TEAGUE,BRUCE W $38.46
TEAGUE,DANIELLE $32.40
TEAGUE,LORRAINE H $7.30
TEAMER II,JOHN $7.79
TEE,AMANDA R $22.36
TEGLUND,ROBERT $4.89
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TEITZEL,MARK E $6.81
TEJOCOTE,IRVING $36.15
TELKAMP,TERREEA $8.33
TELLES,ANGELA R $8.59
TELLESON,FORREST K $5.64
TEMPLE,DARCEY $10.86
TENBOER,HEATHER LINN $45.24
TENISON,EMILY $9.10
TENNANT,ABBY $17.46
TENNANT,MATT $12.09
TENNIS,JANIS L $23.90
TENNISON,CARMEN G $61.32
TENNISON,DAYNA D $29.95
TENNISON,KAYLA $29.04
TENNYSON,CHARENA SYLCARRIE $15.04
TEO,FLORA L $12.39
TERBELL,ANDREA $31.43
TERRACCIANO,MARCO $15.03
TERRELL JR,LEON $31.52
TERRY,CAROL S $5.06
TERRY,EVAN $17.23
TERVOOREN,KRISTY $29.54
TERWILLIGER,EILEEN Y $65.24
TERWILLIGER,JO $122.17
TES,SOSALENA $29.26
TESSIER,DORINE $41.39
TESSMER,AARON $35.31
TEST,ELAINE $13.30
TEVELDE,MARY A $52.50
THAO,DAO $13.12
THAO,KER $55.84
THAO,MAI KAO $26.31
THAO,YANG $6.69
THATCHER,CHRISTOPHER $10.65
THAYER,PAUL D $6.56
THAYER,SAMANTHA $15.91
THE ESTATE OF NANCY ROMAN $21.27
THE JOURNEY CHURCH OF ANCHORAG $10.03
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THE KENNETH E TURNER TRUST $10.09
THE STUDIO $13.06
THEBODEAU,SHANNON $20.03
THENO'S $23.31
THERMO-KOOL OF ALASKA INC $615.59
THERON,AVA YASHIKA $24.48
THERRIEN,STEVEN PAUL $18.83
THIBEDEAU,STEPHANIE L $53.15
THIELE,GLORIA B $25.84
THIES,SAMANTHA L $21.36
THIMSEN,KILE $33.32
THINOI,DOKMAI TEO $27.19
THIPPHAVONG,PHONETHIP $4.65
THODE,RENAE M $20.05
THODEN,MARK A $2.32
THOMAS,ADRIAN K $34.12
THOMAS,ALAN $11.12
THOMAS,AMY N $14.59
THOMAS,DANIELLE $15.92
THOMAS,DANIELLE B $19.76
THOMAS,DEANNA $29.74
THOMAS,DEREK W $7.50
THOMAS,DONTA $23.25
THOMAS,EDWARD H $4.05
THOMAS,ELLEN H $17.97
THOMAS,IAN C $17.95
THOMAS,JAMES $26.26
THOMAS,JANET A $12.99
THOMAS,JESSICA L $1.25
THOMAS,JON F $71.41
THOMAS,LAPRIEST $14.71
THOMAS,LOGAN BRYANT $5.77
THOMAS,LOIC H $13.71
THOMAS,LORRAINE $9.69
THOMAS,MICHAEL KEITH $25.97
THOMAS,PHILLIP MYRON $17.40
THOMAS,ROBERT K $83.42
THOMAS,ROBERT R $3.25
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THOMAS,SARA $13.00
THOMAS,STEVE $49.83
THOMAS,SYBLE L $26.24
THOMAS,SYNDEN $8.64
THOMAS,TARIK $2.74
THOMAS,THEA $24.15
THOMAS,TODD E $21.51
THOMASES,ARIA $6.59
THOMASON,JOHN D $9.23
THOMASON,TWILLA R $37.42
THOMASSON,COLIN $28.59
THOMPSON,ALICIA $15.99
THOMPSON,BRADLEY J $5.39
THOMPSON,BRANDY E $14.87
THOMPSON,CHRISTINA MARIE $26.24
THOMPSON,CHRISTOPHER N $24.86
THOMPSON,DEBORAH D $12.04
THOMPSON,DIANE J $12.93
THOMPSON,ERICA $10.57
THOMPSON,ERIN G $1.50
THOMPSON,G NANETTE $6.83
THOMPSON,GERALD DEWAYNE $8.72
THOMPSON,GINA M $9.87
THOMPSON,GLENN H $20.98
THOMPSON,H VICTORIA $9.79
THOMPSON,JAMES R $36.33
THOMPSON,JANET L $23.91
THOMPSON,JASON $52.26
THOMPSON,KEVIN D $7.67
THOMPSON,LISA $10.41
THOMPSON,MARGARET $58.32
THOMPSON,MARK $9.70
THOMPSON,MELISSA G $41.02
THOMPSON,MICHELLE L $2.11
THOMPSON,NATASHA LEE $22.60
THOMPSON,RANDY S $42.64
THOMPSON,ROSALYN $25.12
THOMPSON,SAMANTHA $2.49
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THOMPSON,STAN E $3.94
THOMPSON,STEPHANIE $6.13
THOMPSON,STEVE P $6.15
THOMPSON,TAMMY T $15.68
THOMPSON,TAYLOR L $8.24
THOMPSON,VIRGINIA H $22.98
THOMPSON,WENDY ANNE $17.89
THOMPSON,WILLIAM L $9.84
THOMPSON-SLOAN,TINA A $20.42
THOMSON,ERIN M $16.69
THOMSON,KASSIE R $5.21
THONGDYNALAY,THEUK $10.24
THOR,GE $37.97
THORDARSON,JOANNE K $8.80
THORNBURG,HARRY $68.55
THORNE II,ROBERT J $27.50
THORNLEY,JEAN M $40.09
THORNTON,IAZELL $12.69
THORNTON,JANETTE C $11.69
THORNTON,JERAMIE W $29.58
THORNTON,PATRICK $31.36
THORNTON,TAMMY ANN $17.53
THREATS,BRITTANY D $14.14
THREATS,CHRISTINA $32.54
THRUSH,JARED LYLE $12.09
THRUSTON,MEREDITH $5.43
THURBEE,THOMAS F $0.10
THURMAN,GARRET $6.68
THURMAN,LEANDREW $13.13
THURNER,MATTHEW $46.40
THUROW,CHANSE $38.44
THYSSEN SOUND ELEVATOR $9.31
TIA,SUSAN $13.84
TIAI,ELENOA $11.52
TIAI,MARIA $40.44
TIBBETTS,BRENDA ANN $12.97
TICE,MICHAEL R $2.13
TICHNELL,CHARLES J $80.35
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TICHNELL,WAYNE $11.53
TIEDEMAN,BARIN $8.69
TIEDEN,ANGELINE M $19.25
TIEFENBRUN,BRIAN $6.57
TIEMESSEN,DINAE M $0.76
TILBURY,JOSHUA J $15.75
TILI,IOANE $26.85
TILLERY,CHARLES E $6.96
TILLION,JILL $88.43
TILLITSON,DANI L $13.30
TILLMAN,JULIE A $32.39
TILLOTSON,JERALEE $4.52
TILLOTSON,JERRY $18.52
TILLY,MARY $16.86
TIMBES,ROZANNE $6.87
TIMME,LINDA L $41.83
TIMMONS,JAMES C $17.30
TINDALL,ROBBIE LEEANN $17.65
TING,ERNESTO G $27.80
TINGBERG,JAN ERIK $2.41
TINGEN,CRYSTAL M $37.31
TINGLE,MARCUS A $4.05
TINKER,TONJA $54.77
TISCHER,BENJAMIN D $24.47
TITAN ENTERPRISES LLC $74.29
TIUAN,DEVON V $6.74
TOBEN,ELLEN $15.95
TOBEY,KIRSTEN $4.30
TOBIAS,DAVID R $7.90
TOBIAS-ELLORZA,DELIA B $32.23
TOBIN,JONATHAN $12.98
TOBIN,KRISTINE M $36.03
TOBIN,STEPHANI $34.12
TOBIN,THOMAS T $3.26
TOBUK,ROY $2.14
TOFTEBERG,CHRIS $13.20
TOH,CHEE B $1.17
TOHER,SHAWN J $8.57
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TOI,MAFUTAGAFA AFOUINA ONOSAI $2.56
TOIA,TALA $16.55
TOKLAT COMPANY LLC $35.92
TOLBERT,CORNELIUS C $4.74
TOLEAFOA,ASOOVAILOA $62.88
TOLEAFOA,ASOSAOTAMA $40.86
TOLEAFOA,SINIRA $19.11
TOLENTINO,NELSON $48.11
TOLHURST,AARON $12.56
TOLIVER,WILLIAM M II $11.39
TOLLEFSEN,TIFFANY J $25.76
TOLLEY JR,FRANK E $2.55
TOLLEY,DAVID $49.90
TOLLIVER,MATOYIA $49.20
TOLMAN,MICHAEL $27.54
TOLT SERVICE GROUP $31.04
TOM,DOREEN $8.18
TOM,HENRIETTA M $6.04
TOMASIEWICZ,CHAE $0.52
TOMLINSON,BRIAN G $14.70
TOMLINSON,REX $11.55
TOMLINSON,TRACY $14.91
TONEY,DEBORAH $37.26
TONEY,WENDY $12.10
TONGATE,JEFFREY $18.52
TONGOTA,IRISH $8.43
TOOKS,JEDIDIAH $23.20
TOOMER,CHRIS J $4.65
TOOTOO,GILBERT $27.78
TOPETE,STEPHANIE $36.10
TOPPS,CHARLES BERNARD $32.97
TORBA,YAN $1.86
TORNAI,MARK D $19.44
TORNGA,CRAIG N $51.77
TORPEN,JAMIE $22.98
TORRES,ANDRES $4.72
TORRES,DAMIAN $33.05
TORRES,ELIZABETH $10.00
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TORRES,MELVIN $18.18
TORRES,XAVIER $42.99
TORRIE,MAUREEN ELYSE $9.85
TOSCANO,MARTIN $18.18
TOSCH,DEBORAH $20.84
TOTEMOFF,JUNE V $25.45
TOTEMOFF,RON $62.04
TOTH,JOSEPH A $18.10
TOTTEN,MILES $25.51
TOTUA,FOIMAI T $31.03
TOUSSAINT,REBECCA K $1.99
TOVES,RONELLE L $39.67
TOWARAK,BARBARA $2.81
TOWARAK,SAMUEL RUEBEN $1.82
TOWNE,ANITA $13.77
TOWNSEND,ERIC $46.15
TOWNSEND,TIMOTHY $25.41
TRACY,DAVID $27.66
TRACY,JANET A $14.58
TRACY,JOHN A $31.19
TRACY,VICTOR $50.05
TRAER,NICOLE $7.17
TRAINOR,JENNIFER $12.74
TRAMMELL,LEIGH $12.64
TRAMP,TERRY J $51.08
TRAN,ELIZABETH K $4.56
TRAN,KIM $13.68
TRANEL,DENNIS L $9.10
TRANNUM,AMANDA $4.99
TRASK,BRANDILYNN $10.38
TRAVERS,JENNIE M $1.39
TREADWAY,BARBARA J $1.26
TREADWAY,NICHOLES $9.01
TREADWELL,TINESE $11.12
TREBUS,DANIEL $18.44
TREFON,IRENE $41.11
TREKELL,APRIL $22.28
TREMBLAY,MICHELLE $28.75
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TRENHOLME,ARTHUR K $13.48
TRENT,AARON T $10.85
TRETIKOFF,NORMAN J $6.39
TREYBIG,CLYDE $71.38
TRIGG,MARGARET LORRAINE $11.94
TRIM,BRANDON $14.41
TRIMBLE,JOHN D $9.42
TRINIDAD,ANTOINETTE $7.68
TRINKA,CHANTAL $12.14
TRIPP,CASSANDRA L $10.24
TROBOUGH,PHILLIP $29.83
TROMBLEY CONSTRUCTION SERVICES $20.61
TROMBLEY,J $18.13
TROTTER,JEANENE $30.14
TROTTER,PAUL T $23.81
TROUTMAN,JOSHUA R $11.78
TROUTMAN,MAURICE $3.59
TROWER,DANIEL S $2.29
TROXELL,STEVEN A $22.48
TROYER,LU RUE $4.23
TROYER,TERESA $16.00
TROYER,WANDA C $13.31
TRUAX,GWEN $1.88
TRUDEL,JEFFREY $6.00
TRUELOVE,TONI LYNN $71.00
TRUJILLO,JACOB ANDRES $11.42
TRUJILLO,JASON $20.11
TRUMBLE,MICHAEL P $29.99
TRUMBLEE,SETH C $12.96
TSUNODA,PAUL H $8.97
TUANQUI,REBECCA $2.27
TUATAGALOA,TINO $23.33
TUBBS JR,DONALD EUGENE $10.72
TUCKER,BURNIE $1.60
TUCKER,EDWARD J $11.00
TUCKER,FRANK T $31.40
TUCKER,MARY L $25.85
TUCKER,MICHELLE L $32.01
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TUCKER,SEAN $5.23
TUCKER,STACY L $5.75
TUILAEPA,TINA SILALEUTH $29.64
TULI,TUVALE $52.67
TULIMASEALII,ISUMU $11.61
TULIMASEALII,MONALISA $25.56
TULIMASEALII,PATOSINA $25.66
TULIN,WILLIAM G $4.10
TULIP,KYLE R $26.49
TULPA,CINDY $0.71
TUMA,JASON C $23.53
TUMMONDS,JULIE A $29.97
TUNGUL,ALEJANDRO R $7.58
TUOTT,ERIC LEE $44.22
TUPA,DANIEL $12.65
TUPPER,MICHAEL $39.52
TUPUOLA,JOLENE A $37.50
TUPUOLA,KEUENE $11.30
TURI,LUCUS $5.62
TURINSKY,RHODA $10.49
TURLINGTON,DERRELL D $25.96
TURNBOW,DIANE $29.35
TURNER JR,WALTER E $16.65
TURNER,CHRISTOPHER $11.12
TURNER,GREGORY D $50.15
TURNER,GREGORY S $43.48
TURNER,JERRY $17.17
TURNER,KELLY D $26.01
TURNER,KIMBERLY A $18.68
TURNER,MARY M $41.48
TURNER,MERIDETH K $9.08
TURNER,ROSS ALLEN $41.58
TURNER,SHANNON $25.40
TURNER,STACY L $22.51
TURNER,TARA A $31.13
TURNER,WARREN $6.22
TURSICH,MARDI $7.14
TUTIAKOFF,JEREMY DALE $5.36
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1. Press CTRL plus F on your keyboard.  A FIND dialog box will appear on the PDF reader.

2. Click on the Edit menu, and locate-click the Find command.
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TUTIAKOFF,ROSE $13.08
TUTKA LLC $58.27
TUTTEROW,MARY $16.69
TUTTLE,DEBRA A $2.10
TUTTLE,JAMES $19.10
TUTTLE,TRACY $3.98
TWEET,CARLA R $32.21
TWEGGS,LULA P $45.79
TWEIT,JOHN D $29.92
TWETO,BRUCE $28.20
TWUMWAA,AKOSUE ROSE $17.47
TYLER,M JOAN $59.57
TYLER,MARK $12.55
TYLOCK,SHAWN A $12.95
TYMICK,JONATHAN $3.30
TYNAN,KATE $35.18
TYNAN,KELLY M $30.35
TYNDALL,SARAH $44.13
TYONE,LINDA M $16.52
TYREE,CHRISTINA L $45.34
TYUKOS,GEORGE S $55.10
U BREW WINERIES INC $174.19
UA JR,ROY H $28.84
UAHINUI,SUZANNE N $19.50
UDARBE,REYNOLD $3.75
UEECK,ACE A $25.38
UELESE,SYBOL $31.15
UIAGALELEI,EDWARD $22.29
ULEP,ROMEO $0.95
ULLAH,HAZIZ $13.91
ULLRICH,LAUREN $14.23
ULLRICH,RICHARD JED $14.48
ULUKIVAIOLA,SPLENDORA A $16.12
UMATUM,SHANE J $6.71
UMLAUF,BEATRICE E $0.54
UNANGAM SISMIILUGAA LLC $64.57
UNDERWOOD,ANITA M $10.88
UNDERWOOD,MELVIN $23.26
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UNITED WAY $41.90
UNIVERSAL ROOFING OF AK INC $10.95
UNSWORTH,JOANNE R $19.97
UPADHYAY,ARUN $28.18
UPICKSOUN,HILARY $8.92
UPPER LEVEL LLC $2.08
UPTEGROVE,MATHEW $36.13
URBANIC,JOHN $10.37
URBANSKI,MELISSA $62.30
URE,THOMAS H $42.00
URENA,JESSICA $15.49
URFANO,MARCIANO $42.12
URMSTON,GREGORY D $6.33
URNESS,JARED $2.80
URREA,NICHOLAS $10.03
US COAST GUARD $32.14
US DEPT INTERIOR $536.07
US MARSHALS $1.70
USTIN,PAUL $36.26
UTKIN,KELLY $17.25
UTSLER,MICHAEL J $65.02
UTTER,JAMES R $13.95
UTTER,ROBERT J $5.48
VAHL,MELODY LYNN $45.37
VAISVIL,WAYNE ANTHONY $6.33
VAITOHI,LEONE $90.61
VAKULICH,OKSANA $17.51
VALDEZ,DAVE M $19.88
VALDEZ,JENNIFER $27.48
VALDEZ,JOSH $7.77
VALENTINE,JESSE D $27.41
VALENTINSEN,MICHAEL W $42.84
VALENZUELA,BIANCA $3.64
VALINSKE,KAMI D $4.77
VALLADOLID,VIRGINIA $24.98
VALLEE,WILLIAM $35.35
VALLEJO,EMILIA C $24.52
VALLEJO,THELMA $14.10
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VAN BUREN,NETA K $4.09
VAN ECK,ALLISON M $34.51
VAN HATTEN,CHARMIAN $4.54
VAN SANDT,SHAWN A $25.65
VAN STRATEN,JOSH $3.94
VAN WINKLE,LYNDA $18.06
VAN WYNE,CHRISTOPER $10.77
VANATTEN,BECKY $14.90
VANBEUSEKOM,CRAIG J $24.46
VANBLARCOM,LARK CAMILLE $24.88
VANCE,GREGORY A $5.39
VANCE,JOHN $2.09
VANCE,TIMOTHY $55.08
VANCLEAF,KRISTIN C $11.37
VANDEGRIFT,DUSTIN R $38.97
VANDERHOEVEN,PATRICIA A $8.99
VANDERHOUWEN,ZANDRA L $35.44
VANDERMARTIN,DORINDA $17.80
VANDERPLOEG,ALAN D $34.12
VANDERPOOL,SHARON J $17.30
VANDERSYS,KEVIN R $10.61
VANDESAMPEL,THEODORE $11.02
VANDEURSEN,ANDREW $17.64
VANDEWALLE,ELIZABETH J $7.80
VANDIVER,JOANN $7.68
VANETTEN,DOUG $23.54
VANG,DEE $4.68
VANG,ERIC $25.60
VANG,LEE $22.95
VANG,MARY $39.25
VANG,PA $15.36
VANG,XIA $22.80
VANGELDEREN JR,TIMOTHY JAMES $12.28
VANGILDER,ANDREW $47.40
VANHOLLAND,ADAM R $14.24
VANHORNE,RITA $5.81
VANILAU,TAALOGAPASEFIKA $22.06
VANMETER,MARK A $1.21
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VANNOSTRAND,LAUREL $29.63
VANNOY JR,DANIEL J $0.52
VANNOY,MATTHEW $17.69
VANO,REBECCA $26.88
VANPELT,FAITH $15.90
VANSANDT,COURTNEY $14.56
VANSANDT,KATHYRN M $3.60
VANTERRY,JOSEPH $8.89
VANUCCI,MICHAEL D $21.29
VANVLEET,MICHAEL $9.91
VANVLIET,CHRISTINE $18.44
VAOVASA,SANFERNANDO $6.67
VARADAY,SHARON L $2.61
VARADY,JESSE $26.55
VARGAS,DAVID R $32.21
VARGAS,JUAN $13.85
VARNADO,FRANK E $36.67
VARNER,RODNEY $8.39
VARNEY,ANDREW R $11.64
VASQUEZ,JARED $6.75
VASQUEZ,LAURENTINO $27.47
VASQUEZ,RICARDO $17.64
VASSEN,KJELL $3.69
VAUGHAN,BRIAN $76.00
VAUGHAN,MATTHEW $16.94
VAUGHAN,MICHAEL $3.60
VAUGHAN,WILLIAM I $4.18
VAUGHN,DARYL $10.38
VAUGHN,RYAN $1.00
VAZQUEZ,SEAN $2.22
VAZQUEZ,SHONDA M $7.80
VEA,MADELEINE L $27.66
VEASLEY,ANTHONY $2.47
VEDENOJA,NICHOLE M $17.44
VEGA JR,ARTURO $8.94
VEIT,MARK D $50.63
VELASCO,DORIS D $54.56
VELASCO,ELLA $14.85
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VELASQUEZ JR,HECTOR $18.27
VELASQUEZ,MARY $18.43
VELEZ-JUARBE,VANESSA I $9.96
VELTRI,MARTY G $5.65
VENEGAS,JULIO A $15.99
VENSULA,AMELIA $18.70
VENTRES,WANDA W $21.50
VERA,JUAN N $2.55
VERA,MARIANNE $26.47
VERCELLINE,KEVIN G $30.19
VERIATO,STEPHANIE $1.82
VERNA,JENNIFER B $6.03
VERNARCHICK,LALENIA $15.65
VERNEY,RYAN N $9.47
VERNON,JANETTE K $14.66
VERSNICK,HENRY $20.27
VETS HELP VETS LLC $138.15
VETTERS,MICHAEL $14.15
VICENT,SADESHA $2.64
VICK,JOHN T $6.14
VICKARYOUS,DAVID $12.73
VICKERS,DENISHA $5.35
VICKERY,DEBRA F D $10.34
VICKERY,LAUREN $7.38
VICKERY,MARLENE M $5.85
VICTA,SANDRA R $7.62
VICTORIANO,GERI A $34.30
VICTORIANO,GRETCHEN $49.09
VICTORIANO,GRETCHEN $8.67
VICTORY BAPTIST CHURCH $54.11
VIDAL,CATHERINE M $30.53
VIDAL,PAUL $2.02
VIDAL,TERESITA $0.67
VIGIL,DIANA $20.85
VILLAFUERTE,SHEENA $39.70
VILLAMIDES,LUIS ANTONIO $1.59
VILLAMIDES,VIRGENMINA $3.94
VILLANUEVA,CARLOS A $8.50
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VILLANUEVA,KRYSTAL K $1.09
VILLAREAL,LAURO N $0.76
VILLARREAL,DANIEL E $13.19
VILLARREAL,JESUS ALBERTO $17.47
VILLARROEL,ALICIA $9.51
VILLASENOR,CARMEN M $30.52
VILLEDA,MARIA B $42.69
VILLENA,SONNY S $14.43
VILLINES,SID $27.70
VILLON,XAVIER $3.06
VINCENT,KENDRA CATHERINE $10.45
VINCENT,ODESSA $26.89
VINCIK,SCOTT $13.56
VINCZE,ANDRAS $1.55
VINNIKOVA,MARINA $6.50
VINSON,CAROLYN $58.22
VINSON,MICHAEL $31.35
VIRAMONTIS,AMY C $41.60
VIRDEN,ERIC $5.80
VIRGIN,MARLIN L $16.40
VIRGINIA D HILLIKER LVG TRUST $17.99
VISCARDI,EDWARD F $29.42
VISTE,LINDSEY $13.72
VITT,ASHLEIGH $2.87
VIVIAN,RHYSS WYMAN $31.32
VIZZERRA,BILL D $2.84
VLASOFF,BONNIE $30.08
VLASOFF,DANIEL $23.27
VOELKER II,ROBERT P $15.81
VOELKER,JOSEPH $15.64
VOGEL,FRANCIS J $3.31
VOGEL,JAMES E $23.26
VOGEL,NICHOLAS $10.32
VOHS,JACOB,M $13.83
VOIGT,MITCHELL $5.73
VOISINE JR,DAVID $16.08
VOLZ,LARRY C $23.88
VONADA,JENNIFER $4.89
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VONALVENSLEBEN,CHRISTINE $33.55
VONDERHEIT,KARLA $11.08
VONGDANG,CHOUMMARY LASY $46.76
VONGEMMINGEN,BRET $1.03
VONGPHRACHANH,GREG V $14.73
VONGTHALANGSY,VANESSA $6.26
VONGTHONGDY,MARTIN $14.48
VONGTHONGDY,SAVANHNARY $1.57
VOSBURG,RACHEL H $18.61
VOSIKA,JANICE L $6.22
VREELAND,VERNON $44.09
VREELAND,VIVIAN L $20.19
VRLAKU,RESHAT $23.03
VROMAN,CRYSTAL S $21.85
VU,THAI QUOC $37.59
VUE,GER $12.77
VUE,KATHRINE LEE $10.74
VUE,PAO $20.91
VUKASIN,RITA MAY $43.62
VUSMANOV,MARAT $5.95
W M LEWIS COMPANY LLC $61.80
WAALKES,KASHMERE M $19.62
WACKER,SETH $37.16
WADDEL,MICHAEL $4.76
WADDELL,KAY L $68.26
WADDELL,SHAWN $1.99
WADE,JAKE $4.86
WADE,JED $33.65
WADE,LORI A $58.88
WADE,ROBIN $11.70
WADE,STEPHEN $13.25
WADE,TANCEN C $16.52
WADE,WARREN $9.09
WADSWORTH,TOBY $22.05
WAGAHOFT,CHERIE L $21.94
WAGAR,KATHLEEN D $11.21
WAGEMAKER,WHITNEY M $6.75
WAGGONER,K VAN $14.82



Name Allocation

Chugach recently mailed 2010 Capital Credit Allocation letters to its former members.  The letter stated an incorrect allocation 
amount on the letter.  If you received one of these letters, you may confirm the correct amount of your allocation by searching* 
for your name in the list below.  

*There are three ways to search for your name:                                                                                                                            
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WAGGONER,MEGAN M $9.74
WAGGY,KATIE $19.48
WAGNER JR,ZANE $27.17
WAGNER,BRYCE A $19.67
WAGNER,JEFFREY S $27.90
WAGNER,LAURA J $4.34
WAGNER,MARION L $38.40
WAGONER,FRANCES C $27.28
WAHL,NATALIE $28.99
WAHTO,DAVID G $4.37
WAIALEE,KYONG CHA $11.97
WAID,JACK $40.90
WAINRIGHT,DORA $17.55
WAINWRIGHT,CALEB $25.00
WAITERS,LORENZO $40.43
WALAS,JUSTIN G $14.84
WALCOTT,ANGEL L $25.66
WALDAL,BARBARA J $24.02
WALDEN,ANGELA $28.67
WALDEN,CAYLEY A $6.76
WALDO,AARON R $26.17
WALDRIDGE,DAVID C $16.64
WALDRON,ANDREW J $28.98
WALDRON,MICHAEL $10.07
WALDROUP,G LEE $3.36
WALENCZYK,PETE $77.74
WALKER II,DAVID A $23.42
WALKER II,EVANS J $12.27
WALKER,ANNA M $19.28
WALKER,CAROL A $5.22
WALKER,CHANDRIKA $11.64
WALKER,DANELLA D $12.81
WALKER,DARRIN W $11.67
WALKER,DEBORA A $15.31
WALKER,DONALD W $1.08
WALKER,JASMINE S $12.79
WALKER,JESSICA LYNN $2.85
WALKER,JESSICA S $31.64
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WALKER,KAITLIN $0.33
WALKER,LAQOIA $13.25
WALKER,LILLIAN $36.45
WALKER,NAN $8.83
WALKER,PATRICK LEE $0.06
WALKER,PAULA $9.12
WALKER,RANDALL $17.99
WALKER,SHARON $22.14
WALKER,SYBIL A $3.06
WALKER,TRISTA $8.89
WALKER,TYNE $3.69
WALKER,WANDA R $36.40
WALKER,WILSON LEWIS $63.14
WALKERS,BRYAN A $4.85
WALKING EAGLE,ANNA $37.74
WALL,CODY $11.61
WALL,GARY A $8.93
WALL,JUSTIN $31.27
WALLACE,ANESHA M $10.99
WALLACE,ASHLEY DAVID $6.30
WALLACE,GILLIAN $8.72
WALLACE,KAREN ANN $12.09
WALLACE,PAMELA $43.27
WALLACE,ROBBIE A $7.90
WALLACE,ROGER $2.27
WALLACE,STEPHANIE $51.52
WALLACE,WESLEY L $86.81
WALLACE,WILLIAM JT $35.22
WALLEN,SUSAN E $52.89
WALLENDER,AARON $79.80
WALLER,AARON $43.09
WALLETTE,NICHOLAS C $31.17
WALLIS,BRITTANY M $24.96
WALLS,JOANN $36.36
WALLS,JOHNATHAN W $35.19
WALLS,KELLY $4.27
WALLS,MIKE $30.16
WALMER,TAMARA $5.92
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WALSH,AMANDA C $27.39
WALSH,ARIEL $9.90
WALSH,DANIEL A $2.54
WALSH,DEBORAH J $3.34
WALSH,GEORGE C $3.17
WALSH,PHILLIP DANIEL $20.55
WALTER,DANIEL E $21.27
WALTERS SR,TERRY L $11.82
WALTERS,DAVID M $20.95
WALTERS,JACQUELINE $17.59
WALTERS,LEOTA $17.98
WALTERS,LILLIAN LORRAINE $23.29
WALTON,ALAN R $18.14
WALTON,JANICE L $3.84
WALTON,PHILIP M $22.86
WALTON,SARAH ANN $57.44
WALUNGA,WILLIS CHARLES $44.72
WANDA M WARNER LIVING TRUST $2.43
WANDLER,KENNETH $3.37
WANDS,LEROY $26.22
WANG,CANDY YUEZU $24.13
WANGLER,JOSEPH $9.89
WARBURTON,DOUG $9.38
WARD HOMES INC $5.74
WARD,BEN $36.69
WARD,BEN A $43.79
WARD,CHRISTOPHER $31.53
WARD,DEBORAH $8.92
WARD,JAMES ALVIN $21.29
WARD,JANE $12.60
WARD,JASON $3.27
WARD,JOSHUA D $4.61
WARD,LESLIE KIMIKO $14.03
WARD,LLOYD B $7.09
WARD,MARK V $18.95
WARD,MILO R $4.85
WARD,RONALD A $20.19
WARD,RUTH Y $12.54
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WARDLAW-BAILEY,FREYA $17.43
WARENDA,TARA $16.34
WARFIELD,MICHAEL A $213.45
WARNER,SARAH $4.74
WARNER,TERESA GAIL $27.97
WARNIX,JEANNETTE $10.52
WARREN,AMBER $6.25
WARREN,ANDREW S $24.98
WARREN,ARTHUR $15.89
WARREN,BELINDA D $21.76
WARREN,DENNIS G $36.22
WARREN,DONALD E $18.61
WARREN,JACOB D $3.05
WARREN,KIMBERLY M $19.81
WARREN,RANDY N $4.32
WARREN,SANDRA L $48.54
WARREN,WENDY O $10.02
WARREN,WILLIAM $6.89
WARRICK,JEAN R $3.55
WASHBURN,LAURA $7.29
WASHINGTON III,ROOSEVELT $21.05
WASHINGTON,ANTWONE $10.67
WASHINGTON,BRENDA J $12.54
WASHINGTON,JAMAR $9.15
WASHINGTON,JUANITA $16.58
WASHINGTON,KEINDDRELLE $13.86
WASHINGTON,M M $55.52
WASHINGTON,ROSALIND M $16.59
WASHINGTON,VICTOR C $12.56
WASSMAN,APRIL DAWN $42.21
WATANABE,MASAHIRO $10.60
WATERMAN,JOSHUA C $30.69
WATERS,VIRGINIA M $4.31
WATERS,YOLANDA K $11.63
WATKINS,DEMIRES $21.09
WATKINS,JOHN S $18.81
WATKINS,TRACEY J $25.06
WATKINS,WINSTON $11.20



Name Allocation

Chugach recently mailed 2010 Capital Credit Allocation letters to its former members.  The letter stated an incorrect allocation 
amount on the letter.  If you received one of these letters, you may confirm the correct amount of your allocation by searching* 
for your name in the list below.  

*There are three ways to search for your name:                                                                                                                            

1. Press CTRL plus F on your keyboard.  A FIND dialog box will appear on the PDF reader.

2. Click on the Edit menu, and locate-click the Find command.

3. Locate the Find tool button on the toolbar of the PDF reader (most commonly under the File menu bar). The Find tool button 
has the icon image of a pair of binoculars. Pressing the binocular icon will also result to the display of the Find dialog box.

WATSON JR,GLEN $5.96
WATSON,AMBER M $24.58
WATSON,ANTONIO M $13.27
WATSON,DAVID W $8.69
WATSON,DIANA M $18.95
WATSON,GREGORY A $3.46
WATSON,JACOB A $5.54
WATSON,JENNIFER $26.46
WATSON,LATOYA DENICE $10.34
WATSON,LEWIS S $27.11
WATSON,SHIRLEY A $1.17
WATTS,JASON $13.89
WATTS,KAREN $36.58
WATTS,KIMBERLY $5.89
WATTS,KYLE $11.52
WATTS,MATTHEW $21.58
WATTS,RACHELE $35.16
WATTS,SCOTT $29.42
WATTS,TERESA $19.15
WATTS,VERNON A $31.06
WATTS,WACO $82.83
WAYNE,MIGAILA M $8.29
WEATHERS,DANIEL C $4.98
WEAVER,CHARLES W $63.56
WEAVER,CODY D $3.10
WEAVER,CONNIE E $3.93
WEAVER,DESIREE $12.12
WEAVER,GREG $30.96
WEAVER,NICHOLAS J $10.98
WEAVER,REBECCA ANN $30.53
WEBB,ASHLEY M $7.55
WEBB,COLLEEN T $11.38
WEBB,DOROTHY M $22.96
WEBB,MICHELLE A $2.91
WEBB,PEGGY J $13.96
WEBB,RACHEL C $9.06
WEBBER,ASHLEY $7.89
WEBBER,CALLIE $26.08



Name Allocation

Chugach recently mailed 2010 Capital Credit Allocation letters to its former members.  The letter stated an incorrect allocation 
amount on the letter.  If you received one of these letters, you may confirm the correct amount of your allocation by searching* 
for your name in the list below.  

*There are three ways to search for your name:                                                                                                                            

1. Press CTRL plus F on your keyboard.  A FIND dialog box will appear on the PDF reader.

2. Click on the Edit menu, and locate-click the Find command.

3. Locate the Find tool button on the toolbar of the PDF reader (most commonly under the File menu bar). The Find tool button 
has the icon image of a pair of binoculars. Pressing the binocular icon will also result to the display of the Find dialog box.

WEBBER,JONATHAN Z $2.52
WEBBER,JUSTIN T $5.66
WEBER,ANGELA KAY $4.70
WEBER,CALVIN L $3.59
WEBER,KIMBERLY LILLIAN $9.62
WEBER,KRISTEN N $39.25
WEBER,LILLIAN D $5.71
WEBER,ROCKY $11.28
WEBER,SHAWN $34.26
WEBER,TERRY $21.20
WEBSTER,DAVID C $3.71
WEBSTER,ELIZABETH $42.87
WEBSTER,MICHAEL F $24.23
WEBSTER,TRISHA L $20.62
WEDDLE,DAMION D $40.69
WEEDEN,ANTHONY L $21.52
WEEKLEY,DUSTI R $38.76
WEEKLEY,LAURA $8.60
WEEKLEY,RONALD D $32.36
WEEKLY,JOSEPH LEE $12.34
WEEKS,JONATHAN $15.28
WEEKS,RANDY $10.44
WEEMS,RICK D $32.80
WEESE,NANCY L $13.82
WEGER,CHESTER $46.12
WEGGELAND,LISA $60.80
WEGNER,MITCHELL S $65.32
WEHMEYER,BRETT A $45.19
WEI,JIAN YING $23.45
WEICHEL,MEGAN $39.24
WEIGLE,ERIKA $0.06
WEIGMAN,DANIEL R $3.18
WEIL,GREG $7.40
WEILBACHER,RON $34.11
WEIMAN,CORD A $63.14
WEIMAN,TRACIE $2.44
WEIMER,KENNETH JOE $27.52
WEIMER,KIMBERLY $9.34



Name Allocation

Chugach recently mailed 2010 Capital Credit Allocation letters to its former members.  The letter stated an incorrect allocation 
amount on the letter.  If you received one of these letters, you may confirm the correct amount of your allocation by searching* 
for your name in the list below.  

*There are three ways to search for your name:                                                                                                                            

1. Press CTRL plus F on your keyboard.  A FIND dialog box will appear on the PDF reader.

2. Click on the Edit menu, and locate-click the Find command.

3. Locate the Find tool button on the toolbar of the PDF reader (most commonly under the File menu bar). The Find tool button 
has the icon image of a pair of binoculars. Pressing the binocular icon will also result to the display of the Find dialog box.

WEIMER,WILLOW A $26.04
WEINBERGER,JOHN LOUIS $0.72
WEINBRECHT,ROBERT $22.89
WEINKAUF,SPENCER $6.15
WEINSTOCK,BLAIR I $16.30
WEISHUHN,NATHAN ROBERT $14.71
WEISS,TIMOTHY $17.82
WEITZ,MICHAEL $3.64
WELBORN,KIMBERLY $38.83
WELCH,DANIEL $49.37
WELCH,JOSHUA $32.81
WELCH,SARA G $16.34
WELDY,MIRANDA J $9.42
WELLING,ERIC M $36.13
WELLMAN,PAUL $21.34
WELLMAN,POLLEN $30.00
WELLNER,LYN N $0.59
WELLS FARGO FINANCIAL AK INC $126.45
WELLS,ALISHA $9.65
WELLS,ASHLEY $9.53
WELLS,BRENDA L $5.11
WELLS,DEWEY C $45.61
WELLS,GARY L $32.03
WELLS,GRACE C $7.85
WELLS,JENNIFER M $19.31
WELLS,KAITLIN $10.15
WELLS,KARA $24.90
WELLS,LAUREN M $0.90
WELLS,MARK ALLEN $26.14
WELLS,MAYO T $16.10
WELLS,SCOTT A $11.36
WELLS,TISA $41.65
WELLS-MCGREW,ESTERIA $39.03
WELSH,TANYA LEE $18.37
WELSH,WILLIAM $2.45
WELTE,AMY K $0.70
WENDELL,MATT $4.88
WERBA,ALEXANDRA $6.42



Name Allocation

Chugach recently mailed 2010 Capital Credit Allocation letters to its former members.  The letter stated an incorrect allocation 
amount on the letter.  If you received one of these letters, you may confirm the correct amount of your allocation by searching* 
for your name in the list below.  

*There are three ways to search for your name:                                                                                                                            

1. Press CTRL plus F on your keyboard.  A FIND dialog box will appear on the PDF reader.

2. Click on the Edit menu, and locate-click the Find command.

3. Locate the Find tool button on the toolbar of the PDF reader (most commonly under the File menu bar). The Find tool button 
has the icon image of a pair of binoculars. Pressing the binocular icon will also result to the display of the Find dialog box.

WERBELOW,TAMMY $11.84
WERDAL,DAVID L $16.25
WERNING,STEVE $41.35
WERT,TATYANA G $27.90
WERTISH,JASON $11.95
WERTS,MIKE $4.11
WESCO PRODUCTS INC $90.23
WESCOVICH,CHRISTOPHER $8.48
WESLEY,JOHN H $31.21
WESLEY,RONALD $1.51
WESOLOWSKI,GARY J $5.51
WESSELLS,UDELLA $66.60
WESSELS,ROBERT P $41.98
WEST LLC $8.24
WEST TRAVEL INC $46.06
WEST,ALEXANDRA E $12.70
WEST,ANDREW P $21.97
WEST,DAVID L $8.77
WEST,ERIN $15.76
WEST,JOSEPH $45.42
WEST,KIMBER L $43.66
WEST,MELISSA $15.70
WEST,MICHELLE N $8.43
WEST,RAL T $31.17
WESTBROOK,MICHEA $28.50
WESTBROOK,SEAN A $13.46
WESTERMANN,ROBERT $69.90
WESTFALL,DEVRA ANN $11.94
WESTFALL,RONALD L $6.97
WESTHUSING,PAULA $15.10
WESTLAKE,JAMES $8.46
WESTON,WILLIAM $6.04
WESTPHAL,CERENA L $14.31
WESTPHALL,DENA J $20.75
WESTWICK,LINDA C $31.27
WETHERELL,JEREMY S $32.20
WETZEL,PETER $13.60
WEYNAND,ERICKA LIN $17.08



Name Allocation

Chugach recently mailed 2010 Capital Credit Allocation letters to its former members.  The letter stated an incorrect allocation 
amount on the letter.  If you received one of these letters, you may confirm the correct amount of your allocation by searching* 
for your name in the list below.  

*There are three ways to search for your name:                                                                                                                            

1. Press CTRL plus F on your keyboard.  A FIND dialog box will appear on the PDF reader.

2. Click on the Edit menu, and locate-click the Find command.

3. Locate the Find tool button on the toolbar of the PDF reader (most commonly under the File menu bar). The Find tool button 
has the icon image of a pair of binoculars. Pressing the binocular icon will also result to the display of the Find dialog box.

WHALEY,KANIE L $20.44
WHEELER,NATHAN B $4.24
WHEELER,SEAN $25.23
WHEELER,SHERYL A $16.03
WHEELER,TODD M $21.65
WHEELOCK,MARION $2.46
WHELTON,VALERIE G $20.46
WHIFFEN,DIANE M $10.32
WHINNEM,RACHAEL R $2.50
WHIPPLE,BRYAN P $50.77
WHISAMORE,HEATHER $7.13
WHISEL,TIMOTHY L $34.00
WHISMAN,ERIC $14.08
WHISMAN,JOHN C $3.88
WHITE RAVEN PROPERTIES $4.43
WHITE,AMY $10.16
WHITE,BRANDON J $11.75
WHITE,CHRYSTLE $4.80
WHITE,EBONEY M $5.45
WHITE,GARY $53.14
WHITE,JAMES $15.74
WHITE,JAMES A $43.85
WHITE,JENNIFER M $17.86
WHITE,JEREMY ALLEN $8.23
WHITE,JOSHUA M $13.93
WHITE,KENNETH $22.95
WHITE,LINDA A $41.26
WHITE,LINDA JEAN $17.81
WHITE,LON A $5.40
WHITE,MACADE B $3.92
WHITE,MICHAEL J P $26.80
WHITE,RICHARD H $15.47
WHITE,RICKY L $44.21
WHITE,SEAN C $12.88
WHITE,STEVE A $7.38
WHITE,VERA E $51.70
WHITEBERG,MARJORIE $17.50
WHITEHEAD,SANDY $35.22



Name Allocation

Chugach recently mailed 2010 Capital Credit Allocation letters to its former members.  The letter stated an incorrect allocation 
amount on the letter.  If you received one of these letters, you may confirm the correct amount of your allocation by searching* 
for your name in the list below.  

*There are three ways to search for your name:                                                                                                                            

1. Press CTRL plus F on your keyboard.  A FIND dialog box will appear on the PDF reader.

2. Click on the Edit menu, and locate-click the Find command.

3. Locate the Find tool button on the toolbar of the PDF reader (most commonly under the File menu bar). The Find tool button 
has the icon image of a pair of binoculars. Pressing the binocular icon will also result to the display of the Find dialog box.

WHITELEY,CHARLES $31.64
WHITENER,ANDREW T $11.33
WHITESELL,DENNIS B $0.17
WHITESELL,PATRICK $6.20
WHITESELL,SHAWN C $13.99
WHITESIDES,STEVEN K $2.00
WHITFIELD,DONNA $4.60
WHITLEY,TONDRA $9.41
WHITLEY,TYLER I $3.94
WHITLOCK,JOSE D $34.71
WHITMAN,MARC $13.35
WHITMAN,YANA $31.13
WHITMORE,IAN $20.89
WHITMORE,ROBIN L $31.65
WHITNEY,RUSSELL $8.02
WHITSON,LISA $16.77
WHITTINGTON,FRANK D $78.75
WHITTINGTON,PEGGY JO $4.57
WHITTOCK,RAYMOND R $14.25
WHITWELL,JOSEPH K $16.25
WHITWORTH,LORENZA $34.36
WHYTE,CHRISTOPHER C $13.91
WICKES,ADAM $26.65
WICKHEM,CARLY $4.03
WICKMAN,LAURIE L $46.59
WIDMER,STEPHEN $4.75
WIDNESS,BRANT $8.41
WIDO,MARK $17.25
WIEBLER,WILLIAM E $4.03
WIEGARDT,RANDY $23.40
WIEHE,CHRISTOPHER B $34.89
WIEHL,ANTOINETTE B $21.39
WIELER,IRIS $1.65
WIESE,BRIAN $27.00
WIESE,ERIN A $44.77
WIEST,TRACY $21.98
WIEWIOROWSKI,CHERYL G $36.39
WIGET,CONSTANCE R $4.66



Name Allocation

Chugach recently mailed 2010 Capital Credit Allocation letters to its former members.  The letter stated an incorrect allocation 
amount on the letter.  If you received one of these letters, you may confirm the correct amount of your allocation by searching* 
for your name in the list below.  

*There are three ways to search for your name:                                                                                                                            

1. Press CTRL plus F on your keyboard.  A FIND dialog box will appear on the PDF reader.

2. Click on the Edit menu, and locate-click the Find command.

3. Locate the Find tool button on the toolbar of the PDF reader (most commonly under the File menu bar). The Find tool button 
has the icon image of a pair of binoculars. Pressing the binocular icon will also result to the display of the Find dialog box.

WIGGINS JR,CLAUDE $17.80
WIGGINS,ANNETTE $6.26
WIGGS,CITA $56.41
WIGGS,MELANIE L $34.76
WIITA,JOANNE $0.01
WIKER,MARGARITA L $24.65
WILCOX,BONNIE $15.87
WILCOX,CHRIS $22.81
WILCOX,DAVID A $28.69
WILCOX,KERI $15.33
WILCOX,MARISSA B $3.53
WILCOX,SHENA $3.12
WILCOX,TRACY L $22.77
WILCOX,ZACHARY $14.70
WILDE,JESSICA $3.36
WILDER,CHRISTINA M $22.69
WILDER,EMILY T $14.85
WILDER,MARY LOU $34.39
WILDING,NICKOLAS JOSEPH $1.97
WILES,ANDREW $17.65
WILES,SEAN $15.19
WILEY,ADALINE $36.96
WILEY,BRENT $24.26
WILEY,DEMETRIUS T $25.98
WILEY,JENNIFER $12.12
WILEY,KEVIN M $3.22
WILEY,MARK L $42.38
WILEY,PAUL E $2.27
WILEY,TISH ANN $10.04
WILHELM,ANGELA S $37.77
WILHELM,ELIZABETH $26.02
WILKES,CONSTANCE $13.06
WILKES,TAMRA $18.73
WILKES,THOMAS R $10.82
WILKESON,TERESA ANN $2.28
WILKIE JR,GEORGE ALAN $10.26
WILKINS,JAMES C $16.64
WILKINS,PHYLLIS $24.64



Name Allocation

Chugach recently mailed 2010 Capital Credit Allocation letters to its former members.  The letter stated an incorrect allocation 
amount on the letter.  If you received one of these letters, you may confirm the correct amount of your allocation by searching* 
for your name in the list below.  

*There are three ways to search for your name:                                                                                                                            

1. Press CTRL plus F on your keyboard.  A FIND dialog box will appear on the PDF reader.

2. Click on the Edit menu, and locate-click the Find command.

3. Locate the Find tool button on the toolbar of the PDF reader (most commonly under the File menu bar). The Find tool button 
has the icon image of a pair of binoculars. Pressing the binocular icon will also result to the display of the Find dialog box.

WILKINS,RICHARD $10.24
WILKINSON,LATISHA $32.91
WILL,JACOB N $10.26
WILL,JOSEPH B $33.12
WILLARD,DEBORAH MAY $10.07
WILLARD,MEGAN $5.66
WILLENBRINK,WILLIAM $29.43
WILLIAMS JR,MELVIN J $40.79
WILLIAMS JR,WHITTIER $11.22
WILLIAMS SR,ELBERT $10.31
WILLIAMS,ALICIA $0.58
WILLIAMS,AMANDA $21.38
WILLIAMS,AMANDA LYNN $15.76
WILLIAMS,BARBARA J $10.40
WILLIAMS,BARRY K $19.73
WILLIAMS,BILLIE A $8.39
WILLIAMS,CARTER $59.17
WILLIAMS,CASSANDRA $17.57
WILLIAMS,CHAMIRE L $26.60
WILLIAMS,CHARLES W $25.15
WILLIAMS,CHRIS $45.08
WILLIAMS,CINDY $18.11
WILLIAMS,CRYSTAL $20.03
WILLIAMS,DANIEL E $12.03
WILLIAMS,DARRELL K $7.57
WILLIAMS,DEAN A $40.79
WILLIAMS,DEBORAH A $8.05
WILLIAMS,DENNIS F $32.36
WILLIAMS,DOMINIC R $11.67
WILLIAMS,DONNA J $35.39
WILLIAMS,DONTE $26.01
WILLIAMS,DUSTY $13.02
WILLIAMS,ELISHA $7.98
WILLIAMS,ELLEN $12.83
WILLIAMS,ESTELLETA F $10.06
WILLIAMS,EUGENE L $28.52
WILLIAMS,HALSTON D $43.59
WILLIAMS,IRVIN J $14.44



Name Allocation

Chugach recently mailed 2010 Capital Credit Allocation letters to its former members.  The letter stated an incorrect allocation 
amount on the letter.  If you received one of these letters, you may confirm the correct amount of your allocation by searching* 
for your name in the list below.  

*There are three ways to search for your name:                                                                                                                            

1. Press CTRL plus F on your keyboard.  A FIND dialog box will appear on the PDF reader.

2. Click on the Edit menu, and locate-click the Find command.

3. Locate the Find tool button on the toolbar of the PDF reader (most commonly under the File menu bar). The Find tool button 
has the icon image of a pair of binoculars. Pressing the binocular icon will also result to the display of the Find dialog box.

WILLIAMS,IVON JAY $0.99
WILLIAMS,JACOB E $80.04
WILLIAMS,JAMES LESTER $29.93
WILLIAMS,JAMIE $20.92
WILLIAMS,JANET L $15.39
WILLIAMS,JENNIFER L $19.82
WILLIAMS,JESSE T $30.31
WILLIAMS,JOE W $42.19
WILLIAMS,JOHN K $1.03
WILLIAMS,JOHN RAY $12.27
WILLIAMS,JONEL C $16.43
WILLIAMS,JULAINE $3.71
WILLIAMS,KATHLEEN J $5.99
WILLIAMS,KAYLA $5.98
WILLIAMS,KEENAN R $1.63
WILLIAMS,KEENAN R $28.34
WILLIAMS,KELLY $52.29
WILLIAMS,KELLY L $17.55
WILLIAMS,LEIGH A $20.20
WILLIAMS,LINDA ANN $39.62
WILLIAMS,MARIANNE $21.69
WILLIAMS,MATHEW $3.46
WILLIAMS,PAT $11.02
WILLIAMS,PATRICK JA $13.54
WILLIAMS,PETER $9.00
WILLIAMS,RANDALL F $5.31
WILLIAMS,REGINA MARIE $26.58
WILLIAMS,RICHARD $2.14
WILLIAMS,RICK $29.73
WILLIAMS,ROBERT $5.15
WILLIAMS,ROBERT A $0.90
WILLIAMS,ROBERT K $21.62
WILLIAMS,ROGER $11.24
WILLIAMS,RUDY G $36.14
WILLIAMS,SHAELA R $5.58
WILLIAMS,SHARON E $14.64
WILLIAMS,SHAWN $24.43
WILLIAMS,SHELLEY LOU $40.93



Name Allocation

Chugach recently mailed 2010 Capital Credit Allocation letters to its former members.  The letter stated an incorrect allocation 
amount on the letter.  If you received one of these letters, you may confirm the correct amount of your allocation by searching* 
for your name in the list below.  

*There are three ways to search for your name:                                                                                                                            

1. Press CTRL plus F on your keyboard.  A FIND dialog box will appear on the PDF reader.

2. Click on the Edit menu, and locate-click the Find command.

3. Locate the Find tool button on the toolbar of the PDF reader (most commonly under the File menu bar). The Find tool button 
has the icon image of a pair of binoculars. Pressing the binocular icon will also result to the display of the Find dialog box.

WILLIAMS,SILAS $4.77
WILLIAMS,STEVEN LOYD $31.60
WILLIAMS,SVEA MAE $27.60
WILLIAMS,TENISHA J $24.25
WILLIAMS,VIVIAN $20.20
WILLIAMSON,CONOR $18.41
WILLIAMSON,KRYSTYNA $10.75
WILLIAMSON,MAGALINE $22.73
WILLIAMSON,MATT $3.64
WILLIAMSON,STEPHANIE L $8.75
WILLIAMSON,TODD A $7.24
WILLIFORD,DENNIS LEE $9.68
WILLINGHAM,LATRICE S $11.33
WILLIS,ALISHA M $15.46
WILLIS,DANIEL W $46.01
WILLIS,NICOLE $37.96
WILLIS,TAMI $16.05
WILLMAN,HOLLY DAUGHERTY $6.17
WILLMAN,JAMES J $10.49
WILLMAN,THOMAS A $29.66
WILLMON,MICHAEL G $9.58
WILLOUGHBY,BREANN $12.20
WILLOUGHBY,KEITH $38.55
WILLOUGHBY,KEITH $8.98
WILLOUGHBY,WILLIAM T $10.08
WILLOYA,ROBIN ELAINE $5.40
WILLS,CYNTHIA K $23.79
WILMARTH,REBECCA $7.80
WILMOTT,DONN S $38.22
WILSACK,JOLANDA R $13.06
WILSON,AMBER ROSE $20.89
WILSON,ANGELA ROSE $3.10
WILSON,BETTY $7.66
WILSON,BREARLEY C $14.95
WILSON,BRISTOL M J $27.47
WILSON,CARISSA L $5.12
WILSON,CHARLES R $10.34
WILSON,CHRISTINA L $29.10



Name Allocation

Chugach recently mailed 2010 Capital Credit Allocation letters to its former members.  The letter stated an incorrect allocation 
amount on the letter.  If you received one of these letters, you may confirm the correct amount of your allocation by searching* 
for your name in the list below.  

*There are three ways to search for your name:                                                                                                                            

1. Press CTRL plus F on your keyboard.  A FIND dialog box will appear on the PDF reader.

2. Click on the Edit menu, and locate-click the Find command.

3. Locate the Find tool button on the toolbar of the PDF reader (most commonly under the File menu bar). The Find tool button 
has the icon image of a pair of binoculars. Pressing the binocular icon will also result to the display of the Find dialog box.

WILSON,CONNIE R $37.91
WILSON,DARLENE NOLA $29.75
WILSON,DAVID B $59.88
WILSON,ELLEN JO $15.48
WILSON,ESTELLE MARIE $26.05
WILSON,FRED A $5.38
WILSON,FREDERIC H $12.50
WILSON,GRACE K $49.44
WILSON,JENNIFER M $25.11
WILSON,JEREMIAH N $32.11
WILSON,KEITH J $21.73
WILSON,KIRK $29.68
WILSON,KYLE C $3.98
WILSON,LARRY $24.32
WILSON,LAURA M $15.20
WILSON,LOUIS $21.10
WILSON,MICHAEL $10.24
WILSON,MICHAEL J $14.16
WILSON,MICHAEL M $25.72
WILSON,MIKE $16.57
WILSON,NOLA GAY $2.52
WILSON,OTTIS C $6.08
WILSON,PATRICK $19.23
WILSON,PAUL R $3.54
WILSON,QUINTON $31.40
WILSON,REBEKAH $26.32
WILSON,RICHARD G $66.87
WILSON,RICK $4.95
WILSON,RONALD $2.11
WILSON,RONDA L $23.07
WILSON,ROSETTA $35.75
WILSON,RYAN $1.53
WILSON,SHARON L $32.96
WILSON,SHAWN M $9.09
WILSON,SIENNY BOEDIARTO $47.37
WILSON,TAMARA BETH $7.97
WILSON,TERESA A $33.07
WILSON,TIMOTHY DAVID $48.18



Name Allocation

Chugach recently mailed 2010 Capital Credit Allocation letters to its former members.  The letter stated an incorrect allocation 
amount on the letter.  If you received one of these letters, you may confirm the correct amount of your allocation by searching* 
for your name in the list below.  
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3. Locate the Find tool button on the toolbar of the PDF reader (most commonly under the File menu bar). The Find tool button 
has the icon image of a pair of binoculars. Pressing the binocular icon will also result to the display of the Find dialog box.

WILSON,TIMOTHY J $49.96
WILSON,TRISCILLA $9.23
WILSON,WAYNE H $17.22
WILSON,WILLIAM J $1.33
WILSON,YONG $2.18
WINCHESTER HOLDINGS LLC $50.78
WINCHESTER,JIM $19.15
WINCHESTER,LORRI J $18.79
WINCHESTER,MELISSA $3.30
WIND RIVER LLC $2.95
WINDELER,LEON A $8.69
WINDSOR,HEATHER S $27.18
WINFIELD,ANGELA M $27.39
WINGARD,MICHAEL DALE $0.78
WINGERTER,PETER $20.34
WINKLE,CURTIS R $5.57
WINSTEAD,THOMAS $24.04
WINSTON,SASHA P $3.58
WINTERFELD,AARON $6.24
WINTERHALDER,BRENDA $3.11
WINTERS,CHRISTOPHER J $30.45
WINTERS,MAEGAN $16.08
WINTERS,ROSE L $19.35
WIPPERMAN,R H $28.00
WIRT,LAUREENA F $14.37
WIRZ,GARY $6.04
WISE JR,BRUCE $38.98
WISECUP,LEE M $3.60
WISEMAN,MATT $24.65
WISHNACK,ELENA V $107.93
WISSA,DOMINIC $26.39
WITHERS,KAY E $2.41
WITT,BRANDY M $30.95
WITT,CHRISTINA J $24.95
WITTE,ESMERALDA M $21.36
WITTENBRADER,JILL C $1.06
WITTHUS,MARY N $18.97
WITTROCK,ERIC $10.59
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WOGNILD,GREG E $22.53
WOITEL,CHERIE $28.99
WOJNAREK,JAMES D $8.81
WOLF,BRIAN E $19.72
WOLF,CYNTHIA $11.64
WOLF,DAN $1.04
WOLF,DANIEL M $4.47
WOLF,JULIE D $15.30
WOLF,ROBERT D R $8.05
WOLFE,JEFFREY S $8.16
WOLFE,SAMUEL D $9.32
WOLFE,SCOTT $1.75
WOLFE,STEPHEN JOHN $15.12
WOLFF,TELMA $16.15
WOLFGANG,TIMOTHY $22.80
WOLFORD,BRITANY $12.14
WOLFORD,MARK $13.91
WOLFRAM,CALEB $13.63
WOLKOFF,TERRY $29.10
WOLLENZEIN,BETH A $10.26
WOLSKI,LORETTA $0.95
WOLVERTON,ABBY J $26.39
WOLZEN,TROY $14.87
WOMACK,BRUCE W $4.03
WONG JR,WILFRED M $16.18
WONG SIN,FALANIKO $17.73
WONG,BARBARA $0.43
WONG,SIEW-KHEONG $28.63
WOO,DEYLO A $81.67
WOOD,CHRISTIAN D $7.63
WOOD,CYNTHIA $11.17
WOOD,DARRON M $25.91
WOOD,DEBORAH ANN $2.94
WOOD,JAMES M $16.20
WOOD,JAMES R $1.41
WOOD,JEFFERSON $32.09
WOOD,KARA $27.03
WOOD,KENNETH R $33.06
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WOOD,KRISTINA D $21.03
WOOD,LAURA L $1.75
WOOD,MARIANNE R $8.65
WOOD,MEGAN $8.55
WOOD,MICHAEL $9.98
WOOD,MICHAEL C $31.53
WOOD,PRECAUTIOUS T $3.55
WOODARD,BEAU $14.73
WOODARD,JASON R $14.37
WOODARD,JOSHUA D $7.74
WOODARD,MARK J $1.66
WOOD-CRANE,JOYKAY $18.34
WOODHULL,KIMBERLY D $10.79
WOODMANSEE,SHAWN $1.57
WOODRING,AMANDA M $8.10
WOODRUFF,DANIEL W $23.48
WOODRUFF,TODD S $32.28
WOODS,CHRISTOPHER A $20.95
WOODS,ELSIE MAE $6.86
WOODS,JOSEPH A $1.35
WOODS,TINA M $40.91
WOODS,TRAVIS L $30.43
WOODS,WILLIAM T $13.65
WOODWARD,JENNIFER $13.45
WOODWARD,KIMBERLY MARIKO $10.86
WOODWORTH,MICHAEL W $44.35
WOODWORTH,STEPHEN A $25.81
WOODY,DEBBIE $14.02
WOOLCOCK,LORRAINE $5.30
WOOLCOTT,THOMAS L $12.51
WOOTEN,MARY GRACE $13.30
WOOTTEN,DOUGLAS C $12.57
WOOTTEN,PAUL $17.55
WORACHEK,ALDEN B $26.46
WORBY,STACY $25.49
WORKS OF ART INC $12.30
WORLAND,CURTIS MATTHEW $45.41
WORMWOOD,DALE $38.15



Name Allocation

Chugach recently mailed 2010 Capital Credit Allocation letters to its former members.  The letter stated an incorrect allocation 
amount on the letter.  If you received one of these letters, you may confirm the correct amount of your allocation by searching* 
for your name in the list below.  

*There are three ways to search for your name:                                                                                                                            

1. Press CTRL plus F on your keyboard.  A FIND dialog box will appear on the PDF reader.

2. Click on the Edit menu, and locate-click the Find command.

3. Locate the Find tool button on the toolbar of the PDF reader (most commonly under the File menu bar). The Find tool button 
has the icon image of a pair of binoculars. Pressing the binocular icon will also result to the display of the Find dialog box.

WORTH,KARI A $16.73
WREN,STAN $22.17
WRIGHT,ANGELA G $34.03
WRIGHT,CALEB G $11.77
WRIGHT,CAMDON $45.43
WRIGHT,CASEY W $53.05
WRIGHT,CHRISTINE $22.39
WRIGHT,CINDY A $9.34
WRIGHT,CYNTHIA L $15.57
WRIGHT,DANA K $21.92
WRIGHT,IAN C $3.25
WRIGHT,JENNIFER L $22.62
WRIGHT,KEITH DAVID $7.14
WRIGHT,MARCY L $15.14
WRIGHT,MICHELLE D $31.67
WRIGHT,RENEE $13.76
WRIGHT,ROBERT M $27.97
WRIGHTS,RICHARD $0.57
WRIGLEY,SUSAN C $0.28
WU,DOUG R $25.37
WU,GEORGE $17.52
WU,QIU DUO $0.70
WUESTENFELD,KATHERINE $25.55
WUKASCH,BRIAN R $55.76
WUNDERLICH,BRENT A $14.20
WUNDERLICH,PATRICK T $14.80
WYATT,KEVIN $4.89
WYCKOFF II,RICHARD A $26.80
WYCOFF,LEIF $15.06
WYLIE,BARBARA $8.31
WYMAN,PAUL $24.90
WYNN,CALVIN $8.15
WYNN,MICHELE M $17.68
WYNNE,BARRY JOHN $8.61
WYNNS,KATHRYN L $67.70
WYRICK,JASON G $33.92
WYZE,JASON $2.54
XAYKEO,THOMAS H $73.07
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XIMENEZ,ARTHUR R $37.67
XIONG,AMEE $2.78
XIONG,HUE $13.70
XIONG,JOHN LIA $29.11
XIONG,KOU $20.21
XIONG,PAO $29.77
X-OTIC APPAREL $58.21
YAMO,JESUS $16.38
YANAI,KIYONORI $40.87
YANEZ,FRANCISCA $12.00
YANG,CHONG $8.32
YANG,FRANK W $35.21
YANG,FUE $115.34
YANG,GUOLONG $15.07
YANG,JAMES P $68.39
YANG,JOLY $12.38
YANG,MANDA MAI $35.25
YANG,SOUA $5.39
YANG,TOU K $49.95
YANTZIE,TERRY $39.83
YAPUNCICH,REBECCA $5.56
YASKA,PATRICIA $1.42
YASSICK,MICHAEL $27.19
YATCHMENEFF,ALLIE $11.05
YATCHMENEFF,MICHAEL $16.89
YATES,ANN $6.21
YATES,DAWN R $10.17
YATES,MICHAEL $15.04
YATES,ROB L $20.24
YAU,SAYONARA $14.26
YEAMANS,JESSICA $44.16
YEARGAN,SCOTT $50.43
YEARWOOD,ROBERT $15.25
YELL,DANIEL E $33.51
YERK,JOSHUA ROY $13.61
YERKES,MIKE $4.04
YERLY,DAVID $22.11
YESCAVAGE,BERNARD $161.01
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YESCAVAGE,MICHAEL $3.30
YEUNG,VIVIAN $11.55
YI,HAN PUN $37.44
YIP,LINDSEY $23.49
YOAKUM,ALLYN E $26.69
YOANG,NYARET $2.41
YOCUM,MARK E $11.14
YODER,JAMIE L $23.04
YODER,MATTHEW $5.24
YODER,REBECCA L $24.03
YODER,REBEKAH $4.24
YOO,KYONG $1.41
YOON,BONG K $1.61
YOON,TAE S $17.07
YORK,AMY L $22.01
YOST,NICLOLE $14.48
YOUNG PLACE,LOUISE $20.72
YOUNG POW,PETER $45.13
YOUNG,ALBERT J $6.16
YOUNG,CHRISTINA $49.99
YOUNG,CHRISTOPHER J $17.15
YOUNG,DARYL $33.56
YOUNG,DAVID C $7.64
YOUNG,EUGENE E $53.03
YOUNG,JAMES $34.70
YOUNG,JAMES C $63.82
YOUNG,JAMES O $15.37
YOUNG,JANIE $20.88
YOUNG,JEREMY $22.31
YOUNG,JERRY F $6.37
YOUNG,JORDAN ALLEN $2.63
YOUNG,KRISTA $1.21
YOUNG,LAURA A $21.63
YOUNG,LYNETTE RENEE $19.69
YOUNG,MARY $5.20
YOUNG,MICHAEL P $9.73
YOUNG,MONTE L $12.63
YOUNG,RAY L $6.14
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YOUNG,RYAN $2.53
YOUNG,SARAH TESSIER $12.14
YOUNG,SHAUNTEL TRELISE $22.43
YOUNG,SONJA D $7.15
YOUNG,STEPHEN $13.37
YOUNG,TIRIA RENA $59.23
YOUNG,TRAVIS $11.53
YOUNG,WILLIAM $46.03
YOUNG,WILLIAM E $0.16
YOUNGBLOOD,SHERRY $21.76
YOUSSEF,AMR M $18.60
YOWDOIN,ANN H $14.58
YTURRALDE,HUGO R $38.26
YU,GRACE N $27.06
YU,HYUK SANG $9.35
YU,OK NAM $19.31
YUK,CANDY $28.31
YUKON PACIFIC CORPORATION $25.50
YUM,YONG $17.35
YUN,JEONG HEE $56.02
YUN,JIMMY $22.64
YUN,JOHN DO $42.22
YUN,TIMOTHY G $3.35
YUN,YUN H $79.37
YUNAK,JACQUELINE $6.41
YUNE,SUGGIE $22.53
YUZON,MARICAR T $24.54
ZABOROSKIE,DAVID $26.88
ZABRIC,BRYCE W $11.30
ZACHARIAS,ARLEN $3.02
ZACK,ANNEMARIE $13.78
ZACKAR,MARY M $6.39
ZAHER,BRYAN M $95.84
ZAIMIS,JOHN J $34.51
ZAITSEV,FEODOSIA A $5.22
ZAK III,VICTOR $17.17
ZAKULA,JOHN $21.53
ZAMORA,CHRISTOPHER A $9.77
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ZAMORA,LISA $7.80
ZAMOROUEV,ALEXANDER $7.82
ZAOCHNEY,ALEX M $18.15
ZAOCHNEY,ANNA $8.86
ZAOCHNEY,SONNY $75.95
ZAPATA,JAVIER $4.34
ZARKOVICH,ROBERT JOSEPH $26.71
ZARR.ASHLEY $6.99
ZATORSKI,JODY M $11.72
ZAUKAR,JENNIE E $25.14
ZAUKAR-PEPPERLING,NATALIE $4.62
ZAVALA,ANTHONY A $7.47
ZECIRI,AGIM ABIDIN $20.93
ZECKSER,MINHO $8.38
ZEEK,THOMAS H $16.75
ZELENAK,MICHAEL B $22.30
ZEMKE,VANCE E $20.54
ZENCEY,MATTHEW E $19.16
ZENTMIRE,ROBERT CHRISTOPHER $4.15
ZERMENO,ANNE L $5.74
ZERNIA,SANDRA $5.87
ZEUTZIUS,TISHA $15.42
ZHELAYEV,AURELIA $20.92
ZHOU,SHUMING $12.42
ZIEGELBEIN,ELIZABETH $5.58
ZIELINSKI,LYNN ROSE $22.02
ZIESMER HAYS,ANNE MARIE $24.50
ZIMMERMAN,ERIC $3.38
ZIMMERMAN,JOSEPH $5.32
ZIMMERMAN,MARK J $19.02
ZIMMERMANN,CRAIG $50.19
ZINCK,ROBERT G $11.00
ZINN,DAVID A $21.17
ZOET,CRAIG $27.38
ZOLLICOFFER,JEROME J $4.12
ZOLLNER,JUDD $18.75
ZOREA,NATHAN M $13.68
ZORRILLA,SUHEIL $16.81
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ZUBROD,AGNES C $8.66
ZUELKE,EDWARD $188.23
ZUELKE,JULIE M $77.85
ZUNDEL,JUDITH T $25.72
ZUPANCIC,MICHAEL GREG $3.68
ZYWNA,JOSEFA M $30.57
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